Congratulations on choosing our product!

Thank you very much for purchasing our product. To obtain the best performance from this device and to ensure safe and correct operation, please read this Instruction Manual carefully, and then keep it in a safe place together with your warranty.

Please read before using this product

For designing beautiful embroidery designs
• This system allows you to create a wide variety of embroidery designs and supports a wider range of sewing attribute settings (thread density, sewing pitch, etc.). However, the final result will depend on your particular sewing machine model. We recommend that you make a trial sewing sample with your sewing data before sewing on the final material.

For safe operation
• Do not save any files on the "Palette Software Key" for transferring or storage.
• Do not plug the "Palette Software Key" into your sewing machine.

For a longer service life
• When storing the "Palette Software Key", avoid direct sunlight and high humidity locations. Do not store the "Palette Software Key" close to a heater, iron or other hot objects.
• Do not spill water or other liquids on the "Palette Software Key".
• Do not drop or hit the "Palette Software Key".

For repairs or adjustments
• In the event that a malfunction occurs or adjustment is required, please consult your nearest service center.

Notice
• Since this "Palette Software Key" device is required to run the software, its replacement value is the retail price of the software. Please keep in a safe place when not in use.
• Neither this Instruction Manual nor the Reference Guide explains how to use your computer under Windows®. Please refer to the Windows® manuals.

Copyright acknowledgment
Windows® is a registered trademark of Microsoft Corporation. Other product names mentioned in the Instruction Manual and Reference Guide may be trademarks of registered trademarks of their respective companies and are hereby acknowledged.

Caution
The software included with this product is protected by copyright laws. This software can be used or copied only in accordance with the copyright laws.

SAVE THESE INSTRUCTIONS
This product is intended for household use.

For additional product information and updates, visit our website at: www.babylock.com
Table of Contents

Table of Contents.............................................  2
Introduction.............................................  4
   How To Use Manuals..................................  5
   Support/Service .....................................  7
   Palette Software Key ................................  9
   Comparison of Types of Data Created With Palette Ver.11 ................................................  10
   Starting Up/Exiting Applications..................  11
   Understanding Windows..............................  13
   Basic Software Settings.............................  16

Basic Layout & Editing Operations.....................  23
   Layout & Editing.....................................  24
   Tutorial 1: Drawing shapes to create an embroidery design .................................................................  29
   Editing Embroidery Designs ............................  38
   Specifying Thread Colors and Sew Types for Lines and Regions ...............................................................  53
   Drawing Shapes .........................................  69
   Reshaping Embroidery Patterns ......................  75
   Editing a Stitch Pattern ................................  80
   Checking Embroidery Patterns .......................  86
   Opening/Importing Embroidery Designs .............  100
   Saving and Printing ....................................  106

Creating Embroidery Patterns Containing Text ............  110
   Tutorial 2: Using Templates .........................  111
   Template Feature ......................................  114
   Tutorial 3: Entering text ..............................  115
   Advanced Operations for Entering Text .............  116
   Tutorial 4: Monograms ................................  130
   Advanced Operations for Entering Monograms .........  133
   User-Mapped Text ......................................  134
   Tutorial 5: Creating Name Drop ......................  135
   Name Drop Feature (Replacing Text) ..................  138

Creating Embroidery Patterns Using Images .............  140
   Stitch Wizard: Automatically Converting an Image to an Embroidery Design ...........................................  141
   Tutorial 6-1: Auto Punch ...............................  142
   Auto Punch Features ....................................  144
   Tutorial 6-2: Cross Stitch .............................  145
   Cross Stitch Features ...................................  147
   Tutorial 6-3: Photo Stitch 1 ............................  149
   Photo Stitch 1 Features ................................  152
   Tutorial 6-4: Photo Stitch 2 ............................  154
   Photo Stitch 2 Features ................................  156
   Advanced Stitch Wizard Operations ..................  157
   Importing Image Data ....................................  162
   Changing the Image Settings .........................  164
   Tutorial 7: Print and Stitch ............................  166

Operations for Specific Applications .....................  171
   Tutorial 8: Filling a specified area around a pattern with embroidery ......................  172
   Specify Settings for Background Fill ...............  176
   Tutorial 9-1: Creating Appliqués ....................  178
   Tutorial 9-2: Creating Embroidered Patches ........  183
   Tutorial 9-3: Creating a Cutwork Pattern Filled with Net Stitching ...............................  186
   On Using the Cutwork Functions .......................  190
   Tutorial 10-1: Creating Split Embroidery Designs .................................................................  194
   Specifying Settings for Split Embroidery Designs .................................................................  200
   Tutorial 10-2: Creating Design for Multi-Position Hoops .................................................................  203
   Tutorial 10-3: Embroidering With the Jumbo Frame .................................................................  208
   Specifying/Saving Custom Sewing Attributes ........  212
   Using Manual Punch Tool ................................  217

Transferring Data .............................................  220
   Transferring Embroidery Designs to Machines ..................  221
   Using the Link Function to Embroider From the Computer .................................................................  226

Design Center ..............................................  236
   Design Center ..........................................  237
   Basic Design Center Operations ......................  240
   Design Center Window ..................................  250
   Original Image Stage ....................................  251
   Line Image Stage .......................................  253
   Figure Handle Stage .....................................  255
   Sew Setting Stage .......................................  260
Table of Contents

Design Database .................................. 268

Design Database ................................ 269
Design Database Window ....................... 270
Starting Up Design Database ................. 271
Organizing Embroidery Designs .............. 272
Opening Embroidery Designs ................ 274
Transferring Embroidery Designs to Machines ................................................. 275
Searching for an Embroidery Design ........ 281
Converting Embroidery Design Files to Different Formats .................................. 282
Checking Embroidery Designs ............... 283
Outputting a Catalog of Embroidery Designs ...................................................... 285

Programmable Stitch Creator .............. 287

Programmable Stitch Creator ............. 288
Basic Programmable Stitch Creator Operations ....................................................... 290
Creating Fill/Stamp Stitch Pattern .......... 292
Editing a Pattern in Fill/Stamp Mode .... 296
Creating Motif Stitch Pattern ............... 298
Editing a Pattern in Motif Mode .......... 301
Creating a Decorative Fill Pattern ....... 302
Programmable Stitch Creator Window .... 305
Opening a Template ......................... 306
Preview Window .................................. 308
Saving Patterns .................................. 308
Changing the Display Settings ............. 310

Font Creator .................................... 311

Font Creator .................................. 312
Creating New Font Characters From Background Images .................................. 314
Registering Embroidery Data as a Font .. 321
Font Creator Window ......................... 326
Opening a File .................................... 328
Selecting a Character and Preparing the Template .................................. 329
Creating a Font Character Pattern ....... 331
Editing the Points of a Font Character Pattern .................................. 332
Checking the Created Font Patterns ...... 333
Saving Font Character Patterns .......... 335
Changing the Settings ......................... 336

Supplement .................................... 338

For Basic Operations .......................... 339
On Settings ...................................... 341

Changing Various Settings .................. 342
For Making an Effective Use of This Application .................................. 348

Reference ...................................... 350

Sewing Attributes .............................. 351
Font List ......................................... 376
Troubleshooting ................................ 380
Index ............................................. 382
Introduction

This section provides a general understanding of the basic software applications as well as support information.
How To Use Manuals

The following manuals are included with this software.

Reference Guide

Read this guide before using the software. This guide contains instructions and precautions necessary to begin using the software. The second half is filled with tutorials that use key features to create embroidery patterns as well as project examples.

Instruction Manual

This manual contains instruction on how to use the Palette software.

First, read “Palette Software Key”, “Starting Up/Exiting Applications”, “Comparison of Types of Data Created With Palette Ver.11”, “Example of Importing Embroidery Data” and “Understanding Windows” to gain a general understanding of the basic software applications.

Next, read “Basic Layout & Editing Operations”. This chapter provides procedures for creating embroidery patterns as examples for performing basic Layout & Editing operations and transferring patterns to the embroidery machine. Follow the procedures to create actual embroidery patterns.

The chapters dedicated to each application provide descriptions of the useful functions and the various settings. Each descriptive title allows you to easily find the information that you need. In the chapters containing tutorials, follow the procedures to practice the various operations. Afterward, read the detailed descriptions.

Additional information is provided in the following chapters. Read the appropriate chapter when necessary.

Support/Service: Provides warranty information for this product in addition to the procedure for updating the software.

Supplement: Provides function introductions, details on the settings available in the [Options] dialog box and troubleshooting procedures in addition to tips and precautions to maximize the use of this software.

Reference: Provides lists of sew types, sewing attributes and fonts.

The procedures in this manual are written for use in Windows® 10. If this software is used on an operating system other than Windows® 10, the procedures and appearance of the windows may differ slightly.

Opening Online Instruction Manual

An online Instruction Manual is available, which can also be accessed from a mobile device.

Babylock.com/palette11/en

Viewing from the [Start] screen (for Windows® 10 users)

Click [Start]. Click [Palette Ver.11] and then select [Online Instruction Manual].

For Windows® 8.1 users: Position the mouse pointer in the [Start] screen to display the down arrow in the lower-left corner of the screen (below and left of the tiles), and click it. From the list of applications that appears in the screen, click [Online Instruction Manual] under the title [Palette Ver.11].

For Windows® 7 users: Click and then [All Programs]. Click [Palette Ver.11] and then select [Online Instruction Manual].
Viewing from the application

Click [Help] in the window of each application. In [Design Database], [Help] is in the menu bar at the top of the window.

In other applications, it is located in the upper-right corner of the window.

- A PDF version of the Instruction Manual is also available, which can be accessed even when the computer is offline. Access the PDF version of the Instruction Manual as described below.
  - Windows® 10 users: Click . Click [Palette Ver.11] and then select [Instruction Manual].
  - For Windows® 8.1 users: Position the mouse pointer in the [Start] screen to display the down arrow in the lower-left corner of the screen (below and left of the tiles), and click it. From the list of applications that appears in the screen, click [Instruction Manual] under the title [Palette Ver.11].
  - For Windows® 7 users: Click and then [All Programs]. Click [Palette Ver.11] and click [PDF] and then select [Instruction Manual].

- Adobe® Reader® is required for viewing and printing the PDF version of the Instruction Manual.
- If Adobe® Reader® is not on your computer, it must be installed. It can be downloaded from the Adobe Systems Incorporated Web site (https://www.adobe.com/).
Support/Service

Technical Support

Contact Technical Support if you have a problem. Go to www.babylock.com, then click on Customer Support.

![Important]

• Have the information ready before contacting Technical Support.
  ◆ Make sure your computer’s operating system is current with all updates.
  ◆ Have the make and model of your computer and Windows® Operating System. (Refer to the Reference Guide for system requirements.)
  ◆ Information on error messages that appear. This information will help expedite your questions more quickly.
  ◆ Make sure Palette Ver.11 is current with any updates.

Online Registration

If you wish to be contacted about upgrades and provided with important information such as future product developments and improvements, you can register your product online by following a simple registration procedure.

Click [Help] in Layout & Editing, then [Online Registration] to start up the installed Web browser and open the online registration page on our Web site.

The online registration page on the Web site appears when the following address is entered in the address bar of the Web browser.

www.babylock.com/register

Online registration may not be available in some areas.
Checking for the Latest Version of the Program

Click **[Help]** in Layout & Editing, then **[Check for Updates]**.
The software is checked to determine whether or not it is the latest version.
If the message shown below appears, the latest version of the software is being used.

![Check for Most Recent Version]

If the message shown below appears, the latest version of the software is not being used. Click **[Yes]**, and then download the latest version of the software from the Web site.

![Check for Most Recent Version]

If the **[Always check for most recent version at startup]** check box is selected, the software is checked at startup to determine whether or not it is the latest version.
Palette Software Key

In order to use Palette Ver.11, the included "Palette Software Key" must be plugged into a USB port of the computer. The "Palette Software Key" prevents unauthorized use of this software. The software cannot be started if the "Palette Software Key" is not plugged in.

* Design is subject to change.

- The "Palette Software Key" cannot be used as USB media. Do not save embroidery files on the "Palette Software Key" for transferring or storage.
- When the "Palette Software Key" is plugged into a USB port of the computer, the [AutoPlay] dialog box appears. Do not use this dialog box. Click to close the dialog box, and then start up Palette Ver.11.

![AutoPlay dialog box]

- When the message "Do you want to scan and fix PALETTE (E:)?" appears, select [Continue without scanning] and then start up Palette Ver.11. The drive name for the Palette differs depending on computers.

![Adobe Reader dialog box]

- To unplug the "Palette Software Key" from the computer, click [Start] - [File Explorer], right-click the "Palette Software Key", and then click [Eject].
- Do not format the "Palette Software Key".
- We recommend that you back up this software in order to prepare for unexpected problems.
Comparison of Types of Data Created With Palette Ver.11

Three types of data are used in Palette Ver.11.

**Stitch pattern**: Built-in embroidery data (created through a conversion in Palette Ver.11)

**Text pattern**: Data created with the [Text] tools

**Shape pattern (Outline pattern)**: Data created with the [Shapes] tools. A uniform/multiple sewing direction(s) are applied to the entire region.

Each data can be converted to another type as shown below. The arrows indicate the directions in which data can be converted. The methods of editing the data differ depending on the data type.

### Stitch pattern

You can edit (reshaping by moving/deleting points or splitting/connecting lines at points) points (needle drop points) and split stitches; however, you cannot specify region and line sew types or sewing attributes.

### Text pattern

You can edit text by entering/deleting characters, specify text attributes (such as the font or the transformation shape) and specify sewing attributes.

### Shape pattern

You can specify region and line sew types as well as sewing attributes, edit paths (by moving/deleting points, reshaping through handle movements or by splitting/connecting lines at points), change the sewing direction, input/edit stamps, apply embossing/engraving effects, remove/merge overlapping regions, set hole sewing, split outlines and create offset lines and floral patterns.

For example, when a stitch pattern is converted to shapes, the sew types and sewing attributes can be changed, and the shapes can easily be edited and resized. When text pattern is converted to shapes, the sewing direction and character shapes can be edited and offset lines can be created.

Functions that are not available with one data type may be performed if the data is converted to a different type. Convert data to the type that allows you to perform the operations necessary for creating the desired embroidery data.
Starting Up/Exiting Applications

Starting Up the Application

Click \( \phantom{\text{Start}} \) and then Click \([\text{Palette Ver.11 (Layout & Editing)}]\) under the title \([\text{Palette Ver.11}]\) in the screen. When the application starts up, the Startup Wizard appears.

"About the Startup Wizard" on page 12

For Windows® 8.1 users: Click the down arrow in the bottom-left corner of the \([\text{Start}]\) screen to show the \([\text{Apps}]\) view, and then Click \([\text{Palette Ver.11 (Layout & Editing)}]\) under the title \([\text{Palette Ver.11}]\) in the screen.

For Windows® 7 users: Click \( \phantom{\text{Start}} \), then \([\text{All Programs}]\), then \([\text{Palette Ver.11}]\), and then click \([\text{Palette Ver.11 (Layout & Editing)}]\).

Exiting the Application

Click \( \phantom{\text{Exit}} \), then \([\text{Exit}]\).
About the Startup Wizard

When [Layout & Editing] starts up, the following wizard appears.

1. **Open Instruction Manual**
   - Click this button to open the Instruction Manual (HTML/PDF format).

2. **Use Template Designs**
   - Click this button to start the [Template Wizard].
     - “Tutorial 2: Using Templates” on page 111

3. **Create Embroidery Patterns Using Images**
   - Click this button to start the wizard for creating an embroidery pattern from an image.
     - “Stitch Wizard: Automatically Converting an Image to an Embroidery Design” on page 141 and “Importing Image Data” on page 162

4. **Set Hoop Size and Fabric**
   - Click this button to specify the size of the Design Page (embroidery hoop size). The fabric to be embroidered can be selected, and the sewing attributes appropriate for that fabric can be specified.
     - “Specifying the Design Page Settings” on page 16 and “Recalling a group of settings from the list” on page 212

5. **Click this button to import patterns from [Text] of the [Import] pane.**

6. **Close This Wizard**
   - Click this button to close the Startup Wizard without performing an operation.

To open the wizard while you are using the [Layout & Editing], click at the top of the window (in the [Quick Access Toolbar]), or click and then select [Wizard] from the command menu.
Understanding Windows

Layout & Editing Window

1. Application button
   Click to display a menu containing commands for file operations, such as [New], [Save], [Print] and [Design Settings].

2. Ribbon
   Click a tab at the top to display the corresponding commands. Refer to the name below each group when selecting the desired command. Clicking a command with the mark displays a menu containing a choice of commands. Some other tabs may appear depending on the tool or embroidery pattern that is selected. These tabs contain various commands for performing operations with the selected tool or embroidery pattern.

Example: When the Shapes (Rectangle) tool is selected

3. Quick Access Toolbar
   This contains the most frequently used commands. Since this toolbar is always displayed, regardless of the Ribbon tab that is selected, adding your most often used commands makes them easily accessible.

   "Customizing Quick Access Toolbar" on page 344

4. Option button
   Click this button to start up other applications and specify application settings, such as user thread charts.
Help button
Click this button to display the Instruction Manual and view information about the software.

Sewing Order pane
This pane shows the sewing order. Click the buttons at the top of the pane to change the sewing order or thread color.

Import/Color/Sewing Attributes/Text Attributes panes
This pane combines tabs for importing embroidery patterns as well as for specifying thread colors, sewing attributes and text attributes. Click a tab to display the available parameters.

Stitch Simulator pane
The Stitch Simulator shows how the pattern will be sewn by the machine and how the stitching will appear.

Design Page
The actual part of the work area that can be saved and sewn.

Work area

Status Bar
This displays the size of the embroidery data, the number of stitches or a description of the selected command.

View mode buttons
Click a button to change the View mode.

Show grid button
Click to switch between displaying and hiding the grid.

Design Property button
Click to display a dialog box containing sewing information for the embroidery data.

Zoom slider
This displays the current magnification ratio. Click to specify a value for the magnification ratio. Drag the slider to change the magnification ratio.

• Panes 6, 7 and 8 can be displayed or hidden from the [Show/Hide] group in the [View] tab. In addition, these panes can be displayed as separate dialog boxes (Floating) or attached to the main window (Docking).

• Position the pointer over a command to display a ScreenTip, which provides a description of the command and indicates its shortcut key.
Example of Importing Embroidery Data

■ Using the Import pane
Embroidery data can be imported by using the [Import] pane.

1 From
Select a pattern location.

2 Category
Select a pattern category.
The categories in the pattern location selected in the [From] selector are listed.

3 The patterns in the category selected in the [Category] selector appear in the list.
Pointing to a pattern and holding down the left mouse button displays a dotted box in the Design Page. This allows you to check the size of the pattern.

4 Import
Click this button to import the selected pattern.

• The pattern can also be imported by double-clicking it in the list or by dragging it to the Design Page.
• Multiple files cannot be selected to be imported at the same time.

■ Using Import commands
1 Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group, and then click [from Design Library], [from File], [from Card] or [Decorative Pattern] from the [Import] menu.

→ The [Import] pane appears on the right side of the screen.

The [Import] pane can also be displayed by selecting the [Import Pane] check box in the [View] tab.

When the [Color] pane, [Sewing Attributes] pane or [Text Attributes] pane is displayed, click the [Import] tab to display the [Import] pane.
Basic Software Settings

Specifying the Design Page Settings

The color and size of the Design Page can be changed. You can select a Design Page size according to the size of hoop that you will be using with your embroidery machine. You can also specify a custom size for the Design Page for embroidery patterns that will be split and embroidered in multiple sections.

1. Click , then [Design Settings].

2. Specify the settings for the Design Page, and then click [OK].

   - **Machine Type**
     Select your machine type. The settings available in the [Page Size] selector differ depending on the selected machine type.

   - **Hoop Size**
     Select the desired hoop size from the selector.

   - **Rotate 90 Degrees**
     Select this check box to arrange the pattern in a Design Page rotated 90°.

   - **Custom Size**
     Specify a custom size for split embroidery patterns. Select this option, and then type or select the desired width and height for the Design Page.

   - "Tutorial 10-1: Creating Split Embroidery Designs" on page 194

   - **Page**
     Select the desired color for the Design Page.

   - **Background**
     Select the desired color for the work area.

   - **Default**
     To return to the default settings, click this button.

   - **Edit User Hoop**
     Click this button to display the [User Hoop Settings] dialog box, where a user hoop size can be added. The added user hoop size appears at the bottom of the list.

   - "Specifying a user hoop size" on page 17
Basic Software Settings

Introduction

Specifying a user hoop size

1 User Hoop List
   The added hoop size appears in the list. Select a hoop size in this list to change the display order or to delete it.

2 Width, Height
   Type in the size of the hoop to be added.

3 Comment
   If text was entered in this box, that text appears beside the size.

4 Up, Down
   Click these buttons to move the selected hoop size up or down in the display order.

5 Delete Hoop
   Click this button to delete the selected hoop size.

6 Add Hoop
   Click this button to add the hoop size.

- The Design Page sizes 130 × 300 mm, 100 × 172 mm indicated by the “*”, are used to embroider multi-position designs using a special embroidery hoop attached to the embroidery machine at three installation positions.

- Do not select a hoop size larger than the embroidery hoop that can be used with your machine.

- When Cap Frame, Cylinder Frame or Round Frame has been selected, the Design Page cannot be rotated 90°.

- "Tutorial 10-2: Creating Design for Multi-Position Hoops" on page 203

- Do not create a Custom Hoop larger than the embroidery hoop that can be used with your machine.

- Embroidery data created in a user hoop size cannot be saved in a format for a previous version.

- A User Hoop cannot rotate 90°.

- A User Hoop cannot be added to the Section Size (for Hoop Size) selector under Custom Size.

- Do not create a Custom Hoop larger than the embroidery hoop that can be used with your machine.

- Embroidery data created in a user hoop size cannot be saved in a format for a previous version.
Basic Software Settings

■ Specifying the sewing area
The pattern drawn in the Design Page is sewn differently depending on the sewing area setting.

2. Select the desired sewing area ([Design Page area] or [Use existing design area]).

Design Page area
The patterns will be sewn so that the needle position when you start sewing is aligned with the center of your Design Page. The dimension of the pattern matches the size of the Design Page, therefore reducing the ability to move a pattern around the layout screen of your embroidering machine.

Use existing design area
The patterns will be sewn so that the needle position when you start sewing is aligned with the center of the actual patterns. The actual pattern size is maintained, therefore allowing greater mobility when using the layout functions of your embroidering machine.

■ Optimize hoop change
This setting can be selected if a multi-position hoop (100 × 172 mm or 130 × 300 mm) has been selected as the Design Page size.

Select the check box to optimize the sewing order/order of hoop position changes so that the number of times that the hoop position is changed is reduced to the minimum.

This reduces the risk of misalignment in the embroidery pattern or uneven stitching from changing the hoop position too often.

■ Jump Stitch Trimming
These settings are applied only when embroidering with our multi-needle embroidery machines. Before these settings can be specified, select [Machine Type] under [Machine Type] in the [Design Settings] dialog box.

Specify the minimum jump stitch length for thread trimming.

These settings are not applied with any other embroidery machine. For details, refer to the instruction manual provided with your machine.

>> "Jump Stitch Trimming" on page 97, "Specifying trimming settings in Layout & Editing" on page 341 and "Adding jump stitch trimming to new patterns" on page 346
Basic Software Settings

Using Fabric Selector

A group of sewing attribute settings appropriate for the major types of fabric can be recalled from the [Fabric Selector] dialog box. Select the fabric to be embroidered to view a description of the fabric and advice on embroidering.

1. Click , then [Fabric Selector].

2. Select the group of settings to be recalled.

   a. Select the type of fabric to be embroidered to specify the recommended settings for that fabric. When a fabric type is selected, a description appears.

   b. Select this check box to apply the sewing attributes to all shape patterns and text patterns in the current Design Page.

3. Click [OK].

   The sewing attributes will be set to those recommended for the selected fabric.

   • Perform a trial sewing before embroidering your project.
   
   "For Basic Operations" on page 339

   Original settings can be saved to be later used in the [Fabric Selector]. Click  in the [Sewing Attributes] tab, click [Save As], and then click [OK] without changing the name for the settings. The group of settings that you have saved will appear with “*” beside its name.

   "Saving the settings in a list" on page 212

   • Perform a trial sewing before embroidering your project.

   "Specifying sewing attributes" on page 63
Specifying Basic Display Settings

Changing the grid settings
A grid of dotted lines or solid lines can be displayed or hidden, and the spacing for the grid can be adjusted.

1. Click [View] tab.
2. Specify the grid settings.

   1. Show Grid
      Select this check box to display the grid.
   2. with Axes
      Select this check box to display the grid as solid lines.
   3. Interval
      Specify the grid spacing.
   4. Snap to Grid
      Select this check box to align patterns with the grid. The snap feature works whether or not the grid is displayed.

The button can also be used to switch the grid between being displayed or hidden.

Changing the ruler settings
The ruler can be displayed or hidden.

1. Click the [View] tab.
2. To display the ruler, select the [Ruler] check box in the [Ruler] group.
   To hide the ruler, clear the [Ruler] check box.

   Click to switch the measurement units between millimeters and inches.
Changing the guideline settings

Guidelines can also be used when the ruler is displayed.

1. Click the [View] tab.
2. Select the [Ruler] check box, and then select the [Guideline] check box in the [Ruler] group.
3. Click a ruler in the Design Page. → appears, and a guideline is drawn.

- To move a guideline, drag .
- To delete a guideline, click .

Adjusting on-screen measurements (Screen Calibration)

Measurements can be adjusted so that objects will be displayed at the same size as the actual embroidery at a zoom ratio of 100%. Once this adjustment is made, it will not need to be done again later.

1. Click , then [Options].
2. Click [Screen Calibration]. Hold a ruler against the screen to measure the length of ①. Next, enter the value at ②, and then click [OK].

- A guideline is added each time the ruler is clicked. In addition, up to 100 guidelines each can be added to the horizontal and vertical rulers.
- While a guideline is being dragged, its position is shown in the status bar.
- When the [Ruler] check box or the [Guideline] check box is cleared, the guidelines are hidden.
- If both the [Show Grid] and [Snap to Grid] check boxes are selected, the guidelines will be added/moved along the lines of the grid.

*Changing the grid settings* on page 20

When a pattern is saved, the guidelines are saved with it. However, the guidelines are deleted if the pattern is saved in a format for a version earlier than version 10.
■ System unit

1. Click , then [Options].

2. Click [System Unit], and then select the desired measurement units ([mm] or [inch]).
Basic Layout & Editing Operations

This section describes the basic operations performed in Layout & Editing, such as drawing shapes, editing the embroidery design, specifying sewing attributes, saving the file and printing it.
Layout & Editing

Application button menu

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>New</td>
<td>p. 100</td>
</tr>
<tr>
<td>2</td>
<td>Open</td>
<td>p. 100</td>
</tr>
<tr>
<td>3</td>
<td>Save</td>
<td>p. 106</td>
</tr>
<tr>
<td>4</td>
<td>Save As</td>
<td>p. 106</td>
</tr>
<tr>
<td>5</td>
<td>Print</td>
<td>p. 107</td>
</tr>
<tr>
<td>6</td>
<td>Design Property</td>
<td>p. 98</td>
</tr>
<tr>
<td>7</td>
<td>Design Settings</td>
<td>p. 16</td>
</tr>
<tr>
<td>8</td>
<td>Fabric Selector</td>
<td>p. 19</td>
</tr>
<tr>
<td>9</td>
<td>Select Color Palette</td>
<td>p. 216</td>
</tr>
<tr>
<td>10</td>
<td>Wizard</td>
<td>p. 12</td>
</tr>
<tr>
<td>11</td>
<td>Export</td>
<td>p. 106</td>
</tr>
</tbody>
</table>

Ribbon menu tabs

Home tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tools</td>
<td>p. 38</td>
</tr>
<tr>
<td>2</td>
<td>Cut</td>
<td>—</td>
</tr>
<tr>
<td>3</td>
<td>Copy</td>
<td>—</td>
</tr>
<tr>
<td>4</td>
<td>Paste</td>
<td>p. 63</td>
</tr>
<tr>
<td>5</td>
<td>Duplicate</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>Arrange Copy Tools</td>
<td>p. 42</td>
</tr>
<tr>
<td>7</td>
<td>Delete</td>
<td>—</td>
</tr>
<tr>
<td>8</td>
<td>Text Tools</td>
<td>p. 116</td>
</tr>
<tr>
<td>9</td>
<td>Shapes Tools</td>
<td>p. 69</td>
</tr>
<tr>
<td>10</td>
<td>Zoom In</td>
<td>p. 86</td>
</tr>
<tr>
<td>11</td>
<td>Zoom Out</td>
<td>p. 86</td>
</tr>
<tr>
<td>12</td>
<td>Other Zoom Tools</td>
<td>p. 86</td>
</tr>
<tr>
<td>13</td>
<td>Pan</td>
<td>p. 86</td>
</tr>
<tr>
<td>14</td>
<td>Measure</td>
<td>p. 87</td>
</tr>
<tr>
<td>15</td>
<td>Import Patterns</td>
<td>p. 101</td>
</tr>
<tr>
<td>16</td>
<td>Arrange</td>
<td>p. 39</td>
</tr>
<tr>
<td>17</td>
<td>Rotate/Flip</td>
<td>p. 41</td>
</tr>
<tr>
<td>18</td>
<td>Size</td>
<td>p. 40</td>
</tr>
<tr>
<td>19</td>
<td>Group</td>
<td>p. 46</td>
</tr>
<tr>
<td>20</td>
<td>Stamp/Emboss</td>
<td>p. 65</td>
</tr>
<tr>
<td>21</td>
<td>Modify Overlap</td>
<td>p. 47</td>
</tr>
<tr>
<td>22</td>
<td>Fit Text to outline</td>
<td>p. 122</td>
</tr>
<tr>
<td>23</td>
<td>Background fill</td>
<td>p. 173</td>
</tr>
<tr>
<td>24</td>
<td>Applique Wizard</td>
<td>p. 178</td>
</tr>
<tr>
<td>25</td>
<td>Embroidered Patch Wizard</td>
<td>p. 184</td>
</tr>
<tr>
<td>26</td>
<td>Cutwork Wizard</td>
<td>p. 187</td>
</tr>
<tr>
<td>27</td>
<td>Sew Embroidery</td>
<td>p. 221</td>
</tr>
</tbody>
</table>
### Image tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Image</td>
<td>p. 162</td>
</tr>
<tr>
<td>2</td>
<td>Save Image</td>
<td>p. 165</td>
</tr>
<tr>
<td>3</td>
<td>Modify Image</td>
<td>p. 164</td>
</tr>
<tr>
<td>4</td>
<td>Background Image Density</td>
<td>p. 164</td>
</tr>
<tr>
<td>5</td>
<td>Rotate Right</td>
<td>p. 165</td>
</tr>
<tr>
<td>6</td>
<td>Rotate Left</td>
<td>p. 165</td>
</tr>
</tbody>
</table>

### View tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Solid View</td>
<td>p. 87</td>
</tr>
<tr>
<td>2</td>
<td>Stitch View</td>
<td>p. 87</td>
</tr>
<tr>
<td>3</td>
<td>Realistic View</td>
<td>p. 88</td>
</tr>
<tr>
<td>4</td>
<td>View Thread Trimming</td>
<td>p. 88</td>
</tr>
<tr>
<td>5</td>
<td>Realistic View Settings</td>
<td>p. 88</td>
</tr>
<tr>
<td>6</td>
<td>Sewing Order</td>
<td>p. 91</td>
</tr>
<tr>
<td>7</td>
<td>Stitch Simulator</td>
<td>p. 89</td>
</tr>
<tr>
<td>8</td>
<td>Attributes Setting</td>
<td>p. 35</td>
</tr>
<tr>
<td>9</td>
<td>Import Pane</td>
<td>p. 15</td>
</tr>
<tr>
<td>10</td>
<td>Reference Window</td>
<td>p. 90</td>
</tr>
<tr>
<td>11</td>
<td>Show Grid</td>
<td>p. 20</td>
</tr>
<tr>
<td>12</td>
<td>Show Grid with Axes</td>
<td>p. 20</td>
</tr>
<tr>
<td>13</td>
<td>Snap to Grid</td>
<td>p. 20</td>
</tr>
<tr>
<td>14</td>
<td>Grid Spacing</td>
<td>p. 20</td>
</tr>
<tr>
<td>15</td>
<td>Ruler</td>
<td>p. 20</td>
</tr>
<tr>
<td>16</td>
<td>Guideline</td>
<td>p. 21</td>
</tr>
</tbody>
</table>
Text tab (Text)

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tools</td>
<td>p. 38</td>
</tr>
<tr>
<td>2</td>
<td>Text Tools</td>
<td>p. 116</td>
</tr>
<tr>
<td>3</td>
<td>Font</td>
<td>p. 117</td>
</tr>
<tr>
<td>4</td>
<td>Text Size</td>
<td>p. 119</td>
</tr>
<tr>
<td>5</td>
<td>Font Filter</td>
<td>p. 118</td>
</tr>
<tr>
<td>6</td>
<td>Font Filter Settings</td>
<td>p. 118</td>
</tr>
<tr>
<td>7</td>
<td>TrueType Font Attribute Setting</td>
<td>p. 120</td>
</tr>
<tr>
<td>8</td>
<td>Line color</td>
<td>p. 127</td>
</tr>
<tr>
<td>9</td>
<td>Text Outline Sew Type</td>
<td>p. 127</td>
</tr>
<tr>
<td>10</td>
<td>Region color</td>
<td>p. 127</td>
</tr>
<tr>
<td>11</td>
<td>Text Body Sew Type</td>
<td>p. 127</td>
</tr>
<tr>
<td>12</td>
<td>Edit Text</td>
<td>p. 117</td>
</tr>
<tr>
<td>13</td>
<td>Convert to Blocks</td>
<td>p. 125</td>
</tr>
<tr>
<td>14</td>
<td>Convert to Stitches</td>
<td>p. 80</td>
</tr>
<tr>
<td>15</td>
<td>Convert to Outline</td>
<td>p. 126</td>
</tr>
</tbody>
</table>

Outline tab (Shapes (Outline))

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tools</td>
<td>p. 38</td>
</tr>
<tr>
<td>2</td>
<td>Closed Straight Line</td>
<td>p. 72</td>
</tr>
<tr>
<td>3</td>
<td>Closed Curve</td>
<td>p. 72</td>
</tr>
<tr>
<td>4</td>
<td>Pencil (Closed Curve)</td>
<td>p. 72</td>
</tr>
<tr>
<td>5</td>
<td>Open Straight Line</td>
<td>p. 72</td>
</tr>
<tr>
<td>6</td>
<td>Open Curve</td>
<td>p. 72</td>
</tr>
<tr>
<td>7</td>
<td>Pencil (Open Curve)</td>
<td>p. 72</td>
</tr>
<tr>
<td>8</td>
<td>Line color</td>
<td>p. 74</td>
</tr>
<tr>
<td>9</td>
<td>Line sew type</td>
<td>p. 74</td>
</tr>
<tr>
<td>10</td>
<td>Region color</td>
<td>p. 74</td>
</tr>
<tr>
<td>11</td>
<td>Region sew type</td>
<td>p. 74</td>
</tr>
</tbody>
</table>
■ Outline tab (Shapes (Rectangle))

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tools</td>
<td>p. 38</td>
</tr>
<tr>
<td>2</td>
<td>Edge radius</td>
<td>p. 70</td>
</tr>
<tr>
<td>3</td>
<td>Line color</td>
<td>p. 74</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Line sew type</td>
<td>p. 74</td>
</tr>
<tr>
<td>5</td>
<td>Region color</td>
<td>p. 74</td>
</tr>
<tr>
<td>6</td>
<td>Region sew type</td>
<td>p. 74</td>
</tr>
</tbody>
</table>

■ Manual Punch tab (Shapes (Manual Punch))

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tools</td>
<td>p. 38</td>
</tr>
<tr>
<td>2</td>
<td>Straight Block</td>
<td>p. 217</td>
</tr>
<tr>
<td>3</td>
<td>Curved Block</td>
<td>p. 217</td>
</tr>
<tr>
<td>4</td>
<td>Running</td>
<td>p. 217</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Feed</td>
<td>p. 217</td>
</tr>
<tr>
<td>6</td>
<td>Region color</td>
<td>p. 74</td>
</tr>
<tr>
<td>7</td>
<td>Block sew type</td>
<td>p. 74</td>
</tr>
</tbody>
</table>
**Shapes tab (Shapes (Shapes/Circle/Arc))**

- Select Tools
- Split Outline
- Add Direction Line
- Delete Direction Line
- Reverse Direction Line
- Edit Point
- Delete Point
- Split at Point
- Line color
- Line sew type
- Region color
- Region sew type
- Convert Region to Line
- Convert to Stitches
- Create Offset Lines
- Create Floral Pattern

**Stitches tab (Stitches)**

- Select Tools
- Split Stitch Data
- Change Color
- Divide by Color
- Split at Point
- Convert to Blocks
- Convert to Outline

**Hoop Settings tab**

- Select Tools
- Move Sections
- Design Settings
Tutorial 1: Drawing shapes to create an embroidery design

This section will describe how to combine various shapes to create an embroidery design.

We will use an Outline tool to draw the stem. Then, we will create the leaves, flower and flower pot by importing shape patterns.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_1.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drawing, importing and moving shapes</td>
</tr>
<tr>
<td>2</td>
<td>Duplicating, flipping and moving shapes</td>
</tr>
<tr>
<td>3</td>
<td>Specifying hole sewing</td>
</tr>
<tr>
<td>4</td>
<td>Applying a pattern to stitching</td>
</tr>
<tr>
<td>5</td>
<td>Editing points and modifying shapes</td>
</tr>
</tbody>
</table>

Step 1 Drawing, importing and moving shapes

Shapes can be created either by drawing them with the Shapes tools or by importing sample shape patterns.

1 To draw a shape, select a Shapes tool, and then drag the pointer in the Design Page to draw the shape.

2 To import a shape, select [Outline Shapes] from the [From] selector of the [Import] pane, then [Basic Shapes] from the [Category] selector. Select the shape, and then click [Import].

Specify the sew types for the shape on the [Shapes] tab, and the thread colors on the [Shapes] tab or the [Color] pane.
Tutorial 1: Drawing shapes to create an embroidery design

Basic Layout & Editing Operations

1. Draw the stem.
   (A) Click the [Home] tab.
   (B) Click [Shapes] in the [Tools] group, and then click .
   (C) Click the [Color] tab to display the color palette.
   (D) Click [LIME GREEN]. If the desired color is not displayed, move the scroll bar until it appears.
   (E) Click the [Line sew type] selector, and then select [Zigzag Stitch].
   (F) Click the start point 1, and then double-click the end point 2.

To view the thread colors in a list so that the desired color can more easily be found, click [To list mode].

"Setting the sew type" on page 56

The color, sewing attributes and size can also be changed after the shape is drawn.
Create the leaf on the right.

This time, we will import a shape pattern. We will also specify the color and sew type for the region.

(A) Click the [Import] tab.

(B) Select [Outline Shapes] from the [From] selector and [Basic Shapes] from the [Category] selector.

(C) Select [BS_shapes27.pes], and then click [Import].

(D) Click the [Shapes] tab.

(E) Click for line sewing, and then click under [Colors Used] to select [LIME GREEN].

(F) Click the [Line sew type] selector, and then select [Zigzag Stitch].

(G) As with the line color, click for region sewing, and then click under [Colors Used] to select [LIME GREEN].

The thread colors being used are listed under [Colors Used].

(H) Drag the handle to adjust the leaf to the desired size.

(I) Place the pointer over the leaf so that the shape of the pointer changes to , and then drag the leaf to the desired position.

Step 2 Duplicating, flipping and moving shapes

Now, we will duplicate the leaf on the right side, flip it horizontally, and then move it to the left side of the stem.

1 To duplicate the leaf on the right.

(A) Select the leaf.

(B) While holding down the <Ctrl> key, drag the leaf to move it.

(C) Release the mouse button.
**Tutorial 1: Drawing shapes to create an embroidery design**

### Basic Layout & Editing Operations

2. **To flip the duplicated leaf horizontally.**
   - Right-click on the duplicated leaf.
   - A drop down menu will appear.
   - Click [Flip], then [Horizontal].

3. **Drag the duplicated leaf to the left side of the stem.**

4. **Align the leaves on the left and right sides.**
   - While holding down the <Ctrl> key, click the leaf on the right side, then the leaf on the left side to select the two leaves. Then, right-click the selected leaves.
   - Right-click the leaves, and then click [Align], then [Top].

---

**Step 3 Specifying hole sewing**

Now, we will create the flower and a circle at the center. Then, we will apply a setting so that the overlapping areas are not sewn twice.

1. **Create the flower petals.**
   - Click the [Import] tab.
   - Select [BS_shapes26.pes], and then click [Import].
   - Click the [Shapes] tab.

---

- Multiple embroidery patterns can be selected in any of the following ways.
  - Click the first pattern, and then, while holding down the <Ctrl> key, click the next pattern.
  - Drag the pointer to draw a selection frame around the patterns to be selected.
- Flipped copies can also be created by clicking [Arrange Copy] in the [Clipboard] group of the [Home] tab, then clicking [Vertical Mirror Copy].

> "Using the Mirror Copy tool" on page 42.

---

**To move an object horizontally, hold down the <Shift> key while dragging the object.**
Tutorial 1: Drawing shapes to create an embroidery design

Basic Layout & Editing Operations

(D) Select [RED] in the color palette as the line color and [Zigzag Stitch] as the sew type ①.

(E) Select [Radial Stitch] as the sew type ②.

(F) Drag the handle ③ to adjust the flower petals to the desired size.

(G) Drag the flower petals to adjust their position.

2 Create the circle at the center.

(A) Click the [Import] tab.

(B) Select [BS_shapes01.pes], and then click [Import].

(C) Click the [Shapes] tab.

(D) Select [YELLOW] in the color palette as the line color and [Zigzag Stitch] as the sew type ①.

(E) Select [YELLOW] in the color palette as the region color and [Concentric Circle Stitch] as the sew type ②.

(F) Drag the circle to the center of the flower petals.

(G) While holding down the <Shift> key, drag the handle ③ to adjust the circle to the desired size.

3 Select the patterns where hole sewing is to be applied.

(A) While holding down the <Ctrl> key, click the yellow circle ① and the flower petals ②.

If the <Shift> key is held down while a handle is dragged, the pattern is enlarged or reduced from the center of the pattern.
Specify hole sewing.
(A) Click the [Home] tab.
(B) Click [Modify Overlap] in the [Edit] group, and then click [Set hole sewing].

Hole sewing cannot be applied if one of the patterns is not completely enclosed within the other pattern.

"Hole sewing" on page 46.

Step 4 Applying a pattern to stitching

Detailed line and region attribute settings can be specified from the [Sewing Attributes] pane. Now, we will specify settings for region sewing for the flowerpot.

1 Specify the color and sew type for the line and region of the flowerpot.
(A) Click the [Import] tab.
(B) Select [BS_shapes13.pes], and then click [Import].
(C) Click the [Shapes] tab.
(D) Select [CLAY BROWN] in the color palette as the line color and [Zigzag Stitch] as the sew type 1.
(E) Select [DEEP GOLD] in the color palette as the region color and [Prog. Fill Stitch] as the sew type 2.

Hole sewing cannot be applied if one of the patterns is not completely enclosed within the other pattern.
2 Specify the sewing attributes.

(A) Click the [Sewing Attributes] tab. If the [Sewing Attributes] pane is not displayed, click the [View] tab, then [Attributes], then [Sewing Attributes].

(B) There are two display modes for the [Sewing Attributes] pane. For this example, we will specify settings in Beginner mode.

(C) In the [Density] box, type "5.0".

(D) In the [Direction] section, drag the red arrow to 90°. Otherwise, type "90".

(E) Click in the [Programmable fill] section.

(F) Select [net4], and then click [OK].

(G) Type "7.6" to specify the pattern size.

1 The selected pattern is displayed.

① The effects of the specified settings can be previewed. This preview can be displayed/hidden by clicking the Show Hint/Hide Hint button.

② Click this button to return the attribute to its default setting.
Tutorial 1: Drawing shapes to create an embroidery design

Basic Layout & Editing Operations

Now, we will delete one corner from the pentagon to create a flowerpot.

1. Drag the handle to adjust the flowerpot to the desired size.

2. Drag the flowerpot to adjust its position.

2. Delete a point.
   (A) Click the [Home] tab.
   (B) Click [Select] in the [Select] group, and then click .
   (C) Click the shape for the flowerpot. → The points in the shape appear.

Step 5 Editing points and modifying shapes

Now, we will delete one corner from the pentagon to create a flowerpot.

1. Drag the handle to adjust the flowerpot to the desired size.

2. Drag the flowerpot to adjust its position.

2. Delete a point.
   (A) Click the [Home] tab.
   (B) Click [Select] in the [Select] group, and then click .
   (C) Click the shape for the flowerpot. → The points in the shape appear.

• If the dialog box is displayed in Expert mode, click [To Beginner mode] to display the dialog box in Beginner mode.
• More detailed settings can be specified in Expert mode.

"Specifying sewing attributes" on page 63
(D) Right-click the top point to be deleted, and then click [Delete].

→ The point is deleted to form a trapezoid.

If you want save or export

► For details on saving embroidery patterns, refer to “Saving” on page 106. For details on transferring designs to an embroidery machine, refer to “Transferring Embroidery Designs to Machines” on page 221.
Editing Embroidery Designs

Selecting patterns

1. Click the [Home] tab.
2. Click \(\text{Select} \) in the [Select] group.
3. Click the pattern.

- Rotation handle
- Handles

4. To select an additional pattern, hold down the <Ctrl> key and click the other pattern.

- If \(\text{Select} \) is not displayed in the [Select] group, click the arrow at the bottom of the button, and then click \(\text{Select} \).
- The status bar shows the dimensions (width and height) of the pattern.

Selecting all embroidery patterns

1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click [Select All].

- All patterns can also be selected by pressing the shortcut keys <Ctrl> + <A>.
- Locked embroidery patterns cannot be selected.

Moving patterns

Moving manually
Drag the selected pattern(s) to the desired location.

- To move the pattern horizontally or vertically, hold down the <Shift> key while dragging it.
- Pressing the arrow keys moves the selected pattern.
- Holding down the <Ctrl> key and dragging the pattern creates a duplicate of the pattern at the destination.

Selecting patterns

- You can also select patterns by dragging the pointer across the pattern.
- Press the <Tab> key to select the next pattern in the order that they were created.
- If multiple patterns are selected, a pattern can be deselected by holding down the <Ctrl> key while clicking the pattern.
Moving embroidery patterns to the center

1. Select the pattern(s), and then click the [Home] tab.
2. Click [Arrange] in the [Edit] group, and then click [Move to Center].

Aligning embroidery patterns

1. Select the patterns, and then click the [Home] tab.
2. Click [Arrange] in the [Edit] group, and then click the desired command under [Horizontal] or [Vertical].

Scaling patterns

Scaling manually

1. Select the pattern(s).
2. Drag the handle to adjust the selected pattern(s) to the desired size.

We recommend not scaling patterns imported from original cards.
■ Scaling numerically

1 Select the pattern(s), and then click the [Home] tab.

2 Click [Size] in the [Edit] group.

3 Specify the size, and then click [OK].

To change the width and height proportionally, select the [Maintain aspect ratio] check box.

To resize the selected pattern while maintaining the original density and fill pattern, select the [Keep density and fill pattern] check box.

The [Keep density and fill pattern] check box is available only if stitch pattern is selected.

"Enlarging/Reducing Stitch Patterns" on page 339.

Rotating patterns

■ Rotating manually

1 Select the pattern(s).

2 Drag the rotation handle.

To rotate the pattern in 15° increments, hold down the <Shift> key while dragging the handle.

The shape of pointer changes to 旋转

Rotation handle

Select the whether the width and height will be set as a percentage (%) or a dimension (millimeters or inches). Set the width and height.
Rotating numerically

1. Select the pattern(s), and then click the [Home] tab.

2. Click [Rotate/Flip] in the [Edit] group, and then click [Rotate].

3. Type or select the rotation angle. Click [OK].

Some patterns imported from original cards cannot be flipped.

Flipping patterns horizontally or vertically

1. Select the pattern(s), and then click the [Home] tab.

2. Click [Rotate/Flip] in the [Edit] group, and then click [Flip Vertically] or [Flip Horizontally].
Arrange Copies

It may not be possible to create mirror copies of some embroidery data read from original cards.

■ Using the Mirror Copy tool

1. Select the pattern(s), and then click the [Home] tab.
2. Click [Arrange Copy] in the [Clipboard] group, and then click [Vertical Mirror Copy], [Horizontal Mirror Copy] or [Four-Way Mirror Copy].
3. Move the pointer, and then click when the patterns are arranged as desired.

■ Using the Circle Copy tool

1. Select the pattern(s), and then click the [Home] tab.
2. Click [Arrange Copy] in the [Clipboard] group, and then click [Circle Copy].

It may not be possible to create mirror copies of some embroidery data read from original cards.
3 Specify the pattern arrangement and spacing.

1 Select the desired arrangement.
2 Select how the pattern arrangement will be specified.
   Select [Number] to specify the number of patterns to be arranged.
   Select [Spacing] to specify the spacing between the patterns.
   The higher the value, the wider the patterns are spaced from each other.

4 Drag the pointer to draw a circle or an oval.

5 Move the pointer to select the desired angle.

- To draw a circle, hold down the <Shift> key while dragging the pointer.
- To redraw the ellipse, right-click the Design Page to return to before the ellipse was drawn.
- After drawing a circle or ellipse, hold down the <Ctrl> key while dragging the pointer to move, rotate or enlarge/reduce the shape.

6 Click to finish the copies.
Using the Matrix Copy tool

1. Select the pattern(s), and then click the [Home] tab.

2. Click [Arrange Copy] in the [Clipboard] group, and then click [Matrix Copy].

3. Specify the spacing between patterns. The higher the value, the wider the patterns are spaced from each other.

4. Click in the Design Page, and then move the pointer. A rectangle and the patterns that can be arranged within it appear as dotted lines.

5. Click to finish the copies.

Merging patterns

Overlapping shape patterns arranged using [Vertical Mirror Copy], [Horizontal Mirror Copy], [Four-Way Mirror Copy], [Circle Copy] or [Matrix Copy] can be merged. When the following message appears, click [Yes].

- To redraw the rectangle, right-click the Design Page to return to before the rectangle was drawn.
- While resizing the rectangle by moving the pointer, the pattern spacing can still be changed in the [Matrix Copy] dialog box.

To overlap the patterns, specify a negative value number.

The shape patterns are merged.

Patterns may not merge under certain conditions.
Optimizing the sewing order (color sort)

Before using an [Arrange Copy] tool, optimizing the sewing order adjusts the sewing order of the patterns created with the [Arrange Copy] tool in order to reduce the number of thread color changes.

1. Select the pattern(s), and then click the [Home] tab.
2. Click [Arrange Copy] in the [Clipboard] group, and then click [Optimize Sewing Order] so that the check mark appears.
3. Perform the Arrange Copy operation.

Adding a decorative pattern

A decorative pattern can be added to selected embroidery pattern.

1. Select the pattern(s).
2. Display the [Import] pane, and select [Decorative Pattern] from the [From] selector.
3. Select a category from the [Category] selector, select the desired decorative pattern from the list, and then click [Decorative Import].

Maintain aspect ratio

When the check box is selected
The original height-to-width proportion of the added decorative pattern is maintained.

When the check box is cleared
The height-to-width proportion of the decorative pattern changes with the height-to-width proportion of the selected embroidery pattern.
Grouping/Ungrouping embroidery patterns

Grouping patterns
1 Select several patterns, and then click the [Home] tab.
2 Click [Group] in the [Edit] group, and then click [Group].

Ungrouping patterns
1 Select grouped patterns, and then click the [Home] tab.
2 Click [Group] in the [Edit] group, and then click [UnGroup].

Editing grouped patterns individually
Even after patterns are grouped, they can be edited individually.
1 To select a single pattern within a group, hold down the <Alt> key while clicking the pattern.
2 Edit the pattern.

Hole sewing
By specifying hole sewing, the stitching in overlapping regions will not be sewn twice. Hole sewing can be set only when one region completely encloses another.

Embroidery patterns created with the Shapes tools can be selected to set hole sewing.

Hole sewing not set
Hole sewing set

1 Sewn twice
2 Sewn once
1 Select a pair of patterns, for example, a star included in a pentagon. While holding down the <Ctrl> key, click the star, then the pentagon.

![Image](image1.png)

1 Valid

2 Invalid

Hole sewing cannot be specified with the following shape patterns.
- Patterns with an intersecting outline.
- Patterns with multiple sewing direction lines.

2 Click the [Home] tab.

3 Click [Modify Overlap] in the [Edit] group, and then click [Set hole sewing].

**Canceling hole sewing**

1 Select a pattern that has been set for hole sewing.

2 Click the [Home] tab.

3 Click [Modify Overlap] in the [Edit] group, and then click [Cancel hole sewing].

**Changing shapes of overlapped patterns**

Embroidery patterns created with the Shapes tools can be selected to remove overlapping regions or to be merged.

**Removing overlapping**

Overlapped patterns can be set so that the overlapping region is removed.

1 While holding down the <Ctrl> key, click two or more overlapped patterns to select them.

2 Click the [Home] tab.

To see better what the hole sewing setting does, preview the patterns before and after setting hole sewing.

▶ "Stitch View" on page 87
Click [Modify Overlap] in the [Edit] group, and then click [Remove Overlap].

- When partially overlapped

- When enclosed

Merging

Overlapped pattern can be merged together.

1. While holding down the <Ctrl> key, click two or more overlapped patterns to select them.
2. Click the [Home] tab.
3. Click [Modify Overlap] in the [Edit] group, and then click [Merge].

→ If this cannot be applied to the selected patterns, an error message appears.

- When partially overlapped

After removing or merging an overlapping region of patterns with sewing directions specified, the sewing direction returns to the uniform default direction.

"Specifying the straight sewing direction" on page 58
Splitting Shape pattern

1. Select a shape pattern, and then click the [Shapes] tab.
   - "Shape pattern" on page 10


   → If the design contains overlapping patterns, the selected pattern will appear in front of the others. All patterns other than the selected pattern will appear in gray.

3. Click in the Design Page at the point where you want to start drawing the enclosing lines.

4. Continue clicking in the Design Page to specify each corner of the enclosure around the area to be cut off.

5. Double-click in the Design Page to specify the section to be split off.

   • Only closed patterns with no intersecting lines can be split. The pattern shown below cannot be split.
   - The inside pattern with hole sewing applied cannot be split.
   - If the enclosing line that was drawn intersects itself, the section cannot be split off, and a message appears.
   - After splitting a pattern with fit text to outline applied, fit text to outline will be canceled.
   - If the entered patterns are not in the desired sewing order, change it in the [Sewing Order] pane.
   - "Sewing order optimization" on page 93, and "Changing colors" on page 95
   - "Checking and Editing the Sewing Order" on page 91

Creating a floral pattern

Line stitching in a floral pattern can be created based on the selected shape.

1. Draw a shape, and then select it.

   Be sure to select a closed line.
   - "Changing the attributes of line ends" on page 73

2. Click the [Shapes] tab.
3 Click [Create Floral Pattern] in the [Edit] group.

2 Click the desired pattern, and then click [OK].

---

**Basic mode**

1 Drag the [Density] slider to adjust the pattern.

---

**Detailed mode**

More detailed settings can be specified in Detail mode.

1 Click [To detailed mode] in the [Floral Pattern] dialog box.

2 Drag the [Density] slider and the [Pattern] slider to adjust the pattern.

- Density 3, Pattern 251
- Density 10, Pattern 251
- Density 6, Pattern 251
- Density 6, Pattern 0
3 After the pattern has been adjusted as desired, click [OK].

4 Specify the desired settings for the offset line pattern, and then click [OK].

The running stitch is specified for the floral line pattern.

Creating an offset line pattern

Line stitching in a concentric pattern can be created based on the selected shape.

1 Draw a shape, and then select it.

2 Click the [Shapes] tab.

- Be sure to select one closed line.
- "Changing the attributes of line ends" on page 73
**Converting region stitching to line stitching**

The stitching in regions can be converted to line stitching.

1. Draw a shape, and then select it.


   → The region sew types change to [Running Stitch].

3. Select the desired line sew type.
   For this example, select [Chain Stitch].

---

**Offset Direction**

- **Outward**
- **Inward**

**Spacing**

- 1 mm
- 5 mm

**Offset Line Count**

- 1 line
- 5 lines

**Rounded Corners**

- Check box selected.
- Check box cleared.
Specifying Thread Colors and Sew Types for Lines and Regions

Setting the thread color

The [Sew] group in the [Shapes] tab allows you to set the thread color of shapes.

1. Line color
2. Region color

Color

Click the [Color] button, and then select the desired color from the list of thread colors.

1. Thread brand name or name of user thread chart and its thread color list: Displays the brand name and its thread color chart for the currently selected pattern.

2. Colors Used
Displays all thread colors being used in the embroidery design.

3. Show Color Palette
Click to display the [Color] pane.

Color pane

Palette mode

List mode
Select the type of stitching ([Line] or [Region]) to display the corresponding colors being used.

**Line**
- Line color

**Region**
- Region color

Select the check box to apply gradation/blending. Click the [Pattern] button to specify a gradation/blending pattern. (Only available when a shape pattern is selected)

*Creating a gradation/blending* on page 54

From the [Thread Chart] selector, select a thread brand or your user thread chart.

From the list of thread colors, select the desired color.

Click to switch the mode.

Displays all thread colors being used in the embroidery design. When an embroidery pattern is selected, a frame appears around the colors used in that pattern. The same thread colors can be specified by selecting them here.

### Creating a gradation/blending

The density of one or two colors can be adjusted at various locations to create a custom gradation pattern.

1. Select an embroidery pattern with region sewing specified.
2. Click the [Color] tab, select the [Gradation] check box, and then click [Pattern].
3. Specify the desired settings in the [Gradation Pattern Setting] dialog box, and then click [OK].

   ![Gradation Pattern Setting](image)

   1. To change the thread color, click . Select a color in the [Thread Color] dialog box that appeared, and then click [OK].
   2. To select a preset gradation pattern, click the desired pattern under [Select pattern].
   3. Move the sliders to adjust the density of the gradation pattern. The overall density of the gradation can be adjusted with the [Max] and [Min] sliders. Drag the [Max] slider to adjust the maximum value and the [Min] slider for the minimum value. The values between the maximum and minimum are automatically adjusted.
   4. To blend two colors, select the [Blend] check box, and then click . Select a color in the [Thread Color] dialog box that appeared, and then click [OK].
   5. The preview area shows the setting changes that you make.
   6. Specify the density.
   7. Specify a direction, or drag the red arrow to adjust it.
Specifying Thread Colors and Sew Types for Lines and Regions

- Gradation/blending can be specified if satin stitches, fill stitches or programmable fill stitches have been selected for the region sewing and [Manual straight line] has been selected as the sewing direction.
- If the [Blend] check box is cleared, the gradation settings are applied to the remaining color.
- Gradation/blending can also be specified under [Density] when the [Sewing Attributes] pane is displayed in Expert mode.

Colors for creating appliqués:
- You can create appliqués using the following three special colors.
  - **APPLIQUE MATERIAL** marks the outline of the region to cut from the appliqué material.
  - **APPLIQUE POSITION** marks the position on the backing material where the appliqué must be sewn.
  - **APPLIQUE** sews the appliqué on the backing material.

By using the Applique Wizard, appliqués can easily be created.

» "Tutorial 9-1: Creating Appliqués" on page 178
Specifying Thread Colors and Sew Types for Lines and Regions

**Setting the sew type**

The [Sew] group in the [Shapes] tab allows you to set the sew type.

The sew type for lines in shapes and text can be selected in the [Line sew type] selector. Click the [Line sew type] selector, and then select the desired sew type.

1. **Not Sewn (Line)**
   Select this setting to turn off line sewing (line will not be sewn).

2. **Cutting**
   Select this setting to specify the line as a cutting line in a cutwork pattern.

   "Practical use of Satin Stitch and Cutting Line" on page 185

The sew type for regions in shapes, and text can be selected in the [Region sew type] selector.

Click the [Region sew type] selector, and then select the desired sew type.

- The available region sew types differ depending on whether a shape pattern or text pattern is selected.

1. **Not Sewn (Region)**
   Select this setting to turn off region sewing (region will not be sewn).

   "Specifying sewing attributes" on page 63
   "Specifying sewing attributes" on page 364

**Line sew types**

1. **Zigzag Stitch** on page 358
2. **Running Stitch** on page 358
3. **Triple Stitch** on page 358
4. **Motif Stitch** on page 359
5. **Stem Stitch** on page 360
6. **Candlewicking Stitch** on page 360
7. **E/V Stitch** on page 361
8. **Chain Stitch** on page 362
9. **Cutting** on page 362

**Region sew types**

1. "Satin Stitch" on page 364
2. "Fill Stitch" on page 366
3. "Programmable Fill Stitch (Prog. Fill Stitch)" on page 367
4. "Piping Stitch" on page 370
5. "Motif Stitch" on page 371
6. "Cross Stitch" on page 372
7. "Concentric Circle Stitch, Radial Stitch and Spiral Stitch" on page 372
8. "Flexible Spiral Stitch" on page 372
9. "Stippling Stitch" on page 373
10. "Net Fill Stitch" on page 373
11. "Zigzag Net Fill Stitch" on page 374
12. "Decorative Fill Stitch" on page 375
Moving entry/exit points, the center point and stitch pattern reference point

■ Moving the entry/exit points

1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click ![Select Entry/Exit Point tool] to select the Select Entry/Exit Point tool.
3. Click the object.
4. Drag the arrow for the point to the desired location on the outline.

A dotted line appears between the entry (or exit) point being moved and the cross indicating the exit (or entry) point of the previous (or next) pattern.

The codes that appear indicate the following.

- L: Line sewing
- R: Region sewing

1: Entry point
2: Exit point

This is the entry (or exit) point for the next (or previous) pattern that is connected to the exit (or entry) point of the currently selected pattern. This point is connected to the entry/exit point with the same code in the currently selected pattern. In this example, R1 in the currently selected pattern and R1 in the previous pattern are connected.

- Drag the arrow for the point to the desired location on the outline.

In this case, finish the operation by clicking a blank area in the [Sewing Order] pane.

- If the outline or the inside region are set to not be sewn, the corresponding point does not appear.
- The entry and exit points can be checked in the [Sewing Order] pane. Select the Select Entry/Exit Point tool, and then click a frame in the [Sewing Order] pane. The entry and exit points of the selected pattern appear.

• In this case, finish the operation by clicking a blank area in the [Sewing Order] pane.
Moving the center point and stitch pattern reference point

The center point and reference point for arranging the stitch pattern can be repositioned for a more decorative effect.

- Regions with the concentric circle stitch, radial stitch or flexible spiral stitch specified have a center point.
- Regions with the prog. fill stitch, motif stitch, cross stitch, net fill stitch, zigzag net fill stitch or decorative fill stitch specified have a stitch pattern reference point.

1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click .
3. Click a region with the concentric circle stitch, radial stitch, prog. fill stitch, motif stitch, cross stitch, net fill stitch or zigzag net fill stitch specified.

Specify the straight sewing direction

When the Outline tools, Rectangle/Circle/Arc tools or Shapes tools are used, shapes with a single sewing direction will be created. When the Manual Punch tools are used, shapes with multiple sewing directions are created.

The sewing direction is indicated by a sewing direction line (red arrow). These lines can be edited by moving the end points, or new sewing direction lines can be added.

These settings can be adjusted for regions with the satin stitch, fill stitch, prog. fill stitch, piping stitch or motif stitch specified.

This feature can be used when [Direction] in the [Sewing Attributes] pane is set to [Manual straight line] (default setting).
Specifying multiple sewing directions

1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click \( \) to select the Select Point tool.
3. Click a shape pattern.
   \( \rightarrow \) The sewing direction lines appear.
4. Click the [Shapes] tab.
5. Click [Add Direction Line] in the [Sewing Direction Line] group.
6. Click the point for one end of the sewing direction line being added, and then click the point for the other end.

```
\[Image\]
```

- Specify the sewing direction lines as described below.
  - Position both end points outside of the pattern.
  - Only the lines can be positioned over the pattern.
  - When specifying multiple sewing direction lines, they must not intersect within the pattern.
- Sewing direction lines specified in any way other than described above will not be added.

If hole sewing has been applied, sewing direction lines cannot be added.

Changing the sewing angle

1. Select the Select Point tool.
2. Click a shape pattern, and then click an empty square or empty triangle on the sewing direction line to select the point.
3. Drag the point to the new location.

```
\[Image\]
```

The sewing angle can also be set to a specific direction (one sewing direction line) with the settings under [Direction] in the [Sewing Attributes] pane.

"Specifying sewing attributes" on page 63
■ Reversing the sewing direction

1. Select the Select Point tool.
2. Click a shape pattern.
3. Click the [Shapes] tab.
4. Click [Reverse Direction Line] in the [Sewing Direction Line] group.

If there are multiple sewing direction lines, all lines will be reversed.

■ Deleting sewing direction lines

1. Select the Select Point tool.
2. Click a shape pattern, and then click an empty square or empty triangle on the sewing direction line to select the point.
3. Click the [Shapes] tab.
4. Click [Delete Direction Line] in the [Sewing Direction Line] group, and then click [Delete Selected Line] or [Delete Lines Not Selected].

Delete Selected Line
Click this command to delete the selected sewing direction line. Otherwise, press the <Delete> key to delete the sewing direction.

Delete Lines Not Selected
Click this command to delete all sewing direction lines except the currently selected one. The sewing direction will become uniform.
Sample patterns with sewing directions changed

When the sewing direction is changed, the pattern stitching changes as shown below.

- Default
- Fill Stitch
- Programmable Fill Stitch (Prog. Fill Stitch)
- Piping Stitch
- Motif Stitch

The sewing direction is also changed when the pattern size and shape are changed.

Specifying the curved sewing direction (round fill)

Specifying curved sewing direction line

- This feature can be used when [Direction] in the [Sewing Attributes] pane is set to [Manual curve].
- A curved sewing direction line can be specified if fill stitches, programmable fill stitches, piping stitches or motif stitches have been selected.

1. Click a shape pattern.
   In this example, the motif stitch is selected for the region sew type.

2. Click the [Sewing Attributes] tab, and then click [To Expert mode].
   "Specifying sewing attributes" on page 63
Specifying Thread Colors and Sew Types for Lines and Regions

3 In the [Region sew] section, select [Manual curve] under [Direction].

→ The sewing direction line becomes curved.

4 Click [Select] in the [Select] group, and then click .

5 Drag a selected point to adjust the curved line. To add a point, click on the curved line.

---

- Sample patterns with sewing directions changed

When the sewing direction is changed, the pattern stitching changes as shown below.

- To remove a point at either end or along the path, select [Delete Point].
- A point at either end of the line or on the outline of the shape pattern cannot be deleted.
- Only one curved sewing direction line can be specified.
- Complex curved sewing direction lines that twist cannot be specified.
Specifying sewing attributes

1. Select an embroidery pattern, a Shapes tool or a Text tool.
2. Click the [Sewing Attributes] tab.

### Beginner mode

1. Click to return to the default setting.
2. Click to switch the attributes between those for Beginner mode and those for Expert mode.
3. Click to load/save the sewing settings.
4. Click to switch between displaying and hiding the hint view.

### Expert mode

1. Click to return to the default setting.

**Hint view**

With each change in the settings, a preview of the stitching can be checked here. By moving the pointer over each setting, a preview of the setting can be displayed.

The sewing attributes displayed in the dialog box depend on the selected sew type.

### Copying sewing attributes

3. Change the sewing attributes displayed under [Line sew] or [Region sew].

   → The settings are applied to the embroidery pattern each time the settings are changed.

   ▶️ For details on the different sewing attributes and settings, refer to "Line sewing attributes" on page 358 and "Region sewing attributes" on page 364.

**Frequently used sewing attributes can be saved.**

▶️ For details, refer to "Saving the settings in a list" on page 212

### Copying sewing attributes

The thread colors, sew types and sewing attributes can be copied from one pattern and pasted onto another to apply the same settings to the pattern.

1. Select the shape pattern or text pattern whose settings are to be copied, and then press the shortcut keys <Ctrl> + <C> to copy.
2. Select the shape pattern or text pattern where the settings are to be pasted, and then click the [Home] tab.

   ▶️ "Shape pattern" on page 10

3. Click [Paste] in the [Clipboard] group, and then click [Paste Attributes].
**Specifying Thread Colors and Sew Types for Lines and Regions**

### Basic Layout & Editing Operations

- **Copying only specific attributes**
  
  Specific attributes, such as the line thread color, can be copied and pasted onto another pattern.

1. Select the shape pattern or text pattern whose settings are to be copied, and then press the shortcut keys `<Ctrl>` + `<C>` to copy.

2. Select the shape pattern or text pattern where the settings are to be pasted, and then click the [Home] tab.

3. Click [Paste] in the [Clipboard] group, and then click [Paste Selected Attributes].

- **When copying attributes from a shape, text, monogram or small text pattern and pasting them to a pattern of a different type, only the colors will be pasted. The sew types and sewing attributes cannot be pasted.**

- **When copying a text pattern with different sewing attributes applied to each character, the sewing attributes of the first character will be copied.**

- **This function cannot be used with stitch patterns.**
4 Select the check boxes of the attributes to be pasted, and then click [Paste].

### Embossing/Engraving

Multiple shape patterns can be selected to create an engraved/embossed effect.

1. Draw a shape.

   In this example, the fill stitch is selected for region sewing.

2. Draw a shape overlapping the shape drawn in step 1.

3. Select the two shapes, and then click the [Home] tab.
Specifying Thread Colors and Sew Types for Lines and Regions

4 Click [Stamp/Emboss] in the [Edit] group, and then click the desired command under [Convert from Outline].

Example: When the [Engraved Line] command is selected

- **Engraved Line**
  The bottom shape is engraved with the outline of the shape on top.

- **Engraved Region**
  An engraving is made in the bottom shape from the shape on top. For best result, select [Satin Stitch] for region sewing of the bottom shape.

- **Embossed Region**
  An embossing is made in the bottom shape from the shape on top. For best result, select [Fill Stitch] for region sewing of the bottom shape.

This effect can be edited with the Edit Stamp tool.

⚠️ These commands can only be used with shape pattern.
- The bottom shape pattern must have one of the following sew types specified for region sewing.
  - Satin Stitch
  - Fill Stitch
  - Programmable Fill Stitch (Prog. Fill Stitch)
- In order to use the [Engraved Line] command, [Line sew type] for the shape pattern must be set to any setting other than [Not Sewn (Line)].
- In order to use the [Engraved Region] or [Embossed Region] commands, [Region sew type] for the shape pattern must be set to any setting other than [Not Sewn (Region)].

Applying and editing stamps

You can create engraved/embossed effects by stamping stamp patterns into a shape. This appears as stitching sewn in different directions.

### Applying a stamp

1. Draw a shape.

2. Click the [Home] tab.

This effect can be edited with the Edit Stamp tool.
Specifying Thread Colors and Sew Types for Lines and Regions

3 Click [Stamp/Emboss] in the [Edit] group, and then click [Input Stamp Tool].

4 Select a stamp pattern (.pas file with stamp settings applied).

   1 Select a stamp pattern.
   2 Specify the size of the stamp pattern.
   3 Specify the direction of the stamp pattern.
   4 To select a different folder, click .

   Engraving and embossing stamp settings appear as red- and blue-filled areas.

5 Click the shape pattern drawn in step 1 to select it.
   → “Marching lines” appear around the selected shape pattern.

6 Click the desired locations within the shape pattern.
   You can preview the effect of the created stamp in Realistic View.

- Stamps can be applied to regions of shape pattern that have the satin stitch, fill stitch and programmable fill stitch specified.
- Using Programmable Stitch Creator, you can edit stamp pattern that have been provided or you can create your own.

   “Programmable Stitch Creator” on page 287

### Editing a stamp

1 Click the [Home] tab.

2 Click [Stamp/Emboss] in the [Edit] group, and then click [Edit Stamp Tool].

3 Click the shape pattern with the stamp.
   → “Marching lines” appear around the selected shape pattern.

4 Click the stamp.

   1 Rotation handle
   2 Scale handles

- Only one stamp can be selected at a time.
- To enlarge the stamp, drag a scale handle.
- To rotate the stamp, drag the rotation handle.
- To delete the stamp, press the <Delete> key.
5 **Edit the stamp.**

- To change the stamp pattern, select a different pattern, and then click **[Apply]**.

- If the size of a shape pattern is changed, the size of the stamp does not change. Be sure to check the stamp after editing a shape pattern.
- If a shape pattern containing a stamp is edited, be sure to check the stamp after editing is finished.
Drawing Shapes

Drawing rectangle, circle or arc shape

1. Rectangle
2. Rectangle with rounded corners
3. Circle
4. Oval
5. Arc
6. Fan shape
7. Arc & string

1. Click the [Home] tab.
2. Click [Shapes] in the [Tools] group, and then click a tool icon under [Rectangle]/[Circle]/[Arc] to select the desired [Rectangle]/[Circle]/[Arc] tool.

To draw a circle or square, hold down the <Shift> key while dragging the pointer.
Rectangles with rounded corners
To change the radius of the corners, click the [Edge radius] selector in the [Outline] tab. Then, type the desired radius, or select the desired value.
Specify the radius of the corners before drawing the rectangle. The setting cannot be changed after the rectangle has been drawn.

Example 1
Edge radius: 0.0 mm

Example 2
Edge radius: 20.0 mm

Arc & String

1. Proceed as you would to draw a circle or an oval.

→ A radial line appears on the oval when the mouse button is released.

2. Move the pointer to the start point of the arc, and then click.
→ The radial line disappears.

3. Move the pointer until the arc/arc & string/fan has the desired shape, and then click.

Dragging the pointer while holding down the <Shift> key moves it in 15° increments. The current angle is shown in the status bar.

Arc & String

1. Click at start point.
2. Move to end point.
3. Click at end point.
Drawing Shapes

Arc

1. Click at start point.
2. Move to end point.
3. Click at end point.

Fan

1. Click at start point.
2. Move to end point.
3. Click at end point.

- You can change the color and sew type either before or after drawing the shape.
  >>> “Setting the sew type” on page 56
- You can also use the settings in the [Sewing Attributes] pane to define other attributes of the shape before or after drawing the shape.
  >>> “Specifying sewing attributes” on page 63

Drawing various shape

1. Click the [Home] tab.
2. Click [Shapes] in the [Tools] group, and then click a tool icon under [Shapes] to select the desired Shapes tool.
3. Drag the pointer in the Design Page.

- To draw the shape while maintaining the original height-to-width proportion, hold down the <Shift> key while dragging the pointer.
- Various sample shape patterns are available in the [Import] pane when [Outline Shapes] is selected in the [From] selector and [Basic Shapes] is selected in the [Category] selector.
  >>> “Using the Import pane” on page 15
Drawing outlines (straight lines and curves)

1. Start point
2. End point
3. Open line
4. Closed line
5. Open curve
6. Closed curve

1. Click the [Home] tab.
2. Click [Shapes] in the [Tools] group, and then click a tool icon under [Outline] to select the desired Outline tool.

3. Click in the Design Page or drag the pointer to draw the line.

The shortcut keys are available only after an Outline tool has been selected.

### Straight lines/curves

1. Click in the Design Page to specify the start point.

2. Click in the Design Page to specify the next point.

→ The dotted lines change to solid lines.

- To remove the last point that was entered, right-click the mouse button, or press the <BackSpace> key.
- The Curve tool is used in the same way.

3. Continue clicking to specify every point, and then double-click the last point, or press the <Enter> key.
**Freehand lines**

1. Drag the pointer to draw the line.
2. Release the mouse button to finish drawing.

---

**Changing the attributes of line ends**

After selecting a shape pattern, right-click it, and then click [Open] or [Close] to change the line ending.

In addition, closed shape patterns can be split at points to create open lines, or the end points of open shape patterns can be connected to create closed lines.

---

You can freely switch between the different line types either by clicking a different button or by pressing the shortcut key.

When drawing a straight line, hold down the `<Shift>` key while moving the pointer to draw vertically or horizontally.

Even after the pattern is drawn, you can change the attributes of line ends.

Even after the pattern is drawn, you can transform straight lines into curves and vice versa.

"Changing the attributes of line ends" on page 73.

"Transforming straight lines into curves or curves into straight lines" on page 79.
Embroidery attributes of shapes

The [Shapes] tab allows you to set the embroidery attributes (thread color and sew type).

Example: When a rectangle is selected.

1 Line color/Region color
   Click this button to set the thread color for lines and regions.

   For special colors:
   ➤ "Special colors" on page 55

2 Line sew type selector
   All lines in a shape can be set to the same sew type.
   Use these selectors to set the sew type for lines.

   ➤ "Line sewing attributes" on page 358

3 Region sew type selector
   All regions in a shape can be set to the same sew type.
   Use these selectors to set the sew type for regions.

   ➤ "Region sewing attributes" on page 364

   ➤ "Specifying Thread Colors and Sew Types for Lines and Regions" on page 53

- To turn off line sewing, select [Not Sewn (Line)] from the [Line sew type] selector.
- To turn off region sewing, select [Not Sewn (Region)] from the [Region sew type] selector.
Reshaping Embroidery Patterns

Patterns can be reshaped by moving, adding or deleting points. While creating shape patterns, a clicked location becomes a point.

**Selecting points**

1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click to select the [Select Point] tool.
3. Click the pattern.
4. To select a single point, click an empty square.

Multiple points can be selected in any of the following ways.
- Drag the pointer.
  - All points within the box are selected.
- Hold down the <Ctrl> key while clicking the points.
  - To deselect a point, click the selected point.
- Hold down the <Shift> key while pressing an arrow key to select multiple points.
- Hold down the <Ctrl> key while pressing an arrow key to change the point that is selected.

**Moving points**

1. Select the point.
2. Drag the point to the new location.

- To move the point of a broken line, a curve, or stitch data horizontally or vertically, hold down the <Shift> key while dragging it.
- A selected point can also be moved with the arrow keys.
- Points in patterns set for hole sewing can also be moved. However, the point cannot be moved to cross an outline. In order to move the point in this way, cancel hole sewing first.
- If you start dragging by clicking elsewhere on the outline of the pattern, a new point will be inserted or the selected point(s) will be deselected.
Inserting points
1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click the Select Point tool.
3. Click the pattern.
4. Click the outline to add a point.

Deleting points
1. Select the point.
2. Click the [Shapes] tab.
3. Click [Delete Point] in the [Edit Point] group. Otherwise, press the <Delete> key to remove the point.

Connecting points/splitting outlines (shape patterns)

Splitting outlines of open shape patterns
The outline of an open shape pattern can be split at a point.
1. Select a point in an open shape pattern.
2. Click the [Shapes] tab.
3. Click [Split at Point] in the [Edit Point] group to split the line.

Inserting points

Connecting points/splitting outlines (shape patterns)

Deleting points
Splitting outlines of closed shape patterns

The closed path of a shape pattern can be split. The closed path consists of the points that are connected to create the shape pattern.

1. Select a point in a closed shape pattern.

2. Click the [Shapes] tab.

3. Click [Split at Point] in the [Edit Point] group to split the line.

- If a shape pattern is split in a shape with hole sewing applied, hole sewing will be canceled.
- If a shape pattern is split in a shape with fit text to outline applied, fit text to outline will be canceled.

- When the outline of a closed shape pattern is split to create an open shape pattern, region sewing attributes can no longer be specified.

- The [Open] command is also available to change a closed shape pattern to an open shape pattern.

"Changing the attributes of line ends" on page 73
Connecting two open shape patterns
The end points of two shape patterns can be connected to create a single shape pattern.

1. Select an end point (entry point or exit point).
2. Press the <Alt> key.
   - The points that can be connected appear as ×.
3. While holding down the <Alt> key, drag the selected point to the other point that you want to connect to it.
   - The shape of the pointer changes to , and a red square appears when the two points are overlapping.
4. Release the mouse button to connect the two points.

Connecting the two end points of a shape pattern
The two end points of an open shape pattern can be connected to create a closed shape pattern.

1. Select an end point (entry point or exit point).
2. Press the <Alt> key.
   - The other end point appears as ×.
3. While holding down the <Alt> key, drag the selected point to the other end point.
4. When the two points are overlapping and the red square appears, release the mouse button.

When a shape pattern is closed, its region sewing attributes may appear.

The [Close] command is also available to change an open shape pattern to a closed shape pattern.

"Changing the attributes of line ends" on page 73
**Transforming straight lines into curves or curves into straight lines**

1. Select the point.
2. Click the [Shapes] tab.
3. Click [Edit Point] in the [Edit Point] group, and then click [To Straight] or [To Curve].

**Changing the curve type**

1. Select a point on a curve.
2. Click the [Shapes] tab.
3. Click [Edit Point] in the [Edit Point] group, and then click [To Smooth], [To Symmetry] or [To Cusp].

4. Drag the solid black handle to adjust the shape of the line.

The shape can be changed by dragging the solid black handle on either side of the point.
Editing a Stitch Pattern

Converting shape pattern or text pattern to a stitch pattern

Shape pattern or text pattern can be converted into a stitch pattern, allowing you to make detailed changes by modifying the position of individual stitches.

1. Select the shape pattern, and then click the [Shapes] tab.
2. Click [Convert to Stitches] in the [Edit] group.

- [Convert to Stitches] can also be used with text pattern to convert it to stitch patterns.
- In stitch patterns, stitches appears as solid lines (---), and jump stitches appear as dotted lines (----).
- If any part of grouped patterns, patterns set for hole sewing, and text arranged on shapes is selected, all patterns in the entire group are converted to stitch patterns.
- Patterns that do not have stitches are deleted when the pattern is converted to a stitch pattern.

Selecting stitch patterns by thread color

Hold down the <Alt> key and click the thread color for the stitch patterns that you wish to select.

- The thread color can be changed when patterns are selected using this method.
  
  "Setting the thread color" on page 53

  - If stitch patterns are grouped, patterns cannot be selected by color using this method.
Selecting stitch points of stitch pattern

1. Click the [Home] tab.
2. Click [Select] in the [Select] group, and then click \( \text{Select Point tool} \) to select the Select Point tool.
3. Click the stitch pattern.
4. To select a single stitch point, click an empty square.

- **Moving stitch points**
  Drag the selected stitch points to the new location.

- **Inserting stitch points**
  Click a line between two stitch points to add a new point at that position.

- **Deleting stitch points**
  Press the <Delete> key to delete the selected stitch point.

- When selecting stitch points, be sure to click the stitch point (do not click a blank area of the Design Page), otherwise all of the selected points will be deselected.
- If you click on a jump stitch, the points at both ends are selected.
- Multiple stitch points can be selected in the same way that embroidery pattern points are selected.

"Selecting points" on page 75

Stitch points cannot be edited if the pattern is not a stitch pattern. The pattern can be viewed in Solid View.

"Moving points" on page 75

"Inserting points" on page 75

"Deleting points" on page 75
A single color pattern can be divided into two by splitting stitches at a point, and two color patterns can be combined into one by connecting points. If a stitch pattern is divided into multiple parts, each part can be edited separately, such as changed to different colors.

Splitting one stitch pattern into two at the selected point

1. Select a point in a stitch pattern.
2. Click the [Stitches] tab.
3. Click [Split at Point] in the [Edit] group to split the stitch pattern.

→ The stitch pattern is split at the point.

Connecting two stitch patterns to create a single one

1. Select an end point (entry point or exit point) of a stitch pattern.

Select the entry point of the stitch pattern by pressing keys <Ctrl> + <Home>. Select the exit point by pressing keys <Ctrl> + <End>. For details, refer to "Selecting stitch points of stitch pattern" on page 81.

2. Press the <Alt> key.
   → The points that can be connected appear as ×.

If the entry point of a stitch pattern is selected, the exit points of the other stitch patterns appear as ×. If the exit point of a stitch pattern is selected, the entry points of the other stitch patterns appear as ×.
3 While holding down the <Alt> key, drag the selected point to the other point that you want to connect to it.
   → The shape of the pointer changes to , and a red square appears when the two points are overlapping.

4 Release the mouse button to connect the two points.

After the points are connected, the pattern will have the thread color of the pattern that was first in the sewing order before the points were connected.

Splitting off parts of a stitch pattern

1 Select a stitch pattern, and then click the [Stitches] tab.

2 Click [Split Stitches] in the [Tools] group to select the [Split Stitches] tool.
   → All other patterns will appear in gray. Selected pattern will appear in front of other patterns.

3 Click in the Design Page at the point where you want to start drawing the enclosing lines.

4 Continue clicking in the Design Page to specify each corner of the enclosure around the area to be cut off.

5 Double-click in the Design Page to specify the section to be split off.
   The cutoff piece moves to the end of the sewing order.
   ➤ “Checking and Editing the Sewing Order” on page 91
Editing a Stitch Pattern

Basic Layout & Editing Operations

1. Select the stitch pattern(s), and then click the [Stitches] tab.
2. Click [Divide by Color] in the [Edit] group.

→ Dotted lines appear around each part of the stitch pattern.

Converting stitch patterns

Stitch patterns can be converted into two types of shape patterns. After being converted, various editing operations can be performed.

1. Select the stitch pattern(s), and then click the [Stitches] tab.
2. Click [Convert to Blocks] in the [Edit] group.

Convert to Blocks
The pattern is converted while maintaining the multiple sewing direction lines.
Use this when you want to enlarge or reduce an embroidery pattern that uses satin or fill stitches.

Convert to Outline
The pattern is converted following the shape of the outline.

- After being converted, the outline patterns can be edited.
  - “Setting the sew type” on page 56
  - “Specifying the straight sewing direction” on page 58
  - “Specifying sewing attributes” on page 63
  - “Reshaping Embroidery Patterns” on page 75

- For details on the shape pattern and stitch pattern refer to “Comparison of Types of Data Created With Palette Ver.11” on page 10.

Converting stitch pattern to blocks

Stitch patterns can be converted into blocks (group of shape patterns with multiple sewing direction lines). In blocks (shapes) pattern, the sew types and sewing attributes can be changed, and the pattern can easily be edited.

1. Select the stitch pattern(s), and then click the [Stitches] tab.
2. Click [Convert to Blocks] in the [Edit] group.

- Stitch patterns
- Blocks: A group of shape patterns with multiple sewing direction lines
- Shape patterns
- Convert to Blocks
- Convert to Outline

Dividing stitch pattern by color

1. Before dividing
2. After dividing

- Stitch patterns
- Blocks: A group of shape patterns with multiple sewing direction lines
- Shape patterns
- Convert to Blocks
- Convert to Outline
Move the slider to select the desired sensitivity. Click [OK].

The [Normal] setting should provide satisfactory results in most cases, but depending on the complexity of the pattern, you may need to select a setting more towards [Coarse] or [Fine].

The stitch pattern is converted to grouped shape patterns. Being converted to shape patterns, the outlines of the stitch pattern can be edited.

For details see the following instructions:
“Setting the sew type” on page 56
“Specifying sewing attributes” on page 63
“Reshaping Embroidery Patterns” on page 75
“Specifying the straight sewing direction” on page 58

The [Convert to Blocks] command cannot be used with some stitch pattern imported from original cards.

Converting stitch pattern to outline pattern

Outline patterns can be created from each color in a stitch pattern or from an outline around the entire pattern.

1. Select the stitch pattern(s).
2. Click the [Stitches] tab.
3. Click [Convert to Outline] in the [Edit] group, and then click [Convert Whole to Outline] or [Convert Parts to Outlines].

The outline patterns are created, and the original stitch patterns are deleted.

- Line sewing in the created outline patterns is set to [Not Sewn (Line)], and region sewing is set to [Fill Stitch].
- If the [Convert Whole to Outline] command is selected, the thread color will be set to the first thread color in the sewing order for the original stitch pattern.
- If multiple outline patterns are created from a single stitch pattern, the outline patterns are grouped.
- If there is an opening (area with no stitching, but surrounded by stitching) in the original stitch pattern, hole sewing may be applied.

- Convert Whole to Outline
- Convert Parts to Outlines
Checking Embroidery Patterns

Zooming

1. Click the [Home] tab.

2. Click [ ] or [ ] in the [Tools] group.

: Click the Design Page to zoom in. (Right-click the Design Page to zoom out.)

: Click the Design Page to zoom out. (Right-click the Design Page to zoom in.)

Otherwise, click beside , and then click [Zoom All], [Selected object zoom] or [Actual size zoom].

Zoom All
The entire Design Page is displayed to fit within the window. The same operation can be performed by clicking in the [Tools] group.

Selected object zoom
The Design Page is zoomed to display only the selected objects.

Actual size zoom
The Design Page is displayed at its actual size.

Using the Pan tool

The part of the work area that is displayed can easily be changed by using the Pan tool.

1. Click the [Home] tab.

2. Click [ ] in the [Tools] group.

3. Drag the work area to view the desired part.

You can also pan the work area when any other tool is selected by holding down the <Space> key while dragging the pointer.

To scroll horizontally, hold down the <Alt> key while rotating the mouse wheel.

• Zooming is also possible by dragging the [Zoom] slider in the status bar or clicking the Zoom ratio.

• You can also zoom in or out when any other tool is selected by holding down the <Ctrl> key while rotating the mouse wheel.

"Layout & Editing Window" on page 13
Using the Measure tool

1. Click the [Home] tab.
2. Click \( \text{in the [Tools] group.} \)
3. Click the two points, one on each end of the distance that you want to measure.
   \( \rightarrow \) The length appears in the status bar.

Changing the display of the embroidery design

1. Click the [View] tab.
2. Click [Solid], [Stitch] or [Realistic] in the [View Mode] group.

   ■ Solid View

   ■ Stitch View

When the rulers are displayed, click \( \text{mm} / \text{in.} \) to switch the measurement units between millimeters and inches.

You can display a stitch view of it in order to see how the stitching is connected.
If is selected under [Machine Type] in the [Design Settings] dialog box, click the [View] tab, and then select the [View Thread Trimming] check box to view the thread trimming locations in the Design Page.

### Realistic View

You can display a realistic view of it in order to see how the design will appear once it is sewn.

### Changing realistic view settings

1. Click the [View] tab.
2. Click [Realistic View Settings] in the [View Mode] group.
3. If necessary, specify settings for [Thread Width], [Contrast] and [Brightness], and then click [Apply] ([OK]).
Checking the stitching with the Stitch Simulator

1. Click the buttons to view a simulation of the stitching.

   a. Starts the stitching simulation. During stitching simulation, this button changes to 🎬, which can be clicked to temporarily stop the simulation.

   b. Stops the simulation and returns to the previous display.

   c. The slider shows the current location in the simulation. In addition, the slider can be moved to change the position in the simulation.

      📈: Returns to the beginning of stitching and stops the simulation.

      🎁: Advances to the end of stitching and stops the simulation.

   d. Drag the slider to adjust the simulation stitching speed.

   e. Select this check box to automatically scroll the simulation of the pattern when it is too large to be fully displayed.

   f. Click to hide the bottom section of the Stitch Simulator. Click 🕹️ to display it again.

   g. Shows the number of the current stitch/total number of stitches.

      🎭: Reverses the simulation by the indicated number of stitches.

      🎇: Advances the simulation by the indicated number of stitches.

   h. Shows the number of color being drawn/total number of colors used.

      🎏: Returns to the beginning of stitching for the current or previous thread color.

      🎁: Advances to the beginning of stitching for the next color.

   i. Shows the currently displayed pattern section/total number of hoop sections in the pattern.

      (Appears only for split embroidery patterns.)

      🎭: Returns to the beginning of stitching in the current or previous hoop section.

      🎁: Advances to the beginning of the design in the next hoop section.

   2. If the Stitch Simulator is not displayed at the bottom of the window, click [Stitch Simulator] on the [View] tab.

   3. The zoom tools and pan tool can be used while a simulation is being viewed. If any other command is selected, the simulation stops.

   4. If a value is entered at 7, 8 or 9, the simulation is reversed/advanced to the indicated location.

   5. If a pattern was selected when the stitching simulation was started, only the selected pattern is drawn in the simulation.

   6. The [Auto Scroll] check box is not available in Realistic View.
Viewing design in the Reference Window

1. Click the [View] tab.

2. Select the [Reference Window] check box in the [Show/Hide] group.

The display are a frame (red rectangle) indicates the part of the pattern displayed in the Design Page.

Zooming

The Reference Window can be switched to display either the entire Design Page or only the embroidery pattern.

1. ON
2. OFF
Moving/Resizing/Redrawing the display area frame

The part of the design displayed in the Design Page can be selected from the Reference Window.

Instead of moving the display area frame, the frame can be redrawn to display the desired part of the pattern in the Design Page.

Checking and Editing the Sewing Order

1. Select how patterns are displayed in the [Sewing Order] pane.
2. Select the desired command to change the sewing order.
3. Optimize Sewing Order
   Click to rearrange the sewing order so that the parts of the entered objects with the same thread color will be sewn together.
4. Thread Color
   Set the color of the selected object.
5. Show/hides in the work area the stitched objects.
6. Lock
   Click to lock the selected object so it cannot be edited.
7. Jump Stitch Trimming
   The Jump Stitch Trimming function can be turned on or off.
8. Select Patterns
   Selects the patterns in the Design Page.

1. Click the [View] tab.
2. Click [Sewing Order] in the [Show/Hide] group.
   Clicking the button switches between displaying and hiding the Sewing Order.

With the frame, you can select the area in the Reference Window to be displayed enlarged.
3 Click in the [Sewing Order] pane, and then click [Zoom] and [Show by color order].

**Zoom**
Click to enlarge each pattern to fill its frame.

**Show by color order**
Click to display in one frame all patterns of the same color that will be sewn together.

When multiple same color patterns are combined into one frame, + appears to the left of that frame. Click + to display the combined same color patterns in separate frames. - appears under the first frame, and each frame is displayed with a subnumber following the first, to indicate its sewing order within the patterns of the same color.

Click - to recombine all of the same color patterns back into one frame.
Sewing order optimization

The sewing order and entry and exit points can be automatically adjusted to reduce the number of thread color changes and jump stitches.

Click to optimize the sewing order. For the pattern at the right (the numbers indicate the sewing order), the sewing order will be adjusted as shown below.

1. The sewing order is adjusted so that patterns of the same color are grouped in the most optimized sequence.
2. In addition, patterns of the same color are optimized so that the exit point of the previous pattern and the entry point of the next pattern are the closest points.
3. However, overlapping patterns will be arranged in the most appropriate sewing order.
4. The patterns in locked frames and hidden frames will also be optimized.
5. The sewing order of multi-position patterns will not be optimized.

"Optimizing the sewing order (color sort)" on page 45
Checking Embroidery Patterns

Basic Layout & Editing Operations

**Editing the sewing order**

The sewing order can be changed by selecting the frame containing the pattern, then dragging the frame to the new location. A red line appears, indicating the position where the frame is being moved.

The frame can also be moved by clicking in the [Sewing Order] pane, then clicking the desired command in the menu that appeared.

**Selecting a pattern**

1. Click a frame containing the pattern in the [Sewing Order] pane.
2. Click in the [Sewing Order] pane to select the pattern in the Design Page corresponding to the frame selected in the [Sewing Order] pane. The pattern can also be selected by double-clicking its frame in the [Sewing Order] pane.

---

**Sew First**
Click to move the selected pattern to the beginning of the sewing order.

**Sew Previous**
Click to move the selected pattern ahead one position in the sewing order.

**Sew Next**
Click to move the selected pattern back one position in the sewing order.

**Sew Last**
Click to move the selected pattern to the end of the sewing order.

Check the stitching after changing the sewing order to be sure that overlapping patterns will not be sewn in the wrong order.
Changing colors

1. Select one or more frames in the [Sewing Order] pane, and then click at the top of the [Sewing Order] pane.
   → The Color pane appears in front of the other panes.

2. Click the desired color in the [Color] pane.

   "Color pane" on page 53

Changing sewing attributes

1. In the [Sewing Order] pane, select one or more frames containing a pattern other than a stitch pattern.
   → The sew type selector for the selected frame appears.

2. Click the [Sewing Attributes] tab.
   If the [Sewing Attributes] pane is not displayed, click the [View] tab, then [Attributes], and then click [Sewing Attributes].

3. Change the sewing attributes and sew type.

   "Line sew types", "Region sew types" on page 56 and "Specifying sewing attributes" on page 63

Displaying/hiding frames not sewn

Frames containing patterns that will not be sewn can be displayed or hidden.

Click , then [Hide Objects Not Stitched].

As a default, frames containing patterns that will not be sewn will be hidden.
When frames containing patterns that will not be sewn are displayed, that frame can be selected and its pattern can be edited.
### Hiding embroidery patterns

Each embroidery pattern can be displayed or hidden in the Design Page. Overlapping embroidery patterns can easily be edited if the pattern not being edited is hidden.

Select a frame, and then click [ ].

1. **ON**
2. **OFF**

![Diagram showing hidden and visible patterns](image)

- Frames with [ ] contain multiple patterns of the same color. If these frames are selected to be displayed, all patterns in the frame are displayed.
- [ ] appears if the display setting is not the same for all patterns in a frame with [ ] beside it.
- Displaying either the line or region of an embroidery pattern made up of an outline and inside region displays the entire embroidery pattern.

### Locking embroidery patterns

Embroidery patterns can be locked to prevent them from being moved or deleted. Locked embroidery patterns cannot be selected or edited in the Design Page.

Select a frame, and then click [ ].

![Diagram showing locked patterns](image)

- Frames with [ ] contain multiple patterns of the same color. If these frames are selected to be locked, all patterns in the frame are locked.
- [ ] appears if the lock setting is not the same for all patterns in a frame with [ ] beside it.
- Locking either the line or region of an embroidery pattern made up of an outline and inside region locks the entire embroidery pattern.
- Locking any part of a combined pattern, such as grouped patterns, text arranged on a curve or patterns with hole sewing specified, locks the entire embroidery pattern.
Jump Stitch Trimming

The Jump Stitch Trimming function can be turned on or off.

These settings are applied only when embroidering with our multi-needle embroidery machines. Before these settings can be specified, select ON or OFF under [Machine Type] in the [Design Settings] dialog box.

About Minimum jump stitch length for thread trimming
• The jump stitch length can be specified on the [Output] tab into the [Design Settings] dialog box. (To displayed it, click ON, then [Design Settings]).

• If the jump stitch length is less than the length specified for [Minimum jump stitch length for thread trimming], the thread will not be cut, even if [Jump Stitch Trimming] has been set.

• Whether or not [Minimum jump stitch length for thread trimming] is available differs depending on the selected machine model. For details, refer to the instruction manual for the machine.
The default setting can be specified for whether or not thread trimming is applied to objects that are created.

Click [Option] above the Ribbon, and then click [Options] to display the [Options] dialog box. Next, click [Jump Stitch Trimming], and then select or clear the [Add jump stitch trimming to the entered patterns.] check box.

Click , then [Design Property].

You can enter comments and information about the pattern to a saved .pes file.

- The information shown in the color list can be switched.

  * Color Changes

  The thread color information for each color change is displayed. This allows you to check the total number of thread color changes.

- Total Colors

  The thread color information for the necessary threads is displayed. This allows you to check the total number of thread colors.

  - The colors corresponding to the 61 basic Palette colors are listed under [Basic Color].
• You can select and check the properties of individual patterns within the embroidery design by selecting the pattern before opening this dialog box. In this case, clearing the [Show about selected Object(s)] check box switches the dialog box to display properties for all patterns in the Design Page.

• If the Design Page was set to [Custom Size] or [Hoop Size] was set to a multi-position hoop (100 × 172 mm or 130 × 300 mm) or the jumbo frame (360 × 360 mm), a [Design Property] dialog box appears with the sewing information for each hoop of the pattern in the Design Page.

• Files can be searched for in Design Database according to the entered information.
Opening/Importing Embroidery Designs

Creating a new embroidery design

Click , then [New].

The size of the Design Page can be changed.
➤ "Specifying the Design Page Settings" on page 16

Opening a Layout & Editing file

1 Click , then [Open].

2 Select the drive, the folder and the file, and then click [Open], or double-click the file’s icon.

To see a more detailed design, select a file, and then click [Preview].

• To view the data in the selected folder as thumbnails in the [Browse] dialog box, click [Browse].

To open the displayed file, click [Open].
• If no files are listed, there are no .pes files in the selected folder. Select a folder containing a .pes file.
• If the selected file is in a format other than the .pes format, the message "Unexpected file format" appears in the [Preview] window.
• A file can be opened in any of the following ways.
  ◆ Drag the embroidery design from file Windows® Explorer into the Layout & Editing window.
  ◆ Double-click the embroidery design file in Windows® Explorer.
  ◆ Double-click the embroidery design file in Design Database.
Opening/Importing Embroidery Designs

Importing embroidery designs

Embroidery designs can be imported from the [Import] pane. For more details on the [Import] pane, refer to "Example of Importing Embroidery Data" on page 15.

From Design Library

1. Click the [Home] tab.
2. Click [Import Patterns] in the [Import] group, and then click [from Design Library].
3. From the [Category] selector, select a category to display the corresponding embroidery data.
4. Select the file icon for the design to be imported, and then click [Import].

From a folder

1. Click the [Home] tab.
2. Click [Import Patterns] in the [Import] group, and then click [from File].
3. Click [Folder].

Indicates the path to the currently selected folder.
4. Select a folder, and then click [OK].

5. Click [File Type] in the [Import] pane. Select the file name extensions of the corresponding embroidery data to be displayed, and then click [OK].

6. Select the file icon, and then click [Import].

When importing designs from other vendors, be sure to choose a design that will fit in the Design Page.

- Since .dst files do not contain thread color information, the colors of an imported .dst file may not appear as expected. You can change the thread colors by using functions in the [Sewing Order] pane or by holding down the <Alt> key and selecting a stitch pattern.

  "Selecting stitch patterns by thread color" on page 80

- When importing .dst files, the number of jump stitches for thread trimming can be specified.

  "Specifying the number of jumps in embroidery design of the DST format" on page 345

---

From an original card

1. Insert an original card into the USB card writer module.
   - Refer to "Transferring to a machine by using an original card" on page 224

2. Click the [Home] tab.

3. Click [Import Patterns] in the [Import] group, and then click [from Card].

    After the card has been read, the embroidery designs on the card are displayed.

4. Select the file icon, and then click [Import].

Due to copyright issues, some original cards cannot be used with this function.
From a machine via wireless network
Embroidery designs can be imported from a sewing machine via the wireless network.

This function is available only when embroidering with our wireless LAN-compatible embroidery machines. Contact your Baby Lock retailer for details on our wireless LAN-compatible models.

1. Register the machine with the application.
   ▶︎ "Registering a machine with the application" on page 223

2. Click the [Home] tab.

3. From the [From] selector of the [Import] pane, select [Network Sewing Machine].

4. Select the icon of the file, and then click [Import].

   ![Import Pane](image)

To update the pane with the latest information from the embroidery machine, click [Refresh].
Opening/Importing Embroidery Designs

Importing vector images (WMF/EMF/SVG)

Vector image data in the "wmf" (Windows Metafile), "emf" (Enhanced Metafile) and "svg" (Scalable Vector Graphics) file formats can be converted to shape patterns.

1. Click the [Home] tab.
2. Click [Import Patterns] in the [Import] group, and then click [from Vector Image].
3. Select the drive, folder and file, and then click [Open].

→ The imported image appears in the Design Page.

■ Creating an embroidery pattern using vector images drawn with other image-editing applications

Being converted to the "svg" file format, vector image files created with other commercially available applications (e.g., "ai" (Adobe® Illustrator Artwork) and "cdr" (CorelDRAW® file)) can be imported.

First convert the vector image files into either of WMF, EMF or SVG file format with your applications, and then import them to Palette by following the steps described in "Importing vector images (WMF/EMF/SVG)".

- Image, text, width of the line, gradient, opacity, and any other styles or attributes of graphics will not be imported. With files in the "emf" and "svg" formats, the data is converted while retaining curves.
- The data on all layers of an SVG file, regardless of whether it is displayed or hidden, will be converted into the embroidery pattern.

- Raster image files (e.g., "bmp" and "jpg") can be used as background images in Palette, or they can be converted to embroidery patterns using the Image To Stitch Wizard.

- "Stitch Wizard: Automatically Converting an Image to an Embroidery Design" on page 141
Opening/Importing Embroidery Designs

Importing embroidery design from Design Center

1. Start up Design Center and open the file.
   
   "Original Image Stage" on page 241 and "Opening a file" on page 252

2. Click the [Home] tab.

3. Click [Import Patterns] in the [Import] group, and then click [from Design Center].

4. Specify the desired settings beside [Import], [Magnification] and [Orientation], and then click [Import].

   **Import Options**
   
   **Import:**
   - As Stitches
   - As Outlines

   **Magnification:** 100%
   
   **Actual size:** W 97.0 × H 80.8 mm

   **Orientation:**
   
   ![Import Options]

   **Import**
   
   As Stitches:
   Imports, as stitch patterns, embroidery data created in Design Center.

   As Outlines:
   Imports, as outline patterns, embroidery data created in Design Center. This data can be edited in the same way as outline patterns created in Layout & Editing.

   The maximum magnification ratio that can be specified is the ratio that enlarges the design to the size of the Design Page.
Saving and Printing

Saving

■ Overwriting

Click  , then [Save].

If no file name has been specified or if the file cannot be found, the [Save As] dialog box appears.

■ Saving with a new name

1 Click  , then [Save As].

2 Select the drive and the folder, and then type in the file name.

If you select a file type of a previous software version, saved .pes files can be opened with that version of the software; however, all saved designs will be converted to stitch pattern.

3 Click [Save] to save the data.

→ The new file name appears in the title bar of the Layout & Editing window.

■ Outputting design in a different format

The data shown in the Design Page can be exported as a file of a different format (.dst, .hus, .exp, .pcs, .vip, .sew, .jef, .csd, .xxx, and .shv).

1 Click  , then [Export].

2 Select the drive and the folder, and then type in the file name.
3 Select a format (.dst, .hus, .exp, .pcs, .vip, .sew, .jef, .csd, .xxx, and .shv) that the file will be exported as.

The [Number of jumps for trim] setting can be specified for outputting to the .dst format. Before outputting, click the [Option] button, then [Options], then [DST Settings] to specify the settings.

- "Specifying the number of jumps in embroidery design of the DST format" on page 345

Some patterns imported from original cards cannot be exported.

Divided embroidery patterns and embroidery patterns for the jumbo frame or multi-position hoop will be exported as a single file, and will not be split into sections.

Printing

Specifying print settings
Before printing, you may need to change the print settings for the embroidery design files.

1 Click , then [Print], then [Print Setup].

- Specify the paper size.
- Specify the paper orientation.
- To print the embroidery pattern, select [Embroidery print mode].

Print type

- Actual Size:
  Select this option to print the design at actual size and the sewing information (dimensions of the embroidery pattern, sewing color order, stitch count and hoop position) on separate pages.

- Reduced Size:
  Select this option to print a reduced image together with all of the above-mentioned information on a single page.

Print option

- Print image:
  Select this check box to print the image imported into the Design Page in addition to the embroidery pattern. However, any part of the image extending out of the print area for the embroidery will not be printed.

- Print sewing area box & center axes:
  (This setting is only available when [Actual Size] is selected.)

- Print template grid:
  Select this check box to print green lines to represent the grid printed on the embroidery sheet included with the hoop. (This setting cannot be selected if [Jumbo Frame] has been selected as the Design Page size.)

Print template grid:
Select this check box to print green lines to represent the grid printed on the embroidery sheet included with the hoop. (This setting cannot be selected if User Hoop, [Cap Frame], [Cylinder Frame], [Jumbo Frame], [Clamp Frame] or [Round Frame] has been selected as the Design Page size.)
Print hoop section boundaries onto the first page:
Select this check box to print the sections of a design where the Design Page has been set to a custom size or to [Jumbo Frame]. The pattern sections are printed in red.

Divide embroidery image into 2 pages:
Select this check box to print at actual size and on A4- or Letter-size paper a design that is larger than the paper size by dividing it in two and printing each half on different pages.
(This setting is only available when [Actual Size] is selected in the [Print Setup] dialog box and when the Design Page is set to the larger hoop sizes. This setting is not available if a [User Hoop] size is selected.)
With this split printing feature, / or / is printed in the lower-right corner of the paper to indicate which half is printed.

Color Changes:
Select this check box to print the thread color change information for the pattern. When this check box is cleared, the information for the necessary threads is printed. This allows you to check the total number of thread colors.

Stitch image
Normal:
Select this option to print the design as lines and dots.

Realistic:
Select this option to print a realistic image of the design. To change the settings of the realistic image, click [Attributes].
▶ “Changing realistic view settings” on page 88

If the [Divide embroidery image into 2 pages] check box is cleared and you print on paper of a larger size, the design does not print in two halves. Likewise, if you print on paper of a smaller size, the design might be cut off.

When printing an imported image onto iron-on paper or printable fabric, or when printing the sheet for positioning the embroidery in the printed image, select [Image print mode], and then select an option under [Material].

Material
Print the image on printable fabric or an iron-on transfer sheet:
Select this option to print the background image on iron-on paper or fabric that can be printed on. Only the image is printed.

Print a flipped image:
Select this check box to print the image flipped on a vertical axis. When printing on iron-on paper, the image is normally printed flipped (mirror image). (For details, refer to the instructions for the iron-on paper that you are using.)
Select this option if your printer does not have a function for printing a flipped (mirror) image. (For details, refer to the instructions for your printer.)

Print a sheet of paper for aligning the printed image and the embroidery:
Select this option to print a sheet for aligning the positions of the image and embroidery. Positioning marks and guide lines indicating the embroidering area are printed on the image.

Change Position
The position where the image is printed on the paper can be changed. (Any part of the image extending out of the print area of the paper is not printed.) Click [Change Position] to display the [Image Print Position Setting] dialog box, and then drag the image to the desired printing position in the paper.

Positioning sheet print mode
Select this option to print positioning sheets for split embroidery patterns.
▶ “Printing the positioning sheets” on page 202
2 Click [OK].
   “Changing the display of the embroidery design” on page 87.

With embroidery patterns for the jumbo frame
The pattern in Side 2 of an embroidery pattern for the jumbo frame is printed with the orientation of the actual embroidery (rotated 180°).

Checking a print image
You can preview the contents of the Design Page before printing.
Click , then [Print], then [Print Preview].

The print image can also be displayed by clicking [Print Preview] in the [Print Setup] dialog box.

Printing a Design Page with sewing information
You can print the Design Page together with its sewing information.

1 Click , then [Print], then [Print].

2 Select the necessary settings.

3 Click [OK] to begin printing.

4 Follow the instructions for the printer to finish printing.
Creating Embroidery Patterns Containing Text

This section provides descriptions for entering text and the various operations for arranging them. In addition, details are provided for creating embroidery patterns whose text can easily be replaced.

From Layout & Editing, various embroidery patterns can be created for text.

The following types of text can be created.

**Built-in fonts:** This software is provided with 130 built-in fonts. (10 built-in fonts are specifically for small text)

**TrueType fonts:** TrueType fonts installed on your computer can be used to create embroidery patterns.

**Small text:** These small fonts have sizes between 3 and 6 mm (0.12 and 0.24 inch). Because of their size, these fonts are useful for beautifully sewing small text.

**Monogram:** Design custom monograms by combining text and decorative patterns.

**User-defined fonts:** User-defined fonts can be created by using the Font Creator.

**User-mapped fonts:** With Font Creator, embroidery patterns can be registered to create a user-mapped font. Registered embroidery patterns can be edited in the same way as text patterns.

In addition, text can be arranged in the following ways.

**Text arrangement:** The text can be arranged along an outline or an arc.

**Transforming:** Text can be transformed into any of the 26 Transform styles.
Tutorial 2: Using Templates

Using the [Template Wizard], you can easily create custom embroidery patterns by simply changing the text in the patterns that are already available. Follow each step to create a custom embroidery pattern.

Step 1 Starting the Template Wizard

When Layout & Editing starts up, the first dialog box of the wizard appears.

1. Plug your USB media into the computer.
2. Click [Use Template Designs].

Step 2 Selecting the type of template to be used

1. Select [shirtsCH11B.pes] from the category [Shirts_Chest], and then click [Next].

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_2.
Various templates are available when [Template] is selected in the [From] selector of the [Import] pane.
Select [shirtsCH11B.pes] from the category [Shirts_Chest], and then click [Template Wizard] to open the Template Wizard.

Step 3  Editing the text

1. Click "R" in the text edit box, to be changed, and then click [Edit Text].
   → The text is highlighted.

2. Type "S", and then press the <Enter> key.
   → The results of editing appear in the preview window.
   The text "Sweetheart" in the second row is highlighted.

3. Type "Championship", and then press the <Enter> key.

4. Click [Next].
Step 4 Outputting the edited template

1. **Edit in Design page**
   Click this button to open the template in a Design Page, where it can be edited or saved.

2. **Send to selector**
   Select the output destination.

3. **Send**
   Click this button to output the template.

4. **Create New Embroidery Design**
   Click this button to return to the dialog box for selecting a template. A different template can be edited.

1. In the [Send to] selector, select your USB media to be used, and then click [Send].

2. To create another embroidery pattern using a different template, click [Create New Embroidery Design]. The dialog box from Step 2 appears.

   To close the Template Wizard, click [Cancel].

### Outputting the edited template

USB media, a sewing machine, an original card or the Link function can be selected as output destinations.

1. Depending on the desired output destination, prepare the USB media or original card. Otherwise, connect the embroidery machine to the computer.

2. Select the output destination from the [Send to] selector, and then click [Send].

   - Select an output destination according to the method used to transfer data to your embroidery machine.
   - When no output destination is found, the [Send] button will be grayed out and unavailable.

   "Transferring Embroidery Designs to Machines" on page 221 and "Using the Link Function to Embroider From the Computer" on page 226.
Creating Embroidery Patterns Containing Text

Template Feature

**Saving your design as a new template**

A design that you have created can be used as a template.

1. Create an embroidery pattern that contains text.

2. Apply the **[Name Drop]** attribute to the text.

   - "Tutorial 5: Creating Name Drop" on page 135 and "Name Drop Feature (Replacing Text)" on page 138

3. Click , then **[Save As]**.

4. Save the created embroidery pattern in a folder of the **[Template Library]** folder. Select the folder (Drive where Palette was installed)\Program Files (x86)\Babylock\Palette Ver.11\Template Library\Sample, type in the file name, and then click **[Save]**.
Tutorial 3: Entering text

This section describes the procedures for importing a transformed text pattern and editing the text.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_3.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Importing a transformed text pattern</td>
</tr>
<tr>
<td>2</td>
<td>Editing entered text</td>
</tr>
</tbody>
</table>

### Step 1 Importing a transformed text pattern

Import a text pattern from the [Import] pane.

1. Display the [Import] pane.
2. Select [Text] from the [From] selector and [Transformed] from the [Category] selector. Select [TT_001.pes], and then click [Import].

### Step 2 Editing entered text

1. Select the imported text pattern, and then click the [Text Attributes] tab.
2. Click in the text field.
   - The text pattern appears as dotted lines, and the cursor appears at the end of the text.
3. Press the <BackSpace> key to delete the text, and then click characters in the character table to enter text. Finally, press the <Enter> key to apply them.

Sample built-in font patterns are available in the [Import] pane when [Text] is selected in the [From] selector.

For details on other ways to edit text, refer to the section indicated below.

 "Editing entered text" on page 117
Entering text

1. Click the [Home] tab.
2. Click [Text] in the [Tools] group, and then click .
3. If necessary, change the font, text size, color and sew type.
   - “Setting text attributes” on page 117 and “Embroidery attributes for text” on page 127
4. Click in the Design Page.
5. Type the text.
6. Press the <Enter> key or click the Design Page.

- Hold down the <Ctrl> key and press the <Enter> key to enter a new line of text.
- Characters can also be entered by clicking them in the character table. This is particularly useful if you have to enter accented characters that are not available on your keyboard.
- Click [Hide List] to hide the character table. While it is hidden, click [Show List] to display the character table.

If the entered character is not available with the selected font or if the character cannot be converted to an embroidery pattern, the character appears as in the Design Page. If this occurs, enter a different character.
Creating Embroidery Patterns Containing Text

Advanced Operations for Entering Text

Editing entered text

Switch to one of the following text edit modes, and then type text as needed using the cursor appearing at the end of the text.

■ Using Text Attributes tab
1. Select a single text pattern.
2. Click the [Text Attributes] tab, and then click in the text field.

■ Using Edit text tool
1. Select a single text pattern.
2. Click the [Text] tab, and then click [Edit Text] in the [Edit] group.

■ Using keyboard
1. Select a single text pattern.
2. Press a character key in the keyboard.

■ Using Text tool
1. Click [Text] in the [Tools] group of the [Home] tab, and then select .

Setting text attributes

Text attributes can be specified with the [Font] selector and [Text Size] selector in the [Text] tab.

■ Font
Click the [Font] selector, and then select the desired font.

Font Type:
- A number identifies built-in fonts.
- identifies user-defined fonts.
- identifies TrueType fonts.

Font sample:
If a single string of text is selected, the fonts in the list appear with the selected characters.

Font name:
Recommended minimum size
Most recently used fonts
Advanced Operations for Entering Text

Creating Embroidery Patterns Containing Text

■ Font Filter

A font listed in the [Font] selector can be selected.

1. Click text or a monogram, or select the [Text] tool or [Monogram] tool.
2. Click the [Text] tab.
3. Click  beside [Font Filter] in the [Font] group, and then click [Font Filter Settings].

4. Select the check boxes for the fonts to be displayed, and clear the check boxes for the fonts to be hidden.

   ![Font Filter Settings](image)

   The [Monogram] check box is available when a pattern with a monogram font or the [Monogram] tool is selected.

5. Click [OK] to apply the filter settings.

6. To return the fonts to the default (all fonts displayed), click [Default].

   ![Font Filter](image)

   The font filter cannot be applied to small text fonts.

   ![Small Text](image)

- User-defined fonts

  PEF files created with Font Creator and saved in the [MyFont] folder where Palette was installed appear as userdefined fonts after the fonts listed in the table above.
  The UD icon appears on user-defined fonts.

  "Font Creator" on page 311

- TrueType fonts

  The installed TrueType fonts appear after the user-defined fonts.

  TrueType font settings can be changed in the [TrueType Font Attribute Setting] dialog box.

  "Specifying TrueType font attributes" on page 120

- User-defined fonts

  "Font Creator" on page 311

  TrueType fonts

  The installed TrueType fonts appear after the user-defined fonts.

  TrueType font settings can be changed in the [TrueType Font Attribute Setting] dialog box.

  "Specifying TrueType font attributes" on page 120

- Text created using certain TrueType fonts may not be converted correctly into an embroidery pattern due to the shape of the character. These characters cannot be embroidered correctly.
  Test sew before embroidering on your project.

- In addition, text created using some TrueType fonts cannot be converted at all.

- Text created using certain TrueType fonts may not be converted correctly into an embroidery pattern due to the shape of the character. These characters cannot be embroidered correctly.
  Test sew before embroidering on your project.

- In addition, text created using some TrueType fonts cannot be converted at all.

- To return the fonts to the default (all fonts displayed), click [Default].

- The font filter cannot be applied to small text fonts.

  "Small Text" on page 128
## Text size

Click the [Text Size] selector. Type the desired height and press the <Enter> key, or select the desired value.

Built-in fonts are listed in the [Font] selector with the recommended minimum size. We recommend using these fonts at a size equal or greater than the size indicated.

1. Recommended minimum size

## Specifying various text attributes

1. Select the text.
2. Click the [Text Attributes] tab.

If the [Text Attributes] pane is not displayed, click the [View] tab, then [Attributes], and then click [Text Attributes].

3. Change the text attributes.

- **Kerning**
  - 0.0 mm
  - 5.0 mm (between "A" and "B")

- **Vertical Offset**
  - 0.0 mm
  - 2.0 mm

- **Rotate Angle**
  - 0°
  - 20°
Advanced Operations for Entering Text

Creating Embroidery Patterns Containing Text

### Specifying TrueType font attributes

1. Select text in a TrueType font.
2. Click [TTF Settings] in the [Font] group.
3. Select a font style from the [Font style] selector, select a character set from the [Script] selector, and then click [OK].

### Transform

- "Transforming text" on page 121
- Click to return to the default setting.
- "Name Drop Feature (Replacing Text)" on page 138

- The settings for [Font style] and [Script] differ depending on the TrueType font that is selected.
- If text created from multiple TrueType fonts is selected, this command is not available. In addition, if text of the same font but different font styles or scripts is selected, this dialog box appears with the attribute settings for the first letter in the text. In either case mentioned above, selecting only one character from within text displays a dialog box containing only that character’s attributes.

### Character Spacing

<table>
<thead>
<tr>
<th></th>
<th>0.0 mm</th>
<th>2.0 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>ABC</td>
<td></td>
</tr>
</tbody>
</table>

### Line Spacing

<table>
<thead>
<tr>
<th></th>
<th>100%</th>
<th>150%</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>ABC</td>
<td></td>
</tr>
</tbody>
</table>

### Alignment

<table>
<thead>
<tr>
<th></th>
<th>Left</th>
<th>Center</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td></td>
</tr>
</tbody>
</table>

### Direction

<table>
<thead>
<tr>
<th></th>
<th>Horizontal</th>
<th>Vertical</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>ABC</td>
<td></td>
</tr>
</tbody>
</table>

### Transform

- "Transforming text" on page 121

### Name Drop

- "Name Drop Feature (Replacing Text)" on page 138

- Both [Kerning] and [Character Spacing] set the spacing between characters. [Character Spacing] is always applied to the entire text pattern, while [Kerning] can be applied to individual characters.

- Refer to "Editing individual characters" on page 123 for more details about selecting individual characters in a text pattern.

- Settings specified for [Kerning], [Vertical Offset] and [Rotate Angle] in the [Text Attributes] pane are applied to all selected characters.
**Transforming text**

1. Select the text.

2. Select the [Transform] check box, and then click the transformation shape button.

   Depending on the selected shape, a dotted line and △ or ▽ appear around the text.

3. Drag △ to transform the text.

   If ▽ was selected in step 2, the following operations can also be performed.

   - Drag △, □, and △ to transform the text.
   - △: Adjusts the text size.
   - □: Moves the text along the circle.
   - △: Adjusts the radius of the circle.

A text pattern contains data for both line and region sewing. Therefore, if this command is selected, depending on the form of the font, there may be a gap between the line and the region in the text.

- △ can only be dragged vertically.
- ▽ can only be dragged horizontally.
- To return the transformed text to its original shape, clear the [Transform] check box.

---

**Advanced Operations for Entering Text**

Creating Embroidery Patterns Containing Text
Creating Embroidery Patterns Containing Text

**Advanced Operations for Entering Text**

1. Select the text or small text and an outline.
2. Click the **[Home]** tab.
3. Click **[Fit Text]** in the **[Edit]** group, and then click **[Fit Text to Outline]**.

Fitting text to an outline

1. Select the text or small text and an outline.
2. Click the **[Home]** tab.
3. Click **[Fit Text]** in the **[Edit]** group, and then click **[Fit Text to Outline]**.

4. Specify the desired settings in the **[Fit Text to Outline Attribute Setting]** dialog box, and then click **[OK]**.

<table>
<thead>
<tr>
<th><strong>Horizontal Alignment</strong></th>
<th><strong>Vertical Alignment</strong></th>
<th><strong>Text Orientation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Example" /></td>
<td><img src="image2.png" alt="Example" /></td>
<td><img src="image3.png" alt="Example" /></td>
</tr>
</tbody>
</table>

Depending on the shape selected under **[Transform]**, different handles appear for editing the text.

- Horizontal Alignment
- Vertical Alignment
- Text Orientation
- the other side

- Depending on the shape selected under **[Transform]**, different handles appear for editing the text.
Creating Embroidery Patterns Containing Text

Advanced Operations for Entering Text

Releasing text from an outline

1. Select text or small text that is arranged on an outline.
2. Click the [Home] tab.
3. Click [Fit Text] in the [Edit] group, and then click [Release Text from Outline].

Editing individual characters

1. Select the text.
2. Select characters in the text.

   To select a single character, click ◇ for the character.

Multiple ◇ can be selected and the selected ◇ can be changed in the same way that embroidery pattern points are selected.

   • Drag the pointer.
     → All points within the box are selected.
   • Hold down the <Ctrl> key while clicking the points.
     → To deselect a point, click the selected point.
   • Hold down the <Shift> key while pressing an arrow key to select multiple points.
   • Hold down the <Ctrl> key while pressing an arrow key to change the point that is selected.

   ［“Selecting points” on page 75］
Changing a character size and character’s attributes

You can easily use drag operations to change the size and text attributes.

■ Changing the size

1 Bring the pointer onto the upper right handle.
2 Drag the handle.
3 When you release the mouse button, the character size is changed.

■ Changing the kerning

1 Place the pointer onto the character body other than the handles, and drag the character horizontally.

■ Rotating the characters

1 Bring the pointer onto the handle.
2 Drag the handle.
3 When you release the mouse button, the character offset is changed.
3 When you release the mouse button, the character angle is changed.

Converting text patterns

1 Select the text or monogram text.
2 Click the [Text] tab.
3 Click [Convert to Blocks] in the [Edit] group.

Converting text to blocks

Text can be converted into blocks, allowing you to reshape characters. By changing the sewing direction line in each of these small regions, you can create text patterns that appear like manual embroidery.

- Click \( \text{Select Point tool} \) and select the converted pattern to see the sewing direction lines.
- Small text cannot be converted to blocks (shape patterns with multiple sewing direction lines).

Convert to Blocks

The pattern is converted while maintaining the multiple sewing direction lines. The character shapes can be partially rearranged.

Convert to Outline

The text is converted to shapes, which can be edited.

Various sew types or embossing/engraving effects can be applied.

\( \Rightarrow "\text{Comparison of Types of Data Created With Palette Ver.11}" \) on page 10

- The text pattern is converted with the original sewing quality maintained.
- The shapes of created blocks can be edited in their finest details.

\( \Rightarrow \) For details on editing blocks or outlines, refer to "Reshaping Embroidery Patterns" on page 75

- Since the text data is no longer available, the text cannot be edited.
Converting text to outline pattern
1. Select text.
2. Click the [Text] tab.
3. Click [Convert to Outline] in the [Edit] group.

Selecting connection point positions in a text pattern
- The positions for connection points between characters within the same text (end point of one character and the start point of the next character) can be specified.
- The available settings are [Default], [Closest] and [Farther].

Text patterns created with built-in fonts 025 and 029, user-defined fonts or small text fonts cannot be converted to outlines.

Tips
- When a pattern is converted outlines, the sewing quality will decrease slightly.
- The sewing direction will become uniform, but it can be edited.

Stitches are created in the default sewing order for good stitching quality of all characters.
Creating Embroidery Patterns Containing Text

Advanced Operations for Entering Text

A BC

Stitches are created at the shortest distance between the end point of one character and the start point of the next character. This shortens jump stitches and reduces the number of times that the thread is trimmed.

Farther

A BC

Stitches are created at a farther distance between the end point of one character and the start point of the next character. This lengthens jump stitches so they can easily be trimmed manually.

A Connection Points setting can be selected not only for region sewing, but also for line sewing.

Embroidery attributes for text

The Sew group in the Attributes tab allows you to set the embroidery attributes (thread color and sew type, outline and inside region on/off).

When text is selected, settings can be specified for the following.

1. **Line color/Region color**
   Sets the thread color for outlines and inside regions.
   ➤ "Color" on page 53

2. **Line sew type**
   Sets the sew type for the outlines. Except with built in fonts 025 and 029, and a user-defined fonts, all sew types are available for lines in text.
   ➤ "Line sew types" on page 56

3. **Region sew type**
   Sets the sew type for an inside region. [Satin Stitch], [Fill Stitch] and [Prog. Fill Stitch] are available for lines in text.
   ➤ "Region sew types" on page 56

- These settings are not available with text created using built-in fonts 025 or 029, a TrueType font, a user-defined font or a small text font.
- These settings are not available for text containing characters of different colors.
- These settings are not available for text where the sewing order of the characters is not continuous.

- Text patterns created using built-in fonts 025 and 029 or user-defined fonts only have an inside region. The thread color and sew type for only the region can be selected.
- Sewing attribute that can be set with Text under sewing. For details, refer to "Region sewing attributes" on page 364.
Advanced Operations for Entering Text

Creating Embroidery Patterns Containing Text

Entering small text

1. Click the [Home] tab.
2. Click [Text] in the [Tools] group, and then click .
3. Enter text in the same way that regular text is entered.

Sample small text font patterns are available in the [Import] pane when [Text] is selected in the [From] selector and [Small Text] is selected in the [Category] selector.

Editing small text

Small text attributes can be selected from the [Text] tab, the [Text Attributes] pane and the [Color] pane. When the small text tool is selected, the [Text] tab appears as shown below.

The [Text] tab appears when a small text pattern or the small text tool is selected.

Small text fonts

1. Font number
2. Font sample
3. Font name
4. Recommended size
Only built-in fonts specifically for small text can be used.

For a list of the built-in fonts specifically for small text, refer to “Small Text” on page 378.

The settings for all small text attributes except the font are specified in the same way that they are specified for regular text patterns. However, with small text, settings cannot be specified for the following.

- Sew type
- Sewing Attributes
- Transform
- Name Drop

To edit an entered small text, select the small text with the [Select] tool, and then type the new text into the text field in the [Text Attributes] pane. There are three other ways to edit text.

- "Editing entered text" on page 117

When sewing small fonts

For best results when using your embroidery machine to embroider patterns containing small font patterns, follow the recommendations described below.

1. Reduce the thread tension to less than what is used when embroidering normal designs.

2. Sew at a speed slower than what is used when embroidering normal designs.
   (For details on adjusting the thread tension and sewing speed, refer to the instruction manual provided with your embroidery machine.)

3. Do not trim the jump stitches between the characters.
   (For details on setting the machine for thread trimming, refer to the instruction manual for the embroidery machine.)
Tutorial 4: Monograms

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_4.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Entering monograms</td>
</tr>
<tr>
<td></td>
<td>Display the [Import] pane.</td>
</tr>
<tr>
<td></td>
<td>Select [Text] from the [From] selector and [Monogram] from the [Category] selector. Click [TM_002.pes], then [Import].</td>
</tr>
<tr>
<td></td>
<td>The text pattern appears as dotted lines, and the cursor appears at the end of the text.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Adding a decorative pattern</td>
</tr>
<tr>
<td></td>
<td>Press the &lt;BackSpace&gt; key to delete the text, and then use the keyboard to type in “XYZ”.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Changing character size of the monogram</td>
</tr>
<tr>
<td></td>
<td>Press the &lt;Enter&gt; key.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Changing the thread color and sew type of the monogram</td>
</tr>
</tbody>
</table>

**Step 1 Entering monograms**

1. Display the [Import] pane.
2. Select [Text] from the [From] selector and [Monogram] from the [Category] selector. Click [TM_002.pes], then [Import].
   
   Sample monogram patterns are available in the [Import] pane when [Text] is selected in the [From] selector and [Monogram] is selected in the [Category] selector.
3. Select the imported monogram pattern, and then click the [Text] tab.

**Step 4**

   
   The text appears in the Design Page.

**Tutorial 4: Monograms**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Entering monograms</td>
</tr>
<tr>
<td></td>
<td>Display the [Import] pane.</td>
</tr>
<tr>
<td></td>
<td>Select [Text] from the [From] selector and [Monogram] from the [Category] selector. Click [TM_002.pes], then [Import].</td>
</tr>
<tr>
<td></td>
<td>The text pattern appears as dotted lines, and the cursor appears at the end of the text.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Adding a decorative pattern</td>
</tr>
<tr>
<td></td>
<td>Press the &lt;BackSpace&gt; key to delete the text, and then use the keyboard to type in “XYZ”.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Changing character size of the monogram</td>
</tr>
<tr>
<td></td>
<td>Press the &lt;Enter&gt; key.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Changing the thread color and sew type of the monogram</td>
</tr>
</tbody>
</table>

**Step 1 Entering monograms**

1. Display the [Import] pane.
2. Select [Text] from the [From] selector and [Monogram] from the [Category] selector. Click [TM_002.pes], then [Import].
   
   Sample monogram patterns are available in the [Import] pane when [Text] is selected in the [From] selector and [Monogram] is selected in the [Category] selector.
3. Select the imported monogram pattern, and then click the [Text] tab.

**Step 4**

   
   The text appears in the Design Page.
Creating Embroidery Patterns Containing Text

**Tutorial 4: Monograms**

A decorative pattern can be added.

1. Display the [Import] pane, and select [Decorative Pattern] from the [From] selector.

2. Select the monogram.

3. Select [Monogram Decoration] from the [Category] selector. Click [Deco09.pes], then [Decorative Import].

→ The decorative pattern is added.

**Step 2 Adding a decorative pattern**

A decorative pattern can be added.

- If a monogram is selected, the [Decorative Import] button and [Maintain aspect ratio] check box will appear. To import the decorative pattern adjusted to the size of the monogram while maintaining its original height-to-width proportion, select the [Maintain aspect ratio] check box. Clear the check box to import the decorative pattern with its height-to-width proportion adjusted to the monogram.
- If no monogram is selected, the button will appear as the [Import] button. Clicking this button will import the decorative pattern at its standard size.

- In this example, a monogram pattern was imported from the [Import] pane; however, a pattern can also be created by selecting the Monogram tool, then typing in text.

- Characters can also be entered from the character table in the [Text Attributes] tab.

- You cannot insert line feeds.
- A maximum of three characters can be entered.
- Only uppercase letters (the characters displayed at the character table) can be entered.

- "Entering text" on page 116

- You cannot insert line feeds.
- A maximum of three characters can be entered.
- Only uppercase letters (the characters displayed at the character table) can be entered.
Step 3 Changing character size of the monogram

Changing the character size of the monogram
Click the [Text Size] selector, and then type in “22”.

Diamond and Script are fonts exclusively for monograms. You can also use the built-in fonts or TrueType fonts.

"Editing monograms“ on page 133

Step 4 Changing the thread color and sew type of the monogram

Changing the thread color
1. Click [Color] tab to display the color palette.
2. Click [TANGERINE].
3. Select the characters “YZ”, and then click [RED].

Changing sew type
1. Click the [Text] tab.
2. Click the [Text Body Sew Type] selector in the [Sew] group, and then select [Fill Stitch].
Advanced Operations for Entering Monograms

Editing monograms

Monogram attributes can be selected from the [Text] tab, the [Text Attributes] pane, the [Sewing Attributes] pane and the [Color] pane. When the Monogram tool is selected, the [Text] tab appears as shown below.

■ Monogram font

Click the [Font] selector, and then select the desired font.

1. Font Type
   - A number identifies built-in fonts.
   - Identifies Monogram fonts.

2. Font sample
   If a single string of text is selected, the fonts in the list appear with the selected characters.

3. Font name

4. Most recently used fonts

The [Text] tab appears when a monogram or the Monogram tool is selected.

Diamond and Script are fonts exclusively for monograms. You can also use built-in fonts, user-defined fonts and TrueType fonts.

For a list of the built-in fonts and monogram fonts, refer to "Font List" on page 376.

The settings for all monogram attributes except the font are specified in the same way that they are specified for regular text patterns. However, with monograms, settings cannot be specified for the following.

- Rotate Angle, Character Spacing, Line Spacing, Alignment, Direction
- Transform
- Name Drop
- Fit Text to Outline

To edit an entered monogram, select the text pattern with the [Select] tool, and then type the new text into the text field in the [Text Attributes] pane.

There are three other ways to edit text.

"Editing entered text" on page 117
User-Mapped Text

■ Entering user-mapped text

1. Register the embroidery data with Font Creator.
   "Registering Embroidery Data as a Font" on page 321

2. Click the [Home] tab.

3. Click [Text] in the [Tools] group, and then click .

4. Click the [Font] selector, and then select the desired font.
   The standard character height for the selected font appears.

5. Enter the text.
   "Entering text" on page 116

The [Text] tab appears when a user-mapped text pattern or the User-mapped text tool is selected.

The settings for all user-mapped text attributes except the font are specified in the same way that they are specified for regular text patterns. However, with user-mapped text, the following parameters, commands or operations cannot be used.

- Sew type
- Sewing Attributes
- Font Filter
- TTF Settings
- Convert to Blocks
- Convert to Outline
- Some editing of individual characters
- Name Drop
- Changing colors
- Some transform functions

To edit entered user-mapped text, select the user-mapped text with the [Select] tool, and then type the new text into the text field in the [Text Attributes] pane. There are three other ways to edit text.

"Editing entered text" on page 117

To change the color of text, perform either of the following operations.

- Click [Convert to Stitches] on the [Text] tab to convert the text pattern to a stitch pattern whose thread colors can be changed. However, the text data will no longer be available.
- Change colors in the embroidery data of the original .pes file.

Enlarging or reducing user-mapped text from the standard character height may reduce the embroidery quality.
Tutorial 5: Creating Name Drop

By creating an embroidery pattern containing text and using the Name Drop function, you can easily create a number of similar embroidery patterns, for example, for uniforms, by replacing only the name in the pattern.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_5.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Designing the embroidery pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Creating the list</td>
</tr>
<tr>
<td>Step 3</td>
<td>Outputting patterns using text from the text list</td>
</tr>
</tbody>
</table>

**Step 1 Designing the embroidery pattern**

1. Display the [Import] pane, and select [Design Library] from the [From] selector.

2. Select [Misc] from the [Category] selector, and then drag the rainbow pattern into the Design Page.

3. Click the [Home] tab.


5. Type in "Fernand", and then press the <Enter> key.

6. Select the text pattern, select the [Transform] check box, and then click .
7 Drag the pattern to adjust its position.

Step 2 Creating the list

1 Select "Fernand", and then select the [Name Drop] check box, and click [Name Drop List] button.

2 Enter text in the list. In this example, we will add text at the end of the list.
   (A) Click a cell in the row and click [Edit Text], or click the cell to enter input mode.
   (B) Use the keyboard to enter the text.

(C) When entering text, press the <Enter> key so that the cell in the next row enters input mode.

Repeat steps (A) through (C) to create the text list.

Selecting a cell containing entered text allows you to preview that text.

Step 3 Outputting patterns using text from the text list

Let's practice outputting the patterns to files. Embroidery data with the text replaced by each row of text in the list can be outputted.

1 Click [To Folder].

2 Select the drive and folder in the dialog box that appears after clicking , type the name of the file in the [File Name] box, and then click [OK].

→ This application begins checking that there are no errors in the embroidery data. If no errors were detected, it begins outputting the data.
3 After the data has been outputted, the following message appears. Click [OK].

![Screenshot showing the message dialog]

The files are named "<file_name>xxx.pes" (where "xxx" are consecutive numbers starting with 001).

An embroidery file is saved in the selected folder for each line of text in the list.
Name Drop Feature (Replacing Text)

Text attributes with Name Drop attribute applied

1 Name Drop
If this check box is selected, the [Name Drop] attribute is applied.

- When the [Name Drop] attribute is applied, the settings for [Kerning], [Vertical Offset], [Rotate Angle], [Character Spacing], [Line Spacing], the character size and color will be reset.

- The [Name Drop] attribute is not available with text where the [Fit Text to Outline] command has been specified, small text or monogram text.

2 Name Drop List
Click this button to display the [Name Drop List] dialog box.

The [Name Drop List] dialog box for a text pattern can be displayed by selecting a text pattern with the [Name Drop] attribute applied, clicking [Text] in the [Home] tab, then clicking [Text], then [Open Name Drop List].

3 Maintain aspect ratio
If this check box is selected, the height-to-width proportion of the text is maintained.

4 ABC
5 ABC
6 ABC
7 ABCDEFg
8 ABCDEFg
9 ABCDEFg
### Creating Embroidery Patterns Containing Text

**Name Drop Feature (Replacing Text)**

1. **Name Drop List**
   Create the list of text to be used to replace text in the pattern. Double-click a cell to enter input mode. Select a row to display a preview of the pattern with the text in that row. A row in the text list can be selected by pressing the ↑ or ↓ key.

2. **Click** + to add a row at the end of the list. (Up to 500 rows can be added.)

3. **Edit Text**
   Enters input mode for the text in the selected cell. (Input mode can also be entered by double-clicking a cell.)

4. **Insert**
   Select a row, and then click [Insert]. A new row is inserted above the selected one.

5. **Delete**
   Select a row, and then click [Delete]. The selected row is deleted.

6. **Import CSV**
   Imports a Name Drop List as a .csv file. Click this button, select the drive and folder, click the name of the file, and then click [Open], or double-click the file's icon.

7. **Save as CSV**
   Saves the created Name Drop List. Click this button, select the drive and folder, type the name of the file in the [File Name] box, and then click [Save] to save the list as a .csv file.

8. **USB Link**
   Click to send to machines by using the USB Link function. This button is available if an embroidery machine compatible with the USB Link function is connected to the computer. Connect a compatible embroidery machine that has been started in USB Link mode.

   "USB Link" on page 226

9. **Wireless Link**
   Click to send to machines by using the Wireless Link function. This button is available if an embroidery machine compatible with the Wireless Link function has been connected to the same wireless network as the computer that is running Palette version 11.2 or later.

   "Wireless Link" on page 231

10. **To Folder**
   "Outputting patterns using text from the text list" on page 136

11. Select text in the [Name Drop List] dialog box and click [OK] to return to the Design Page and edit the pattern with the text replaced.

If the pattern contains two text patterns with the [Name Drop] attribute applied, the text list appears as shown below.
Creating Embroidery Patterns Using Images

Embroidery patterns can easily be created from images. In addition, this section provides details on creating an embroidery pattern that is combined with an image.
Stitch Wizard: Automatically Converting an Image to an Embroidery Design

An embroidery pattern can be created from a digital camera photo, a scanned illustration, or a clip art image.

- **Auto Punch** ➤ "Tutorial 6-1: Auto Punch" on page 142

- **Cross Stitch** ➤ "Tutorial 6-2: Cross Stitch" on page 145

- **Photo Stitch 1** ➤ "Tutorial 6-3: Photo Stitch 1" on page 149

- **Photo Stitch 2** ➤ "Tutorial 6-4: Photo Stitch 2" on page 154
Tutorial 6-1: Auto Punch

In this section, we are going to use the Auto Punch function to automatically create an embroidery pattern from an image. This creates an embroidery pattern from shapes and colors in the image.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Importing image data into Layout &amp; Editing</td>
</tr>
<tr>
<td>2</td>
<td>Starting the Auto Punch wizard</td>
</tr>
<tr>
<td>3</td>
<td>Applying an image mask and adjusting its size and position</td>
</tr>
<tr>
<td>4</td>
<td>Creating a border from the mask outline and converting to an embroidery pattern</td>
</tr>
</tbody>
</table>

Step 1 Importing image data into Layout & Editing

1. Click the [Image] tab.
2. Click [Open] in the [Image] group, and then click [from File].
3. Double-click the [Documents (My documents)]\Palette Ver.11\Tutorial\Tutorial_6] folder to open it.

When this application is installed, the [Palette Ver.11] folder is installed in the Documents folder.

4. Select the file [penguin.bmp], and then click [Open], or double-click the file’s icon.

→ The image appears in the work area.

• Images with few and distinct colors work best with [Auto Punch].
• Repeat steps 1 to 4 to choose another picture image.

For details on other procedures, refer to the following.

Step 2 Starting the Auto Punch wizard

1. Click the [Image] tab.
Step 3 Applying an image mask and adjusting its size and position

1. Click to select the circle mask. Drag handle to adjust the size of the mask, and drag the mask to adjust its position. Click [Next].

   "Select Mask dialog box" on page 157.

2. Drag the image to adjust its output location and size. The white background indicates the sewing area in the Design Page. Click [Next].

   "Check Mask Shape/Modify Image dialog box" on page 160

The mask outline selected here can be used as line data (border) in Step 4.

Step 4 Creating a border from the mask outline and converting to an embroidery pattern

Select the [Add mask outline] check box, check the preview image, and then click [Finish].

→ The image is automatically hidden and stitches are automatically input.
Auto Punch Features

Auto Punch Parameters dialog box

1 Result View
The resulting analyzed image appears in the Result View box.

2 Omit Region Colors/Omit Line Colors
In the [Omit Region Colors] list and [Omit Line Colors] list, click the colors to select whether or not they will be sewn. You can select whether or not areas will be sewn by selecting their colors. Colors that are crossed out are set to not be sewn.

3 Zoom
Click this button to display the [Select Regions] dialog box, where the areas to be converted to lines can be selected.

4 Create Lines
Click the button to display the [Select Regions] dialog box, where the areas to be converted to lines can be selected. Click the areas to be converted to lines, and then click [OK].

5 Thread Chart
Select the thread chart to be used.

6 Add mask outline
If this check box is selected, line data is created from the mask outline.

7 Noise reduction
Sets the level of noise (distortions) that is removed from the imported image.

8 Segmentation sensitivity
Sets the sensitivity for the image analysis.

9 Max. Number of Colors
Sets the number of colors used.

10 Retry
To view the results of the changes, click this button.

- To select whether or not a part of the image is to be sewn, click in the Result View box, or click in the [Omit Region Colors] and [Omit Line Colors] lists.
- Areas filled with a crosshatch pattern in the Result View box will not be sewn. In addition, lines that appear as dotted lines will not be sewn.

1 These areas will not be sewn.
Tutorial 6-2: Cross Stitch

The Cross Stitch function creates cross-stitch embroidery patterns from images. In this section, we will create a cross-stitch embroidery pattern from an image.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Importing image data into Layout &amp; Editing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Starting the Cross Stitch wizard</td>
</tr>
</tbody>
</table>

**Step 1 Importing image data into Layout & Editing**

Select the [Tutorial_6] folder, and then select [tulip.bmp] as the image.

"Importing image data into Layout & Editing" on page 142

**Step 2 Starting the Cross Stitch wizard**

1. Click the [Image] tab.
2. Click [Cross Stitch] in the [Stitch Wizard] group, and then click [Color].

**Step 3**

Click [Next].

From this dialog box, an image mask can be applied, and its size can be adjusted and shape edited. For this example, we will simply continue to the next step.

"Select Mask dialog box" on page 157

**Step 4**

Click [Next].

From this dialog box, the size and position of the image can be adjusted. For this example, we will simply continue to the next step.

"Check Mask Shape/Modify Image dialog box" on page 160
5 Click [Next].

In this dialog box, the cross size and the number of colors can be specified. For this example, we will use the default settings.

6 Click [Finish].

In this dialog box, stitches can be added, deleted or edited, and colors and the number of times each stitch is sewn can be specified. For this example, we will use the default settings.

→ The image is automatically hidden and stitches are automatically input.
Cross Stitch Features

Cross Stitch Parameters dialog box

1 Result View
Areas that will not be converted to cross-stitching are shown with a crosshatch pattern.

2 Omit Colors
In the Omit Colors list, click the colors to select whether or not they will be sewn.

3 Zoom

4 Cross size
Sets the size of the pattern.

5 Thread Chart
You can select the brand of thread to use in the created cross stitch pattern.

6 Max. Number of Colors
Sets the number of colors used in the created pattern.

7 Retry
To view the results of the changes, click this button.

8 Next
Continues to the next step ([Edit Cross Stitch] dialog box).

Edit Cross Stitch dialog box
Click a button in 1 to select the type of stitch, select a thread color in 2, and then click or drag in 3 to edit the stitches.

1 Selecting stitches
Selecting stitches to be added/deleted
× (cross-stitches): Specifies a cross-stitch inside a box.
◎ (backstitches): Specifies a back stitch inside ( ◆ or ◇ ) or on the edge ( □ or ◆ ) of a box.

2 Color Option
To change the color, click [Change Color] to display the [Thread Color] dialog box, and then click the desired color.
To select the color to be used for a stitch, click ◆, and then click the stitch to be sewn with that color.
3 Editing area

- For cross-stitches
  Clicking a box: Adds one stitch.

- For backstitches
  Clicking an edge of a box: Adds one stitch at the edge.
  Clicking a diagonal line in a box: Adds one stitch on the diagonal.

- For both cross-stitches and backstitches
  Dragging the pointer: Adds consecutive stitches.
  Right-clicking/dragging with the right mouse button held down: Deletes one stitch/deletes consecutive stitches.

4 Zoom

5 Display Template
To display the imported image, click [Display Template].

6 Add mask outline
If this check box is selected, line data is created from the mask outline.

7 Cross Stitch Times/Backstitch Times
For the number of times each stitch is to be sewn, select [Single], [Double] or [Triple].

If [Previous] is clicked to return to the [Cross Stitch Parameters] dialog box after the stitches have been edited, the edited stitches are reset to their previous arrangement.
Tutorial 6-3: Photo Stitch 1

By using the Photo Stitch 1 function, embroidery patterns can be created from photos. This type of embroidery pattern created from a photo has detailed and overlapping stitching.

### Step 1 Importing photo data into Layout & Editing

Select the [Tutorial_6] folder, and then select [swimming_girl.jpg] as the image.

- "Importing image data into Layout & Editing" on page 142

### Step 2 Starting the Photo Stitch 1 wizard

1. Click the [Image] tab.
2. Click [Photo Stitch 1] in the [Stitch Wizard] group, and then click [Color].

### Step 3 Applying an image mask and adjusting its size and position

1. Drag the handles to adjust the shape of the mask. Drag the mask to adjust its position.
2. Then click [Next].
3. Click [Design Settings].

With [Photo Stitch 1], an embroidery pattern can be created in color (Color), sepia (Sepia), grayscale (Gray) or one color (Mono). For this example, select [Color].
4 Select [Hoop Size] and choose a Design Page size of 100 × 100 mm from the selector. Then, click [OK].

5 Click [Fit to page] to change the final finishing size.

6 Check the preview of the area to be converted then click [Next].

---

**Step 4 Selecting appropriate thread colors and creating an embroidery pattern**

At this point, the embroidery pattern can be completed by clicking [Finish]. However, this section will describe how to improve the photo stitching by changing various settings.

1 From the [Thread Chart] selector, select the thread chart to be used. In the [Max. Number of Colors] selector, specify "20". Click [Update Preview].

2 Slide the [Brightness] slider one position to the left, and the [Contrast] slider two positions to the right. Click [Update Preview].

Make adjustments as needed, depending on the image. If it is difficult to adjust the tone, click [Select from Candidates].

► "Select from Candidates" on page 153.

- The size of the embroidery pattern appears in the lower left corner of the dialog box. The user can change the size freely with this display.
- The minimum sizes of embroidery patterns that can be sewn are listed below.
  - Face only: 100 × 100 mm
  - Head and face: 130 × 180 mm

► "Check Mask Shape/Modify Image dialog box" on page 160 and "Gray Balance / Modify Image dialog box" on page 161.
3 While looking at the preview on the right side, select colors from the list for the most frequently used colors (light blue for the background) and for the more characteristic colors (deep rose for the lips), and then click [Reserve].

→ For this example, four colors (cream brown, light blue, highlight peach and deep rose) are reserved.

4 In the [Max. Number of Colors] selector, specify "10", and then click [Update Preview].

5 Click [Finish].

→ The image is automatically hidden.

If the created embroidery pattern contains colors that you do not wish to emphasize (for example, grays in the face), change the sewing order in the [Sewing Order] pane so that the undesirable color is sewn before all other colors.

"Changing colors" on page 95.
Photo Stitch 1 Features

Photo Stitch 1 Parameters dialog box

With Color, Sepia or Gray

![Photo Stitch 1 Parameters dialog box]

With Mono

![Photo Stitch 1 Parameters dialog box]

Select the thread colors in the color options 1, specify the desired settings under [Sewing Option] 2 and [Color Option] 3, and then, click [Update Preview] 4 to preview the effects of the specified settings. Click [Finish] 5 to convert the image to an embroidery pattern.

### Color options

<table>
<thead>
<tr>
<th>Color/Sepia/Gray</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Thread Chart</strong></td>
</tr>
<tr>
<td><strong>Auto Select</strong></td>
</tr>
<tr>
<td><strong>Max. Number of Colors</strong></td>
</tr>
<tr>
<td><strong>List of colors used</strong></td>
</tr>
</tbody>
</table>

Select a thread chart, then a thread color, and then click [OK] to add the color to the list. Added thread colors will be reserved as thread colors that must be used.

### Add

Select a thread chart, then a thread color, and then click [OK] to add the color to the list. Added thread colors will be reserved as thread colors that must be used.

### Remove

Select a thread color in the list of colors used, and then click this button to delete the selected color from the list. This is used to delete unnecessary thread colors and reduce the number of colors.

### Reserve

Specifies thread colors that must be used. Select a thread color in the list of colors used, and then click this button to display  in the Reserved column. To cancel this setting, click icon so that it appears as  .

### Mono

<table>
<thead>
<tr>
<th>List of colors used</th>
<th>Displays the thread colors that are being used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Color</td>
<td>Click this button to display the [Thread Color] dialog box, where the thread colors can be changed.</td>
</tr>
</tbody>
</table>
**Photo Stitch 1 Features**

### Sewing Option

<table>
<thead>
<tr>
<th>Detail</th>
<th>Selecting a setting closer to [Fine] creates more details in the pattern and increases the number of stitches. (The stitches will be overlapping.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Pitch</td>
<td>When the value is lowered, the sewing pitch (stitch length) will be shortened, resulting in finer stitching.</td>
</tr>
<tr>
<td>Sew Page Color</td>
<td>If this check box is cleared, the parts of the pattern that are the same color as the Design Page will not be sewn. If it is selected, those parts will be sewn.</td>
</tr>
<tr>
<td>Add mask outline</td>
<td>If this check box is selected, line data is created from the mask outline.</td>
</tr>
</tbody>
</table>

### Brightness / Contrast

The top slider is used to adjust the brightness. The bottom slider is used to adjust the contrast.

The image can be automatically adjusted. Click this button to display nine patterns with different brightness and contrast levels based on the original image. Select one of the candidates, and then click [OK].

### Update Preview

Update the previewed image after settings have been changed.

- If the [Auto Select] check box is selected, the thread colors will be automatically selected from the chart selected in the [Thread Chart] selector. If thread colors are reserved, they will be included in the colors selected according to the number specified in the [Number of Colors] box.
- If the [Auto Select] check box is cleared, the settings in the [Thread Chart] selector and [Number of Colors] box are not applied, and only the thread colors in the current list of colors used will be used to assign thread colors.
- When thread colors are added/deleted, the [Auto Select] check box is cleared. To use added thread colors and automatically select other thread colors, select the [Auto Select] check box, and then update.
- The thread colors in the list of colors used are listed, in order, starting from the brightest. This order is the sewing order and cannot be changed.

Creating beautiful photo embroidery

- Actual thread colors may differ from the thread colors on the screen. In addition, thread colors may appear differently on the screen depending on your operating environment. By editing the colors to create a user thread chart corresponding to the threads that you have, you can create patterns while viewing them in colors nearest to the actual threads that will be embroidered.

  - "Editing user thread color lists" on page 212

- The following types of photos are not appropriate for creating embroidery patterns.
  - Photos where the subject is small, such as in photos of gatherings
  - Photos where the subject appears dark, such as photos taken in a room or taken with backlighting
  - An image with a width and height between 300 and 500 dots is suitable.
Creating Embroidery Patterns Using Images

Tutorial 6-4: Photo Stitch 2

We will create an embroidery pattern with [Photo Stitch 2] in a method different than that used with [Photo Stitch 1]. Although this embroidery pattern will also be created from a photo, this type of embroidery pattern contains repeating zigzag stitches. This produces a more general rendering than with [Photo Stitch 1]; however, the data is created with well-regulated stitching.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Importing photo data into Layout &amp; Editing</td>
</tr>
<tr>
<td>Step 2</td>
<td>Starting the Photo Stitch 2 wizard</td>
</tr>
<tr>
<td>Step 3</td>
<td>Applying an image mask and adjusting its size and position</td>
</tr>
<tr>
<td>Step 4</td>
<td>Changing the sewing angle</td>
</tr>
</tbody>
</table>

**Step 1 Importing photo data into Layout & Editing**

Select the [Tutorial_6] folder, and then select [dog3.jpg] as the image.

- "Importing image data into Layout & Editing" on page 142

**Step 2 Starting the Photo Stitch 2 wizard**

1. Click the [Image] tab.
2. Click [Photo Stitch 2] in the [Stitch Wizard] group, and then click [Mono].

- "Select Mask dialog box" on page 157

**Step 3 Applying an image mask and adjusting its size and position**

1. Click  to select the circle mask. Drag handle to adjust the size of the mask, and drag the mask to adjust its position.
2. From this dialog box, the size and position of the image can be adjusted. For this example, we will simply continue to the next step. Click [Next].

- "Check Mask Shape/Modify Image dialog box" on page 160 and "Gray Balance / Modify Image dialog box" on page 161
Step 4  Changing the sewing angle

1  In the [Direction] box, type "45".

2  Click [Update Preview].

3  Click [Finish].
Creating Embroidery Patterns Using Images

Photo Stitch 2 Features

Photo Stitch 2 Parameters dialog box

With Color

1. Sewing Option
   - Line interval
     - Lower value
     - Higher value
   - Max. Density
     - Lower value
     - Higher value
   - Direction
     - 0°
     - 45°
     - 90°
   - Add mask outline
     - If this check box is selected, line data is created from the mask outline.

2. Color Option
   - Thread Chart
     - You can select the brand of thread available in the [Color Set] selector.
     - If [Auto Select] is selected, the most appropriate four colors will automatically be selected.
     - Selecting a different option specifies the four colors used when creating the embroidery pattern.
     - The color choices are: cyan (C), magenta (M), yellow (Y), black (K), red (R), green (G) and blue (B). Select one of the following combinations that contains the colors most used in the image.
     - Color combinations: CMYK, RGBK, CRYK, BMYK
   - Thread Colors Used
     - Displays the four selected thread colors.
   - Change Color
     - Under [Thread Colors Used], click a color. Then, click [Change Color] to display the [Thread Color] dialog box. Select the new color and click [OK]. The selected thread color will be applied to the image shown in the preview window.
   - Mono
     - Change Color
     - Click on the [Change Color] button to open the [Thread Color] dialog box if you wish to change the color of the photo stitching. Select the color and click [OK] to make the color change.
   - Color/Mono
     - Brightness / Contrast
       - The top slider is used to adjust the brightness.
       - The bottom slider is used to adjust the contrast.
     - Update Preview
       - Updates the previewed image after settings have been changed.

With Mono

Specify the desired settings under [Sewing Option] 1 and [Color Option] 2, and then click [Update Preview] 3 to preview the effects of the specified settings. Click [Finish] 4 to convert the image to an embroidery pattern.
Creating Embroidery Patterns Using Images

Advanced Stitch Wizard Operations

Image To Stitch Wizard

Click at the top of the window (in the [Quick Access Toolbar]) to display the Startup Wizard, and then click [Create Embroidery Patterns Using Images]. If an image has been imported, the next dialog box appears.

Adjusting the Mask and Image

Select Mask dialog box
The [Select Mask] dialog box appears no matter which conversion method was selected.

Sample image before being converted
Sample image of embroidery pattern after being converted
Select the conversion method.
Select to start up Design Center and import the image into the Design Page.
Description of conversion method
Click to continue to the next step.

Mask shapes
The image will be masked with the selected shape.

The mask can be reshaped or repositioned. Select the tool appropriate for the operation to be performed.

: Drag the handles to enlarge/reduce the mask. Drag the mask to adjust its position.

: Points can be entered, moved and deleted to create a mask with the desired shape. To add points, click the outline of the mask. To move a point, select the point, and then drag it. To delete points, select the point, and then press the <Delete> key.

With a small original image, it may not be possible to reduce the size of the mask.

If no image has been imported into the Design Page, the [Open an image file] dialog box appears.
Creating Embroidery Patterns Using Images

Advanced Stitch Wizard Operations

3 Click to detect the outline of the image. The detected outline can be edited.

"Adjusting the image mask" on page 159

4 Zoom

A mask shape edited with or created by clicking [Clipping Mask] will be added at the top of the list. Then, this mask shape can be selected the next time a pattern is created using a Stitch Wizard. A maximum of five shapes will be added, and they will be arranged in order of the most recently used. These mask shapes appear no matter which Image To Stitch function is selected.

5 Clicking the [Image Tune] button displays an [Image Tune] dialog box.

- Move the [Original] – [Sharp] slider to adjust the sharpness of the image’s outlines. A setting more towards [Sharp] makes a more noticeable boundary between bright and dark areas.
- Move the [Low] – [High Contrast] slider to adjust the contrast of the image.
- Move the [Low] – [High Saturation] slider to adjust the color saturation of the image.


The next step differs depending on the color range selected for the embroidery pattern.

"Check Mask Shape/Modify Image dialog box" on page 160

"Gray Balance / Modify Image dialog box" on page 161
### Adjusting the image mask

The detected outline can be edited. Your image is accurately traced for a more precise output.

1. Select [Auto Punch], [Cross Stitch], [Photo Stitch 1] or [Photo Stitch 2].

2. Click or , and then specify the image mask. 
   - "Adjusting the Mask and Image" on page 157

3. Click [Clipping Mask].
   - The automatically detected image mask appears.

4. Adjust the image mask. The outline of the image mask is indicated by a thick cyan line, and the inside of the image mask is filled with a cyan crosshatch pattern.
   
   ![Image showing steps 1 to 4](image.png)

   1. Fill areas with the yellow-green pen to remove them from the image mask.
   2. Fill areas with the pink pen to add them to the image mask.

Enclose the desired part of the image with the image mask, and then press [Clipping Mask] to increase the masking precision.
3. Trace over lines drawn with pen 1 or 2 to erase them.
4. Hide all lines drawn with pen 1 or 2.
5. Delete all drawn lines.
6. Undo the last operation to return the image mask to its previous condition.
7. Redo the last operation that was undone.
8. Update the image mask according to the currently drawn pen lines.
9. Click to apply the image mask.
10. Click to return to the [Select Mask] dialog box.

5. Click [Update Preview], check the adjusted area, and then click [OK].

- When selecting areas to be added or removed from the image mask, the entire area does not need to be completely filled with the pen marks.
- We recommend repeatedly marking the image mask with the pens and updating the preview until the desired image mask is obtained.

---

**Check Mask Shape/Modify Image dialog box**

If Color, Sepia or Gray was selected for [Photo Stitch 1], [Photo Stitch 2] or [Cross Stitch], or if [Auto Punch] was selected:

The following dialog box appears.

1. Adjust the position and size of the image. Drag the image to the desired position. Drag the handle to adjust the image to the desired size.
2. Click [Design Settings] to change the size of the Design Page. Specify the settings in the [Design Settings] dialog box.

   ► “Specifying the Design Page Settings” on page 16

3. Click [Fit to page] to adjust the image to the size of the Design Page.

4. Embroidery pattern size
Gray Balance / Modify Image dialog box

If [Mono] was selected for [Photo Stitch 1] or [Photo Stitch 2]:
The following dialog box appears.

1. Adjust the position and size of the image. Drag the image to the desired position. Drag the handle to adjust the image to the desired size.
2. Click [Design Settings] to change the size of the Design Page. Specify the settings in the [Design Settings] dialog box.
   ▶ "Specifying the Design Page Settings” on page 16
3. Click [Fit to page] to adjust the image to the size of the Design Page.
4. Embroidery pattern size
5. Drag the slider to adjust the gray balance.

Importing to Design Center

We will create embroidery data in Design Center by using an image that was opened in Layout & Editing.

1. Click the [Image] tab.
2. Click [Design Center] in the [Stitch Wizard] group.
   
   → Design Center starts up and the image appears in the Design Page.
   
   ▶ "Basic Design Center Operations” on page 240 and "Line Image Stage” on page 253
Creating Embroidery Patterns Using Images

Importing Image Data

An imported image can be used with the Image To Stitch Wizard, as a template for manual punching, or for printing onto iron-on transfer sheets or printable fabric when using "Print and Stitch".

An image can be imported using any of the following four methods.

- From a file
- From a scanner (TWAIN Device)
- From the Clipboard

Important:
Only one image can be added to the work area. If you try to display a different image, it will replace the previous one.

**Image file formats**
Images in the following formats can be imported.

- Windows bitmap (.bmp)
- Exif (.tif, .jpg)
- Windows Metafile (.wmf)
- Portable Network Graphics (.png)
- Encapsulated PostScript (.eps)
- GIF (.gif)

- Vector image data in the "wmf" (Windows Metafile), "emf" (Enhanced Metafile) and "svg" (Scalable Vector Graphics) file formats can be converted to shape patterns as it is without some information not supported.

"Importing vector images (WMF/EMF/SVG)" on page 104

- If an EPS file doesn't contain a "Preview" image, it can not be displayed correctly. When you create a file in EPS format, be sure to save it with preview image.

**Importing image from a file**

1. Click the [Image] tab.
2. Click [Open] in the [Image] group, and then click [from File].

- If the [Preview] check box is selected, the contents of the selected file will appear in the [Preview] window.
- Various clip art images can be found in the [ClipArt] folder (in the folder where Palette was installed) at:
  C:\Program Files (x86)\Baby lock\Palette Ver.11\ClipArt
Creating Embroidery Patterns Using Images

Importing Image Data

Importing image from the clipboard

1. Click the [Image] tab.
2. Click [Open] in the [Image] group, and then click [from Clipboard].

→ The image on the clipboard is imported into the Design Page.

This can only be done when there is image data on the Clipboard.

Importing image from a scanner (TWAIN Device)

TWAIN is an application interface (API) standardization for software that controls scanners and other devices.

1. Check that the scanner or other TWAIN device is correctly connected to your computer.
2. Click the [Image] tab.
3. Click [Open] in the [Image] group, and then click [Select TWAIN device].

4. From the [Sources] list, click the desired device to select it. Click [Select].

→ The driver interface for the device selected in the Select Source dialog box appears.

5. Click the [Image] tab.
6. Click [Open] in the [Image] group, and then click [from TWAIN device].

→ The imported image will be pasted into the Design Page at its original size.

If no TWAIN device is installed, there will be no names displayed in the [Sources] list. First, install the driver software for the TWAIN device.

7. Specify the necessary settings for importing an image, and then import the image.

For information on using the driver interface, refer to the help manual for that interface, or contact the manufacturer of the interface.
Changing the Image Settings

Adjusting the density of the background image

1. Click the [Image] tab.
2. Drag the slider, or click or in the [Image] group.

- Hide (off)
- 25%
- 50%
- 75%
- 100%

Press the shortcut key <F6> to switch between displaying the image (On (100%)) to displaying it faded at each density (75%, 50% and 25%) to hiding the image (Off).

Changing the size, angle and position of the image

Selecting an image

1. Click the [Image] tab.

The image is selected and appears as shown below.

Moving an image

Drag the selected image to the desired location.

Scaling an image

Drag the handle to adjust the image to the desired size.

If the <Shift> key is held down while a handle is dragged, the image is enlarged or reduced from the center of the image.
Creating Embroidery Patterns Using Images

**Rotating an image**
An image can be rotated in 90° increments.

1. Click the [Image] tab.
2. Click [Rotate Right] or [Rotate Left] in the [Edit] group.

An image can also be deleted by selecting it, then pressing the <Delete> key.

![Image](image.png)

1. Rotate Right
2. Rotate Left

**Deleting an image**
1. Click the [Image] tab.
2. Click [Delete] in the [Edit] group.

The image data can be saved in either of the following formats: Windows bitmap (.bmp), Exif (.jpg).

**Saving the image data**

**Saving as a file**
1. Click the [Image] tab.
2. Click [Save] in the [Image] group, and then click [to File].
3. Select the drive, the folder and the format. Type in file name. Click [Save].

**Outputting to the Clipboard**
1. Click the [Image] tab.
2. Click [Save] in the [Image] group, and then click [to Clipboard].
Creating Embroidery Patterns Using Images

Tutorial 7: Print and Stitch

In this example, we will create a design that combines embroidery and an image.

1. Print the background image on fabric.
2. Embroider

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_7.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Creating a design combined with a background image</td>
</tr>
<tr>
<td>Step 2</td>
<td>Printing the background image</td>
</tr>
<tr>
<td>Step 3</td>
<td>Printing the positioning sheet</td>
</tr>
<tr>
<td>Step 4</td>
<td>Embroidering</td>
</tr>
</tbody>
</table>

Step 1 Creating a design combined with a background image

For this example, we will use the gift box image (Bear_Background.jpg) and the embroidery pattern of the bear (tutorial_7_Bear.pes).

1. Start up Layout & Editing.
   Specify a Design Page size of 130 × 180 mm.
   ➤ “Specifying the Design Page Settings” on page 16
2. Click the [Image] tab.
3. Click [Open] in the [Image] group, and then click [from File].

4. Import the file [Bear_Background.jpg].
   Select the file Bear_Background.jpg in the folder [Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_7].
   ➤ “Importing Image Data” on page 162.
5. Display the [Import] pane.
6 Import the file [tutorial_7_Bear.pes].

   "Importing embroidery designs" on page 101

7 Enter the text.
   Select built-in font [No. 30], and thread color [DEEP ROSE].
   Type in "Happy Birthday!".

   "Entering text" on page 116

8 Transform the text to fit with the design of the image.
   1 Click [Text Attributes] tab.
   2 Select the [Transform] check box, and then click .

   Drag the rotation handle to adjust the angle of the pattern.

   Drag or a handle to adjust the size of the pattern.

   "Transforming text" on page 121 and "Rotating patterns" on page 40

9 After the design is finished, save the embroidery data onto media so it can be transferred to the embroidery machine.

   For details on saving embroidery patterns, refer to "Saving" on page 106.

   For details on transferring designs to an embroidery machine, refer to "Transferring Embroidery Designs to Machines" on page 221.
Step 2  Printing the background image

Print the background image on an iron-on transfer sheet or printable fabric.

1  Click , then [Print], then [Print Setup].

2  Specify the print settings.

   a  Select the printer to be used.
   b  Under [Paper] and [Orientation], select the appropriate settings for the iron-on transfer sheet or printable fabric to be printed on.
   c  Select [Image print mode].
   d  Select [Print the image on printable fabric or an iron-on transfer sheet].

3  Click [Change Position].

4  Check the image position.

If any part of the image extends out of the print area, drag the image to adjust its position.

5  To print a flipped image on an iron-on transfer sheet, select the [Print a flipped image] check box.

Some printers will automatically print an image flipped if an iron-on transfer sheet is selected as the paper. If this type of printer is being used, clear the [Print a flipped image] check box.

For details, refer to the instructions for the printer being used.

6  Click [Print].

To check the print image, click [Print Preview].
Tutorial 7: Print and Stitch

Creating Embroidery Patterns Using Images

169

Step 3 Printing the positioning sheet

Print a sheet for aligning the image and the embroidery.

1 Specify the print settings.

2 Select [Print a sheet of paper for aligning the printed image and the embroidery].

3 Specify the appropriate settings in the [Print Setup] dialog box, and then click [OK].

4 Click [Print].

For details on printing on iron-on transfer sheets or printable fabric, refer to the instructions for the iron-on transfer sheets and printable fabric.

To check the print image, click [Print Preview].

Step 4 Embroidering

1 If an iron-on transfer sheet is used, transfer the image onto fabric.

2 Hoop the fabric in the embroidery frame.

For details on transferring from iron-on transfer sheets, refer to the instructions for the iron-on transfer sheets.
3 Place the positioning sheet on the fabric to be embroidered so that it is aligned with the printed image.

- If the positioning sheet is too large, cut it to an appropriate size so it can easily be used for aligning the positions.
- Tape the positioning sheet to the fabric to secure it in place.

4 Attach the embroidery frame to the embroidery machine. Be sure that the positioning sheet does not move out of place.

5 Align the needle with the mark at the center of the positioning sheet.
   - If the embroidery machine has a built-in camera, press the start positioning button to detect the positioning mark and automatically align the embroidering position.
   - With other embroidery machines, manually align the positions.

6 After positioning is finished, remove the positioning sheet from the fabric.

7 Start the embroidery machine to embroider the pattern.

- For details on using the embroidery machine, refer to the instruction manual included with the machine.
- Some patterns of completed samples for "Print and Stitch" are provided in the following folder.
  Documents (My documents)\Palette Ver.11\Sample\Layout & Editing\Print and Stitch
Operations for Specific Applications

This section describes operations for creating embroidery patterns using manual punching and for specific applications such as appliqués, embroidered patches and large-sized embroidery patterns.
Tutorial 8: Filling a specified area around a pattern with embroidery

Use the Background Fill function to specify an area around a pattern and fill the area with embroidery. For this example, we will create an echo quilting pattern.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_8.

### Step 1 Creating a pattern

1. Click the [Home] tab.
2. Draw the pattern that will be arranged at the center.

![Step 1 Creating a pattern](image)

This feature can not be used if the pattern runs off the Design Page. Be mindful of the placement of the pattern.

### Step 2 Adding a pattern to the background fill

3. Add a pattern around the first one to specify the area to be filled. For this example, select [BLACK] as the line color and [BLUE] as the region color.

![Step 2 Adding a pattern to the background fill](image)

4. Select [Not Sewn (Region)] from the [Region sew type] selector.

![Step 2 Adding a pattern to the background fill](image)

- The thread color used to fill an area is the region color that was specified last.
- Any region with no stitching can be specified in the Design Page. Set the sew type for the pattern that was added to specify the area to any setting other than [Not Sewn].

172
Tutorial 8: Filling a specified area around a pattern with embroidery

**Step 2 Adding a pattern to the background fill**

1. Select all patterns.
2. Click [Background Fill] on the [Wizards] tab.
3. Click an area to select it.

**4.** Select [Echo Fill] under [Fill Type], and then click [Next].

- Creates an echo quilting pattern to fill the area.
- Creates a stippling pattern to fill the area.  
  "Stippling Fill" on page 176
- Creates a decorative fill pattern to fill the area.  
  "Decorative Fill" on page 176
- Creates a crosshatch/stripe pattern to fill the area.  
  "Crosshatch/Stripe Fill" on page 177
**Tutorial 8: Filling a specified area around a pattern with embroidery**

1. Specify the distance from the inner pattern and the spacing between the echo patterns.
   
   ➔ For this example, set it to 5.0 mm.

   ![Distance and Spacing](image)

   7.0 mm
   
   12.0 mm

2. Select the type of echo quilting pattern.
   
   ➔ For this example, select [Echo Clipped].

   **Echo Clipped**
   
   The inner pattern is enclosed by concentric copies of its outline.

3. Select this check box to link the ends of the echo patterns.
   
   This setting is available only when [Echo Clipped] is selected for [Echo Type].

   ➔ For this example, clear this check box.

4. Specify the sew type and other sewing attributes for the pattern.
   
   ➔ For this example, select [Triple Stitch].

   **Running Stitch**
   
   Settings can be specified for [Run pitch] and [Run time(s)].

   ➔ “Running Stitch” on page 358

   **Triple Stitch**
   
   Settings can be specified for [Run pitch].

   ➔ “Triple Stitch” on page 358

   **Chain Stitch**
   
   Settings can be specified for [Stitch Type] and [Size].

   ➔ “Chain Stitch” on page 362

5. Click to update the previewed image.

6. Click [OK].

   ![Updated Preview](image)

   Check box selected.

   Check box cleared.
Select the shape added in step 3 of “Creating a pattern”, and then select [Not Sewn (Line)] from the [Line sew type] selector.
Specify Settings for Background Fill

Specify settings for background fill pattern

**Stippling Fill**

1. Specify the spacing between the patterns.
   - 1.0 mm
   - 7.0 mm

2. Specify sewing attributes for the stippling.
   - "Stippling Stitch" on page 373

**Decorative Fill**

1. Specify the spacing between the patterns.
2. Click to select a decorative fill pattern.

3. Specify the size of the decorative fill pattern.
4. Select this check box to connect the edges of objects with running stitches.
   - "Decorative Fill Stitch" on page 375

With patterns that are not connected at the top and bottom or at the left and right as shown below, select this check box to reduce the feed.

5. Select this check box to not embroider the part of the background overlapped by the inner pattern.
   - Clear this check box to sew the created stitching first, then sew the overlapping pattern.

Check box selected.

Check box cleared.
Specify Settings for Background Fill

Crosshatch/Stripe Fill

1. Specify the spacing between the patterns.
   - 0.0 mm
   - 6.0 mm

2. Select the fill type.
   - Crosshatch
   - Stripes

3. Specify the size of the pattern (or line spacing).
   - 7.0 mm
   - 30.0 mm

4. Specify the pattern angle.
   - 45°
   - 90°

5. Select this check box to not embroider the part of the background overlapped by the inner pattern. Clear this check box to sew the created stitching first, then sew the overlapping pattern.

- This function is not available when the selected embroidery frame has a width or height of less than 100 mm.
- This function is not available when the selected embroidery frame is a multi-position hoop.
- This function is not available if the [Name Drop] attribute is applied to a part of the pattern.
Tutorial 9-1: Creating Appliqués

The Applique Wizard provides instructions for easily creating appliqués. For this example, we will create an appliqué that has holes (empty regions).

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_9.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Creating an appliqué pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Using the Applique Wizard</td>
</tr>
</tbody>
</table>

The Applique Wizard cannot be used if a pattern containing text with the [Name Drop] attribute applied is selected.

Step 1 Creating an appliqué pattern

1. Click the [Home] tab.
2. Click [Shapes] in the [Tools] group, and then click .

3. Drag the pointer in the Design Page to draw a circle.

Step 2 Using the Applique Wizard

4. Select as described in steps 1 and 2, and then drag the pointer in the Design Page to draw a heart on top of the circle.

5. Select the two patterns, click [Modify Overlap] in the [Edit] group, and then select [Set hole sewing] to apply hole sewing.

Be sure to select the outer pattern before starting the [Applique Wizard].
2 Specify settings in the [Applique Wizard] dialog box in the following order 1 - 6.

1 Applique Material
2 Applique Position
3 Tack down
4 Covering Stitch
5 Output Pattern
6 Create an applique with hole sewing

This check box appears when using a pattern with hole sewing applied and [Replace] is selected under [Output Pattern].

To return all parameters to their default settings, click [Default].

3 Specify cutting lines for the appliqué in [Applique Material].

The outline of the appliqué can be sewn as running stitches or the appliqué can be cut out, or it can be neither sewn nor cut out.

→ For this example, select [Yes] then [Cutting].

Running Stitch
Select this setting to sew the cutting line, then cut along the cutting line with scissors.

Cutting
In order for this setting to be available

"Basic requirements for Cutwork functions" on page 190

Select this setting to cut the fabric with a machine installed with cutwork needles.

4 [Applique Position] is specified automatically.

→ The guideline for attaching the appliqué piece is set to be sewn automatically.

5 Specify basting of the appliqué in [Tack down].

The appliqué piece can be basted onto the base fabric. Select one of three stitches.

→ For this example, select [Yes] then [V Stitch].

Zigzag Stitch E Stitch V Stitch
6 Specify the stitching for securing the appliqué in [Covering Stitch]. Select the sew type and other attributes ([Width] and [Density]) for finishing the appliqué.

→ For this example, select "Zigzag Stitch", and then set [Width] to "3.0 mm" and [Density] to "5.0 line/mm".

Zigzag Stitch
Settings can be specified for [Width] and [Density].

E Stitch
Settings can be specified for [Stroke], [Interval] and [Pitch].

V Stitch
Settings can be specified for [Stroke], [Interval] and [Pitch].

Chain Stitch
Settings can be specified for [Stitch Type], [Size] and [Time].

→ For details on setting [Stroke], [Interval] and [Pitch], refer to "E/V Stitch" on page 361

→ For details on setting [Stitch Type], [Size] and [Time], refer to "Chain Stitch" on page 362.

7 Under [Output Pattern], select whether covering stitches will be added around the entire pattern ([Add]) or covering stitches will be sewn for shape lines ([Replace]).

→ For this example, select [Replace].

Add
Settings can be specified for [Distance from original Pattern].

Replace

8 Specify hole sewing in [Create an applique with hole sewing].

Select this check box when creating an appliqué with holes (empty regions).

→ For this example, select this check box.

This check box appears when only the outer pattern with hole sewing applied or only a text pattern (with fonts other than built-in fonts 025 and 029, a user-defined font or a Small Text font) is selected, or when [Replace] is selected under [Output Pattern].

* Multiple text patterns can be selected if certain conditions are met.
Tutorial 9-1: Creating Appliqués

The shape of the appliqué material appears as shown below, depending on whether the [Create an applique with hole sewing] check box is selected or not.

When the [Create an applique with hole sewing] check box is cleared:

![A
 O](image1)

When the [Create an applique with hole sewing] check box is selected:

![A
 O](image2)

9 Click [OK] to exit the Applique Wizard dialog box.

- **Add**
  - Covering stitches will be created around the original pattern.
  - Under [Distance from original Pattern], specify the distance of the covering stitches from the original pattern.
  - This can be used to combine various patterns.

- **Replace**
  - Covering stitches will be sewn for outlines in the original pattern.
  - The original pattern will be deleted.
  - Shape and text patterns can be used as the original pattern. However, the following patterns cannot be used:
    - Open lines
    - Closed lines that are intersecting
    - Text created with built-in fonts 025 and 029, an user-defined font or a Small Text font
    - Original patterns containing both a shape pattern and a text pattern

The [Add] setting is not available if the stitch pattern does not exist, for example, when both the line and region sew types are set to [Not Sewn].

When [Cutting] is selected under [Applique Material]:

- Uncut sections will remain in cutting lines specified with the Applique Wizard. Be sure to cut them with scissors after embroidering is finished.
When multiple patterns are selected, covering stitches will be created as shown below.

- If the patterns do not overlap
  Covering stitches will be created for each pattern.

1. Add
2. Replace

- If the patterns overlap
  With the [Add] setting, covering stitches will be created for an outline around all patterns.

1. Add
2. Replace
Tutorial 9-2: Creating Embroidered Patches

The Embroidered Patch Wizard provides instructions for easily creating embroidered patches.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_9.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Creating the patch pattern</td>
</tr>
<tr>
<td>Step 2</td>
<td>Using the Embroidered Patch Wizard</td>
</tr>
</tbody>
</table>

The Embroidered Patch Wizard cannot be used if a pattern containing text with the [Name Drop] attribute applied is selected.

**Step 1 Creating the patch pattern**

1. Select the appropriate [Shapes] tool, and then draw a heart.
   - "Drawing various shape" on page 71.
2. Import the fish pattern from the [Aquatic] category of the Design Library.
   - "From Design Library" on page 101.
3. Select the [Text] tool, and then type in "I", "Fresh" and "Fish".
   - "Entering text" on page 116.
4. Drag each pattern to arrange them so that they are well balanced.
Step 2 Using the Embroidered Patch Wizard

1. Select all patterns, and then click the [Home] tab.

2. Click [Embroidered Patch] in the [Wizards] group to start the [Embroidered Patch Wizard].

3. Specify settings in the [Embroidered Patch Wizard] dialog box in the following order 1 - 2:
   - **Satin Stitch**
   - **Cutting Line**

To return all parameters in the [Embroidered Patch Wizard] to their default settings, click [Default].

4. Under [Satin Stitch], specify a border for the embroidered patch.
   - For this example, select [Yes], and then set [Width] to "3.0 mm", [Density] to "4.5 line/mm" and [Distance from original Pattern] to "5.0 mm".

5. Under [Cutting Line], specify the cutting lines for the embroidered patch.
   - The cutting line of the embroidered patch can be sewn as running stitches or the embroidered patch can be cut out.
   - For this example, select [Running Stitch], and then set [Distance from satin stitch] to "3.0 mm".

   **Running Stitch**
   Select this setting to sew the cutting line, then cut along the cutting line with scissors.

   **Cutting**
   In order for this setting to be available
   - "Basic requirements for Cutwork functions" on page 190

   Select this setting to cut the fabric with a machine installed with cutwork needles.

6. Click [OK] to exit the [Embroidered Patch Wizard] dialog box.

   - When [Cutting] is selected under [Cutting Line], uncut sections will remain in the cutting lines created with the Embroidered Patch Wizard. Be sure to cut them with scissors after embroidering is finished.
   - The thread color of the satin stitching is the color currently specified in the Design Page.
**Practical use of Satin Stitch and Cutting Line**

**When [Satin Stitch] is set to [Yes]**
The distance between the patch pattern and the satin stitches is specified under [Distance from original Pattern], and the distance between the satin stitches and the cutting line is specified under [Distance from satin stitch].

1. Patch pattern
2. Satin Stitch
3. Cutting Line

If multiple patterns are selected for the patch pattern, the finished result differs depending on the distances between the patterns as well as between the patterns, satin stitches and cutting line in addition to the width of the satin stitches.

**When [Satin Stitch] is set to [No]**
The distance between the patch pattern and the cutting line is specified under [Distance from original Pattern].

1. Patch pattern
2. Cutting Line

If multiple patterns are selected for the patch pattern, the finished result differs depending on the distances between the patterns and between the patterns and cutting line.
Tutorial 9-3: Creating a Cutwork Pattern Filled with Net Stitching

Cutwork patterns, combining embroidery and cutting with cutwork needles, can be created using the extended functions. By using the [Cutwork Wizard], a cutwork pattern can easily be created.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_9.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Creating an outline shape for cutwork</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Using the Cutwork Wizard</td>
</tr>
</tbody>
</table>

For the cutwork functions to be available, click [Design Settings], then [Machine Type].

When the cutwork functions are not being used, it is not necessary to select this setting.

Specifying the Design Page Settings” on page 16

Step 1 Creating an outline shape for cutwork

1. Display the [Import] pane.
2. Select [Outline Shapes] from the [From] selector, select [Leaves] from the [Category] selector, select [OL_clover01.pes], and then click [Import].

Patterns in [Outline Shapes] from the [From] selector are appropriate for creating the cutwork patterns.
3 Enlarge the pattern imported into the Design Page.

4 Ungroup the pattern. Select the pattern, right-click it, and then click [Ungroup].

Step 2 Using the Cutwork Wizard

1 Select the four leaves, and then click the [Home] tab.

2 Click [Cutwork Wizard] in the [Wizards] group to start the [Cutwork Wizard].

Specify settings in the [Cutwork Wizard] in the following order 1 - 5.

1 Stabilize Cut Edge
2 Cutting Line
3 Secure Water-Soluble Stabilizer
4 Net Fill
5 Covering Satin Stitch

To return all parameters to their default settings, click [Default].

4 Specify running stitching along the edge before cutting in [Stabilize Cut Edge].

By specifying that running stitches be sewn before the fabric is cut, the cut edges are reinforced, preventing them from unraveling.

→ For this example, select [Yes].

- The [Cutwork Wizard] can also be used if closed shape patterns or text patterns are selected.
- If a line of the pattern crosses itself, the [Cutwork Wizard] will not be available.
- Text with built-in font 025 or 029 or a user-defined font cannot be used.
- Shape patterns and text patterns cannot be combined.
**5** Specify cutting line type in [Cutting Line].
Select whether the fabric will be cut along the cutting line or whether the cutting line will remain as running stitches.
→ For this example, select [Cutting].

**Cutting**
In order for this setting to be available

“Basic requirements for Cutwork functions” on page 190

Select this setting to cut the fabric with a machine installed with cutwork needles.

**Running Stitch**
Select this setting to sew the cutting line, then cut along the cutting line with scissors.

**6** Specify securing of the water-soluble stabilizer in [Secure Water-Soluble Stabilizer].
Running stitches will be sewn to secure the water-soluble stabilizer after the fabric has been cut. In order to prevent embroidery from losing its shape after it has been cut, place water-soluble stabilizer in the cutout areas and sew it in place.
→ For this example, select [Yes].

**7** Specify net fill stitching inside the cutout areas in [Net Fill].
By sewing net fill stitching in cutouts, inner cutouts can be reinforced while allowing for a greater design variety.
→ For this example, select [Yes].

Select the parameters according to the procedure from step 8 to 10, when [Net Fill] is set to [Yes].

**8** Specify the net fill stitch pattern in [Pattern].
Five net fill stitch patterns are available.
→ For this example, select [Pattern 2].
9 Specify the pattern spacing for the net fill stitch in [Spacing].
→ For this example, set it to [3.0 mm].

10 Specify the pattern direction of the net fill stitch in [Direction].
→ For this example, set it to [0°].

11 Specify satin stitching after cutting in [Covering Satin Stitch].
Satin stitching is sewn along the edges of inner cutouts.
The zigzag stitch or the stem stitch is used as an underlay for the satin stitching.
→ For this example, select [Yes].

12 Specify the width of the satin stitching in [Width].
→ For this example, set it to [4.0 mm].

13 Specify the density of the satin stitching in [Density].
→ For this example, set it to [6.5 line/mm].

14 Click [OK] to exit the [Cutwork Wizard].
On Using the Cutwork Functions

Before using Cutwork functions, check the following.

**Basic requirements for Cutwork functions**

- **Set the "Machine Type" to multi-needle embroidery machine**
  
  For the Cutwork functions to be available, click , then [Design Settings]. Under [Machine Type], select .

- **Outline shapes and text can be used to create a cutwork pattern**
  
  - Outline shapes that have been drawn with the tools indicated below.
  
  - Text created in fonts other than built-in fonts 025 and 029, a user-defined font or a small text font.

- **Use a multi-needle machine that has been upgraded to work with Cutwork functions**
  
  The embroidery machine should be set to cutwork mode in the settings screen before starting to embroider. Refer to the included instruction manual for the details of embroidery machine operation.

- **Patterns when [Outline Shapes] is selected in the [From] selector of the [Import] pane.**

- **Cutwork functions cannot be used with single-needle embroidery machines. In addition, some multi-needle machines may not support the functions. Be sure to check that your machine is compatible with the cutwork functions.**
On Using the Cutwork Functions

Layout & Editing window for cutwork patterns

The settings and window areas specifically for cutwork functions are described below.

1. Sewing Order
   The cutting lines appear in one frame in the [Sewing Order] pane, and the icon for the cutwork needle appears beside the frame.

2. Design Page
   The cutting lines appear as gray dotted lines in the Design Page, regardless of whether the [Solid View], [Stitch View] or [Realistic View] is selected.

3. Sewing Attributes
   In the [Sewing Attributes] pane, detailed cutting settings can be specified for the cutwork functions.

4. Previewing cutting lines
   In the [Stitch Simulator] pane, the cutwork needles are displayed in four different shades of gray.

   In a stitch simulation, the cutting lines appear as short gray lines, indicating the needle drop points for making the cuts.

   "Cutting" in the "Line sewing attributes" on page 362

While being edited

In a stitch simulation
Checking Design Property

When [Cutting] has been assigned to a line from the [Line sew type] selector, [Design Property] screen appears as shown below.

Transferring/saving/exporting the cutwork patterns

In addition to transferring cutwork patterns to a machine, they can be saved or printed.

- **Transferring**
  
  **Transferring using USB media**
  
  By using commercially available USB media, cutwork patterns can be transferred to embroidery machines compatible with the USB media.

  "Transferring to a machine by using USB media" on page 221

  **Transferring directly to a machine’s memory**
  
  Cutwork patterns can be transferred to embroidery machines that can be connected to a computer using a USB cable.

  "Transferring directly to a machine’s memory" on page 222

- **Saving**
  
  **Saving cutwork patterns in the PES format**
  
  For details, refer to "Saving and Printing" on page 106.

  Designs containing the line sew type [Cutting] are saved as cutwork patterns.
Exporting

Exporting cutwork patterns in other formats

Created cutwork patterns can be converted to other formats (.dst, .hus, .exp, .pcs, .vip, .sew, .jef, .csd, .xxx, and .shv) and outputted.

When exported as another format, the cutting lines will be changed to a running stitch.
Tutorial 10-1: Creating Split Embroidery Designs

Layout & Editing has a function for creating split embroidery designs when the embroidery pattern being created is larger than the embroidery hoop.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_10.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Specifying the Design Page size in Layout &amp; Editing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Creating the embroidery design</td>
</tr>
<tr>
<td>Step 3</td>
<td>Checking the embroidering order</td>
</tr>
<tr>
<td>Step 4</td>
<td>Attaching stabilizer to the fabric</td>
</tr>
<tr>
<td>Step 5</td>
<td>Using the Positioning Sheet to mark the embroidering position on the fabric</td>
</tr>
<tr>
<td>Step 6</td>
<td>Hooping the fabric</td>
</tr>
<tr>
<td>Step 7</td>
<td>Embroidering</td>
</tr>
</tbody>
</table>

1. Click , then [Design Settings].

2. Specify the Design Page size and the size of the design sections.

3. Select [Custom Size], and then type or select the desired width and height for the Design Page. This setting is to specify the exact width and height of a design. For this example, set width to 230 mm and height to 330 mm.

4. Select the [Use smaller section sizes.] check box to create sections that are smaller than normal. This makes it easier to connect large-size split embroidery patterns. For this example, clear this check box.

5. Click the [Section Size (for Hoop Size)] selector, and then select the size of the sections (your embroidery hoop). For this example, select 120 × 170 mm (130 × 180 mm).

"Changing the size of sections" on page 200

With the [Section Size (for Hoop Size)] setting, the width and height of the sections are 10mm smaller than the actual hoop size in order to provide space for fine positioning adjustments with adjustment sections. The 10mm is for overlapping.

It is not necessary for the [Section Size (for Hoop Size)] to match the Design Page size. Select the hoop size to be used for sewing.

6. Click [OK].
Step 2 Creating the embroidery design

For this example, we will use one of the lace embroidery patterns provided with the software.

1. Display the [Import] pane.
2. Select [Tutorial] from the [From] selector and [Tutorial_10] from the [Category] selector. Click [tutorial_10-1.pes], then [Import].

"Importing embroidery designs" on page 101.

Step 3 Checking the embroidering order

Check the sewing order to see the order that the design sections will be sewn and determine which parts of the fabric should be hooped. The design sections are sewn in order from left to right, top to bottom.

1. Click , then [Design Property].

2. Uncheck the [Show about selected Object(s)] to view the separate design sections. Click on [Next] and [Previous] to move back and forth through each section. Check the design, and then click [Cancel].

Memo of "Step 7 Embroidering" on page 198
Step 4 Attaching stabilizer to the fabric

Stabilizer must always be used when embroidering to stabilize the fabric. There are many types of stabilizer; the type that you will use depends on the type of fabric that you are embroidering on. For large-size designs that are split into sections, the stabilizer must be adhered to the fabric, for example, iron-on stabilizer. In some cases, you may need to use two pieces of stabilizer for your embroidery.

When using spray adhesive, spray the adhesive onto a hooped piece of stabilizer that is strong enough for the entire large-size embroidery. In some cases, you may need to use two pieces of stabilizer for your embroidery.

⚠️ For best results, attach the stabilizer to the fabric (as described on this page). Without the correct stabilizer, the design may become misaligned due to puckering in the fabric.

Be sure to check the recommendations on the stabilizer package.

Step 5 Using the Positioning Sheet to mark the embroidering position on the fabric

The positioning sheets are included in the package.

The Positioning Sheets are also in the [Positioning Sheet] folder and can be printed out with a printer.

Location of the Positioning Sheets: C:\Program Files (x86)\Baby lock\Palette Ver.11\Positioning Sheet.

The positioning sheets in the PDF files are at actual size. When printing the positioning sheet from the PDF file, be sure to print it at actual size. Do not print while reducing or enlarging to fit the paper size.

1. Punch a hole at the end of each arrow on the positioning sheet.

2. Place the positioning sheet on the fabric, and then insert the tip of a marking pen into each hole to mark the fabric.

3. Connect the points marked on the fabric to draw reference lines. The intersections of the lines drawn on the fabric are marked as a, b, c and d. In addition, the intersections of the lines on the positioning sheet are marked as A, B, C and D.

4. Place the positioning sheet on the fabric. Align points A and D on the positioning sheet with marks b and c on the fabric, and then repeat steps 2 and 3 to draw reference lines on the fabric for an embroidering position on the right side.
5 Place the positioning sheet on the fabric. Align points A and B on the positioning sheet with marks d and c on the fabric, and then repeat steps 2 and 3 to draw reference lines on the fabric for an embroidering position below the first one.

6 Repeat steps 4 through 5 to reposition the positioning sheet and draw the embroidering position for each section of the embroidery pattern.

**Step 6 Hooping the fabric**

1 Insert the embroidery sheet into the inner ring of the embroidery hoop, and then place them on top of the fabric with the centerline on the embroidery sheet aligned with the reference lines (drawn on the fabric) for the first pattern section to be sewn.

2 Keeping the reference lines on the embroidery sheet aligned with the reference lines for the first pattern section, place the fabric and inner ring of the embroidery hoop into the outer ring of the hoop, and then pull the fabric so that it is tight.

3 Finish hooping the fabric, and then remove the embroidery sheet.

• The intersection of the horizontal and vertical line indicates the center of the embroidery hoop.
• While carefully considering how the fabric will be hooped, place the positioning sheet on the fabric, and then draw lines to indicate the embroidering position. In addition, because all embroidery areas are not drawn on the positioning sheet for large embroidery hoops, be careful that the embroidery area does not extend from the marked area on the fabric as shown below.
When large-size embroidery designs are transferred to the embroidery machine, the patterns appear on the embroidery machine display as shown below. For this example, select the first embroidery pattern section (Aa).

If there is no stitching in section Aa, select the first section that contains stitching. Click on [Application] button, and then click [Design Property] to check the embroidering order.

Attach the embroidery hoop to the embroidery machine, and then using the machine's layout adjusting functions, align the needle position with the intersection of the lines drawn on the fabric.

Embroider the selected pattern.

Remove the embroidery hoop from the embroidery machine, and then remove the fabric from the hoop.

Hoop the fabric for the next design section.

When an embroidery design created in a custom Design Page is saved or transferred to an original card, alignment stitching (single lines of running stitches with the color [NOT DEFINED], with a pitch of 7.0 mm, and starting with fixed stitches with a pitch of 0.3 mm) is added at the edges of the design sections. (The alignment stitching appears in the print preview and is printed in red.)

Sample data for this tutorial:

(1) Embroider the upper-left design section.
   → Alignment stitching is sewn below and on the right side of the embroidered design section.

(2) Hoop the fabric for the upper-right design section with the left side of the hoop aligned on the alignment stitching on the right side of the design section sewn in step (1), and then embroider the design.
   → Before the design section is embroidered, alignment stitching is sewn on the left side. Make sure that this alignment stitching aligns with the alignment stitching sewn in step (1). After the design section is embroidered, alignment stitching is sewn below the design section.
(3) Hoop the fabric for the lower-left design section with the top of the hoop aligned on the alignment stitching at the bottom of the design section sewn in step (1), and then embroider the design.

→ Before the design section is embroidered, alignment stitching is sewn at the top. Make sure that this alignment stitching aligns with the alignment stitching sewn in step (1). After the design section is embroidered, alignment stitching is sewn on the right side of the design section.

(4) Hoop the fabric for the lower-right design section with the left side of the hoop aligned on the alignment stitching on the right side of the design section sewn in step (3) and with the top of the hoop aligned on the alignment stitching at the bottom of the design section sewn in step (2), and then embroider the design.

→ Before the design section is embroidered, alignment stitching is sewn on the left side and at the top. Make sure that this alignment stitching aligns with the alignment stitching sewn in step (3) and in step (2).

6 Continue hooping the fabric and embroidering until the entire embroidery design is sewn.

- The procedure is different for models that use a built-in camera to connect large-size split embroidery patterns.
- For models that use a built-in camera, embroidery positioning stickers can be used.
- For details, refer to the instruction manual provided with the embroidery machine.
- By adjusting the size of the sections, patterns can easily be connected.

"Changing the size of sections" on page 200
Specifying Settings for Split Embroidery Designs

Changing the size of sections

By reducing the size of the sections, patterns can easily be connected when split embroidery designs are embroidered.

1. Create a split embroidery pattern.

2. Click , then [Design Settings].

3. Select [Custom Size], and then type or select the desired width and height for the Design Page.
   - For details on creating split embroidery designs, refer to “Tutorial 10-1: Creating Split Embroidery Designs” on page 194.

4. Select the [Use smaller section sizes.] check box.

5. Click [OK].
   - The section size is changed.

- Select the [Use smaller section sizes.] check box to create sections with a size of 10 mm less than normal on all sides.
- For a better result, embroidery positioning stickers can be used for models with built-in camera. For details, refer to the instruction manual provided with the embroidery machine.
Adjusting the split positions in split embroidery designs

By specifying the split positions for each hoop section, you can sew embroidery patterns without the need to split patterns smaller than the embroidering area.

Adjusting the split positions

1. Create a split embroidery pattern.

   ➤ “Tutorial 10-1: Creating Split Embroidery Designs” on page 194

2. Click the [Hoop Settings] tab.

   The [Hoop Settings] tab appears only if [Custom Size] was selected in the [Design Settings] dialog box.

3. Click [Move Sections] in the [Hoop Settings] group.

   ➤ appears in the ruler.

4. Drag to adjust the split position. The frame being moved appears as a solid red line.

   ➤ The split positions are changed.

• This is useful in preventing patterns smaller than the embroidering area from being split, reducing the number of thread color changes and allowing you to change the split positions of the pattern.

• Click , then [Design Property] to check the split pattern.

   ➤ “Checking the embroidering order” on page 195

• The settings are reset when the embroidery frame is changed.
Printing the positioning sheets
After specifying split positions for the hoop sections, new positioning sheets are necessary in order to correctly position the pattern.

1. Click \(\text{Print}\), then [Print], then [Print Setup].
2. Change the print settings.

   - Select option to print a positioning sheet for each section.
   - Select check box to print only one positioning sheet (one size).
   - Clear check box to print a positioning sheet for each section.

3. Click [Print] to print the positioning sheets.
   \(\rightarrow\) A page (①) showing the entire pattern, the pattern size and file name as well as a positioning sheet (②) for each section are printed.

   For details on using positioning sheets to connect large-size split embroidery patterns, refer to "Using the Positioning Sheet to mark the embroidering position on the fabric" on page 196.
Tutorial 10-2: Creating Design for Multi-Position Hoops

This program enables you to create multi-position designs that you can stitch in any multi-position hoop attached to your embroidery machine.

Although the size of the design that can be embroidered using an multi-position hoop is 130 × 180 mm (or 100 × 100 mm, depending on the sewing area of the embroidery machine), first determine which of the three installation positions (indicated as a, b, and c in the illustration above) the multi-position hoop will be installed at and determine the orientation of the design.

When creating the design, each design section can only be as large as the sewing area of the embroidery machine.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_10.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Selecting the Design Page size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Creating the design</td>
</tr>
<tr>
<td>Step 3</td>
<td>Optimizing hoop changes</td>
</tr>
<tr>
<td>Step 4</td>
<td>Checking the pattern</td>
</tr>
</tbody>
</table>

**Step 1 Selecting the Design Page size**

1. Click , then [Design Settings].

**Step 2**

2. Select  under [Machine Type], and then select [Hoop Size] and choose a Design Page size of 130 × 300 mm or 100 × 172 mm from the selector. Then, click [OK].
Step 2 Creating the design

1. The Design Page appears on the screen as shown below.

- **Area a**
  Embroidering area when the multi-position hoop is installed at the top installation position.

- **Area b**
  Embroidering area when the multi-position hoop is installed at the middle installation position.

- **Area c**
  Embroidering area when the multi-position hoop is installed at the bottom installation position. The dotted lines separate each area.

2. Create the design, making sure that it meets the following conditions.

- The size of one pattern must be no larger than 100 × 100 mm (or 130 × 180 mm).
- Each pattern must completely fit within a single area (a, b, or c).

---

1: The position of this pattern is correct since it fits completely within area a.
2: The position of this pattern is correct since it fits completely within either area b or area c.
3: The size of this pattern is acceptable, but its position must be corrected since it does not fit completely within any of the areas. (It will be necessary to correct the position in order to fit in either b or c.)
4: This pattern must be corrected since it is too large. (It will be necessary to correct the position and size in order to fit in either a, b, or c.)
Step 3  Optimizing hoop changes

1. Click , then [Design Settings].

2. Click [Output] tab.

3. Select the [Optimize the number of times to change the hoop’s position] check box, and then click [OK].

- A check mark appears when this function is turned on; no check mark is displayed when this function is turned off.

- When the Optimize hoop change function is turned on, the sewing order that you have set is optimized to reduce the number of times that the hoop installation position is changed.

For the example shown on this page, the sewing order is: a (pattern 1) → b (pattern 2) → a (patterns 3 & 5) → c (patterns 4 & 6)

If the Optimize hoop change function is turned off, each pattern is sewn according to the sewing order that you have set.

For the example shown on this page, the sewing order is: a (pattern 1) → b (pattern 2) → a (pattern 3) → c (pattern 4) → a (pattern 5) → c (pattern 6)

Therefore, since the number of times for changing the hoop installation position is not optimized, it may be changed more often than if it was optimized.

Since the pattern may not be sewn correctly or the fabric may not feed evenly if the hoop installation position is changed too often, we recommend turning on the [Optimize hoop change] function. Turning on this function will change the sewing order that you have set, therefore, check the sewing order before you begin embroidering.
Step 4 Checking the pattern

1. Click , then [Design Property].

2. Check the sewing order of each pattern and the number of times the hoop position will be changed.

   - The position in the hoop installation order for the currently displayed pattern.
   - To display information for patterns at other positions in the hoop installation order, click [Previous] or [Next].

   | File Name: Unlabeled Design Name: |
   | File Version: 11.0 Category: |
   | Modified Date: 2012-12-04 Author: |
   | Width: 100.00 mm Height: 100.00 mm |
   | Stitch count: 218 Key Words: |
   | Sewing time: 1 min Convert: |
   | Color changes: 1 Total colors: 1 |

   Only the patterns that would be sewn at the current position in the hoop installation order appear in the Design Page, and the embroidering area for the current hoop position is outlined in red.

   - The position in the hoop installation order for the currently displayed pattern.
   - To display information for patterns at other positions in the hoop installation order, click [Previous] or [Next].

   If a pattern is larger than the embroidery area or if a pattern is positioned so that it does not completely fit within an embroidery area, the error message appears. After the pattern causing the error is displayed, select the pattern and change its size or position.

   - Saving the design
     The entire design is saved as a single file (.pes).

     If the file size or the number of color changes is larger than the specified number, or if one of the patterns does not completely fit within an embroidery area, the error message appears.

   - Writing the design to an original card
     A design for a multi-position hoop is created by considering the pattern in each hoop installation position as one pattern, then combining them. Therefore, when this type of design is written to an original card, one multi-position hoop design is saved as a combination of multiple patterns.

     - This pattern is sewn when the hoop is installed at the top installation position (position a).
     - This pattern is sewn when the hoop is installed at the middle installation position (position b).
     - This pattern is sewn when the hoop is installed at the bottom installation position (position c).

     Therefore, the frame installation position sewing order for the pattern shown above is b, a, then c.
Notes on embroidering using the multi-position hoop

- Before embroidering your design, sew a trial sample of the design on a scrap piece of fabric from your design, making sure to use the same needle and thread.
- Be sure to affix stabilizer material to the back of the fabric and tightly stretch the fabric within the hoop. When embroidering on thin or stretch fabrics, use two layers of stabilizer material. If no stabilizer material is used, the fabric may become over-stretched or wrinkled or the embroidery may not be sewn correctly.
  - For more ways to stabilize large designs, refer to "Attaching stabilizer to the fabric" on page 196
- Use the zigzag stitch for sewing the outlines in order to prevent embroidering outside the outlines.

  ![Correct](image1.png)  ![Incorrect](image2.png)

- For patterns that require the hoop to be installed at different installation positions, design the embroidery pattern so that the various parts of the pattern overlap in order to prevent misalignment while embroidering.

Printing a Design Page for a multi-position hoop

On the first page, a complete image of the Design Page is printed at actual size. (However, for a 130 × 300 mm Design Page, a reduced image of the Design Page is printed.) On the following pages, an image of each design section and its sewing information are printed in the sewing order.

When [Actual Size] is selected:
- An image of the pattern in each design section is printed on a separate page as the corresponding sewing information.

When [Reduced Size] is selected:
- An image of the pattern in each design section is printed on the same page as the corresponding sewing information.
  - "Printing" on page 107
Tutorial 10-3: Embroidering With the Jumbo Frame

This section describes the procedures for creating embroidery data and for embroidering using the jumbo frame (frame size: 360 × 360 mm; with mounts on both sides of the embroidery frame).

Jumbo frame: 360 × 360 mm embroidery frame

- If the jumbo frame was selected, the size of the Design Page becomes 350 × 350 mm in order to create margins that allow automatic positioning using the built-in camera.
- The jumbo frame described here was designed specifically for our multi-needle embroidery machines equipped with a built-in camera. It cannot be used with any other machine, such as single-needle embroidery machines. Check the instruction manual provided with your multi-needle embroidery machine to determine if it is compatible with the jumbo frame.

For details on embroidering using the camera and on affixing the embroidery positioning stickers, refer to the instruction manual provided with the embroidery machine.

The sample file for this tutorial is located at Documents (My documents)\Palette Ver.11\Tutorial\Tutorial_10.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selecting the Design Page size</td>
</tr>
<tr>
<td>2</td>
<td>Creating the embroidery design</td>
</tr>
<tr>
<td>3</td>
<td>Checking a divided pattern</td>
</tr>
<tr>
<td>4</td>
<td>Attaching stabilizer to the fabric</td>
</tr>
<tr>
<td>5</td>
<td>Embroidering</td>
</tr>
</tbody>
</table>

Step 1 Selecting the Design Page size

1. Click , then [Design Settings].
2 Click \(\text{Machine Type}\) under [Machine Type], select 360 \(\times\) 360 mm (Jumbo Frame) from the [Hoop Size] selector under [Page Size], and then click [OK].

3 The Design Page appears on the screen as shown below.

\[\text{Side 1 embroidering area} \quad \text{Area embroidered first}\]
\[\text{Side 2 embroidering area} \quad \text{Area embroidered second}\]

The embroidery pattern is automatically divided into the different areas.

Check the size of embroidery frames that can be used with your machine before changing the setting.

Step 2 Creating the embroidery design

For this example, an embroidery pattern provided with this software will be used in the procedure described below.

1 Display the [Import] pane.

2 Select [Tutorial] from the [From] selector and [Tutorial_10] from the [Category] selector. Click [tutorial_10-3.pes], then [Import].

"Importing embroidery designs" on page 101.

Step 3 Checking a divided pattern

Before starting to embroider, the divided embroidery pattern can be checked. If a pattern that you do not wish to be divided has been split onto Side 1 and Side 2, you can check the embroidery pattern, then adjust it so it is not split.

1 Click , then [Design Property].

The embroidery pattern is split with a section overlapping 1 and 2. If the pattern arranged in this section uses satin stitches, the stitch may change when the pattern is split. Therefore, we recommend shifting the pattern or changing the sew type to fill stitches.
2 Click [Next] to view the next side of the embroidery design.

To view the embroidery pattern of the separate sides, uncheck the [Show about selected Object(s)].

Saving the design
The entire design is saved as a single file (.pes).

- “Transferring to a machine by using USB media” on page 221, and “Transferring directly to a machine’s memory” on page 222

An embroidery design for the jumbo frame cannot be transferred to the machine by using an original card. Transfer these designs directly to the machine's memory or to the machine by using USB media.

Step 4 Attaching stabilizer to the fabric
Always use stabilizer when embroidering. For large designs split into sections, the stabilizer must be attached to the fabric, for example, by using iron-on stabilizer, self-adhesive stabilizer or spray adhesive. Use stabilizer appropriate for the fabric.

In addition, be sure to use stabilizer that is strong enough and large enough for the entire embroidering area. You may need to attach two layers if thin stabilizer is used.

- See more information about stabilizer, “Step 4 Attaching stabilizer to the fabric” on page 196.

Step 5 Embroidering
Embroider using the embroidery positioning stickers included with the embroidery machine. These stickers are detected by the embroidery machine’s built-in camera to automatically position the fabric.

1 Hoop the fabric in the embroidery frame.

2 Attach the embroidery frame to the embroidery machine.

3 Select the pattern for side 1, and then start the embroidery machine to embroider the side 1 embroidering area.
4 When embroidering is finished, follow the instructions on the embroidery machine to affix embroidery positioning sticker on the embroidering area.

An image of the needle location appears in the screen with the positioning detection area framed by a line. Affix an embroidery positioning sticker so that it fits within the line. For details, refer to the instruction manual for the machine.

→ The embroidery machine’s built-in camera detects the embroidery positioning sticker.

5 After the sticker have been detected, remove the embroidery frame, rotate it 180°, and then re-attach it to the embroidery machine.

→ The embroidery machine’s built-in camera detects the embroidery positioning sticker again.

6 Follow the embroidery machine instructions to remove the embroidery positioning stickers.

7 Select the pattern for side 2, and then start the embroidery machine to embroider the side 2 embroidering area.

Embroidery data for the jumbo frame

- When the embroidery design is being saved in [Layout & Editing], older file format versions are not available. In addition, the embroidery design is saved as data specifically for our multi-needle embroidery machines equipped with a built-in camera. It cannot be sewn with any other machine.
- An embroidery pattern created in a Design Page set to the jumbo frame size in [Design Center] cannot be transferred directly to the machine. Import the embroidery pattern into [Layout & Editing], and then transfer it to the embroidery machine.

- For details on using the embroidery machine, refer to the instruction manual included with it.
- Carefully remove the embroidery frame and reattach it correctly. If the embroidery frame is not correctly attached or if there is slack in the fabric, the embroidery pattern may become misaligned.
Specifying/Saving Custom Sewing Attributes

Specifying/Saving Custom Sewing Attributes

Saving frequently used sewing attributes

Frequently used sewing attributes can be saved together, and recalled when specifying sewing attributes.

■ Saving the settings in a list

1. Click the [Sewing Attributes] tab.

2. If necessary, change the settings, and then click .

3. Click [Save As].

4. Type in a name for the group of settings, and then click [OK] to register the group in a list.

■ Deleting a group of settings from the list

1. In the [Load/Save Default Settings] dialog box, select the group of settings to be deleted.

2. Click [Delete] to delete the selected group of settings from the list.

Recalling a group of settings from the list

1. In the [Load/Save Default Settings] dialog box, select the group of settings to be recalled.

- A group of settings that you have saved will appear with "*" beside its name.
- Sewing attributes appropriate for various fabrics are already available. Select the type of fabric to be embroidered to specify the recommended settings for that fabric.

2. Click [Load].

- The settings in the [Sewing Attribute Setting] dialog box change to the saved settings.

Editing user thread color lists

If you have a list of thread colors that are frequently used, they can be saved in a user thread chart.

1. Click [Option], then [Options].

- The saved setting can also be used on a different computer. Simply copy [sastu.txt] from [C:\Program Files (x86)\Baby lock\Palette Ver.11\Settings] on the original computer to the [Settings] folder at the same path on the destination computer.

- In Explorer click on C:\Program Files (x86)\Baby lock\Palette Ver.11\Settings. Single left click on the [Settings] folder to view the contents. Single right click on sastu.txt and select copy from the menu. Paste to a USB device and transfer to a different computer.
### Specifying/Saving Custom Sewing Attributes

#### Creating a new thread chart

1. Click [New Chart].
2. Type in the name of the chart, and then click [OK].

#### Renaming a thread chart

1. From the [User Thread Chart] selector, select the chart.
2. Click [Rename Chart].
3. Type in the name of the chart, and then click [OK].

#### Deleting a chart

1. From the [User Thread Chart] selector, select the chart.
2. Click [Delete Chart].
3. If a message appears, click [Yes].

---

#### Operations for Specific Applications

2. **Click [Edit User Thread Chart].**

3. A user thread chart can be saved, edited or deleted.

<table>
<thead>
<tr>
<th>1</th>
<th>Select an existing thread chart.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Adds thread colors from a existing thread chart.</td>
</tr>
<tr>
<td>3</td>
<td>When editing or deleting a thread chart, select the thread chart here before performing the operation.</td>
</tr>
<tr>
<td>4</td>
<td>Select a user thread chart.</td>
</tr>
<tr>
<td>5</td>
<td>Creates a new thread chart.</td>
</tr>
<tr>
<td>6</td>
<td>Changes the thread chart name.</td>
</tr>
<tr>
<td>7</td>
<td>Deletes a thread chart.</td>
</tr>
<tr>
<td>8</td>
<td>Imports the thread chart.</td>
</tr>
<tr>
<td>9</td>
<td>Changes the order of the thread colors.</td>
</tr>
<tr>
<td>10</td>
<td>Displays thread colors in existing thread chart.</td>
</tr>
<tr>
<td>11</td>
<td>Deletes a thread color.</td>
</tr>
<tr>
<td>12</td>
<td>Displays thread colors in the user thread chart.</td>
</tr>
<tr>
<td>13</td>
<td>Adds a new thread color.</td>
</tr>
<tr>
<td>14</td>
<td>Edits a thread color.</td>
</tr>
</tbody>
</table>

A saved thread chart can be selected from the [User Thread Chart] selector.
Specifying/Saving Custom Sewing Attributes

**Importing a thread chart**

1. Click [Import Chart].
2. Select the drive, the folder, and the btc, btc2 or csv file, and then click [Open].

Files in the .btc, .btc2 or .csv format can be imported.

   - “Changing the order of items” on page 215
3. If a message appears, click [Yes].

**Editing a chart**

1. From the [User Thread Chart] selector, select the chart.
2. Continue with the appropriate procedure. To save the changes, click [OK].

**Adding items from a thread chart**

1. From the [Thread Chart] selector, select the thread brand or a user thread chart. If multiple user thread charts have been created, thread colors can be selected from different user thread charts.
2. From the list, click the thread colors.
3. Click [Add].

   → The selected items are added to the list in the user thread chart.

**Adding a new item**

1. Click [New Item].
2. To create a new color, click [Mix].
3. Specify the color, and then click [OK] to add the specified color to the [Edit Thread] dialog box.

   - The color cannot be changed if the slider (a) is moved to the top of the scale.
4. If necessary, type in the code, brand and description into the appropriate boxes.

   - Only numbers can be entered for the code.
5. Click [OK] to add the new item to the user thread chart.

   - An asterisk (*) appears in front of the index number for items created or edited by the user.
Specifying/Saving Custom Sewing Attributes

■ Deleting items

1. From the list for the user thread chart (12), select the item to be deleted.
2. Click [Remove] (11) to delete the item from the user thread chart.

■ Editing an item

An item registered in the list for a user thread chart can be edited to change the color or thread number.

1. From the list for the user thread chart (12), select the item to be edited, and then click [Edit Item] (18).
2. Edit the item details in the same way as adding a new item.

As with newly added items, an asterisk (*) appears in front of the index number of edited items.

■ Changing the order of items

1. From the list for the user thread chart (12), select the item to be moved.
2. Click [Up] or [Down] (5) to change the order of the item.

User thread chart files

Existing user thread charts can be imported, or edited user thread charts can be used on a different computer.

- A newly created user thread chart is saved, in the .btc2 format with the same name as the thread chart, at [C:\Program Files (x86)\Baby lock\Palette Ver.11\MyChart].
- Existing user thread charts, created with the previous versions of the application such as Palette Ver.10, can be used in Palette Ver.11. Import the file "chart2.btc" from the following location; [C:\Program Files (x86)\Baby lock\Palette Ver.10\Color].
- The file "chart1.btc" in the [Color] folder cannot be imported.
- A user thread chart file in the .csv format can be imported. The .csv file should contain information for Code, Brand, Description, R, G and B, separated by commas with one color on each line. The RGB values must be within 0-255.

Example: For a .csv file

100,MyBrand,Black,10,10,10
101,MyBrand,White,245,245,245
Specifying/Saving Custom Sewing Attributes

Thread colors in embroidery patterns created with this application may appear differently on the embroidery machine, depending on the model used.

1. Embroidery machines without a function for displaying thread colors
   The specified thread color information cannot be displayed at all.

2. Embroidery machines with a function for displaying thread colors
   Of the thread color information specified in the embroidery pattern, only the thread color names are displayed on the machine. However, the names that are displayed are limited to the machine's preset thread color names. Therefore, the machine displays the names of its preset thread colors that are closest to the colors specified in the embroidery pattern.

3. Embroidery machines with a thread color index
   Some machines can display the thread information specified with this application. However, for thread colors that have been edited or added by the user (thread colors with an asterisk (*) at the left side), only the thread number is displayed.

Applying a different thread color chart

The thread colors in the pattern currently displayed in the Design Page can be converted to the colors in a specified thread color chart.

1. Click \( \text{Select Color Palette} \), then [Select Color Palette].

2. In the dialog box, select a thread color chart, and then click [OK].

→ The thread colors in all patterns in the Design Page are converted to similar colors in the specified thread color chart.
Using Manual Punch Tool

By using the [Manual Punch] tools, you can create embroidery patterns whose sewing direction lines can be manually adjusted.

Shapes drawn using the [Manual Punch] tools can be edited in the same way as shapes drawn using the [Shapes] tools.

Creating an original logo

Using the [Manual Punch] tools, an embroidery pattern can be created using an image of your logo in the background.

1. Open an image of the logo to be used to create the embroidery pattern.
   >>> "Importing Image Data" on page 162

For this example, we will create a pattern of the red design at the far left.

A faded copy of the background image can be displayed in the [Design Page].
   >>> "Adjusting the density of the background image" on page 164

2. First, select the [Manual Punch] tool. Click the [Home] tab, click [Shapes], and then click .

   : Select this tool to create straight block patterns (region sewing).
   (Shortcut key: <Z>)

   : Select this tool to create curved block patterns (region sewing).
   (Shortcut key: <X>)

   : Select this tool to create running patterns (line sewing).
   (Shortcut key: <V>)

   : Select this tool to create feed patterns (jump stitches).
   (Shortcut key: <B>)

   >>> "Jump Stitch and Jump Stitch Trimming" on page 341
3. Click points 1 through 4, in order.

4. Select the Curve tool.

5. Click points 5 through 11, in order.
   Click point 12 (last point of the pattern part), and then press the <Enter> key.


7. Click point 13, then point 14 (last point of running stitching connecting the parts), and then press the <Enter> key.
   Specify the point so that it overlaps/connects the part created in step 5.


9. Click points 15 through 23, in order.
   Click point 24 (last point of the pattern part), and then press the <Enter> key.
   Specify the point so that it overlaps/connects the part created in step 7.


   To remove an entered point, right-click it or press the <BackSpace> key.

   Instead of pressing the <Enter> key, the pattern part can be completed by double-clicking.
11 Click points 25 through 27, in order.
Click point 28 (last point of the pattern part),
and then press the <Enter> key.
Specify the point so that it overlaps/connects
the part created in step 9.

Image of finished logo

- If parts are connected to previous and following
  ones, jump stitches will not be created in order
to automatically optimize entry and exit points.
  We recommend checking stitching with the
  Stitch Simulator before sewing.
  ► "Checking the stitching with the Stitch
    Simulator" on page 89

- Manually adding or adjusting sewing direction
  lines in shape patterns afterward allows you to
  continue creating patterns using the same
  Manual Punch tools.
  ► "Specifying the straight sewing direction" on
    page 58
Transferring Data

This section describes operations for transferring embroidery designs to embroidery machines.
Transferring Embroidery Designs to Machines

The procedures for transferring the created embroidery pattern to an embroidery machine differ depending on your embroidery machine model. For details, refer to the instruction manual provided with your embroidery machine.

Transferring to a machine by using USB media

Designs can be transferred to an embroidery machine compatible with the USB Host function.

The "Palette Software Key" cannot be used as USB media. Do not save embroidery files on the "Palette Software Key" for transferring.

1. Plug the USB media into the computer.
2. Click the [Home] tab.
3. Click [Send] in the [Sew] group, click [Send to USB Media], and then select the desired drive.

Data transfer begins.

4. After the data has been transferred, the message "Finished outputting data." appears, indicating that the transfer is finished. Click [OK], and then remove the USB media.

If multiple USB media are connected, specify where the data is to be transferred in the area shown below.

If there is already a file with the same name at the destination, the following dialog box appears. Select whether to overwrite the existing file, to stop copying or to copy the file using a different name.
Transferring Embroidery Designs to Machines

Transferring directly to a machine's memory

Designs can be transferred to embroidery machines that can be connected to a computer using a USB cable.

1. Connect the embroidery machine to the computer.
2. Click the [Home] tab.
3. Click [Send] in the [Sew] group, click [Send to Your Machine], and then select the desired drive.

→ Data transfer begins.

If there is already a file with the same name at the destination, the following dialog box appears. Select whether to overwrite the existing file, to stop copying or to copy the file using a different name.

4. After the data has been transferred, the message "Finished outputting data." appears, indicating that the transfer is finished. Click [OK].

- For details on transferring designs with this method, refer to the instruction manual provided with your embroidery machine.
- If multiple machines are connected, specify where the data is to be transferred in the area shown below.

- If the connected embroidery machine has been set to Link mode, the command [Send to Your Machine], mentioned in this procedure, cannot be selected. To select this command, return the machine to normal mode.
Transferring Embroidery Designs to Machines

Transferring to a machine via wireless network

Embroidery designs can be transferred to a sewing machine via the wireless network.

This function is available only when embroidering with our wireless LAN-compatible embroidery machines. Contact your Baby Lock retailer for details on our wireless LAN-compatible models.

Registering a machine with the application

1. Connect the computer running the application to your home network (wireless LAN access point).
2. Connect the sewing machine to the same home network.
For details on making connections, refer to the manual provided with your machine.

Embroidery patterns cannot be transferred if the computer and sewing machine are connected to different home network. Be sure to connect to the same home network.

3. Click the icon, and then click [Options] at the bottom of the command list.

4. Click [Network Machine Settings], and then click [Add].

The names of sewing machines connected to your home network (wireless LAN access point) appear.

5. Select the sewing machine, and then click [Add].

6. Click [OK] to register the machine.

To unregister a machine, select the machine, click [Delete], and then click [OK].
Transferring embroidery patterns to a sewing machine

1. Click the [Home] tab.

2. Click [Send] in the [Sew] group, click [Send to Network Machine], and then select the desired machine.

→ Data transfer begins.

3. After the data has been transferred, the message “Finished outputting data.” appears, indicating that the transfer is finished. Click [OK].

Transferring to a machine by using an original card

Designs can be transferred to an embroidery machine equipped with a card slot.

- Be sure that the hoop size of the design does not exceed the hoop that will be used on the embroidering machine.
- When writing to an original card that already contains data, all data on the card will be deleted. Before writing to a card, save all necessary data to a hard disk or other media, and check that no necessary data remains on the card.

For details on writing multiple embroidery designs, refer to “Transferring Embroidery Designs to Machines” on page 275.

1. Plug the USB card writer module. Insert an original card into the USB card writer module.

2. Click the [Home] tab.
Click [Send] in the [Sew] group, and then click [Write to Card].

When the following message appears, click [OK].

Data transfer begins. The following message appears while the data is being transferred.

After the data has been transferred, the following message appears, indicating that the transfer is finished. Click [OK].

Transferring split embroidery designs

Embroidery patterns for the split patterns created on the custom-sized Design Page are written to cards split into their separate sections.

If the total size of the pattern exceeds the capacity of the media or the machine’s memory or if the pattern is split into over 80 sections with a Design Page size of 90 × 90 cm (35.4” × 35.4”), you will need to split the pattern and write the separate sections onto several media.

If all pattern sections cannot be saved with a single operation, the [Select Hoop Sections] dialog box appears. Select pattern sections until the media becomes full.

The card capacity indicator at the top of the dialog box shows the amount of space available on the card (white) and the amount of space used by the pattern sections (blue). When a pattern section is selected, the total amount of space used by the selected pattern sections appears in blue. If the capacity is exceeded, the entire card capacity indicator appears in red. To deselect a pattern section, click it again.

Click [Write] to write the selected pattern sections to the media. (The [Write] button is available only when a pattern section is selected and there is sufficient space on the media for the selected pattern sections.)

For details on creating split embroidery designs, refer to “Tutorial 10-1: Creating Split Embroidery Designs” on page 194.
Using the Link Function to Embroider From the Computer

There are two types of Link functions: [USB Link] and [Wireless Link]. If [Link] is listed in the settings screen of your embroidery machine, your machine supports the USB Link function.

USB Link

Embroidery designs can be embroidered by transferring the embroidery data from the computer to one or more embroidery machines compatible with the USB Link function. Connect the embroidery machine and computer with a USB cable. These embroidery designs are embroidered after the data is sent from the computer to the embroidery machine in the same way that a document is printed after the data is sent from a computer to a printer.

1. Create an embroidery design in [Layout & Editing].
2. Set the embroidery machine in USB Link mode.
   • Turn on the USB Link function of the embroidery machine, and then turn off the machine.
3. Use the USB cable included with the embroidery machine to connect the machine to the computer.
   • Turn on the embroidery machine.
4. Click the [Home] tab.

• The USB Link function can be used only with embroidery machines compatible with the function; it cannot be used with other machines. For details, refer to the instruction manual provided with your embroidery machine.
• The USB Link function cannot be used with the following embroidery designs.
  ◆ Size exceeds the area that can be embroidered with the machine
  ◆ Embroidery designs in a Design Page of a custom size or for the jumbo frame
  ◆ Size selected in the [Hoop Size] selector of the [Design Settings] dialog box is for an embroidery hoop that does not completely fit within the maximum embroidering area of the embroidery machine to which the data is transferred
• Up to four embroidery machines can be connected using the USB Link function.

For details on setting the machine in USB Link mode, refer to the instruction manual provided with your embroidery machine.

• For details on connecting the machines to the computer, refer to the instruction manual provided with your embroidery machine.
• If the machine is positioned far from the computer, we recommend you to use a self-powered USB hub. Do not use USB extension cables or repeater cables.
• Do not connect or disconnect the USB cable while the machine is turned on.
• Select [Power Options] in [Control Panel], and then set both [System standby] and [System hibernates] to [Never].
5 Click [Send] in the [Sew] group, and then click [USB Link].

6 After the design has been transferred, press the start/stop button on the embroidery machine to begin embroidering.

The transferred data cannot be edited from the embroidery machine. The received data can only be embroidered. However, embroidering settings can be specified.

When embroidering is started, the following appears in the [USB Link] dialog box.

- Transferred design
- Queue
- Shows the status of the embroidery machine.
- Status indication

Each status indication is described below:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td>Press the button on the embroidery machine (Start/Stop button) to start sewing.</td>
</tr>
<tr>
<td>Waiting</td>
<td>If there is no data in the queue, select [USB Link] as the destination in the application, and send data. If this is the status even though there is data in the queue, continue the operation by using the machine's operation panel.</td>
</tr>
<tr>
<td>Sewing</td>
<td>The machine is sewing.</td>
</tr>
<tr>
<td>Paused</td>
<td>The machine has temporarily been stopped.</td>
</tr>
<tr>
<td>Color change</td>
<td>Change the thread spool on the machine.</td>
</tr>
<tr>
<td>Check thread</td>
<td>Check the bobbin thread or the upper thread on the machine.</td>
</tr>
<tr>
<td>Check frame</td>
<td>Install a different embroidery frame on the machine.</td>
</tr>
<tr>
<td>Error</td>
<td>Check the details of the error that occurred on the machine.</td>
</tr>
</tbody>
</table>

If the data sent from [Layout & Editing] does not appear in the transferred design box, continue the operation by using the machine's operation panel.

If you want to send more than one design to the [USB Link] dialog box, repeat steps 4 and 5 for each design. The [USB Link] dialog will remain open while the selected design from [Layout & Editing] will be sent to the Link.
If multiple designs were sent to a single machine

Multiple embroidery designs can be embroidered after being sent to the [USB Link] dialog box. In this case, the dialog box appears as shown below.

- Design Database is available to send multiple designs at a time.
  - “Sending embroidery designs to machines by using the Link function” on page 280
- With the [Name Drop] function, you can also send multiple designs where only the text is replaced.
  - “Outputting patterns using text from the text list” on page 136

The following operations can be performed from this dialog box.

1. Moves the selected design(s) to the beginning of the embroidering order.
2. Moves the selected design(s) one position forward in the embroidering order.
3. Moves the selected design(s) one position backward in the embroidering order.
4. Moves the selected design(s) to the end of the embroidering order.
5. Automatically adjusts the embroidering order of the designs to reduce as much as possible the number of thread color changes.
6. Deletes the selected design(s) from the [USB Link] dialog box.

Before the message “The machine will move. Keep your hands etc. away from the machine.” appears on the machine and [OK] is pressed, the embroidering order of the designs, including the first one, can be changed since the first design has not yet been sent to the machine.

If multiple embroidery machines are connected

The [Distributor] dialog box appears, in addition with the [USB Link] dialog box for each embroidery machine. The designs in the [Distributor] dialog will all be selected. Specify which file is to be transferred to which machine.

Distributor dialog box

1. Selects all embroidery designs.
2. Deselects the embroidery designs.
3. Deletes the selected embroidery design. (The design is deleted without being moved to the <Recycle Bin>.)

- For multiple designs to be sent in Layout & Editing, repeat step 5 for each design.
  - “USB Link” on page 226
- When using Design Database, multiple patterns can be sent once in the [Distributor] dialog box.
  - “Sending embroidery designs to machines by using the Link function” on page 280
1. Select a machine in the [Machine Name] selector, select an embroidery file, and then click [Send].

- Machine Name
  Sends the selected embroidery file to the [USB Link] dialog box.

- The [Distributor] dialog box can also be displayed by clicking [Distributor] on the [Option] menu of the [USB Link] dialog box.

- The initial machine name is the machine’s ID. For details, refer to the instruction manual provided with your embroidery machine.

- The name of the machine can be changed. For details, refer to “Changing the embroidery machine name appearing with the USB Link function” on page 230

→ The embroidery designs are moved to the [USB Link] dialog box.

2. Repeat step 1 to move each design to the [USB Link] dialog box.
Changing the embroidery machine name appearing with the USB Link function

1. Click [Machine Name] in the [Option] menu of the queue whose name is to be changed.

2. Type the name in the [Machine Name] box, and then click [OK].

To disconnect the USB cable, or shut down the computer

- After data transferring to embroidery machine and the transferring message on the screen of the machine is closed, you can disconnect the USB cable, or shut down the computer. When connected to the embroidery machine again, you can continue the USB Link operation.
- The embroidery machine can finish sewing the design currently being embroidered even if the computer is turned off.
- If the embroidery machine is turned off while it is embroidering, the resume operation can be used the next time it is turned on. At that time, transmission can be resumed using the USB Link function by clicking [USB Link] in [Design Database] or in the [Option] menu of [Layout & Editing] to display the [USB Link] dialog box.
- If the embroidery machine connection cannot be detected, the [USB Link] dialog box will close automatically.
- To display the [USB Link] dialog box again after the computer has been restarted, click [USB Link] in [Design Database] or in the [Option] menu (in the upper-right corner) of [Layout & Editing].
- To display the [Distributor] dialog box, click [Distributor] in the [Option] menu of the [USB Link] dialog box.

A name (up to 10 alphanumeric characters/symbols) can be specified for the embroidery machine.

When an embroidery machine is connected to the computer, the embroidery machine is recognized by the computer as a removable disk and is assigned a drive letter. If this drive letter is the same as one that has already been assigned by the computer, designs cannot be sent from the computer to that embroidery machine. This problem occurs, for example, if a network drive has been assigned a computer drive letter. If this occurs, cancel the assignment for the drive with the conflicting drive letter.

When the number of embroidery machines connected to the computer via USB is increased, the operating system may require that the computer be restarted. At that time, restart the computer.
Using the Link Function to Embroider From the Computer

**Wireless Link**

Embroidery designs can be embroidered by transferring the embroidery data from the computer to one or more embroidery machines that support the Wireless Link function. This is useful when the embroidery machine and computer are set up where they cannot be connected with a USB cable.

- The Wireless Link function can be used only with embroidery machines compatible with the function; it cannot be used with other machines. For details, refer to the instruction manual provided with your embroidery machine.
- The Wireless Link function cannot be used with the following embroidery designs:
  - Size exceeds the area that can be embroidered with the machine
  - Embroidery designs in a Design Page of a custom size or for the jumbo frame
  - Size selected in the [Hoop Size] selector of the [Design Settings] dialog box is for an embroidery hoop that does not fit within the maximum embroidering area of the embroidery machine to which the data is transferred
- Up to ten embroidery machines can be connected using the Wireless Link function.

1. Create an embroidery design in [Layout & Editing].
2. Connect to the embroidery machine wirelessly, and then set to the Link mode that uses a wireless network connection.

For details on setting the machine, refer to the instruction manual provided with your embroidery machine.

3. Click [ ], and then click [Options]. Display the [Network Machine Settings] dialog box, and then register an embroidery machine on the network.

4. Click the [Home] tab.
5. Click [Send] in the [Sew] group, and then click [Wireless Link].

- Transferred design Displays transferred data. If [Connection Error] occurred, the error information appears.
- Queue Displays the data before it is transferred to the embroidery machine.
- When the machine is ready to start loading the data, data transfer begins. While the data is being transferred, a message appears in the screen of the embroidery machine, and the design moves to the transferred design area.

For detailed instructions, see “Transferring to a machine via wireless network” on page 223.
After the design has been transferred, press the start/stop button on the embroidery machine to begin embroidering.

The transferred data cannot be edited from the embroidery machine. The received data can only be embroidered. However, embroidering settings can be specified.

When embroidering is started, the following appears in the [Wireless Link] dialog box.

Each status indication is described below

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td>Press the button on the embroidery machine (Start/Stop button) to start sewing.</td>
</tr>
<tr>
<td>Waiting</td>
<td>If there is no data in the queue [Wireless Link], select [Wireless Link] as the destination in the application, and send data. If this is the status even though there is data in the queue, continue the operation by using the machine's operation panel.</td>
</tr>
<tr>
<td>Sewing</td>
<td>The machine is sewing.</td>
</tr>
<tr>
<td>Paused</td>
<td>The machine has temporarily been stopped.</td>
</tr>
<tr>
<td>Color change</td>
<td>Change the thread spool on the machine.</td>
</tr>
<tr>
<td>Check thread</td>
<td>Check the bobbin thread or the upper thread on the machine.</td>
</tr>
<tr>
<td>Check frame</td>
<td>Install a different embroidery frame on the machine.</td>
</tr>
<tr>
<td>Error</td>
<td>Check the details of the error that occurred on the machine.</td>
</tr>
<tr>
<td>Connection Error</td>
<td>The error information appears in the box where the transferred design is displayed. If the embroidery machine is not in Wireless Link mode, start it up in Wireless Link mode. If a network error has occurred, check the network connection between the computer and embroidery machine.</td>
</tr>
<tr>
<td>Connecting...</td>
<td>Searching for an embroidery machine on the same network.</td>
</tr>
</tbody>
</table>

If the data sent from [Layout & Editing] does not appear in the transferred design box, continue the operation by using the machine's operation panel.

If you want to send more than one design to the [Wireless Link] dialog box, repeat steps 4 and 5 for each design. The [Wireless Link] dialog will remain open while the selected design from [Layout & Editing] will be sent to the Link.
If multiple designs were sent to a single machine

Multiple embroidery designs can be embroidered after being sent to the [Wireless Link] dialog box. In this case, the dialog box appears as shown below.

- Design Database is available to send multiple designs at a time.
  - “Sending embroidery designs to machines by using the Link function” on page 280
- With the [Name Drop] function, you can also send multiple designs where only the text is replaced.
  - “Outputting patterns using text from the text list” on page 136

Before the message “The machine will move. Keep your hands etc. away from the machine.” appears on the machine and [OK] is pressed, the embroidering order of the designs, including the first one, can be changed since the first design has not yet been sent to the machine.

If multiple embroidery machines are connected

The [Distributor] dialog box appears, in addition with the [Wireless Link] dialog box for each embroidery machine. The designs in the [Distributor] dialog will all be selected. Specify which file is to be transferred to which machine.

The following operations can be performed from this dialog box.

1. Moves the selected design(s) to the beginning of the embroidering order.
2. Moves the selected design(s) one position forward in the embroidering order.
3. Moves the selected design(s) one position backward in the embroidering order.
4. Moves the selected design(s) to the end of the embroidering order.
5. Automatically adjusts the embroidering order of the designs to reduce as much as possible the number of thread color changes.
6. Deletes the selected design(s) from the [Wireless Link] dialog box.
7. Reconnects to the machine if communication was interrupted. Available only if a network error has occurred.

- For multiple designs to be sent in Layout & Editing, repeat step 5 for each design.
  - “Wireless Link” on page 231
- When using Design Database, multiple patterns can be sent once in the [Distributor] dialog box.
  - “Sending embroidery designs to machines by using the Link function” on page 280
Transferring Data
Using the Link Function to Embroider From the Computer

1. Select a machine in the [Machine Name] selector, select an embroidery file, and then click [Send].

   ![Image of the Distributor window]

   1. **Machine Name**
   2. Sends the selected embroidery file to the [Wireless Link] dialog box.
   3. The [Distributor] dialog box can also be displayed by clicking [Distributor] on the [Option] menu of the [Wireless Link] dialog box.

   - With embroidery machines that support Wireless Link mode, the name registered with the embroidery machine appears as the machine name. For details, refer to the instruction manual provided with your embroidery machine.

   → The embroidery designs are moved to the [Wireless Link] dialog box.

2. Repeat step 1 to move each design to the [Wireless Link] dialog box.

   ![Image of the Wireless Link dialog box]

   - To exit Wireless Link mode, click X in the upper-right corner of the [Wireless Link] dialog box.
   - If the embroidery machine is turned off while embroidering, a network error will occur. Turn the machine off, then on again, and then press to re-establish the connection.
   * It may not be possible to re-establish the connection, even after pressing , until the embroidery machine has restarted.
Changing the number of connected embroidery machines

Click [Options] in the [Wireless Link] dialog box to display the [Network Machine Settings] dialog box. In the list of registered embroidery machines, select the check box of the embroidery machine to connect to, and then click [OK].

→ The [Wireless Link] dialog box for the embroidery machine appears.

- To switch between Wireless Link and USB Link, close the dialog box, click [Send] in the [Sew] group, and then click either [Wireless Link] or [USB Link].
  Set the appropriate Link function on the embroidery machine (Wireless LAN or USB cable).
This section describes the basic operations performed in Design Center. A simple step-by-step procedure is provided to create an embroidery pattern from a template image, such as an illustration.
### Design Center

#### Application button menu

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wizard</td>
<td>p. 251</td>
</tr>
<tr>
<td>2</td>
<td>New Line Image</td>
<td>p. 254</td>
</tr>
<tr>
<td>3</td>
<td>New Figure Data</td>
<td>p. 256</td>
</tr>
<tr>
<td>4</td>
<td>Open</td>
<td>p. 252</td>
</tr>
<tr>
<td>5</td>
<td>Save</td>
<td>p. 266</td>
</tr>
<tr>
<td>6</td>
<td>Save As</td>
<td>p. 266</td>
</tr>
</tbody>
</table>

#### Ribbon menu tabs

##### Original Image tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Image</td>
<td></td>
</tr>
</tbody>
</table>

##### Line Image tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pen Tools</td>
<td>p. 242</td>
</tr>
<tr>
<td>2</td>
<td>Eraser Tools</td>
<td>p. 242</td>
</tr>
<tr>
<td>3</td>
<td>Zoom In</td>
<td>p. 242</td>
</tr>
<tr>
<td>4</td>
<td>Zoom Out</td>
<td>p. 242</td>
</tr>
<tr>
<td>5</td>
<td>Fit window</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Pan</td>
<td>p. 242</td>
</tr>
<tr>
<td>7</td>
<td>To Original image</td>
<td>p. 251</td>
</tr>
<tr>
<td>8</td>
<td>To Figure handle</td>
<td>p. 255</td>
</tr>
</tbody>
</table>
■ Figure Handle tab

![Figure Handle tab image]

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tools</td>
<td>p. 243</td>
</tr>
<tr>
<td>2</td>
<td>Edit Point Tool</td>
<td>p. 244</td>
</tr>
<tr>
<td>3</td>
<td>Line Tool</td>
<td>p. 243</td>
</tr>
<tr>
<td>4</td>
<td>Zoom In</td>
<td>—</td>
</tr>
<tr>
<td>5</td>
<td>Zoom Out</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>Other Zoom Tools</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>Pan</td>
<td>—</td>
</tr>
<tr>
<td>8</td>
<td>Cut</td>
<td>—</td>
</tr>
<tr>
<td>9</td>
<td>Copy</td>
<td>—</td>
</tr>
<tr>
<td>10</td>
<td>Paste</td>
<td>—</td>
</tr>
</tbody>
</table>

■ View tab

![View tab image]

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reference Window</td>
<td>p. 257</td>
</tr>
<tr>
<td>2</td>
<td>Modify Template</td>
<td>p. 259</td>
</tr>
<tr>
<td>3</td>
<td>Background Image Density</td>
<td>p. 259</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Show Grid</td>
<td>p. 259</td>
</tr>
<tr>
<td>5</td>
<td>Show Grid with Axes</td>
<td>p. 259</td>
</tr>
<tr>
<td>6</td>
<td>Grid Interval</td>
<td>p. 259</td>
</tr>
</tbody>
</table>
### Sew Setting tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Region Tool</td>
<td>p. 260</td>
</tr>
<tr>
<td>2</td>
<td>Line Tools</td>
<td>p. 261</td>
</tr>
<tr>
<td>3</td>
<td>Hole Sew Tool</td>
<td>p. 264</td>
</tr>
<tr>
<td>4</td>
<td>Stamp Tools</td>
<td>p. 265</td>
</tr>
<tr>
<td>5</td>
<td>Zoom In</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>Zoom Out</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>Fit window</td>
<td>—</td>
</tr>
<tr>
<td>8</td>
<td>Pan</td>
<td>—</td>
</tr>
</tbody>
</table>

### View tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reference Window</td>
<td>p. 257</td>
</tr>
<tr>
<td>2</td>
<td>Sewing Attributes</td>
<td>p. 262</td>
</tr>
</tbody>
</table>
Basic Design Center Operations

In Design Center, embroidery patterns can be created from an original image. In addition, you can specify colors and sewing attributes for the lines and regions that are more detailed than those specified with the [Auto Punch] function in Layout & Editing.

An embroidery design is created in the following four stages.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Step 2</th>
<th>Step 3</th>
<th>Step 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Image Stage</td>
<td>Line Image Stage</td>
<td>Figure Handle Stage</td>
<td>Sew Setting Stage</td>
</tr>
</tbody>
</table>

- Open an image file, and select the colors to be used for creating the outlines.
- The original image is converted to a black-and-white line image. Outlines can be drawn or erased. Example: The stripes in the scarf are erased. Stripes are added to the scarf.
- The line image is converted to a figure handle image. Points in the figure handle image can be edited to change the design. Example: The eyes are moved, and the facial expression is changed. A star is added to the tail of the plane.
- The sew type and thread colors are specified in the outline to complete the embroidery design. Example: By applying colors different than in the original image, the design is given a different appearance.

- If the data is saved, work can be stopped at each stage, then started again.
- The most appropriate images to use are those with few and distinct colors. Images or photos that are intricate or have gradations are not suitable since it is difficult to extract their outlines.
- Line image data is saved in the .pel format, and figure handle data is saved in the .pem format.
- The embroidery data is saved in the .pem format. To transfer .pem data created in Design Center to an embroidery machine, import the pattern into Layout & Editing, and then transfer the data to an embroidery machine.

"Importing into Layout & Editing" on page 249 and "Transferring Embroidery Designs to Machines" on page 221

This section describes the basic operations performed in Design Center. For details on the procedures or settings, refer to "Design Center Window" on page 250.
■ Extract outlines from an image

1 Click .

2 Click [Design Center] under the title [Palette Ver.11] in the screen.

3 Click .

4 Click .

5 Select the desired image file, and then click [Open].

Airplane image is located at: Documents (My documents)\Palette Ver.11\Sample\Design Center.

6 In the image displayed in the [Pick Colors] window, select the colors to be used for the outlines (embroidery lines).

→ The selected color appears in a box on the right side, and ✓ appears in the check box to show that the color is selected.

1 The desired color can be selected more easily if the [Zoom] slider is used to enlarge the image.

2 If a color other than that for the outline was selected, clear the check box beside the color to deselect it.
After selecting the colors to be used for the outlines, click [OK].
→ The line image appears in the Design Page.

Step 2 Line Image Stage

Using the Eraser

1 To erase a line, click [Eraser] in the [Tools] group, and then select a tool [ ] according to the size of the area or thickness of the line to be erased.

2 Move the pointer over the line to be erased, and then click the line or drag the pointer to erase the line.

Using the Pen

1 To draw lines, select the [Pen] in the [Tools] group, and then select a tool [ ] with the desired thickness of the line to be drawn.

2 Drag the pointer to draw a line. To add a point, click in the Design Page.

- To draw vertical or horizontal lines, hold down the <Shift> key while moving the pointer.
- If lines are drawn or erased incorrectly, click (Undo button) to undo the last operation.
- To change the display size, use [Zoom] command.
- The part of the work area that is displayed can easily be changed by using the [Pan] tool.
### Editing the extracted outline

1. When the line image is finished, click **[To Figure Handle]** in the **[Stage]** group or (the second icon from the left) in the upper-right corner of the screen.

2. Click **[OK]**.

   ➔ The line image is converted to a figure handle image.

### Moving outlines

1. Click the **[Figure Handle]** tab.

2. Click **[ ]** in the **[Tools]** group, and then click the outline to be moved.

3. Move the pointer over the outline so that the shape of the pointer changes to **[ ]**, and then drag the outline.

   Drag a handle to change the size or angle. To delete the outline, press the *<Delete>* key.

### Adding lines to the figure handle image

1. Click **[Input Line]** in the **[Tools]** group.
2 Click the start point (1), and then click the next point (2).

→ A line is drawn connecting the two points. Continue clicking to draw additional lines.

3 Double-click the end point.

■ Reshaping outlines

1 Click [Select Point] in the [Tools] group.

2 Click an outline.

1 Point
2 Pink Line

4 If the point is deleted, the corner is removed. Click the point to be deleted, and then press the <Delete> key, or click [Delete] in the [Clipboard] group.

To create a corner, drag the point (2).
To change the shape of the line, drag the point.

- If multiple points are selected, all of the points will be moved or deleted.
- To select additional points, hold down the <Ctrl> key and click each point, or drag the pointer over the points.

## Splitting lines
Lines can be split at a point.

1. Perform steps 1 and 2 in “Reshaping outlines” to select a line.
2. Select a point, and then click [Split at Point] in the [Edit] group to split the line.

## Connecting lines
Two points can be connected to form a line.

1. Perform steps 1 and 2 in “Reshaping outlines” to select a line.
2. While holding down the <Alt> key, drag the selected point to the other point that you want to connect to it.
   - The shape of the pointer changes to 💡, and a red square appears when the two points are overlapping.
3. Release the mouse button to connect the two points.
Continuing to the Sew Setting Stage

When the figure handle image is finished, continue to the Sew Setting Stage.

1. Click [To Sew Setting] in the [Stage] group or in the upper-right corner of the screen.

Step 4 Sew Setting Stage

We are now going to apply sewing attributes to the different parts of the outline to create the embroidery pattern.

Specifying sewing attributes

1. Click the [Sew Setting] tab.

2. To specify the sew type for the line, click [Line] in the [Tools] group, and then select the desired tool from [Line Sew Tool].

Even after continuing to the Sew Setting Stage, you can return to the Figure Handle Stage to edit the figure handle image.

To specify the sew type for the region, click [Region] in the [Tools] group.

Sewing attributes cannot be applied to regions if the region is not completely enclosed in an outline in the Figure Handle Stage.
4 Click the desired color.

5 Click the down arrow in the **sew type** selector and choose the desired sew type.

6 When using \( \text{ } \) or \( \text{ } \), click the outline where the sewing attributes are to be applied.

7 When using \( \text{ } \), click the region where the sewing attributes are to be applied.

To change the sewing attributes, repeat steps 2 through 7.
Sewing attributes for region cannot be applied to open regions (regions not fully enclosed in an outline), as shown in the illustration below.

If attributes cannot be applied to a region, return to the Figure Handle Stage and make sure that region is closed. Edit any broken lines with the Edit Point tool.

- From the [Sewing Attribute Setting] dialog box, detailed settings for attributes, such as the width of satin stitches and the run pitch, can be specified.
  - "Specifying sewing attributes" on page 262.
- The Reference Window is useful for specifying colors while checking the colors of the original image.

Using the Reference Window
This allows you to select colors while checking the colors in the original image.

1. Click the [View] tab.
2. Select the [Reference Window] check box in the [Show/Hide] group.
3. Click the [Image] tab.
   → The image opened in Original Image stage appears.

If [Reference] has been clicked, click [Original].
Step 5 Importing into Layout & Editing

The embroidery pattern created in Design Center can be imported into Layout & Editing. In addition, the created data can be transferred to the machine using functions in Layout & Editing.

⚠️ If the sewing attributes of an outline or region are not set, the embroidery pattern cannot be imported.

1. Click the [Sew Setting] tab.
2. Click [Send to Layout & Editing] in the [Stage] group.

→ Layout & Editing starts up.

3. Select either to import a pattern as stitch pattern or as outline pattern.

4. Specify settings for [Import], [Magnification] and [Orientation], and then click [Import].

For details on the settings [As Stitches] and [As Outlines] beside [Import], refer to "Importing embroidery design from Design Center" on page 105.
Design Center Window

- Application button
- Ribbon
- Quick Access Toolbar
- Stage button
  Indicates the current stage. Click to move to a different stage.
- Option button
- Help button
- Reference Window
  Displays all outlines and patterns in the work area, giving you an overview while you work on a detailed area.

  "Viewing outlines in the Reference Window" on page 257

- Design Page
- Work area
- Status Bar
- Refresh Window button

  "Understanding Windows" on page 13
Original Image Stage

Using the wizard

This wizard provides a step-by-step guide for creating embroidery patterns.

Click , and then select [Wizard] from the command list.

From Image
Clicking this button displays the [From Image] dialog box.

New Line Image
Clicking this button opens a new Design Page in the Line Image Stage.

New Figure
Clicking this button opens a new Design Page in the Figure Handle Stage.

Open PEM
Clicking this button displays the [Open] dialog box so that a .pem file can be selected.

Most Recently Used Files
From the list, click the name of the file, and then click [Open].

Always show Wizard at Startup
Select this check box to start up the wizard each time Design Center is started up.

Opening an image

When you click the [From Image] button in the [How do you want to produce embroidery?] dialog box, the [From Image] dialog box appears.

1 Open Image File
Clicking this button that displays the [Open] dialog box to select an image file.

2 From Clipboard
Clicking this button to paste the image on the Clipboard into the Design Page. This function can only be used when there is an image on the Clipboard.

3 From TWAIN Device
Clicking this button to import an image from a TWAIN device (such as a scanner) connected to your computer, then paste it in the Design Page.

4 Use Current Image
Clicking this button to use an image opened in the Original Image Stage. This function can only be used when an image is opened in the Original Image Stage.

“Drawing a new line image freehand” on page 254

“Drawing a new figure handle image freehand” on page 256

“Image file formats” on page 162
• To import an image from a file TWAIN device
  • Connect the TWAIN device to the computer, and then click [Image], then [Open from TWAIN Device], or click [From TWAIN Device] in the [From Image] dialog box. When the [Select Source] dialog box appears, select a device. Next, click [Select].
  • For information on using the driver interface, refer to the help manual for that interface, or contact the manufacturer of the interface.
  • Tips for scanning illustrations for Design Center
  • If the outline is not clear, trace the outline on tracing paper.
  • Better scanning results may be produced by reducing the tone of the image.

Opening a file

1. Click [Open], and then select [Open] from the command list.

2. Select the drive and the folder.

3. To open a file, select it, and then click [Open], or double-click the file’s icon.

• If an image file is selected, the file is opened in the Original Image Stage.
• If a .pel file is selected, the file is opened in the Line Image Stage.
• If a .pem file is selected, the file is opened in the Figure Handle Stage or the Sew Setting Stage.
Line Image Stage

Extracting the outlines of an image

1. In the Original Image Stage, click [To Line image].

2. Selecting the colors to be used for the outlines, and then click [OK].

- **Zoom slider**
  Use this slider to adjust the zoom ratio for displaying the image.

- **Tone slider**
  Use this slider to reduce color tones in images where it is difficult to select the outline color.

- **Noise reduction slider**
  Use this slider to reduce image noise (distortions) in images where the outline is not clear.

- Click the outline color(s) to convert into black outlines.

- Displays the colors selected in 4. To deselect a color, clear the corresponding check box.

- To extract the color boundaries, click [Detect Outlines] check box.

When the extracting color boundaries using [Detect Outlines], the colors are converted to line image as shown below.
Drawing a new line image freehand

Click 🎨 and then select [New Line Images] from the command list.

Using the Pen and Eraser tools, the line image can be drawn freehand in the Design Page.

➤ "Line Image Stage" on page 242.

In the Line Image Stage, the file will be saved as a .pel file.

➤ "Saving embroidery patterns" on page 266, and "Drawing a new figure handle image freehand" on page 256.
**Figure Handle Stage**

### Changing settings for converting to outlines

1. In the Line Image Stage, click **[To Figure Handle]**.

   ![Image of Line Image Stage](image.png)

   "Line Image Stage" on page 242.

2. Specify the desired settings in the **[Figure Object Conversion Setting]** dialog box, and then click **[OK]**.

   ![Figure Object Conversion Setting dialog box](image.png)

   - **Select a setting under [Resolution].**
     - **Fine**
       Select this setting only if the image contains many small details.
     - **Normal**
       Select this setting to provide a sufficient resolution without making the file too large.
     - **Coarse**
       Select this setting to keep the file as small as possible.

   - **To replace the black outlines with figure handle lines along the center of the outlines, select the [Thinning Process] check box, and then use the slider to select the degree of detail.**

   ![Thinning Process](image.png)

   - **ON**
   - **OFF**

   - **Use the [SIZE] slider to set the size.**

   - **You will not be able to enlarge the image beyond the limits of the Design Page area. If necessary, click [Design Page Property], and then change the Design Page size.**

   - **To create outline data from a part of the image, select the specific area by clicking [Pick Area], then dragging the pointer (+) to draw a selection frame around the area to be selected.**

When the slider is set to **[Much]**, even very thick black lines will be replaced with a line along the center.
It may not be possible for outline data to be created from an image when moving from the Line Image Stage to the Figure Handle Stage, even after various outline conversion settings have been specified. If this occurs, return to the Line Image Stage, and correct the outlines in the line image or apply corrections to the image.

**Drawing a new figure handle image freehand**

Click , and then select [New Figure Data] from the command list.

- In the Figure Handle Stage, the file will be saved as a .pem file.
- To retrieve data from a saved .pem file, use the command [Import Figure] in the [Figure Handle] tab.

**Specifying the Design Page size**

1. Click the [Figure Handle] tab.
3. Select the Design Page size, and then click [OK].

   - Select a machine type. The settings available in the [Page Size] selector differ depending on the machine type selected here.
   - To adjust the Design Page size according to the hoop size, select [Hoop Size], and then select the desired hoop size from the selector.
   - To specify a custom Design Page size, select [Custom Size], and then type or select the desired width and height for the Design Page.
   - To return to the default settings, click [Default].

- Do not select a hoop size larger than the embroidery hoop that can be used with your machine.
- Do not create a Custom Hoop larger than the embroidery hoop that can be used with your machine.
### Editing outlines

#### Scaling outlines

**Scaling numerically:**

1. Select the outline.
2. Click the [Figure Handle] tab.
3. Click [Numerical Setting] in the [Edit] group, and then select [Size].
4. Select a size, and then click [OK].

![Scaling outlines](image)

1. To change the width and height proportionally, select the [Maintain aspect ratio] check box.
2. Select whether the width and height will be set as a percentage (%) or a dimension (millimeters or inches). Type or select the desired width and height.

#### Flipping outlines horizontally or vertically

1. Select the outline.

![Flipping outlines](image)

#### Rotating outlines

**Rotating manually**

1. Select the outline.
2. Move the pointer over the rotation handle. And then drag.

**Rotating numerically**

1. Select the outline.
2. Click [Numerical Setting] in the [Edit] group, and then select [Rotate].
3. Type or select the desired rotation angle, and then click [OK].

![Rotating outlines](image)

An angle can also be selected by dragging in the [Rotate] dialog box.

#### Viewing outlines in the Reference Window

1. Click the [View] tab.
2. Select the [Reference Window] check box in the [Show/Hide] group.

![Viewing outlines](image)
**Zooming**

The [Reference Window] can be switched to display either the entire Design Page or only the embroidery pattern.

Click the [Pan/Zoom] tab, click **.**

![Displays the entire Design Page.](image)

![Displays the entire pattern.](image)

**Moving the display area frame**

The part of the outline displayed in the Design Page can be selected from the [Reference Window].

1. Move the pointer over the display area frame.
2. Drag the display area frame so that it surrounds the desired part of the outline.
   → The selected part of the outline is displayed in the Design Page.

**Redrawing the display area frame**

Instead of moving the display area frame, the frame can be redrawn to display the desired part of the outline in the Design Page.

Click the area to be displayed, or drag the pointer over the desired part of the outline in the [Reference Window].

**Displaying a different reference image**

1. Click the [Image] tab.
2. Click [Reference], then click **.**
3. Select the reference image, and then click [Open].

![Displays the entire Design Page.](image)

![Displays the entire pattern.](image)
Changing the background image

Changing the display of the background image

1. Click the [View] tab.

2. Drag the slider, or click \( \text{ or } \) in the [Template] group.

Press the shortcut key <F6> to switch between displaying the image (On (100%)) to displaying it faded at each density (75%, 50% and 25%) to hiding the image (Off).

Changing the size and position of the background image


2. Drag the template image to move it to the desired location.

Changing application settings

Changing the grid settings

1. Click the [View] tab.

2. Specify the grid settings in the [Grid] group.

   - To display the grid, select the [Show Grid] check box.
   - To hide the grid, clear the [Show Grid] check box.

   - To display the grid as solid lines, select the [with Axes] check box.
   - To display the grid as dots (intersecting points of the grid), clear the [with Axes] check box.

   - To set the grid spacing, type or select a value in the [Interval] box.

Changing the measurement units

Click [Option], then [Options], then [System Unit], and then select the desired measurement units ([mm] or [inch]).

   - "System unit" on page 22
Sew Setting Stage

1. In the Figure Handle Stage, click [Figure Handle] tab to display the [Stage] group.

2. Click [To Sew Setting] in the [Stage] group.

3. If necessary, change the color and sew type.

4. Click the enclosed region to apply the sewing attributes.

In the Sew Setting Stage, the colors of the Design Page and background can be changed from the [Design Settings] dialog box (displayed by clicking the [Option] menu, and then selecting [Design Page Settings].)

Setting region/line sewing

Region sewing

1. Click the [Sew Setting] tab.

2. Click [Region] in the [Tools] group.

3. If necessary, change the color and sew type.

   "Sewing attributes" on page 261

- If the attributes cannot be applied to a region, go back to the Figure Handle Stage and make sure that region is closed.
- Edit any broken lines with the Edit Point tool.

- Although a region may seem closed, if the sewing attributes cannot be specified for the region, the region may not actually be closed.
- To find the opening in the region, use the line drawing mode in the Figure Handle Stage to divide the region into smaller regions, and then check which region sewing attributes cannot be applied to in the Sew Setting Stage.
■ Line sewing

1. Click [Line] in the [Tools] group, and then select the desired tool ( or ) from [Line Sew Tool].

2. If necessary, change the color and sew type. >>> “Sewing attributes” on page 261.

3. Click the outline to apply the sewing attributes.

---

Sewing attributes

The Sew pane on the [Sew setting] tab, available in the Sew Setting Stage, allows you to set the color and sew type of region and outlines. The sewing attributes that are available depend on the tool selected.

Example 1: When is selected

1. Region color button
2. Region sew type selector

Example 2: When or is selected

1. Line color button
2. Line sew type selector

■ Sew type

1. Click in a sew type selector.

2. Click the desired sew type.

3. Click the region or line to apply the sew type setting.

- To turn off sewing, select [Not Sewn (Line)] from the [Line sew type] selector or [Not Sewn (Region)] from the [Region sew type] selector.
- If the sewing has been turned off, the regions appear in white or the lines appear as dotted lines.
Specifying sewing attributes

1. Click the [View] tab.

2. Select the [Sewing Attributes] check box in the [Show/Hide] group to display the [Sewing Attributes] dialog box.

For region sewing

Beginner mode

**For line sewing**

Beginner mode

Expert mode

1. Click to return to the default setting.

2. To Expert mode/To Beginner mode
   Click to switch the mode.

3. Click to load/save the sewing settings.
   >> “Saving frequently used sewing attributes” on page 212

4. Hide Hint/Show Hint
   Click to switch between displaying and hiding the hint view

5. With each change in the sewing attributes, a preview of the stitching can be checked here.

1. Change the sewing attributes displayed under [Line sew] or [Region sew].
   >> For details on the different sewing attributes and settings, refer to “Line sewing attributes” on page 358 and “Region sewing attributes” on page 364

2. When the line sewing attributes are displayed, click an outline to apply the line sewing attributes to the outline.

When the region sewing attributes are displayed, click a region to apply the region sewing attributes to the region.
**Saving frequently used sewing attributes**
- Frequently used sewing attributes can be saved together, and recalled when specifying sewing attributes.
- Perform this operation in the same way that it is performed in Layout & Editing.
  ▶ For details, refer to "Saving frequently used sewing attributes" on page 212

**Color**

1. Click the [View] tab.
2. Select the [Sewing Attributes] check box in the [Show/Hide] group to display the [Sewing Attributes] dialog box.
3. Click the [Color] tab.

   ![Thread Chart](Image)

4. From the [Thread Chart] selector, select a thread color chart or a user thread chart.

5. From the list of thread colors, click the desired color.
  ▶ For details on the four buttons under the list, refer to "Special colors" on page 55
6. Click the region or outline to apply the color setting.

**Creating a gradation**

The density of the color can be adjusted at various locations to create a custom gradation pattern.

1. In Expert mode of the [Sewing Attribute Setting] dialog box, select the [Gradation] check box, and then click [Pattern].

   ![Gradation Pattern Setting](Image)

   1. To select a preset gradation pattern, click the desired pattern under [Select pattern].
   2. Move the sliders to adjust the density of the gradation pattern.
   3. The preview area shows the setting changes that you make.

   Gradation can be specified if satin stitches, fill stitches or programmable fill stitches have been selected for the region sewing and [Manual straight line] has been selected as the sewing direction.

   An additional color (used for blending in Layout & Editing) cannot be specified with the gradation setting in Design Center.

**Applying effects to concentric circle and radial stitches**

In order to increase the decorative effect, you can move the center point of regions set to the concentric circle stitch or radial stitch.

1. Click the [Sew Setting] tab.
2 Click [Region] in the [Tools] group.

3 Select the desired color and sew type ([Concentric Circle Stitch] or [Radial Stitch]).

4 Click the region.  
   → The center point ( ) appears.

5 Drag the center point to the desired location.

---

To move the center point later, click and then right click the region with the concentric circle stitch or radial stitch applied. The center point appears and can be moved.

### Preventing overlapping stitching of regions (hole sewing)

By specifying hole sewing, the stitching in overlapping regions will not be sewn twice. Hole sewing can be set only when one region completely encloses another.

1 Click the [Sew Setting] tab.

2 Click [Hole Sew] in the [Tools] group.

3 Click the region that completely encloses another region.

4 Click [OK] to set hole sewing.
To cancel hole sewing, click the white inner region. The inner region will be sewn twice when it appears in the same color as the outer region.

Applying stamps

Stamps can be applied to regions in the Sew Setting Stage of Design Center.

1. Click the [Sew Setting] tab.
2. Click [Stamp] in the [Tools] group, and then select the desired tool from [Stamp Tools].

Settings for stamps are specified in the same way that they are in Layout & Editing.

- **Applying and editing stamps** on page 66

Some stamp patterns are provided with this application; however, by using Programmable Stitch Creator, you can edit the patterns that are provided or you can create your own.

Checking and editing the sewing order

1. Click the [Sew Setting] tab.
2. Click [Sewing Order] in the [Check Design] group.
3. To change the sewing order of a color, select the frame for the color, and then drag the frame to the desired position.

<table>
<thead>
<tr>
<th>Color</th>
<th>Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

- To select additional frames, hold down the <Shift> or <Ctrl> key and select each frame.
- The frames containing regions are separated from the frames containing outlines with a thick vertical line. Frames from one side of the line cannot be moved to the other side.
- To enlarge the pattern for better viewing, click .

4. To view the sewing order of multiple patterns of the same color, select the frame, and then click the [Part] tab.

5. To change the sewing order of a pattern, select the frame for the pattern, and then drag the frame to the desired position.
6. Click [OK].
Checking the stitching in the Stitch Simulator

1. Click the [Sew Setting] tab.
2. Click [Stitch Simulator] in the [Check Design] group to view stitching using the stitch simulator.

The basic operations are the same as those described for Layout & Editing.

- "Checking the stitching with the Stitch Simulator" on page 89

Viewing embroidery patterns in the Reference Window

Embroidery patterns can be viewed in the Reference Window in the Sew Setting Stage in the same way that they are in the Figure Handle Stage.

- "Viewing outlines in the Reference Window" on page 257

Saving embroidery patterns

The file can be saved at each stage.

- Overwriting

Click , and then select [Save] from the command list.

- Saving with a new name

1. Click , and then select [Save As] from the command list.
2. Select the drive and the folder, and then type in the file name.
3 Click `[Save]`.

- Image data from the Original Image Stage can be saved as a bitmap file (.bmp).
- In the Line Image Stage, image data is saved as a .pel file.
- In the Figure Handle Stage and the Sew Setting Stage, pattern data is saved as a .pem file.

If you select a file type of a previous software version, saved .pem files can be opened with that version of the software; however, some information may be lost.
Using Design Database, the created embroidery data can be managed. In addition, while viewing images of the file contents, the files can be organized, or multiple embroidery designs can be transferred to embroidery machines.
## Design Database

### List of menus

#### File menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open in Layout &amp; Editing</td>
<td>—</td>
<td>p. 274</td>
</tr>
<tr>
<td>Import Into Layout &amp; Editing</td>
<td>—</td>
<td>p. 274</td>
</tr>
<tr>
<td>Create New Folder</td>
<td>—</td>
<td>p. 272</td>
</tr>
<tr>
<td>Convert Format</td>
<td>—</td>
<td>p. 282</td>
</tr>
<tr>
<td>Delete</td>
<td>—</td>
<td>p. 273</td>
</tr>
<tr>
<td>Search</td>
<td>—</td>
<td>p. 281</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Setup</td>
<td>—</td>
<td>p. 285</td>
</tr>
<tr>
<td>Print Preview</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Print</td>
<td>—</td>
<td>p. 285</td>
</tr>
<tr>
<td>Create Image File and HTML</td>
<td>—</td>
<td>p. 286</td>
</tr>
<tr>
<td>Create CSV</td>
<td>—</td>
<td>p. 286</td>
</tr>
<tr>
<td>Exit</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

#### Edit menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>—</td>
<td>p. 272</td>
</tr>
<tr>
<td>Copy</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>—</td>
<td>p. 272</td>
</tr>
<tr>
<td>Select All</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

#### Display menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Thumbnails</td>
<td>—</td>
<td>p. 273</td>
</tr>
<tr>
<td>Small Thumbnails</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Details</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Preview</td>
<td>—</td>
<td>p. 283</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>—</td>
<td>p. 283</td>
</tr>
<tr>
<td>Refresh</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Toolbar</td>
<td>—</td>
<td>p. 270</td>
</tr>
<tr>
<td>Status Bar</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

#### Option menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select System Unit</td>
<td>mm</td>
<td>p. 22</td>
</tr>
<tr>
<td></td>
<td>inch</td>
<td>—</td>
</tr>
<tr>
<td>USB Link</td>
<td>—</td>
<td>p. 280</td>
</tr>
<tr>
<td>Wireless Link</td>
<td>—</td>
<td>p. 280</td>
</tr>
<tr>
<td>DST Settings</td>
<td>—</td>
<td>p. 345</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Color</td>
<td>—</td>
<td>p. 347</td>
</tr>
<tr>
<td>Blue</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Black</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Silver</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Aqua</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Network Machine Settings</td>
<td>—</td>
<td>p. 277</td>
</tr>
</tbody>
</table>

#### Help menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Instruction Manual</td>
<td>—</td>
<td>p. 5</td>
</tr>
<tr>
<td>Customer Support</td>
<td>—</td>
<td>p. 7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Design Database</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
**Design Database Window**

1. **Toolbar**
2. **Folder pane**
3. **Contents pane**
   - Displays thumbnails of all embroidery design in the selected folder.
4. **Card reading button**
   - Reads an original card.
5. **Folder content display button**
   - Displays the folder contents.
6. **Send to selector**
   - Select where the embroidery files will be written or sent.
7. **Write button**
   - Begins writing the selected designs (displayed in the writing list).
8. **Remove button**
   - Returns the selected design (displayed in the writing list) to the unselected state.
9. **Writing list**
   - Displays the list of designs to be written to the original card, USB media or embroidery machine.
10. **Add button**
    - Adds the design selected in the contents pane to the writing/transfer list.
11. **Writing box display/non-display button**
   - Click when writing/transferring designs. Click this button to hide or display the Writing list.

Settings for the following can be selected from the **Option** menu.
- Select **mm** or **inch** as the system units.
- Select **Blue**, **Black**, **Silver** or **Aqua** as the application color.
Starting Up Design Database

1. Click 🔍.


3. Click a folder in the folder pane.
   → All embroidery files in the folder are displayed in the contents pane on the right.

📚

- The displayed files have the following extensions:
  .pes, .phc, .phx, .dst, .exp, .pcs, .hus, .vip, .shv, .jef, .sew, .csd, .xxx
- .pem files are not displayed since they cannot be read by the machine. Import the embroidery design into Layout & Editing from Design Center, and then save it as a .pes file.
- Zipped file cannot be read in this application.
Organizing Embroidery Designs

Creating new folders

1. In the folder pane, on the left, select the folder.
2. Click [File], then [Create New Folder].
3. Type in the name of the new folder, and then press the <Enter> key.

Moving/copying files to a different folder

1. In the folder pane, locate the folder where you want to move the embroidery design.
2. In the folder pane, click the folder that contains the embroidery design.
3. Drag the embroidery design in the contents pane to the folder you previously located in the folder pane.

- If the two folders are on the same drive, the selected embroidery design is moved to the other folder.
- If the two folders are on separate drives, the selected embroidery design is copied into the other folder.

Changing file names

The names of embroidery designs can be changed from Design Database only when the sewing information (menu command [Display] – [Details]) is displayed.

1. In the folder pane, select the folder containing the embroidery design.
2. Select the embroidery design. Then click again.
3. Type in the new name of the embroidery design, and then press the <Enter> key.

When renaming a file, the file extension cannot be changed.
Deleting files

1. In the folder pane, select the folder containing the embroidery design that you want to delete.

2. In the contents pane, select the name of the embroidery design.

3. Press the <Delete> key.
   → The file is moved to the Recycle Bin.

Changing how files are displayed

The embroidery designs in the contents pane can be displayed as large thumbnails or small thumbnails, or they can be listed by their sewing information.

- **Large Thumbnails**
  Click or click [Display], then [Large Thumbnails].

- **Small Thumbnails**
  Click or click [Display], then [Small Thumbnails].

- **Sewing information**
  Click or click [Display], then [Details].
Opening Embroidery Designs

Opening files with Layout & Editing

1. In the folder pane, select the folder containing the embroidery design that you want to open in Layout & Editing.

Be sure to select a folder that contains .pes files.

2. In the contents pane, select the .pes file.

3. Click [File], then [Open in Layout & Editing].

Files in the following formats can be imported.
.pes, .phc, .phx, . dst, .exp, .pcs, .hus, .vip, .shv, . jef, .sew, .csd, or .xxx

Importing files into Layout & Editing

1. In the folder pane, select the folder containing the embroidery design that you want to import into Layout & Editing.

2. In the contents pane, select the embroidery design.

3. Click [File], then [Import Into Layout & Editing].

→ The selected embroidery design appears in the Layout & Editing window.
Transferring Embroidery Designs to Machines

The procedures for transferring the created embroidery design to an embroidery machine differ depending on your embroidery machine model. For detail, refer to the instruction manual provided with your embroidery machine.

Transferring to a machine by using USB media/wireless network/USB cable/original card

1 Prepare the media to be used to make the transfer, or connect an embroidery machine to the computer.

Be sure that the hoop size of the design does not exceed the hoop that will be used on the embroidering machine.

- If the design is to be written to an original card, insert the original card into the USB card writer module.
- If the design is to be written to USB media, plug the USB media into the computer.
- If the design is to be transferred directly to an embroidery machine, connect the embroidery machine to the computer. For details on transferring design, refer to the instruction manual provided with your embroidery machine.
- In order to use the Link function to transfer embroidery designs, an embroidery machine compatible with the Link function must be running in Link mode.

"Using the Link Function to Embroider From the Computer" on page 226

2 Click .

Contents pane (Available designs)
Writing list (Selected designs)
3 Click the [Send To] selector, and then click the destination.

Using USB media

Designs can be transferred to an embroidery machine compatible with the USB Host function.

The "Palette Software Key" cannot be used as USB media.

1 Select ✂ from the [Send To] selector.

If multiple USB media are connected, ✂ for each connected device appears. Select the USB media where the design is to be written.

2 Click 📁.

3 Select a folder in 1, select an embroidery file from the contents pane 2, and then click 📁 to add the file to the writing list. After all embroidery files to be written are added to the writing list, click ✂.

→ The designs in the writing list are written to the USB media.

→ When the designs have been written, the message "Finished outputting data." appears.

The remaining steps differ depending on the destination where the data is to be sent.
Wirelessly transferring data

1. Connect the computer running the application to your home network (wireless LAN access point).
2. Connect the sewing machine to the same home network.

For details on making connections, refer to the manual provided with your machine.

- Do not remove the USB media while designs are being written.
- If there is already a file with the same name at the destination, the following dialog box appears. Select whether to overwrite the existing file, to stop copying or to copy the file using a different name.

a. Do not remove the USB media while designs are being written.

b. If there is already a file with the same name at the destination, the following dialog box appears. Select whether to overwrite the existing file, to stop copying or to copy the file using a different name.

- Embroidery patterns cannot be transferred if the computer and sewing machine are connected to different home networks. Be sure to connect to the same home network.

If the desired sewing machine does not appear in the list, click [Refresh].
6 Click [OK] to register the machine.

7 Select the machine in the [Send To] selector.

8 Click .

9 Select a folder in 1, select an embroidery file from the contents pane 2, and then click 3 to add the file to the writing list. After all embroidery files to be written are added to the writing list, click 4.

Transferring directly to a machine's memory

Designs can be transferred to embroidery machines that can be connected to a computer using a USB cable.

1 Select  from the [Send To] selector.

If multiple embroidery machines are connected,  for each machine appears. Select the machine to be used to embroider.

2 Click .

3 Select a folder in 1, select an embroidery file from the contents pane 2, and then click 3 to add the file to the writing list. After all embroidery files to be written are added to the writing list, click 4.

→ The designs in the writing list are transferred to the machine.
→ When the transfer is finished, the message "Finished outputting data." appears.

• Do not remove the USB cable while designs are being written.
• If there is already a file with the same name at the destination, a dialog box appears. Select whether to overwrite the existing file, to stop copying or to copy the file using a different name.
Transferring Embroidery Designs to Machines

■ Using an original card

Designs can be transferred to an embroidery machine equipped with a card slot.

1. Files other than .phc, .phx files can be written.
2. If no USB card writer module is connected to the computer, an original card cannot be selected as the output destination. Before transferring, make sure that a USB card writer module is connected to the computer.

1. Select from the [Send To] selector.
2. Under [Machine Type], select the type of embroidery machine to be used.
   - Single-needle machine
   - Multi-needle machine
3. From the [Hoop Size] selector, select the appropriate size of embroidery hoop.

   100 x 100 / 110 x 110 mm

4. Click .
5. Select a folder in 1, select an embroidery file from the contents pane 2, and then click 3 to add the file to the writing list.

   After all embroidery files to be written are added to the writing list, click .

6. If the files are to be written to an original card, the following message appears. Click [OK].

   Do not remove the card or unplug the USB cable while designs are being written to the card (while the LED indicator is flashing).

   • An embroidery design for the jumbo frame cannot be transferred to the machine by using an original card.
   • If the pattern in the selected embroidery file is larger than the hoop size selected in step 3, or the number of stitches or number of colors for the pattern exceeds the maximum for the hoop selected in step 3, that file cannot be added to the writing list. Only the embroidery designs displayed in the writing list will be written to the original card.
   • Embroidery files can also be added to the writing list by right-clicking the file, then clicking [Add to Writing List], or by selecting a file in the contents pane and dragging it to the writing list.
   • A file can also be removed from the writing list by right-clicking it in the writing list, then clicking [Remove from Writing List].

   • Do not select a hoop size larger than the embroidery hoop that can be used with your embroidery machine. Otherwise, the created original card will not work correctly with the embroidery machine.
   • When writing to an original card that already contains data, all data on the card will be deleted. Before writing to a card, save all necessary data to a hard disk or other media, and check that no necessary data remains on the card.

   "From an original card" on page 102
When a message appears, indicating that writing is finished, click [OK].

Patterns created on a custom-sized Design Page are written to cards split into their various hoop sections.

Note of "Transferring to a machine by using an original card" on page 224

- To rewrite the embroidery files written on the original card, click to select those files, and move files to the writing list in the same manner.
- To check the embroidery design file being written to the original card, click .
  → Card appears in the folder pane, and all embroidery designs written to the original card appear in the contents pane.

Embroidery designs written to the original card appear as [Card Data] in the contents pane.

To display the contents of the folder in the contents pane, click . Switch the display by clicking and .

Sending embroidery designs to machines by using the Link function

An embroidery machine compatible with the Link function must be running in Link mode. [USB Link] and [Wireless Link] are available with the Link function.

"Using the Link Function to Embroider From the Computer" on page 226

1. Select or from the [Send To] selector.
2. Click .
3. Select a folder in 1, select an embroidery file from the contents pane 2, and then click 3.
4. Continue the procedure as described in Step 5 of "USB Link" on page 226 or Step 5 of "Wireless Link" on page 231

Files in the .dst, .exp, .phc, and .phx formats cannot be transferred with the Link function. When [USB Link] or [Wireless Link] is selected in the [Send To] box, .dst, .exp, .phc, and .phx files do not appear in the contents pane. In addition, embroidery files with the Design Page size set to [Custom Size] or with [Hoop Size] set to 360 × 360 mm (Jumbo Frame) do not appear in the contents pane.

To display the [USB Link] or [Wireless Link] dialog box again after the computer has been restarted, click [USB Link] or [Wireless Link] in the [Option] menu.
Searching for an Embroidery Design

1. In the folder pane, select the folder.

2. Click [File], then [Search].

3. Specify the search conditions. Select the check box of the search conditions to be specified.

   - **File Name**
     Select to search for files with a specific file name. Type the file name in the box.

   - Wildcard characters ("?" to represent a single character and "*" to represent multiple characters) can also be used.

   - **Format**
     Select the check box beside the desired file format.

   - **Stitch Count**
     In the boxes, type the lower and upper limits of the range for the number of stitches.

   - **Color Changes**
     In the boxes, type the lower and upper limits of the range for the number of color changes.

   - **Total Colors**
     In the boxes, type the lower and upper limits of the range for the total number of thread colors.

   - **Width**
     In the boxes, type the lower and upper limits of the width range.

   - **Height**
     In the boxes, type the lower and upper limits of the height range.

   - **Date Modified**
     In the boxes, type the modification date range (from when to when).

     When searching for .pes files, the following conditions can also be specified.

   - **Design Name**
     Type the design name in the box.

   - **Category**
     In the box, type specific characters or the embroidery category.

   - **Author**
     In the box, type the author's name to be searched for.

   - **Keywords**
     In the box, type the keyword to be searched for.

   - **Comment**
     In the box, type the comment to be searched for.

4. Click [Search].

   → A list of files matching the specified search conditions appears.
Converting Embroidery Design Files to Different Formats

Embroidery design files can easily be converted to a file of one of the other formats (.pes, .dst, .exp, .pcs, .hus, .vip, .shv, .jef, .sew, .csd, or .xxx).

1. In the folder pane, select the folder containing the embroidery design that you want to convert.
2. In the contents pane, select the embroidery desired format.
3. Click [File], then [Convert Format].
4. From the [Format Type] selector, select the desired format.
5. Under [Output To], select whether the new file is added to the same folder as the original file (Same folder) or to a specified folder (Following folder).

   ![Convert Format dialog box]

6. Click [Convert].
   → The file is converted, and the new file is added to the specified folder.

   • With [DST Settings] on the [Option] menu, the number of jumps for thread trimming can be specified for .dst files.
     "Specifying the number of jumps in embroidery design of the DST format" on page 345

   • If multiple files with different formats are selected to be converted while [Same folder] is selected, any file with the same format as the new one will not be converted. However, if the files are being added to a different folder than the original one, any file with the same format as the new one will be copied to the different folder, instead of being converted.

   • If the file is converted to a .pes file, the thread colors are converted as if the file was imported into Layout & Editing.

   Files cannot be converted to the .phc, or .phx formats.
Checking Embroidery Designs

Previewing files

Toolbar button:～

1 Select a folder in ①, select an embroidery file from the contents pane ②.

2 Click , or click [Display] menu, then [Preview].

Checking file information

Sewing information such as the file name, size, stitch count, sewing time, color count and modification date can be checked in the Property dialog box. With .pes file, additional information about the embroidery design can be viewed.

The displayed sewing time is an estimate. The actual sewing time depends on the machine model used and the specified settings.

Toolbar button:～

1 In the contents pane, select the embroidery design corresponding to the information that you want to view.

2 Click , or click [Display] menu, then [Property].

• When opening PES files (version 4.0 or later), the following [Property] dialog box will be displayed.

• Select [Color changes] beside [Color List] to display the thread color change information in the color list. Select [Total colors] to display the information for all thread colors in the color list.

”Checking embroidery design information” on page 98

• When a .pes file that contains user-defined colors is registered, those colors appear as [Basic Color].

”Checking embroidery design information” on page 98
• When opening Non-PES files or PES files (version 3.0 or earlier), the following [Property] dialog box will be displayed.

```
Property

File Name: 3301627.pes
File Version: 2.0
Modified Date: 1/25/2010
Width: 30.0 mm
Height: 33.0 mm
Strike Color: 1967
Saving Time: 5 min
Color Changes: 0
Total Colors: 2

Color List:  |  Color Changes  |  Total Colors |
------------|----------------|--------------|
1           | 301 EMBROIDERY |  WHITE       |
2           | 401 EMBROIDERY |  BLUE        |
3           | 285 EMBROIDERY |  YELLOW      |
```

• If the Design Page size was set to [Custom Size] or if [Hoop Size] was set to a multi-position hoop (100 × 172 mm or 130 × 300 mm) or a jumbo frame (360 × 360 mm), a [Property] dialog box similar to the one shown below appears.

```
Property

File Name: 3301627.pes
File Version: 2.0
Modified Date: 1/25/2010
Width: 30.0 mm
Height: 33.0 mm
Strike Color: 1967
Saving Time: 5 min
Color Changes: 0
Total Colors: 2

Color List:  |  Color Changes  |  Total Colors |
------------|----------------|--------------|
1           | 301 EMBROIDERY |  WHITE       |
2           | 401 EMBROIDERY |  BLUE        |
3           | 285 EMBROIDERY |  YELLOW      |
```

• The red box in the dialog box shows the position of the displayed pattern section.
• To display information for other hoop positions, click << or >>.
Images and sewing information for all embroidery designs can be outputted in a number of formats. Select among the following modes according to your preferences.

**Printing**
Images of all embroidery designs in the selected folder can be printed as a catalog or as an instruction guide.

1. In the folder pane, select the folder containing the embroidery designs.
2. Click [File], then [Print Setup].
3. Under [Paper] and [Orientation], select the appropriate settings.
4. Select [Color List].
   - **Color changes**: The thread color information for each color change is displayed.
   - **Total colors**: The thread color information for the necessary threads is displayed. This allows you to check the total number of thread colors.

5. Select [Print Layout].

   - Catalog style 1
   - Catalog style 4
   - Catalog style 12
   - Instruction Guide style

6. Under [Color Description], select whether the thread colors appear as the name of the color or as the brand and thread number.
7. Click [Print].
Outputting a Catalog of Embroidery Designs

Outputting as Image and HTML Files

Instead of being printed, the catalog of embroidery designs can be outputted as image and HTML files.

1. In the folder pane, select the folder containing the embroidery designs.
2. Click [File], then [Create Image File and HTML].
3. Select the drive and the folder, and then type in the name of the HTML file.
4. To add a title at the top of the file and in the title bar, type the title in the [Page Title] box.
5. Under [Page Layout], select how the designs appear on the page.
6. Click [Save].

- If one or more embroidery designs were selected in the contents pane, only the selected designs are printed.
- If the brand name, thread number or file properties is too long, some of the text may not be printed.
- If [File], then [Print] is clicked, the embroidery designs are printed according to the settings already selected in the [Print Setup] dialog box.

Outputting as a CSV file

A .csv file containing the sewing information (file name, dimensions, number of stitches, number of colors, file path, file properties (.pes files only) and the names of thread colors and thread numbers) for selected embroidery designs can be outputted.

1. In the folder pane, select the folder containing the embroidery designs.
2. Click [File], then [Create CSV].
3. Select the drive and the folder, and then type in the name of the .csv file.
4. Click [Save].
Programmable Stitch Creator

Programmable Stitch Creator allows you to create and edit stitch patterns, which can then be used as programmable fill stitches or motif stitches in both Layout & Editing and Design Center.
Programmable Stitch Creator

Application button menu

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>New Fill/Stamp Pattern</td>
<td>—</td>
</tr>
<tr>
<td>2</td>
<td>New Motif Pattern</td>
<td>p. 298</td>
</tr>
<tr>
<td>3</td>
<td>New Decorative Fill Pattern</td>
<td>p. 302</td>
</tr>
<tr>
<td>4</td>
<td>Open</td>
<td>p. 292</td>
</tr>
<tr>
<td>5</td>
<td>Save</td>
<td>p. 308</td>
</tr>
<tr>
<td>6</td>
<td>Save As</td>
<td>p. 308</td>
</tr>
</tbody>
</table>

Ribbon menu tabs

■ Home tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Tool</td>
<td>p. 296</td>
</tr>
<tr>
<td>2</td>
<td>Edit Point Tool</td>
<td>p. 296</td>
</tr>
<tr>
<td>3</td>
<td>Draw Line Tool</td>
<td>p. 293</td>
</tr>
<tr>
<td>4</td>
<td>Region (Reset) Tool</td>
<td>p. 294</td>
</tr>
<tr>
<td>5</td>
<td>Region (Engrave) Tool</td>
<td>p. 294</td>
</tr>
<tr>
<td>6</td>
<td>Region (Emboss) Tool</td>
<td>p. 294</td>
</tr>
<tr>
<td>7</td>
<td>Zoom In</td>
<td>—</td>
</tr>
<tr>
<td>8</td>
<td>Zoom Out</td>
<td>—</td>
</tr>
<tr>
<td>9</td>
<td>Other Zoom Tools</td>
<td>—</td>
</tr>
</tbody>
</table>
View tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Template</td>
<td>p. 306</td>
</tr>
<tr>
<td>2</td>
<td>Modify Template</td>
<td>p. 306</td>
</tr>
<tr>
<td>3</td>
<td>Delete Image</td>
<td>p. 306</td>
</tr>
<tr>
<td>4</td>
<td>Background Image Density</td>
<td>p. 307</td>
</tr>
<tr>
<td>5</td>
<td>Show/Hide Preview window</td>
<td>p. 308</td>
</tr>
<tr>
<td>6</td>
<td>Show/Hide Status Bar</td>
<td>p. 305</td>
</tr>
<tr>
<td>7</td>
<td>Show Grid with Axes</td>
<td>p. 310</td>
</tr>
<tr>
<td>8</td>
<td>Grid interval</td>
<td>p. 310</td>
</tr>
<tr>
<td>9</td>
<td>Guideline</td>
<td>p. 310</td>
</tr>
</tbody>
</table>
Basic Programmable Stitch Creator Operations

Programmable Stitch Creator is an application for creating, editing and saving stitch patterns that can be used for programmable fill stitch, motif stitch or decorative fill stitch sewing. The following three types of patterns can be created in their corresponding mode.

**Fill/stamp stitch patterns**

- These patterns can be used as stamp patterns and for sewing with the programmable fill stitch in Layout & Editing or Design Center.
- These patterns can be created with a single line or with multiple lines. In addition, these patterns can be used to create an embossing/engraving effect in sewn regions.
- These patterns are created in Fill/Stamp mode.

**Motif stitch patterns**

- These patterns can be used for sewing lines with the motif stitch and for sewing regions with the motif stitch, piping stitch and stippling stitch in Layout & Editing or Design Center.
- These patterns are created with a single line, which gives the look of a single-stroke drawing, and they are used for decorative machine sewing.
- These patterns are created in Motif mode.
Decorative fill patterns

- These patterns can be selected as the sew type for a region.
- These patterns can be used to sew shapes arranged without spacing, like tiling, or to fill a region with a beautiful pattern.
- These patterns are created in Decorative Fill mode.
Creating Fill/Stamp Stitch Pattern

Existing programmable stitch patterns can be edited to create new patterns.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Opening a fill/stamp stitch pattern</td>
</tr>
<tr>
<td>2</td>
<td>Drawing lines to edit the fill/stamp stitch pattern</td>
</tr>
<tr>
<td>3</td>
<td>Applying embossing/engraving effects to the fill/stamp stitch pattern</td>
</tr>
<tr>
<td>4</td>
<td>Saving the edited fill/stamp stitch pattern</td>
</tr>
<tr>
<td>5</td>
<td>Using the edited fill/stamp stitch patterns in Layout &amp; Editing</td>
</tr>
</tbody>
</table>

Step 1 Opening a fill/stamp stitch pattern

First, we will open a fill/stamp stitch pattern to be edited. In this example, we will use pattern `wave1.pas`.

1. Click [File].
3. Click [Open], and then select [Open] from the command list.

4. Select Fill/Stamp File(*.PAS) in the Files of type selector. Select the pattern file `wave1.pas`.

The pattern file can be found at the following location.

For example, (Drive where Palette was installed)`Program Files (Program Files (x86))\Baby lock\Palette Ver.11\Pattern`.

To view the data in the selected folder as thumbnails in the [Browse] dialog box, click [Browse].
Step 2  Drawing lines to edit the fill/stamp stitch pattern

1  Click the [Home] tab.

2  Click [Draw Line] in the [Tools] group.

3  Click points (1) through (4).

4  Double-click (5) (end point).

- To remove the last point that was entered, right-click the mouse button.
- The grid width can be changed.

Step 3  Applying embossing/engraving effects to the fill/stamp stitch pattern

1  Click (1), and then double-click (2). Next, click (3), and then double-click (4).

- Lines are drawn along the top and bottom edges of the Design Page.

In order to create an effect, the lines must form a closed region.
2 Click [Region (engrave)] in the [Tools] group, and then click the first and fourth wave regions.

→ These regions appear in red and will be sewn with short stitches to give the effect of engraving.

3 Click [Region (emboss)] in the [Tools] group, and then click the second and fifth wave regions.

→ This region appears in blue and will be sewn with no dropped stitches to give the effect of embossing.

To remove the embossing/engraving effect, use the [Region (reset)] tool. Click [Region (reset)] in the [Tools] group, and then click a region with an effect applied.

Step 4 Saving the edited fill/stamp stitch pattern

Fill/stamp stitch patterns are saved in the .pas format.

1 Click , and then select [Save As] from the command list.

2 Select the drive and the folder, and then type in the file name.

When saving a fill/stamp pattern, specify the size beside [Default Size]. Click [mm] or [inch] to select the measurement units.

3 Click [Save].
Creating Fill/Stamp Stitch Pattern

Step 5 Using the edited fill/stamp stitch patterns in Layout & Editing

1. Start up Layout & Editing.
2. Select a shape.
3. From the [Region sew type] selector (in the [Shapes] tab), select [Prog. Fill Stitch].
4. Display the [Sewing Attributes] pane.
   - "Specifying sewing attributes" on page 63
5. Click below [Programmable fill] in the [Region sew] section.
6. Select the drive and folder where the pattern was saved in Step 4.
7. Click the edited fill/stamp stitch pattern, and then click [OK].
   - The pattern is applied to the inside regions of the embroidery pattern.

- A fill/stamp stitch pattern can also be applied as a stamp by using the Stamp Tools.
  - "Applying and editing stamps" on page 66
- For best results, refer to "Notes on programmable fill stitches and stamps" on page 369.
Editing a Pattern in Fill/Stamp Mode

■ Selecting patterns

1. Click the [Home] tab.
2. Click [Select] in the [Tools] group to use the [Select] tool.
3. Click the pattern.
4. To select an additional pattern, hold down the <Ctrl> key and click the other pattern.

- You can also select patterns by dragging the pointer across the pattern.
- Hold down the <Ctrl> key and click a selected pattern to deselect it.

■ Scaling patterns

Drag a handle of the selected pattern to adjust its size. Drag the rotation handle to rotate the pattern.

- If the <Shift> key is held down while a handle is dragged, the pattern is enlarged or reduced from the center of the pattern.
- Click [Flip Vertically] in the [Flip] group to flip the selected pattern(s) up/down. Click [Flip Horizontally] in the [Flip] group to flip the selected pattern(s) left/right.

- Using commands other than those mentioned above, selected patterns can be edited in other ways, for example, duplicated or deleted.

■ Reshaping a fill/stamp stitch patterns

1. Click [Select Point] in the [Tools] group.
2. Click the broken line.

- To move the pattern horizontally or vertically, hold down the <Shift> key while dragging it.
- Pressing the arrow keys moves the selected pattern one grid mark in the direction of the arrow on the key.
3 To edit a point, click the point to select it.

• To move the point, drag it to the new location.
• To insert a point, click the line to add a new point.
  → A new point appears selected.
• To delete the point, click Delete or press the <Delete> key.

📚
- If a line is composed of two points and you delete one of them, the entire line is deleted.
- To select multiple points, hold down the <Ctrl> key while clicking the points, or dragging the pointer over the points.
- Hold down the <Ctrl> key while pressing the ← key or → key. The selection direction changes to the end or start point.
- Hold down the <Shift> key while dragging the points. The points are moved horizontally or vertically.
- Press an arrow key. The points move in the direction of the arrow on the key.

### Splitting patterns

1 Click [Select Point] in the [Tools] group.
2 Select the point that you want to split.
3 Click [Split at Point] in the [Edit] group.
Creating Motif Stitch Pattern

Now, we will create a new motif stitch pattern. Motif stitch patterns are created in Motif mode.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Enter motif mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Shaping a single line to create motif stitch pattern</td>
</tr>
<tr>
<td>Step 3</td>
<td>Saving the created motif stitch pattern</td>
</tr>
<tr>
<td>Step 4</td>
<td>Using the edited motif stitch pattern in Layout &amp; Editing</td>
</tr>
</tbody>
</table>

**Step 1 Enter motif mode**

1. Start up Programmable Stitch Creator.
2. Click , and then select **[New Motif Pattern]** from the command list.

**Step 2 Shaping a single line to create motif stitch pattern**

In Motif mode, you can create original patterns by changing the shape of a single line.

1. Click the **[Home]** tab.

2. Click **[Select Point]** in the **[Tools]** group.

3. Select (1), then drag the point. The line that moves turns green when moving a point.
4 Click the line to insert points. Click (3) located between (1) and (2). Click (4) located between (3) and (2).

5 Select (4), then drag the point.

6 Click between (2) and (4) to insert point (5), and then drag point (5).

7 Click (6) located between (4) and (5), then drag the point to (1). Select (3), then drag the point to (2).

- To move the point horizontally or vertically, hold down the <Shift> key while dragging it.
- Pressing the arrow keys moves the selected point one grid mark in the direction of the arrow on the key. If the grid is not displayed, the pattern moves a distance smaller than the smallest grid interval in the direction of the arrow on the key.
- To delete a selected point, press the <Delete> key.
- These patterns can be applied in line sewing and region sewing in Layout & Editing, and region sewing in Design Center.
Creating Motif Stitch Pattern

**Step 3  Saving the created motif stitch pattern**

Motif stitch patterns are saved in the .pmf format.

1. Click , and then select [Save As] from the command list.

2. Select the drive and the folder, and then type in the file name.

3. Click [Save].

   → When saving a motif pattern, specify the size beside [Default Size]. Click [mm] or [inch] to select the measurement units.

**Step 4  Using the edited motif stitch pattern in Layout & Editing**

1. Start up Layout & Editing.

2. Select a shape.

3. From the [Line sew type] selector (in the [Shapes] tab), select [Motif Stitch].

4. Display the [Sewing Attributes] pane.

   "Specifying sewing attributes" on page 63


6. Select the drive and folder where the pattern was saved in Step 3.

7. Click the created motif stitch pattern, and then click [OK].

   → The pattern is applied to the outlines of the embroidery pattern.

A motif stitch pattern can be used when the motif stitch, piping stitch or stippling stitch has been selected as the sew type of a region.
Editing a Pattern in Motif Mode

Moving and deleting several points at a time

1. Click the [Home] tab.

2. Click [Select Point] in the [Tools] group.

3. To select a single point, click an empty square.
   To select multiple points, hold down the <Ctrl> key while clicking the points, or dragging the pointer over the points.

4. Edit the points.
   - To move the points, drag them to the desired location.
   - To delete the point, click [Delete] or press the <Delete> key.

Scaling patterns

1. Click in the [Tools] group.

2. Drag the handle to adjust the selected pattern(s) to the desired size.

   - If the <Shift> key is held down while a handle is dragged, the pattern is enlarged or reduced from the center of the pattern.
   - To flip the pattern along a vertical axis, click [Flip Vertically] in the [Edit] group.
   - To flip the pattern along a horizontal axis, click [Flip Horizontally] in the [Edit] group.
Creating a Decorative Fill Pattern

Here, we will create a new decorative fill pattern. Decorative fill patterns are created in Decorative Fill mode.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Entering Decorative fill mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Creating a decorative fill pattern</td>
</tr>
<tr>
<td>Step 3</td>
<td>Saving an edited decorative fill pattern</td>
</tr>
<tr>
<td>Step 4</td>
<td>Using an edited decorative fill pattern in Layout &amp; Editing</td>
</tr>
</tbody>
</table>

3 Click points (1) through (4), in order.

4 Double-click point (5) (end point).

---

1 Start up Programmable Stitch Creator.

2 Click ⚜️, and then select [New Decorative Fill Pattern] from the command list.

Step 2 Creating a decorative fill pattern

1 Click the [Home] tab.

2 Click [Draw Line] in the [Tools] group.

---

• To remove the last point that was entered, click the right mouse button.
• The grid spacing can be changed.

→ "Changing the grid settings" on page 310

---

1 2 3 4

5
5 Enter all necessary points.

![Pattern Diagram]

- In order to create patterns that will be cleanly sewn without feeds between them, keep the following in mind.
  - Make sure that all lines in the pattern connect.
  - Make sure that patterns can connect at the top and bottom as well as at the left and right.
  - Make sure that there are points at the top, bottom, left and right where patterns can connect.
- Use the [Preview] pane to check that patterns are connecting at the top, bottom, left and right.
  - "Preview Window" on page 308
- Use the guidelines to easily align the locations of points on the top, bottom, left and right edges.
  - "Changing the guideline settings" on page 310

- The editing procedures for Decorative fill mode are the same as in Fill/Stamp mode. However, region settings cannot be specified.
  - "Editing a Pattern in Fill/Stamp Mode" on page 296

---

**Step 3 Saving an edited decorative fill pattern**

Decorative fill patterns are saved in the .plf format.

1 Click , and then select [Save As] from the command list.

   ![Save As Dialog]

2 Select the destination, and then type in the file name.

   ![Save File Dialog]

   Specify the size beside [Default Size].
   - Click [mm] or [inch] to select the measurement units.

3 Click [Save].

---

**Step 4 Using an edited decorative fill pattern in Layout & Editing**

1 Start up Layout & Editing.

2 Select a shape.

3 From the [Region sew type] selector on the [Shapes] tab of the Ribbon, select [Decorative Fill Stitch].

4 Display the [Sewing Attributes] pane.
  - "Specifying sewing attributes" on page 63
5. In the [Region sew] section, click under [Decorative fill].

6. Select the drive and folder where the pattern was saved in Step 3.

7. Click the created decorative fill pattern, and then click [OK].

   The stitch pattern is applied to the region of the embroidery pattern.

---

• In order to create a decorative fill pattern that will be cleanly sewn, make sure that lines in connecting patterns do not overlap. Create patterns that will not overlap when sewn, as shown below.

1. Patterns overlapping when sewn
2. Clean finish as a result of patterns not overlapping when sewn

• With patterns that are not connected at the top and bottom or at the left and right as shown below, select the [Minimize feed] check box to reduce the feed.
Programmable Stitch Creator Window

1. Application button
2. Ribbon
3. Quick Access Toolbar
4. Help button
5. Preview window
   Shows how the pattern will be sewn.
5. "Preview Window" on page 308
6. Design Page
7. Work area
8. Status Bar
8. "Understanding Windows" on page 13
Opening a Template

Opening an image in the background

1. Click the [View] tab.
2. Click [Open Template] in the [Template] group.
3. Select the drive, the folder and the file, and then click [Open] or double-click the file’s icon.

Editing the Template

1. Click [Modify Template].
   → The application enters template-editing mode, and a red frame appears around the template.
2. Edit the template.

- The tutorial file for this application is located in Documents (My documents)\Palette Ver.11\Sample\Programmable Stitch Creator\Template.
- Only one image can be added to the work area. If you try to display a different image, it will replace the previous one.
- There are many different types of files that can be opened.
   ▶ “Image file formats” on page 162

- Drag the inside of the red frame to move the template image.
- Click outside of the red frame to exit template-editing mode.
- Click [Delete] to delete the template.
Changing the density background image

1. Drag the slider in the [Template] group, or click [ ] or [ ].

- Hide (off)
- 25%
- 50%
- 75%
- 100%

This function is not available if no template image has been imported into the work area.

Press the shortcut key <F6> to switch between displaying the image (On (100%)) to displaying it faded at each density (75%, 50% and 25%) to hiding the image (Off).
Preview Window

1. Click the [View] tab.
2. To switch between displaying and hiding the [Preview] window, select or unselect the [Preview Window] check box in the [View] group.

Saving Patterns

Overwriting

Click , and then select [Save] from the command list.

→ If no file name has been specified or if the file cannot be found, the [Save As] dialog box appears.

Saving with a new name

The files are saved as .pas files in Fill/Stamp mode, as .pmf files in Motif mode, and as .plf files in Decorative fill mode.

1. Click , and then select [Save As] from the command list.

① In Fill/Stamp mode
② In Motif mode
③ In Decorative Fill mode
2 Select the drive and the folder, and then type in the file name.

![File selection dialog box]

→ When saving a motif pattern, specify the size beside [Default Size]. Click [mm] or [inch] to select the measurement units.

3 Click [Save].

Saved files can be used in Layout & Editing or Design Center.

“Using the edited fill/stamp stitch patterns in Layout & Editing” on page 295 and “Using the edited motif stitch pattern in Layout & Editing” on page 300
Changing the Display Settings

Changing the grid settings

The grid can be displayed or hidden, and how the grid is displayed as well as its spacing can be specified.

1. Click the [View] tab.
2. Specify the grid settings.

   a. with Axes
      Select this check box to display the grid lines.
      The grid display differs depending on the mode.

     1. Check box selected.
     2. Check box cleared.

   b. Grid interval
      Drag the slider to specify the grid spacing.
      - In Fill/Stamp mode or Motif mode, the available settings are no grid and 1/64, 1/32, 1/16 and 1/8 of the Design Page width.
      - In Decorative fill mode, the available settings are no grid and 1/128, 1/64, 1/32 and 1/16 of the Design Page width.

Changing the guideline settings

1. Click the [View] tab.
2. To display the guidelines, select the [Guideline] check box in the [Guideline] group. To hide the guidelines, clear the check box.
3. Click a ruler in the Design Page.
   → appears, and a guideline is drawn.

   1. Guideline
      - To move a guideline, drag $\rightarrow$.
      - To delete a guideline, click $\times$.

   • A guideline is added each time the ruler is clicked. In addition, up to 100 guidelines each can be added to the horizontal and vertical rulers.
   • When the [Guideline] check box is cleared, the guidelines are hidden.
   • If the grid is displayed, the guidelines will be added/moved along the lines of the grid.
Font Creator

User-defined fonts can be created using Font Creator. In addition, your embroidery data can be registered as a font. These fonts can be recalled to be used in Layout & Editing.
Font Creator

Application button menu

No. | Menu                      | Reference |
---  |---------------------------|-----------|
1    | Create New Font           | p. 328    |
2    | New Font Mapping          | p. 321    |
3    | Open                      | p. 328    |
4    | Save                      | p. 335    |
5    | Save As                   | p. 335    |

Ribbon menu tabs

■ Home tab

No. | Menu                          | Reference |
---  |-------------------------------|-----------|
1    | Select Object Tool            | p. 331    |
2    | Edit Point Tool               | p. 332    |
3    | Manual Punch Tool             | p. 316    |
4    | Zoom In                       | —         |
5    | Zoom Out                      | —         |
6    | Other Zoom Tools              | —         |
7    | Pan                            | —         |
8    | Cut                            | —         |
9    | Copy                           | —         |
10   | Paste                          | —         |
11   | Duplicate                     | —         |
12   | Delete                         | p. 332    |
13   | Previous Character            | p. 329    |
14   | Select Character              | p. 329    |
15   | Next Character                | p. 329    |
16   | Browse Characters             | p. 334    |
17   | Add/Remove Character          | p. 329    |
18   | Standard Character Height     | p. 323    |
19   | Multiple Import               | p. 325    |
20   | Single Import                 | p. 322    |
21   | Sewing Order                  | p. 333    |
22   | Convert TrueType Font to Data | p. 331    |
23   | Point Edit                    | p. 332    |
24   | Flip                           | p. 331    |
25   | Align                          | —         |
### View tab

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Template</td>
<td>p. 314</td>
</tr>
<tr>
<td>2</td>
<td>Modify Template</td>
<td>p. 336</td>
</tr>
<tr>
<td>3</td>
<td>Delete Image</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Background Image Density</td>
<td>p. 336</td>
</tr>
<tr>
<td>5</td>
<td>Fill Mode</td>
<td>p. 336</td>
</tr>
<tr>
<td>6</td>
<td>Preview Window</td>
<td>p. 333</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Show/Hide Status Bar</td>
<td>p. 326</td>
</tr>
<tr>
<td>8</td>
<td>Show Grid</td>
<td>p. 337</td>
</tr>
<tr>
<td>9</td>
<td>Show Grid with Axes</td>
<td>p. 337</td>
</tr>
<tr>
<td>10</td>
<td>Snap to Grid</td>
<td>p. 337</td>
</tr>
<tr>
<td>11</td>
<td>Grid Spacing</td>
<td>p. 337</td>
</tr>
</tbody>
</table>
Creating New Font Characters From Background Images

With Font Creator, user-defined font characters that can be used in Layout & Editing can be created and edited. Using these custom characters, original embroidery patterns can be created.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selecting a character to be created</td>
</tr>
<tr>
<td>2</td>
<td>Opening a background image</td>
</tr>
<tr>
<td>3</td>
<td>Creating a font character pattern</td>
</tr>
<tr>
<td>4</td>
<td>Creating other font character patterns</td>
</tr>
<tr>
<td>5</td>
<td>Save the font character pattern</td>
</tr>
<tr>
<td>6</td>
<td>Creating an embroidery pattern using the created font characters</td>
</tr>
</tbody>
</table>

**Step 1 Selecting a character to be created**

2. Click the [View] tab.
3. Click [Open] in the [Template] group, and then select [Select Image File] from the list.

**Step 2 Opening a background image**

1. Click the [View] tab.
2. Click [Open] in the [Template] group, and then select [Select Image File] from the list.

**Step 3 Creating a font character pattern**

1. Click the [Home] tab.
2. Click the [Select Character] box in the [Character] group, and then select "T" from the list.

**Step 4 Creating other font character patterns**
Creating New Font Characters From Background Images

3 Import the **Capital_T.bmp**.

The image file can be found at the following location.

Documents (My documents)\Palette Ver.11\Sample\Font Creator\Font Template

There are many different types of files that can be opened.

“Image file formats” on page 162

4 Move the character so that the top aligns with the **[Capital Line]**. To adjust the height of the character, drag a handle to adjust the height between the **[Capital Line]** and the **[Base Line]**.

- Red lines are added above, below and to the left and right of the sample image. Use these lines as guides for adjusting the **[Base Line]**, **[Capital Line]** and **[Set Lines]**.
- If the handles have disappeared, right-click the image, and then click **[Modify Template]** in the menu that appeared.

5 Click the **[Home]** tab.

6 Click **[ ]** in the **[Tools]** group, and then drag the red triangle icons to move the set lines so that they are aligned with the left and right of the character.

7 Click the **[View]** tab.

8 In the **[Template]** group, drag the slider (or click **[ ]** or **[ ]**) to change the density of the template image to “25%”.

- This function is not available if no template image has been imported into the work area.
- Press the shortcut key <F6> to switch between displaying the image (On (100%)) to displaying it faded at each density (75%, 50% and 25%) to hiding the image (Off).

---

**Step 3 Creating a font character pattern**

1 Click the **[Home]** tab.

3. Click , and then click in the Design Page to specify points (1) (start point) through (4).

4. Click [Manual Punch], select , and then click point (5) through (7).

5. Click [Manual Punch], select , and then click points (8) through (10).

- Straight block-type punching patterns (region sewing). (Shortcut key: <Z>)
- Curved block-type punching patterns (region sewing) (Shortcut key: <X>)
- Semi-automatically created straight block-type punching pattern
  By semi-automatically tracing, points can be specified along the lines of a template. (Shortcut key: <C>)
- Running-type punching pattern (line sewing) (Shortcut key: <V>)
- Feed-type punching pattern (jump stitches) (Shortcut key: <B>)

- When entering points, you can switch between the various tools. This is very easy if the shortcut keys are used.
- A template image is needed in order to use the semi-automatic block-type punch tool. If there is no image, this tool will create a punching pattern like the straight block-type punch tool. In addition, this tool cannot be used if a TrueType font is used as the template.
- Once the pattern is drawn, you can still transform straight block-type patterns into curved block-type patterns and vice versa.

For details, refer to "To Straight/To Curve" on page 332.
6. Click [Manual Punch], select ✔, and then click point (11).

7. Click [Manual Punch], select ✔, and then click points (12) through (13).

8. Double-click point (14) (the last point of the entire pattern), or click point (14) and press the <Enter> key.

Step 4 Creating other font character patterns

1. Click the [Home] tab.

2. Click the [Select Character] box in the [Character] group, and then select "g" from the list.

3. Import file Small_g.bmp in the same way that "T" was imported.

4. In the same way that "T" was adjusted, change the character size and position, and then drag the red triangle icons to move the set line so that they are aligned with the left and right of the character.

To remove the last point that was entered, right-click the mouse button, or press the <BackSpace> key.

Note: If the red lines are not shown, change the density of the template image.
5 Click in the [Tools] group, and then drag the blue triangle icons to move the mean line and descender line so that they are aligned with the top and bottom of the character.

6 Click [Manual Punch], select , and then click points (1) through (7).

7 Click [Manual Punch], select , and then click points (8) through (24).

8 Click [Manual Punch], select , and then click points (25) through (26).
Creating New Font Characters From Background Images

9 Click [Manual Punch], select , and then click points (27) through (33).

10 Click [Manual Punch], select , and then click points (34) through (38).

11 Click [Manual Punch] and select . Next, click points (39) through (46), and then double-click point (47) (end point), or click point (47) and press the <Enter> key.

Step 5 Save the font character pattern

1 Click , and then select [Save As] from the command list.

2 Select the [MyFont] folder at the following location.

For example, (Drive where Palette was installed)\Program Files (x86)\Babylock\Palette Ver.11\MyFont.

And then type in the file name. For this example, type in the name "My font 1". Click [Save].

- The created font is saved in the [MyFont] folder at the following location.
  For example, (Drive where Palette was installed)\Program Files (x86)\Babylock\Palette Ver.11\MyFont.
- The font will not be usable in the Layout & Editing if it's stored in a different folder.
- If any part of the character pattern extends off the Design Page, a message appears. Edit the character pattern so that no part extends off the Design Page, and then save it again.

If the background image is displayed, the information for the background image will be saved with the font file. The next time that the font file is opened, the background image is displayed.

If the background image is displayed, the information for the background image will be saved with the font file. The next time that the font file is opened, the background image is displayed.
Creating an embroidery pattern using the created font characters

1. Start up Layout & Editing.

   If Layout & Editing is already started, exit it, and then start it again. The new font is detected when the application starts up.

2. Click the [Home] tab.

3. Click [Text] in the [Tools] group, and then select A from [Text Tools].

4. Click in the Font selector, and then select "My font 1".

5. Click in the Design Page. Input the text, and then press <Enter> the key or click the Design Page.

Fonts created in Font Creator appear with the icon in front of the font name.

Since fonts for only "T" and "g" were created in the previous examples ("A", "B", "C", etc. were not created), only these characters appear in the sample when [Font] selector is clicked.

"Creating Embroidery Patterns Containing Text" on page 110
Registering Embroidery Data as a Font

You can register your embroidery data as a font. Once registered, the character patterns can be arranged by simply entering text. Font character patterns can be created either from individual embroidery patterns or as a batch from multiple embroidery patterns.

1. Prepare the embroidery data and the folder to be registered.
2. Create your folder in the following location, and save your embroidery data in the folder.
   (Drive where Palette was installed)\Program Files (x86)\Baby lock\Palette Ver.11\MyFont.

Registering embroidery data (individual registration)

### Specifying the standard character height

1. Start up Font Creator.
2. Click ✖️, and then select [New Font Mapping] from the command list.

   → The [Set Standard Character Height] dialog box appears.

3. Specify the standard character height. For this example, click [Set standard character height from embroidery file] to specify the height of the embroidery pattern as the standard.

#### User-defined size
The entered value will be the standard character height. Select "mm" or "inch" as the measurement units.

#### Set standard character height from embroidery file
The height of the selected embroidery pattern will be standard character height.

Font Creator

321
4. Select the pattern that will specify the standard character height, and then click [OK].

For this example, select the "M" character.

→ The height of the selected pattern will be standard character height.

■ Selecting the embroidery data to register

1. From the [Select Character] box, select the character to be registered. For this example, select "D".

2. Click [Single Import] on the [Home] tab.

■ Selecting additional embroidery data

1. From the [Select Character] box, select the character to be registered. For this example, select "P".

2. Click [Single Import] on the [Home] tab.
Select the embroidery file to be registered, and then click [Import].

The registered character appears.

Adjusting the character position

1. Click in the [Tools] group, and then click the character.
   → Dotted lines appear around the character.

2. Drag the character to move it.

When text is entered with the registered font, the text will have the height specified in the [Set Standard Character Height] dialog box.

To change the standard character height to the height of the character embroidery pattern currently being edited, click [Standard Character Height], and then select [Size of character being edited].

Saving registered characters

Registered characters will be saved as font character patterns in the PFK format.

1. Click , and then select [Save As] from the command list.
2 Save the pattern to the [MyFont] folder at the following location.

For example, (Drive where Palette was installed)\Program Files (x86)\Baby lock\Palette Ver.11\MyFont

- When the font character pattern is saved, text can be entered with it in Layout & Editing.
- If the pattern is saved in a different folder, it cannot be edited in Layout & Editing.
- When a .pes file that contains user-defined colors is registered, those colors appear as [Basic Color] in Layout & Editing.

Registering embroidery data (batch registration)

1 Prepare the embroidery data to be registered, and rename them so that the character in each file can be identified by the file name.

Characters are registered according to the file name of the embroidery data.

In order to differentiate uppercase and lowercase letters, add "u_" at the beginning of file names for uppercase letters, and "l_" at the beginning of file names for lowercase letters (for example, u_A.pes or l_a.pes).

For characters that cannot be used in file names, specify their file names as shown below.

<table>
<thead>
<tr>
<th>Character</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>s_bs</td>
</tr>
<tr>
<td>/</td>
<td>s_sl</td>
</tr>
<tr>
<td>:</td>
<td>s_cn</td>
</tr>
<tr>
<td>*</td>
<td>s_as</td>
</tr>
<tr>
<td>?</td>
<td>s_qm</td>
</tr>
<tr>
<td>&quot;</td>
<td>s_dq</td>
</tr>
<tr>
<td>&lt;</td>
<td>s_lt</td>
</tr>
<tr>
<td>&gt;</td>
<td>s_gt</td>
</tr>
<tr>
<td>l</td>
<td>s_vb</td>
</tr>
</tbody>
</table>

2 Start up Font Creator.

3 Click [A], and then select [New Font Mapping] from the command list.

→ The [Set Standard Character Height] dialog box appears.

4 Specify the standard character height. For this example, specify a character height of 146.5 mm, and then click [OK].

▶ “Specifying the standard character height” on page 321
5 Click [Multiple Import] on the [Home] tab.

6 Select the files to be registered.

7 Click [Import].

→ When registration is finished, one of the registered characters appears in the Design Page, and the [Browse] dialog box appears.

8 Select the character whose position is to be adjusted, and then click [Select].

9 Adjust the position of the character.

   "Adjusting the character position" on page 323

10 Save the registered characters.

   "Saving registered characters" on page 323

• Embroidery files of the following types will not appear in the file list of the dialog box.

  • Files where the embroidery pattern size exceeds 500 mm
  • Files where the embroidery pattern size is less than 5 mm
  • Files where the hoop size has been set to a large-size split embroidery frame, jumbo frame or a multi-position hoop
  • Files that contain a cutwork pattern
Font Creator Window

1. Application button
2. Ribbon
3. Quick Access Toolbar
4. Help button
5. Preview Window
   Shows how the stitch pattern will be sewn.
   "Previewing the embroidery pattern" on page 333
6. Design Page
7. Guidelines (fixed)
   "About the Design Page guidelines" on page 327
8. Guidelines (movable)
   "About the Design Page guidelines" on page 327
9. Work area
10. Status Bar
    "Understanding Windows" on page 13
The standard guidelines for creating fonts are shown in the Design Pages. The contents of each of the guidelines are as shown below.

1. **Base Line**
   The font's standard height will be from the **Base Line** to the **Capital Line** line. These line cannot be moved.

2. **Capital Line**
   The font's standard heigh will be from the **Base Line** to the **Capital Line** line. These line cannot be moved.

3. **Mean Line**
   When in lower case, the standard height of the font will be from the **Base Line** to this line. It can be moved by dragging the triangle icon on the right edge.

4. **Descender Line**
   This line is the standard for characters with parts that hang down (descenders) such as "g" and "y". It can be moved by dragging the triangle icon on the right edge.

5. **Ascender Line**
   This line is the standard for characters with parts that extended above (ascenders) such as the accent mark. It can be moved by dragging the triangle icon on the right edge.

6. **Set Line (Left)**

7. **Set Line (Right)**
   This line will be the font width. The font width can be adjusted by dragging the triangle icon on the bottom edge.

- The heights and widths specified for the **Base Line**, **Capital Line** and **Set Lines** are the reference mask for creating the font character.
- When characters created with Font Creator are imported into Layout & Editing, the width and height of the characters will be in the following area.
  - Character height: from **Base Line** 1 to **Capital Line** 2
  - Character width: from **Set Line (Left)** 6 to **Set Line (Right)** 7
- In order to align the height of the characters, the **Ascender Line**, **Mean Line** and **Descender Line** appear the same with all characters. Therefore, if the height of any of these lines is changed, the setting is maintained, even when a different character is selected to be edited.
- The widths of the **Set Lines** can be set separately for each character.
Opening a File

Creating a new font

Click , and then select [Create New Font] from the command list.

→ The application enters Create New Font mode.

To create font character patterns from embroidery data, select [New Font Mapping].

"Registering Embroidery Data as a Font" on page 321

Opening a font file

1 In Create New Font mode, click , and then select [Open] from the command list.

2 The created font is saved in the [MyFont] folder at the following location.

(Drive where Palette was installed)\Program Files (x86)\Baby lock\Palette Ver.11\MyFont

3 To open a file, select it, and then click [Open], or double-click the file's icon.
Selecting a Character and Preparing the Template

Selecting the character to be created

### Selecting from the selector

1. Click the [Home] tab.
2. Click the left or right arrow buttons of the [Select Character] box in the [Character] group to select a character before or after the one that is currently displayed.

### Selecting from a character list

1. Click the [Select Character] box in the [Character] group.
2. Click the character to be created.

### Adding/deleting registered characters

2. From the keyboard, enter the character to be registered.

- Characters where pattern has already been created appear with a blue background.
- The blank box in the upper-left corner is a space. Click this box to select a space.

If any part of the character pattern extends off the Design Page when a different character is selected, a message appears. Before selecting a different character, edit the character pattern so that no part extends off the Design Page.
3 Click [Add].

4 To delete a registered character, select the character, and then click [Remove]. The box is selected in red. Each click of the character switches between selecting and deselecting it.

5 When the settings can be applied, click [OK].

If a character is registered even though a font has not been created, the information for the registered character is saved in a font file.

Opening a template (TrueType font)

1 In Create New Font mode, click the [View] tab.

2 Click [Open] in the [Template] group, and then select [Select TrueType Font] from the list.

3 From the [Font] selector, select the font. From the [Style] selector, select the character style. And then click [OK].

While working on a character in a font, the same TrueType font appears until a different template is selected for the background. Each time a different character is selected in the [Select Character] box, the template of the character in the same TrueType font appears.

- If a character is registered even though a font has not been created, the information for the registered character is saved in a font file.

- If the character selected in the [Select Character] box is not available in the TrueType font, “?” appears as the template.

- If a TrueType font was selected as the template, it cannot be moved or resized.

- In this case, it can automatically be converted to a font character pattern.

  "Automatically converting TrueType fonts" on page 331.

- In addition, the character cannot be drawn with the semi-automatic block-type punch tool.
Creating a Font Character Pattern

Automatically converting TrueType fonts

1 In Create New Font mode, open the TrueType font to be used as a template.
   "Opening a template (TrueType font)" on page 330.

2 Click the [Home] tab.

3 Click [Convert from TrueType] in the [Edit/Arrange] group.

4 If a TrueType font has not been selected for the template, the [Select TrueType Font] dialog box appears.

Editing Font Character Patterns

Selecting patterns

1 In Create New Font mode, click the [Home] tab.

2 Click [Select] in the [Tools] group to use the [Select] tool.

3 Click the pattern.

■ Moving patterns
Selected patterns can be dragged to move them.

- To move the pattern horizontally or vertically, hold down the <Shift> key while dragging it.
- Pressing the arrow keys moves the selected pattern one grid mark in the direction of the arrow on the key. If the grid is not displayed, the pattern moves a distance smaller than the smallest grid interval in the direction of the arrow on the key.

■ Scaling patterns
Drag a handle of the selected pattern to adjust its size. Drag the rotation handle to rotate the pattern.

- If the <Shift> key is held down while a handle is dragged, the pattern is enlarged or reduced from the center of the pattern.
- Click [Flip] in the [Edit/Arrange] group, and then select [Flip Vertically] to flip the selected pattern(s) up/down. Select [Flip Horizontally] to flip the selected pattern(s) left/right.

- Using commands other than those mentioned above, selected patterns can be edited in other ways, for example, duplicated or deleted.

To select an additional pattern, hold down the <Ctrl> key and click the other pattern.

You can also select patterns by dragging the pointer across the pattern.

Hold down the <Ctrl> key and click a selected pattern to deselect it.
Editing the Points of a Font Character Pattern

Editing points and reshaping patterns

1. In Create New Font mode, click the [Home] tab.
2. Click [Select Point] in the [Tools] group.
3. Click the pattern.
4. To edit a point, click the point to select it.

- To move the point, drag it to the new location.
- To insert a point, click the line to add a new point.
  → A new point appears selected (as a small black square or circle).
- To delete the point, click (Delete) or press the <Delete> key.

To Straight/To Curve

1. Select the point(s).
2. Click [Point] in the [Edit/Arrange] group, and then select the desired command from the list.

For details on the commands To Straight, To Curve, To Smooth, To Symmetry and To Cusp, "Transforming straight lines into curves or curves into straight lines" on page 79 and "Changing the curve type" on page 79.

These commands are not available with patterns entered using the [Running] or [Feed] tools.
Checking the Created Font Patterns

Checking and editing the sewing order

1. In Create New Font mode, click the [Home] tab.
2. Click [Sewing Order] in the [Edit/Arrange] group.
3. Select a pattern in the [Sewing Order] dialog box.
4. The sewing order can be changed by selecting the frame containing the pattern that you want to move, then dragging the frame to the new location. A vertical red line appears, indicating the position where the frame is being moved.

An alternative method for moving the frames is by clicking the buttons at the bottom of the dialog box.

- : To move back one position in the sewing order.
- : To move to the end of the sewing order.
To change the sewing order, click [OK].

Previewing the embroidery pattern

1. Click the [View] tab.
2. To switch between displaying and hiding the [Preview Window], select or unselect the [Preview Window] check box in the [View] group.

- : To move back one position in the sewing order.
- : To move to the end of the sewing order.

To change the sewing order, click [OK].
Checking and selecting from the list of created characters

A list of characters included in the font file currently being edited can be viewed.

1. Click the [Home] tab.

2. Click [Browse Characters] in the [Character] group.

To select a character, click the character, and then click [Select].
Saving Font Character Patterns

**Overwriting**

In Create New Font mode, click 🔄, and then select [Save] from the command list.

→ If no file name has been specified or if the file cannot be found, the [Save As] dialog box appears.

⚠️ If any part of the character pattern extends off the Design Page, a message appears. Edit the character pattern so that no part extends off the Design Page, and then save it again.

**Saving with a new name**

The font character patterns are saved as .pef files.

1. In Create New Font mode, click 🔄, and then select [Save As] from the command list.

2. Select the [MyFont] folder at the following location.

For example, (Drive where Palette was installed)\Program Files (x86)\Baby lock\Palette Ver.11\MyFont

And then type in the file name, then click [Save].

- The font will not be usable in the Layout & Editing if it's stored in a different folder.
- The created font is saved in the [MyFont] folder at the following location.
For example, (Drive where Palette was installed)\Program Files (x86)\Baby lock\Palette Ver.11\MyFont

- Saved files can be used in Layout & Editing.

"Creating an embroidery pattern using the created font characters" on page 320

- If Layout & Editing has already started up when a new character is saved in Font Creator, that character will not appear in the [Font] selector list in Layout & Editing. In this case, exit Layout & Editing, and then start it up again.
Changing the Settings

Changing the drawing mode

There are two drawing modes in Create New Font mode of Font Creator.

• Fill mode
Blocks appear filled in. In this mode, the overlapping positions of patterns can be viewed better.

• Outline mode (Fill mode Off)
Blocks do not appear filled in. In this mode, points can be edited more easily.

Perform the operation described below to switch between these modes.
Click the [View] tab.
Click [Fill Mode] in the [View] group.

Scaling/Moving the background image

Click [Modify Template] in the [Template] group.

The background image is selected.
The background image can be moved or resized in the same way that font character patterns are edited.

“The background image cannot be scaled or moved if a TrueType font is used as the template.”

“Editing Font Character Patterns” on page 331.
Changing the grid settings

1. Click the [View] tab.

2. Specify the grid settings in the [Grid] group.

   1. To display the grid, select the [Show Grid] check box.
   2. To display the grid as solid lines, select the [with Axes] check box.
   3. In the [Interval] box, select the grid spacing.
   4. To input the font in a uniform thickness or match vertical and horizontal positions, select the [Snap to Grid] check box.

The pointer will move by the amount set in [Interval] box.
The snap feature works whether or not the grid is displayed.
Supplement

This section provides hints and detailed techniques for creating even more attractive embroidery.
Enlarging/Reducing Stitch Patterns

Imported stitch patterns can be enlarged or reduced in Layout & Editing in the following three ways.

1. Stitch patterns can be simply enlarged/reduced.

2. Stitch patterns can be enlarged/reduced while the <Ctrl> key is held down.

3. Using the [Convert to Blocks] tools, stitch patterns can be enlarged/reduced after being converted to a group of shape patterns with multiple sewing direction lines.

With method 1, the stitching will become more dense or light without the number of stitches sewn changing. In other words, greatly enlarging or reducing the pattern changes the quality of the embroidery since the thread density is not adjusted. Use this method when only slightly enlarging/reducing the stitch pattern.

With method 2, the size of the pattern is changed while maintaining the thread density and needle drop point pattern. However, if the original thread density and needle drop point pattern in the stitch pattern are not uniform, the thread density and needle drop point pattern may not be maintained, even by using this method. Enlarge/reduce the pattern while checking the preview. Do not use this method when only slightly enlarging/reducing the stitch pattern.

With method 3, the thread density is maintained while the pattern is enlarged/reduced. However, the needle drop point pattern is not entirely maintained. Use this method when you wish to change the stitching or shape. Do not use this method when only slightly enlarging/reducing the stitch pattern.

Sewing Direction

In order to limit pulling or puckering, select a stitch direction perpendicular to the larger edge of the area.

Pulling or puckering more likely to occur

Pulling or puckering less likely to occur

Sewing Order

After creating an embroidery pattern made of several different parts (in Layout & Editing or Design Center), be sure to check the sewing order and correct it if necessary.

With Layout & Editing, the default sewing order is the order in which the elements are drawn.

With Design Center, the default sewing order is the order in which the sewing attributes are applied.

Be careful when changing the sewing order since overlapping areas may be incorrectly positioned.

This software allows you to create a wide variety of embroidery patterns and supports wider ranges for the setting of the sewing attributes (thread density, sewing pitch, etc.). However, the final result also depends on your particular embroidery machine model. We recommend that you make a trial sewing sample with your sewing data before sewing on the final material. Remember to sew your trial sample on the same type of fabric as your final material and to use the same needle and the same machine embroidery thread.
Sewing Wide Areas

  - For more details, refer to "Under sewing" on page 364.
- Changing the [Sewing Direction] setting prevents pulling-in or puckering of the stitching.
- When embroidering, use stabilizer material specifically for embroidering. Always use stabilizer material when embroidering lightweight or stretch fabrics, otherwise the needle may bend or break, the stitching may pull and pucker, or the pattern may become misaligned.
- When satin stitching is sewn in a wide area, the stitched area may shrink after sewing, depending on the material and the type of thread used. If this happens, switch to this alternate method: Select the fill stitch and use stabilizer material on the reverse side of the fabric.
On Settings

Jump Stitch and Jump Stitch Trimming

- **Machine thread trimming according to settings specified in Layout & Editing**

If is selected in the [Design Settings] dialog box of Layout & Editing, trimming can be turned on or off at each jump stitch location. These settings are saved in embroidery data files (.pes).

- **Specifying trimming settings in Layout & Editing**

1. Select in the [Design Settings] dialog box.
   - “Specifying the Design Page Settings” on page 16
2. Display the trimming locations in Layout & Editing.
   - Memo of “Changing the display of the embroidery design” on page 87
3. Turn on/off jump stitch trimming for each embroidery pattern.
   - “Jump Stitch Trimming” on page 97

If necessary, change settings for the following:

- Automatically turning off trimming when the jump stitch length is less than that specified.
- “Jump Stitch Trimming” on page 97 and “About Minimum jump stitch length for thread trimming” on page 97
- Default setting for turning on/off jump stitch trimming when a new embroidery pattern is created.
- “Adding jump stitch trimming to new patterns” on page 346

These settings are applied only when embroidering with our multi-needle embroidery machines. These settings are not applied with any other embroidery machine.
Changing Various Settings

Customizing the window

■ Quick Access Toolbar/Ribbon

A menu appears when in the [Quick Access Toolbar] is clicked.

Click [More commands] to add or remove the commands appearing in the list of the [Quick Access Toolbar].

Click [Show Above the Ribbon] to move the [Quick Access Toolbar] above the Ribbon. To return it to its original position, display the menu as described above, and then click [Show Below the Ribbon].

If a check mark appears beside [Minimize the Ribbon], the Ribbon is minimized. When a tab is clicked, the Ribbon appears. After a command is selected, the Ribbon is minimized again. To restore it to its original display, clear the check mark.

Example: With [Show Below the Ribbon] selected and a check mark beside [Minimize the Ribbon]

Quick Access Toolbar commands

The first time this application is started up, the following commands appear in the Quick Access Toolbar.

- [New]
- [Redo]
- [Open]
- [Wizard]
- [Save]
- [Design Settings]
- [Zoom In]
- [Select Color Palette]
- [Undo]
- [Online Instruction Manual]

Click , then select or unselect the check boxes beside the commands to switch between displaying and hiding them. When the check mark is cleared, the command is hidden. Alternatively, changes to the commands listed in the [Quick Access Toolbar] can be specified in the [Options] dialog box and all applied at the same time.

迦— "Customizing Quick Access Toolbar" on page 344
Import/Color/Sewing Attributes/Text Attributes pane, Sewing Order pane and Stitch Simulator pane

Floating
Each tab or the entire pane can be undocked to become a dialog box that can be moved around the screen.

- Double-click the title bar of the pane, or tab.
- Right-click the pane or tab, and then click [Floating].
- Drag a tab out of the pane.

Docking
Each pane can be docked back to the window.

- Double-click the title bar.
- Right-click the pane, and then click [Docking].
- Drag the title bar to the location where the pane will be docked.

Hide
When a tab or a pane is no longer needed, it can be hidden.

- Click in the upper-right corner of the dialog box.
- Right-click the tab or dialog box, and then click [Hide].
- To hide the tab, click [View] tab in the Ribbon, and then click the name in the [View] tab. To display the tab again, perform the same operation.

Auto Hide
When a pane is temporarily not needed, it can be moved to the side bar, then displayed by clicking it or positioning the pointer over it. The pane is automatically hidden again when it is no longer being used, for example, when you click anywhere outside of the pane.

- Right-click the tab or the title bar of the pane, and then click [Auto Hide].
- In the upper-right corner of the pane, click .

To cancel Auto Hide, right-click the title bar, and then click [Auto Hide], or simply click in the title bar.

- The Stitch Simulator pane cannot be temporarily hidden (Auto Hide).
- These panes can be returned to their default displays.

Using access keys
When the <Alt> key is pressed, a KeyTip (label showing the letter of the access key) appears on each command. On the keyboard, press the key corresponding to the command that you wish to use.

To stop using the access keys and hide the KeyTips, press the <Alt> key.
Changing options settings

From the [Options] dialog box, the commands appearing in the [Quick Access Toolbar] and settings for the application’s appearance can be selected, and also the settings on shortcut keys, jump stitches, thread charts can be specified or changed. Follow the procedure described below to display the [Options] dialog box.

Click [ ], and then click [Options] on the bottom of the window.

- Customizing Quick Access Toolbar

The [Options] dialog box can also be displayed using either of the following methods.

- Click [ ] at the right end of the Quick Access Toolbar, and then click [More Commands].
- Click [Option] in the upper-right corner of the window, and then click [Options].

1. Click [Customize].

2. Repeat the following operations until the desired commands are displayed.
   - Choose commands from selector
     Select a command category.
   - Commands list
     Select the command to be added.
   - Add button
     Selected command is added. The command appears in A.
   - Remove button
     Selected command is removed. The command is removed from A.
   - Select an icon in A, and then click the buttons to move it to the desired position.
   - Reset button
     Reverting to the default commands.

3. After the settings have been specified, click [OK] to apply them.

4. Show Quick Access Toolbar Below the Ribbon

   Select where the Quick Access Toolbar is displayed. Select the check box to display the Quick Access Toolbar below the Ribbon.
**Customizing Shortcut keys**

1. Click [Customize] in the command list, then [Customize] beside [Keyboard shortcuts].

2. In the [Categories] list, select a command category. Then, in the [Commands] list, select the command whose shortcut keys are to be specified.

   - The default shortcut keys appear in the [Current Keys] box ①.


   - Usage information about the entered key combination appears. If the key combination has already been assigned to another command, the name of that command appears at ③.

   To remove the default or specified shortcut keys, select the shortcut keys in ①, and then click [Remove] ⑤.

   To revert to the default settings, click [Reset All] ⑥.

4. Repeat steps ② and ③ until the desired shortcut keys have been specified for the commands, and then click [Close].

5. Click [OK] in the [Options] dialog box.

**Editing user thread charts**

For detailed instructions, see "Editing user thread color lists" on page 212.

**Specifying the number of jumps in embroidery design of the DST format**

With the DST format, you can specify whether or not the jump stitches are trimmed according to the number of jump codes. The number of codes differs depending on the embroidery machine being used.

Click [DST Settings] in the command list, specify the number of jumps, and then click [OK].

To specify a setting for importing, enter a value beside [DST Import Setting]. To specify a setting for exporting, enter a value beside [DST Export Setting].

**DST Import Setting**

If the number of consecutive jumps in the DST file is less than the number of jumps specified here, those consecutive jumps will be replaced with a stitch.

If the number of consecutive jumps in the DST file is greater than or equal to the number of jumps specified here, those jumps will be replaced with a jump stitch where the thread is trimmed.

**DST Export Setting**

When .pes files are output, jump stitches with thread trimming are replaced with more consecutive jump codes than the specified number of jumps.
Adding jump stitch trimming to new patterns

When creating a new embroidery pattern for our multi-needle embroidery machines, you can specify whether or not to add jump stitch trimming to the pattern.

These settings are applied only when embroidering with our multi-needle embroidery machines. Before these settings can be specified, select under [Machine Type] in the [Design Settings] dialog box.

Click [Jump Stitch Trimming] in the command list, select the [Add jump stitch trimming to the entered patterns.] check box, and then click [OK].

When the check box is selected, scissors icon appear beside the frames to indicate jump stitch trimmings are applied.

Optimize Entry/Exit Points

When data for multiple regions is created with a [Shapes] tool, the exit and entry points between regions of the same color can be automatically optimized.

Click [Optimize Entry/Exit Points] in the command list, select the [Optimize Entry/Exit Points.] check box, and then click [OK].

If data is created by clicking in the order shown below:

When the check box is cleared

The entry and exit points are set based on the order that the data was entered.

When the check box is selected

The entry and exit points are set where a straight line connecting the regions will be the shortest.

Changing the system unit

For detailed instructions, see "System unit" on page 22.

Adjusting the screen calibration

For detailed instructions, see "Adjusting on-screen measurements (Screen Calibration)" on page 21.
Changing Various Settings

■ Customizing User Interface Settings

The color scheme of the applications can be selected.

Click [User Interface Settings] in the command list, select the desired color scheme from [Application Color], and then click [OK].

With the [Show Status Bar] check box, select whether to display or hide the status bar. To display the status bar, select the check box.

If the [Reset Pane Position] button is clicked, the docked panes ([Import]/[Color]/[Sewing Attributes]/[Text Attributes] panes, [Sewing Order] pane and [Stitch Simulator] pane) return to their default displays after the application is restarted.

■ Network Machine Settings

For detailed instructions, see “Transferring to a machine via wireless network” on page 223.
For Making an Effective Use of This Application

Converting Characters (Japanese, Chinese, Korean, etc) to Embroidery Patterns

Embroidery patterns can be created from various characters, such as Japanese, Chinese, Korean etc, using TrueType fonts.
For this example, we will create an embroidery pattern from Japanese characters.

1. Start up Layout & Editing.
2. Select a Text tool, and then select a Japanese TrueType font (for example, "MS Gothic").
3. Display the character map on the computer.
   ( – [Windows Accessories] – [Character Map])
4. Select [MS Gothic] from the [Font] list in [Character Map], and then select the [Advanced view] check box. Next, select [Windows: Japanese] from the [Character set] list, select the desired character, and then click [Select].
   (This example shows the Japanese hiragana for the word meaning "Good Afternoon").
5. After selecting all of the desired characters, click [Copy] to copy the characters.
6. Click in the Design Page where you want to enter the text.
7. Paste the characters into the text field in the [Text Attributes] pane, and then press the <Enter> key.

Converting Characters (Japanese, Chinese, Korean, etc) to Embroidery Patterns

- For Windows® 8.1 users: Position the mouse pointer in the [Start] screen to display the down arrow in the lower-left corner of the screen (below and left of the tiles), and click it. From the list of applications that appears in the screen, click [Character Map] under the title [Windows Accessories].

If Japanese or Korean can be entered directly from the computer keyboard, those characters can be entered directly into the [Edit Text Letters] dialog box.
Fonts Suitable for Embroidering

When converting TrueType fonts to embroidery patterns
For best results when converting TrueType fonts to embroidery patterns, select a font where all lines are as thick as possible, such as with a Block font.

Displaying the embroidery designs in PES format as thumbnails
Embroidery files in PES format can be viewed as thumbnails with Explorer (Windows® Explorer in Windows® 7 and File Explorer in Windows® 8.1/10). It helps you to manage embroidery designs more easily.

To display information on embroidery files, click .
To display embroidery files by using thumbnails, click .
Reference

This section contains font samples and information on the various sewing attributes.
Sewing Attributes

The sewing attributes for each sew type are first set to their default settings; however, by changing the settings of the sewing attributes, you can create custom stitching.

For more details, refer to "Line sewing attributes" on page 358 and "Region sewing attributes" on page 364.

Line sew types

Zigzag Stitch
- "Zigzag Stitch" on page 358

Running Stitch/Triple Stitch
- "Running Stitch" on page 358
- "Triple Stitch" on page 358

Motif Stitch
- "Motif Stitch" on page 359

Stem Stitch
- "Stem Stitch" on page 360

Candlewicking Stitch
- "Candlewicking Stitch" on page 360

E/V Stitch
- "E/V Stitch" on page 361
## Region sew types

The patterns of the programmable fill stitches, motif stitches and decorative fill stitches differ depending on the selected stitch pattern.

<table>
<thead>
<tr>
<th>Chain Stitch</th>
<th>Cutting</th>
</tr>
</thead>
<tbody>
<tr>
<td>➤ &quot;Chain Stitch&quot; on page 362</td>
<td>➤ &quot;Cutting&quot; on page 362</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region sew types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Satin Stitch</strong></td>
</tr>
<tr>
<td>➤ &quot;Satin Stitch&quot; on page 364</td>
</tr>
</tbody>
</table>

| **Programmable Fill Stitch (Prog. Fill Stitch)** |
| ➤ "Programmable Fill Stitch (Prog. Fill Stitch)" on page 367 |

| **Motif Stitch** |
| ➤ "Motif Stitch" on page 371 |

| **Fill Stitch** |
| ➤ "Fill Stitch" on page 366 |

| **Piping Stitch** |
| ➤ "Piping Stitch" on page 370 |

| **Cross Stitch** |
| ➤ "Cross Stitch" on page 372 |
Sewing Attributes

Concentric Circle Stitch

- "Concentric Circle Stitch, Radial Stitch and Spiral Stitch" on page 372

Radial Stitch

- "Concentric Circle Stitch, Radial Stitch and Spiral Stitch" on page 372

Spiral Stitch

- "Concentric Circle Stitch, Radial Stitch and Spiral Stitch" on page 372

Flexible Spiral Stitch

- "Flexible Spiral Stitch" on page 372

Stippling Stitch

- "Stippling Stitch" on page 373

Net Fill Stitch

- "Net Fill Stitch" on page 373

Zigzag Net Fill Stitch

- "Zigzag Net Fill Stitch" on page 374

Decorative Fill Stitch

- "Decorative Fill Stitch" on page 375
## Motif Stitch Pattern

<table>
<thead>
<tr>
<th>Name</th>
<th>Pattern</th>
<th>Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>motif001</td>
<td><img src="image1" alt="pattern" /></td>
<td>motif002</td>
<td><img src="image2" alt="pattern" /></td>
</tr>
<tr>
<td>motif003</td>
<td><img src="image3" alt="pattern" /></td>
<td>motif004</td>
<td><img src="image4" alt="pattern" /></td>
</tr>
<tr>
<td>motif005</td>
<td><img src="image5" alt="pattern" /></td>
<td>motif006</td>
<td><img src="image6" alt="pattern" /></td>
</tr>
<tr>
<td>motif007</td>
<td><img src="image7" alt="pattern" /></td>
<td>motif008</td>
<td><img src="image8" alt="pattern" /></td>
</tr>
<tr>
<td>motif009</td>
<td><img src="image9" alt="pattern" /></td>
<td>motif010</td>
<td><img src="image10" alt="pattern" /></td>
</tr>
<tr>
<td>motif011</td>
<td><img src="image11" alt="pattern" /></td>
<td>motif012</td>
<td><img src="image12" alt="pattern" /></td>
</tr>
<tr>
<td>motif013</td>
<td><img src="image13" alt="pattern" /></td>
<td>motif014</td>
<td><img src="image14" alt="pattern" /></td>
</tr>
<tr>
<td>motif015</td>
<td><img src="image15" alt="pattern" /></td>
<td>motif016</td>
<td><img src="image16" alt="pattern" /></td>
</tr>
<tr>
<td>motif017</td>
<td><img src="image17" alt="pattern" /></td>
<td>motif018</td>
<td><img src="image18" alt="pattern" /></td>
</tr>
<tr>
<td>motif019</td>
<td><img src="image19" alt="pattern" /></td>
<td>motif020</td>
<td><img src="image20" alt="pattern" /></td>
</tr>
<tr>
<td>motif021</td>
<td><img src="image21" alt="pattern" /></td>
<td>motif022</td>
<td><img src="image22" alt="pattern" /></td>
</tr>
<tr>
<td>motif023</td>
<td><img src="image23" alt="pattern" /></td>
<td>motif024</td>
<td><img src="image24" alt="pattern" /></td>
</tr>
<tr>
<td>motif025</td>
<td><img src="image25" alt="pattern" /></td>
<td>motif026</td>
<td><img src="image26" alt="pattern" /></td>
</tr>
<tr>
<td>motif027</td>
<td><img src="image27" alt="pattern" /></td>
<td>motif028</td>
<td><img src="image28" alt="pattern" /></td>
</tr>
<tr>
<td>motif029</td>
<td><img src="image29" alt="pattern" /></td>
<td>motif030</td>
<td><img src="image30" alt="pattern" /></td>
</tr>
<tr>
<td>motif031</td>
<td><img src="image31" alt="pattern" /></td>
<td>motif032</td>
<td><img src="image32" alt="pattern" /></td>
</tr>
<tr>
<td>motif033</td>
<td><img src="image33" alt="pattern" /></td>
<td>motif034</td>
<td><img src="image34" alt="pattern" /></td>
</tr>
<tr>
<td>motif035</td>
<td><img src="image35" alt="pattern" /></td>
<td>motif036</td>
<td><img src="image36" alt="pattern" /></td>
</tr>
<tr>
<td>motif037</td>
<td><img src="image37" alt="pattern" /></td>
<td>motif038</td>
<td><img src="image38" alt="pattern" /></td>
</tr>
<tr>
<td>motif039</td>
<td><img src="image39" alt="pattern" /></td>
<td>motif040</td>
<td><img src="image40" alt="pattern" /></td>
</tr>
<tr>
<td>motif041</td>
<td><img src="image41" alt="pattern" /></td>
<td>motif042</td>
<td><img src="image42" alt="pattern" /></td>
</tr>
<tr>
<td>motif043</td>
<td><img src="image43" alt="pattern" /></td>
<td>motif044</td>
<td><img src="image44" alt="pattern" /></td>
</tr>
<tr>
<td>motif045</td>
<td><img src="image45" alt="pattern" /></td>
<td>motif046</td>
<td><img src="image46" alt="pattern" /></td>
</tr>
<tr>
<td>motif047</td>
<td><img src="image47" alt="pattern" /></td>
<td>motif048</td>
<td><img src="image48" alt="pattern" /></td>
</tr>
<tr>
<td>motif049</td>
<td><img src="image49" alt="pattern" /></td>
<td>motif050</td>
<td><img src="image50" alt="pattern" /></td>
</tr>
<tr>
<td>motif051</td>
<td><img src="image51" alt="pattern" /></td>
<td>motif052</td>
<td><img src="image52" alt="pattern" /></td>
</tr>
<tr>
<td>motif053</td>
<td><img src="image53" alt="pattern" /></td>
<td>motif054</td>
<td><img src="image54" alt="pattern" /></td>
</tr>
<tr>
<td>motif055</td>
<td><img src="image55" alt="pattern" /></td>
<td>motif056</td>
<td><img src="image56" alt="pattern" /></td>
</tr>
<tr>
<td>motif057</td>
<td><img src="image57" alt="pattern" /></td>
<td>motif058</td>
<td><img src="image58" alt="pattern" /></td>
</tr>
<tr>
<td>motif059</td>
<td><img src="image59" alt="pattern" /></td>
<td>motif060</td>
<td><img src="image60" alt="pattern" /></td>
</tr>
<tr>
<td>motif061</td>
<td><img src="image61" alt="pattern" /></td>
<td>motif062</td>
<td><img src="image62" alt="pattern" /></td>
</tr>
<tr>
<td>motif063</td>
<td><img src="image63" alt="pattern" /></td>
<td>motif064</td>
<td><img src="image64" alt="pattern" /></td>
</tr>
<tr>
<td>motif065</td>
<td><img src="image65" alt="pattern" /></td>
<td>motif066</td>
<td><img src="image66" alt="pattern" /></td>
</tr>
<tr>
<td>motif067</td>
<td><img src="image67" alt="pattern" /></td>
<td>motif068</td>
<td><img src="image68" alt="pattern" /></td>
</tr>
<tr>
<td>motif069</td>
<td><img src="image69" alt="pattern" /></td>
<td>motif070</td>
<td><img src="image70" alt="pattern" /></td>
</tr>
<tr>
<td>motif071</td>
<td><img src="image71" alt="pattern" /></td>
<td>motif072</td>
<td><img src="image72" alt="pattern" /></td>
</tr>
<tr>
<td>motif073</td>
<td><img src="image73" alt="pattern" /></td>
<td>motif074</td>
<td><img src="image74" alt="pattern" /></td>
</tr>
<tr>
<td>motif075</td>
<td><img src="image75" alt="pattern" /></td>
<td>motif076</td>
<td><img src="image76" alt="pattern" /></td>
</tr>
<tr>
<td>motif077</td>
<td><img src="image77" alt="pattern" /></td>
<td>motif078</td>
<td><img src="image78" alt="pattern" /></td>
</tr>
<tr>
<td>motif079</td>
<td><img src="image79" alt="pattern" /></td>
<td>motif080</td>
<td><img src="image80" alt="pattern" /></td>
</tr>
<tr>
<td>motif081</td>
<td><img src="image81" alt="pattern" /></td>
<td>motif082</td>
<td><img src="image82" alt="pattern" /></td>
</tr>
</tbody>
</table>
### Prog. Fill Stitch Pattern

<table>
<thead>
<tr>
<th>Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>motif083</td>
<td>motif084</td>
</tr>
<tr>
<td>motif085</td>
<td>motif086</td>
</tr>
<tr>
<td>motif087</td>
<td>motif088</td>
</tr>
<tr>
<td>motif089</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>stamp5_</td>
<td>stamp6</td>
</tr>
<tr>
<td>stamp6_</td>
<td>stamp7</td>
</tr>
<tr>
<td>stamp7_</td>
<td>stampA</td>
</tr>
<tr>
<td>stamp8</td>
<td>stampC</td>
</tr>
<tr>
<td>stampD</td>
<td>stampE</td>
</tr>
<tr>
<td>stampF</td>
<td>stampG</td>
</tr>
<tr>
<td>stampH</td>
<td>stampI</td>
</tr>
<tr>
<td>stampJ</td>
<td>stampK</td>
</tr>
<tr>
<td>stampL</td>
<td>stampM</td>
</tr>
<tr>
<td>stampN</td>
<td>stampO</td>
</tr>
<tr>
<td>stampP</td>
<td>stampQ</td>
</tr>
<tr>
<td>stampR</td>
<td>stampS</td>
</tr>
<tr>
<td>stampT</td>
<td>stampU</td>
</tr>
<tr>
<td>stampV</td>
<td>stampW</td>
</tr>
<tr>
<td>stampX</td>
<td>stampY</td>
</tr>
<tr>
<td>stampZ</td>
<td>tatami1</td>
</tr>
<tr>
<td>tatami2</td>
<td>tatami3</td>
</tr>
<tr>
<td>tatami4</td>
<td>tatami5</td>
</tr>
<tr>
<td>wave1</td>
<td>wave2</td>
</tr>
<tr>
<td>wave3</td>
<td>wave4</td>
</tr>
</tbody>
</table>
### Decorative Fill Stitch Pattern

<table>
<thead>
<tr>
<th>Name</th>
<th>Pattern</th>
<th>Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>df_pat001</td>
<td><img src="image1" alt="df_pat001" /></td>
<td>df_pat002</td>
<td><img src="image2" alt="df_pat002" /></td>
</tr>
<tr>
<td>df_pat003</td>
<td><img src="image3" alt="df_pat003" /></td>
<td>df_pat004</td>
<td><img src="image4" alt="df_pat004" /></td>
</tr>
<tr>
<td>df_pat005</td>
<td><img src="image5" alt="df_pat005" /></td>
<td>df_pat006</td>
<td><img src="image6" alt="df_pat006" /></td>
</tr>
<tr>
<td>df_pat007</td>
<td><img src="image7" alt="df_pat007" /></td>
<td>df_pat008</td>
<td><img src="image8" alt="df_pat008" /></td>
</tr>
<tr>
<td>df_pat009</td>
<td><img src="image9" alt="df_pat009" /></td>
<td>df_pat010</td>
<td><img src="image10" alt="df_pat010" /></td>
</tr>
<tr>
<td>df_pat011</td>
<td><img src="image11" alt="df_pat011" /></td>
<td>df_pat012</td>
<td><img src="image12" alt="df_pat012" /></td>
</tr>
<tr>
<td>df_pat013</td>
<td><img src="image13" alt="df_pat013" /></td>
<td>df_pat014</td>
<td><img src="image14" alt="df_pat014" /></td>
</tr>
<tr>
<td>df_pat015</td>
<td><img src="image15" alt="df_pat015" /></td>
<td>df_pat016</td>
<td><img src="image16" alt="df_pat016" /></td>
</tr>
<tr>
<td>df_pat017</td>
<td><img src="image17" alt="df_pat017" /></td>
<td>df_pat018</td>
<td><img src="image18" alt="df_pat018" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Pattern</th>
<th>Name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>df_pat019</td>
<td><img src="image19" alt="df_pat019" /></td>
<td>df_pat020</td>
<td><img src="image20" alt="df_pat020" /></td>
</tr>
<tr>
<td>df_pat021</td>
<td><img src="image21" alt="df_pat021" /></td>
<td>df_pat022</td>
<td><img src="image22" alt="df_pat022" /></td>
</tr>
<tr>
<td>df_pat023</td>
<td><img src="image23" alt="df_pat023" /></td>
<td>df_pat024</td>
<td><img src="image24" alt="df_pat024" /></td>
</tr>
<tr>
<td>df_pat025</td>
<td><img src="image25" alt="df_pat025" /></td>
<td>df_pat026</td>
<td><img src="image26" alt="df_pat026" /></td>
</tr>
<tr>
<td>df_pat027</td>
<td><img src="image27" alt="df_pat027" /></td>
<td>df_pat028</td>
<td><img src="image28" alt="df_pat028" /></td>
</tr>
<tr>
<td>df_pat029</td>
<td><img src="image29" alt="df_pat029" /></td>
<td>df_pat030</td>
<td><img src="image30" alt="df_pat030" /></td>
</tr>
<tr>
<td>df_pat031</td>
<td><img src="image31" alt="df_pat031" /></td>
<td>df_pat032</td>
<td><img src="image32" alt="df_pat032" /></td>
</tr>
<tr>
<td>df_pat033</td>
<td><img src="image33" alt="df_pat033" /></td>
<td>df_pat034</td>
<td><img src="image34" alt="df_pat034" /></td>
</tr>
<tr>
<td>df_pat035</td>
<td><img src="image35" alt="df_pat035" /></td>
<td>df_pat036</td>
<td><img src="image36" alt="df_pat036" /></td>
</tr>
<tr>
<td>df_pat037</td>
<td><img src="image37" alt="df_pat037" /></td>
<td>df_pat038</td>
<td><img src="image38" alt="df_pat038" /></td>
</tr>
<tr>
<td>Name</td>
<td>Pattern</td>
<td>Name</td>
<td>Pattern</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>df_pat039</td>
<td><img src="image1" alt="Pattern" /></td>
<td>df_pat040</td>
<td><img src="image2" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat041</td>
<td><img src="image3" alt="Pattern" /></td>
<td>df_pat042</td>
<td><img src="image4" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat043</td>
<td><img src="image5" alt="Pattern" /></td>
<td>df_pat044</td>
<td><img src="image6" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat045</td>
<td><img src="image7" alt="Pattern" /></td>
<td>df_pat046</td>
<td><img src="image8" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat047</td>
<td><img src="image9" alt="Pattern" /></td>
<td>df_pat048</td>
<td><img src="image10" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat049</td>
<td><img src="image11" alt="Pattern" /></td>
<td>df_pat050</td>
<td><img src="image12" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat051</td>
<td><img src="image13" alt="Pattern" /></td>
<td>df_pat052</td>
<td><img src="image14" alt="Pattern" /></td>
</tr>
<tr>
<td>df_pat053</td>
<td><img src="image15" alt="Pattern" /></td>
<td>df_pat054</td>
<td><img src="image16" alt="Pattern" /></td>
</tr>
</tbody>
</table>
## Line sewing attributes

The available attributes differ depending on the selected sew type.

*"Specifying sewing attributes" on page 63

### Zigzag Stitch

<table>
<thead>
<tr>
<th>Under sewing</th>
<th>Off</th>
<th>On</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zigzag width</td>
<td>Narrow</td>
<td>Wide</td>
</tr>
<tr>
<td>Density</td>
<td>Coarse</td>
<td>Fine</td>
</tr>
<tr>
<td>Miter limit</td>
<td>Specify the sharpness of corners in zigzag stitching.</td>
<td></td>
</tr>
</tbody>
</table>

#### Half Stitch

- Off
  - The inside stitching is dense.
- On
  - The stitching is adjusted to a more even density.

#### Sharp Corners

- Specify the sharpness of corners in zigzag stitching.

### Running Stitch

<table>
<thead>
<tr>
<th>Run pitch</th>
<th>Specify the length of one stitch.</th>
<th>Short</th>
<th>Long</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run time(s)</td>
<td>Specify the number of times the outline is sewn.</td>
<td>1 time</td>
<td>5 times</td>
</tr>
<tr>
<td>Connection Points</td>
<td>This sewing attribute is available only when a text pattern is selected.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*"Selecting connection point positions in a text pattern" on page 126

### Triple Stitch

| Run pitch | Specify the length of one stitch. | Short | Long |
| Connection Points | This sewing attribute is available only when a text pattern is selected. | | |

*"Selecting connection point positions in a text pattern" on page 126
# Motif Stitch

Select a pattern for the motif stitch.

Click ![Browse](image) to display the [Browse] dialog box. Select a folder, and then select the desired pattern (.pmf file) from the list of patterns that appears.

<table>
<thead>
<tr>
<th>Specify the pattern size. The pattern can be enlarged or reduced while maintaining the width-to-height proportion.</th>
<th>Smaller</th>
<th>Larger</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pattern Size" /></td>
<td><img src="image" alt="Pattern Size" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1 Height (vertical length)</th>
<th>Specify the pattern height.</th>
<th>Short</th>
<th>Tall</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Height" /></td>
<td><img src="image" alt="Height" /></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2 Width (horizontal length)</th>
<th>Specify the pattern width.</th>
<th>Short</th>
<th>Long</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Width" /></td>
<td><img src="image" alt="Width" /></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Maintain aspect ratio**

When selected, the height-to-width proportions of the pattern are maintained.

**H-Arrange**

(horizontal arrangement)

Specify the arrangement of the patterns along a horizontal axis. All patterns or each pattern can be flipped along the horizontal axis.

Normal | Mirror | Alternate

**V-Arrange**

(vertical arrangement)

Specify the arrangement of the patterns along a vertical axis. All patterns or each pattern can be flipped along the vertical axis.

Normal | Mirror | Alternate

**Offset**

0.0 mm | Offset: 4.5mm
## Sewing Attributes

### Stem Stitch

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Narrow</th>
<th>Wide</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td><strong>Spacing</strong></td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td><strong>Angle</strong></td>
<td>45°</td>
<td>135°</td>
</tr>
<tr>
<td><strong>Stitch Type</strong></td>
<td>Triple</td>
<td>Single</td>
</tr>
<tr>
<td><strong>Start/End Type</strong></td>
<td>Feed</td>
<td>Run</td>
</tr>
</tbody>
</table>

- **Feed**
- **Run**

- "If the entry/exit points of sewing have been changed" on page 363

### Candlewicking Stitch

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Dense</th>
<th>Medium</th>
<th>Light</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Density</strong></td>
<td>![Image]</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Smaller</td>
<td>Larger</td>
<td></td>
</tr>
<tr>
<td><strong>Spacing</strong></td>
<td>Narrow</td>
<td>Wide</td>
<td></td>
</tr>
<tr>
<td><strong>Start/End Type</strong></td>
<td>Feed</td>
<td>Run</td>
<td></td>
</tr>
</tbody>
</table>

- "If the entry/exit points of sewing have been changed" on page 363

### Connection Points

- This sewing attribute is available only when a text pattern is selected.

- "Selecting connection point positions in a text pattern" on page 126
### E/V Stitch

<table>
<thead>
<tr>
<th>E Stitch</th>
<th>V Stitch</th>
</tr>
</thead>
<tbody>
<tr>
<td>![E Stitch Icon]</td>
<td>![V Stitch Icon]</td>
</tr>
<tr>
<td>Select the E Stitch or the V Stitch.</td>
<td></td>
</tr>
</tbody>
</table>

#### E Stitch

<table>
<thead>
<tr>
<th>1 Interval</th>
<th>Narrow</th>
<th>Wide</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Interval Narrow]</td>
<td>![Interval Wide]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2 Stroke width</th>
<th>Short</th>
<th>Long</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Stroke Short]</td>
<td>![Stroke Long]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3 Run pitch</th>
<th>Narrow</th>
<th>Wide</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Run Pitch Narrow]</td>
<td>![Run Pitch Wide]</td>
<td></td>
</tr>
</tbody>
</table>

#### Run time(s)

Specify the number of times the line is sewn.

<table>
<thead>
<tr>
<th>1 time</th>
<th>5 times</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Run Time Narrow]</td>
<td>![Run Time Wide]</td>
</tr>
</tbody>
</table>

#### Stroke time(s)

Specify the number of times each stroke is sewn.

<table>
<thead>
<tr>
<th>1 time</th>
<th>3 times</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Stroke Time Narrow]</td>
<td>![Stroke Time Wide]</td>
</tr>
</tbody>
</table>

#### Arrange

This sewing attribute is available only when a text pattern is selected.

| ![Arrange Icon] |

#### Connection Points

This sewing attribute is available only when a text pattern is selected.

| ![Connection Points Icon] |

#### V Stitch

<table>
<thead>
<tr>
<th>1 Interval</th>
<th>Narrow</th>
<th>Wide</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Interval Narrow]</td>
<td>![Interval Wide]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2 Stroke width</th>
<th>Short</th>
<th>Long</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Stroke Short]</td>
<td>![Stroke Long]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3 Run pitch</th>
<th>Narrow</th>
<th>Wide</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Run Pitch Narrow]</td>
<td>![Run Pitch Wide]</td>
<td></td>
</tr>
</tbody>
</table>

#### Run time(s)

With the V stitch, the line and the strokes are sewn the same number of times.

<table>
<thead>
<tr>
<th>1 time</th>
<th>5 times</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Run Time Narrow]</td>
<td>![Run Time Wide]</td>
</tr>
</tbody>
</table>

#### Arrange

| ![Arrange Icon] |

#### Connection Points

This sewing attribute is available only when a text pattern is selected.

| ![Connection Points Icon] |
**Chain Stitch**

<table>
<thead>
<tr>
<th>Stitch Type</th>
<th>Triangular</th>
<th>Diamond-shaped</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Smaller</td>
<td>Larger</td>
</tr>
<tr>
<td>Time</td>
<td>1 time</td>
<td>6 time</td>
</tr>
<tr>
<td>Arrange</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start/End Type</td>
<td>Feed</td>
<td>Run</td>
</tr>
</tbody>
</table>

> "If the entry/exit points of sewing have been changed" on page 363

**Connection Points**

This sewing attribute is available only when a text pattern is selected.

> "Selecting connection point positions in a text pattern" on page 126

**Cutting**

<table>
<thead>
<tr>
<th>Leave uncut sections</th>
<th>Specify whether or not sections of the cutting line are to be left uncut. This prevents the fabric from moving out of place during cutting. If it is set to [On], cut them with scissors after the cutting step is finished.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>Use</td>
<td>Cutting only</td>
</tr>
<tr>
<td></td>
<td>For more cleanly cut edges, for example, on patches, select [Cutting only]. If the cut edge will be embroidered, for example, on appliqués, select [Cutting for covering edge of fabric].</td>
</tr>
</tbody>
</table>
If the entry/exit points of sewing have been changed

If the entry/exit points of line sewing with the motif stitch, stem stitch, candlewicking stitch or chain stitch have been changed or optimized, select a setting for [Start/End Type] in the line sewing attributes.

- "Start/End Type" on page 360 and "Moving entry/exit points, the center point and stitch pattern reference point" on page 57

If [Feed] was selected under [Start/End Type], jump stitches are entered at the beginning or end of pattern stitching (with a motif stitch, stem stitch, candlewicking stitch or chain stitch). If [Run] was selected under [Start/End Type], running stitches following the path are entered at the beginning of and between pattern stitching.

Before the entry/exit points are changed

![Diagram of pattern stitching before entry/exit points are changed]

1. Path of actual stitching
2. Entry point/Exit point

When the entry point is moved

**Feed**

![Diagram of pattern stitching with feed selected]

1. Entry point
2. Jump stitch
3. Exit point

**Run**

![Diagram of pattern stitching with run selected]

1. Entry point
2. Running stitch
3. Exit point

- After changing the Start/End Type, check the stitching with the stitch simulator.

  "Checking the stitching with the Stitch Simulator" on page 89

- Embroidery patterns where the Start/End Type of line sewing with the motif stitch, have been changed or optimized in an application earlier than version 8 are opened or imported with this stitching specified as jump stitches.
# Region sewing attributes

The available attributes differ depending on the selected sew type.

- "Specifying sewing attributes" on page 63

## Satin Stitch

To specify underlay stitching, select the check box, and then specify settings for the following attributes.

<table>
<thead>
<tr>
<th>Under sewing</th>
<th>Specify the type of underlay stitching to be sewn.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge only</td>
<td>For text patterns or for shape patterns with multiple sewing direction lines</td>
</tr>
<tr>
<td>Region only</td>
<td>For shape patterns with a single sewing direction line</td>
</tr>
<tr>
<td>Single</td>
<td>Double</td>
</tr>
<tr>
<td>Single</td>
<td>Double</td>
</tr>
</tbody>
</table>

### Density

Select [Dense], [Medium] or [Light] as the density for the underlay stitching.

<table>
<thead>
<tr>
<th>Density</th>
<th>Coarse</th>
<th>Fine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradation</td>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>

### Direction

This cannot be specified for text pattern.

- **Manual straight line**: Sews at a fixed angle. Drag or select a value to specify the angle. If there are multiple sewing direction lines, a value cannot be specified for the angle.

- **Auto**: Automatically varies the sewing direction according to the shape of the region.

<table>
<thead>
<tr>
<th>Direction</th>
<th>Off</th>
<th>On</th>
</tr>
</thead>
</table>

### Half Stitch

To specify half stitching, select the check box.

This cannot be specified if the sewing direction is set to [Manual straight line] and there is only one sewing direction line.

<table>
<thead>
<tr>
<th>Half Stitch</th>
<th>Off</th>
<th>On</th>
</tr>
</thead>
</table>

The inside stitching is dense.

The stitching is adjusted to a more even density.
### Running Stitch Path

The inside of region setting is not available if the [Gradation] check box is selected. This cannot be specified under the following conditions:
- The sewing direction is set to [Auto].
- Text patterns
- When a feathered edge is specified

#### Pull compensation

Lengthen the sewing region in the sewing direction to adjust for pattern shrinkage during sewing.

<table>
<thead>
<tr>
<th>No compensation</th>
<th>Longest compensation</th>
</tr>
</thead>
</table>

#### Connection Points

This sewing attribute is available only when a text pattern is selected.  
["Selecting connection point positions in a text pattern" on page 126](#)

#### Feathered edge

Specify the edge of the stitching where the feathered edge is to be applied.

- Top side of pattern
- For <pattern11>
- Bottom side of pattern
- For <pattern18>

<table>
<thead>
<tr>
<th>Top edge only</th>
<th>Bottom edge only</th>
<th>Top and bottom edges</th>
</tr>
</thead>
</table>

Click [Browse] to display the [Browse] dialog box. Select the desired pattern from the list of patterns that appears. This sewing attribute is available only when a shape pattern is selected. In addition, this attribute cannot be selected under the following conditions:
- When a gradation is specified
- When the sewing direction is set to [Auto]
- When hole sewing is specified

- Specify the width of the feathered edge

<table>
<thead>
<tr>
<th>Short</th>
<th>Long</th>
</tr>
</thead>
</table>

1. Feathered edge settings not specified
2. Feathered edge settings specified
### Fill Stitch

<table>
<thead>
<tr>
<th>Under sewing</th>
<th>&quot;Satin Stitch&quot; on page 364</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td></td>
</tr>
<tr>
<td>Direction</td>
<td>[Manual straight line]: Sews at a fixed angle. Drag or select a value to specify the angle. If there are multiple sewing direction lines, a value cannot be specified for the angle.</td>
</tr>
<tr>
<td></td>
<td>[Manual curve]: Specify curved sewing direction line. &quot;Specifying curved sewing direction line&quot; on page 61</td>
</tr>
<tr>
<td></td>
<td>[Auto]: Automatically varies the sewing direction according to the shape of the region.</td>
</tr>
<tr>
<td>Stitch Type</td>
<td>Specify the shape of the returning ends of the stitching. This cannot be specified if the sewing direction is set to [Auto].</td>
</tr>
<tr>
<td>Half Stitch</td>
<td>&quot;Half Stitch&quot; on page 364 and &quot;Running Stitch Path&quot; on page 365</td>
</tr>
<tr>
<td>Running Stitch Path</td>
<td></td>
</tr>
<tr>
<td>Step pitch</td>
<td>Specify the length of one stitch.</td>
</tr>
<tr>
<td></td>
<td>Short</td>
</tr>
<tr>
<td>Frequency</td>
<td>0%</td>
</tr>
<tr>
<td>Pull compensation</td>
<td>&quot;Pull compensation&quot; on page 365</td>
</tr>
<tr>
<td>Connection Points</td>
<td>This sewing attribute is available only when a text pattern is selected. &quot;Selecting connection point positions in a text pattern&quot; on page 126</td>
</tr>
<tr>
<td>Feathered edge</td>
<td>&quot;Feathered edge&quot; on page 365</td>
</tr>
</tbody>
</table>

In [Design Center], the settings under [Direction] are as described below.

- [Manual straight line] appears as [Constant].
- [Auto] appears as [Variable].
- [Manual curve] does not exist.
## Programmable Fill Stitch (Prog. Fill Stitch)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Under sewing</strong></td>
<td>“Satin Stitch” on page 364</td>
</tr>
<tr>
<td><strong>Density</strong></td>
<td>“Satin Stitch” on page 364</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td>“Fill Stitch” on page 366</td>
</tr>
<tr>
<td><strong>Half Stitch</strong></td>
<td>“Satin Stitch” on page 364</td>
</tr>
<tr>
<td><strong>Running Stitch Path</strong></td>
<td>“Satin Stitch” on page 364</td>
</tr>
<tr>
<td><strong>Pull compensation</strong></td>
<td>This sewing attribute is available only when a text pattern is selected.</td>
</tr>
<tr>
<td><strong>Connection Points</strong></td>
<td>“Selecting connection point positions in a text pattern” on page 126</td>
</tr>
<tr>
<td><strong>Feathered edge</strong></td>
<td>“Feathered edge” on page 365</td>
</tr>
</tbody>
</table>

We recommend specifying base stitching (selecting the **Base Sewing** check box) for a programmable fill stitch when **Direction** is set to **Manual curve**.
Programmable fill

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Click to display the [Browse] dialog box. Select a folder, and then select the desired pattern (.pas file) from the list of patterns that appears.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Area where the embossing or engraving effects are applied</th>
<th>Specify the pattern size. The pattern can be enlarged or reduced while maintaining the width-to-height proportion.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>1 Height (vertical length)</th>
<th>Specify the pattern height.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>2 Width (horizontal length)</th>
<th>Specify the pattern width.</th>
</tr>
</thead>
</table>

**Maintain aspect ratio**

When selected, the height-to-width proportions of the pattern are maintained.

**Direction**

![Direction Diagram]

**Offset**

<table>
<thead>
<tr>
<th>row</th>
<th>0%</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>column</th>
<th>Row 50%</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>column</th>
<th>Column 50%</th>
</tr>
</thead>
</table>

**Base Sewing**

To specify base stitching, select the check box, and then specify settings for the following attributes.

<table>
<thead>
<tr>
<th>Stitch Type</th>
<th>Specify the shape of the returning ends of the stitching. This cannot be specified if the sewing direction is set to [Auto].</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Step pitch</th>
<th>Specify the length of one stitch.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Frequency</th>
<th>0%</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Frequency</th>
<th>50%</th>
</tr>
</thead>
</table>

1. Pattern
2. Area where the embossing or engraving effects are applied
3. This area is sewn with the stitching settings specified for the base sewing of the programmable fill stitch.
4. This area is sewn with the stitching settings specified by the pattern file.
Notes on programmable fill stitches and stamps

In some case of the sew type and pattern directions setting of a programmable fill stitch or a stamp, lines will not be sewn.

Use the Realistic View to view exactly how the stitch pattern will be sewn. To get an even better view, make test samples of different settings.

Examples of programmable fill stitching:

Example 1
Stitch direction: 45° (default)

Example 2
Stitch direction: 90°

Example 3
Stitch direction: 0°

”Changing the display of the embroidery design” on page 87, and ”Programmable Stitch Creator” on page 287
**Piping Stitch**
Stitching is created to run through the length of blocks.

<table>
<thead>
<tr>
<th>Direction</th>
<th>[Manual straight line]: Sews at a fixed angle. Drag or select a value to specify the angle. If there are multiple sewing direction lines, a value cannot be specified for the angle.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[Manual curve]: Specify curved sewing direction line.</td>
</tr>
<tr>
<td></td>
<td>[Manual curve]</td>
</tr>
</tbody>
</table>

Specify settings for the following if the motif stitch pattern is not used.

<table>
<thead>
<tr>
<th>Density</th>
<th>Coarse</th>
<th>Fine</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Run pitch</th>
<th>Specify the length of one stitch.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Short</td>
</tr>
<tr>
<td></td>
<td>Long</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Specify the shift in the stitches.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>50%</td>
</tr>
</tbody>
</table>

**Use Motif**
To use a motif stitch in the pattern, select the check box, and then specify settings for the following attributes.

**Motif**

- Pattern1 only

  - "Motif Stitch" in the "Region sewing attributes" on page 371

**Pattern1/Pattern2**

- Pattern and size of the motif stitch patterns

  - "Motif Stitch" in the "Line sewing attributes" on page 359

- H-Arrange
- V-Arrange
- H-Offset
- V-Offset
- H-Spacing
- V-Spacing

- Row offset
- Run pitch
## Motif Stitch

**Motif**

Select the pattern to be used for the motif stitch.

<table>
<thead>
<tr>
<th>Pattern1 only</th>
<th>Pattern2 only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern1 only</td>
<td>Pattern2 only</td>
</tr>
<tr>
<td>Pattern1 and 2</td>
<td>Pattern1 only</td>
</tr>
</tbody>
</table>

**Pattern1/Pattern2**

Specify settings for each pattern.

- **Pattern and size of the motif stitch patterns**
  Maintain aspect ratio

- **H-Arrange**

- **H-Offset** (horizontal spacing)

<table>
<thead>
<tr>
<th>Offset</th>
<th>Pattern1</th>
<th>Pattern2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0 mm</td>
<td><img src="pattern1_0.png" alt="Pattern1" /></td>
<td><img src="pattern2_0.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>2.5 mm</td>
<td><img src="pattern1_2_5.png" alt="Pattern1" /></td>
<td><img src="pattern2_2_5.png" alt="Pattern2" /></td>
</tr>
</tbody>
</table>

- **V-Arrange**

- **V-Offset** (vertical spacing)

<table>
<thead>
<tr>
<th>Offset</th>
<th>Pattern1</th>
<th>Pattern2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0 mm</td>
<td><img src="pattern1_0.png" alt="Pattern1" /></td>
<td><img src="pattern2_0.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>2.5 mm</td>
<td><img src="pattern1_2_5.png" alt="Pattern1" /></td>
<td><img src="pattern2_2_5.png" alt="Pattern2" /></td>
</tr>
</tbody>
</table>

- **H-Spacing** (horizontal spacing)

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Pattern1</th>
<th>Pattern2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow</td>
<td><img src="pattern1_narrow.png" alt="Pattern1" /></td>
<td><img src="pattern2_narrow.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>Wide</td>
<td><img src="pattern1_wide.png" alt="Pattern1" /></td>
<td><img src="pattern2_wide.png" alt="Pattern2" /></td>
</tr>
</tbody>
</table>

- **V-Spacing** (vertical spacing)

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Pattern1</th>
<th>Pattern2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow</td>
<td><img src="pattern1_narrow.png" alt="Pattern1" /></td>
<td><img src="pattern2_narrow.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>Wide</td>
<td><img src="pattern1_wide.png" alt="Pattern1" /></td>
<td><img src="pattern2_wide.png" alt="Pattern2" /></td>
</tr>
</tbody>
</table>

- **Direction**

  - **[Manual straight line]**: Sews at a fixed angle.
    Drag or select a value to specify the angle. If there are multiple sewing direction lines, a value cannot be specified for the angle.

<table>
<thead>
<tr>
<th>Angle</th>
<th>Pattern1</th>
<th>Pattern2</th>
</tr>
</thead>
<tbody>
<tr>
<td>45°</td>
<td><img src="pattern1_45.png" alt="Pattern1" /></td>
<td><img src="pattern2_45.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>90°</td>
<td><img src="pattern1_90.png" alt="Pattern1" /></td>
<td><img src="pattern2_90.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>135°</td>
<td><img src="pattern1_135.png" alt="Pattern1" /></td>
<td><img src="pattern2_135.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>180°</td>
<td><img src="pattern1_180.png" alt="Pattern1" /></td>
<td><img src="pattern2_180.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>225°</td>
<td><img src="pattern1_225.png" alt="Pattern1" /></td>
<td><img src="pattern2_225.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>270°</td>
<td><img src="pattern1_270.png" alt="Pattern1" /></td>
<td><img src="pattern2_270.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>315°</td>
<td><img src="pattern1_315.png" alt="Pattern1" /></td>
<td><img src="pattern2_315.png" alt="Pattern2" /></td>
</tr>
</tbody>
</table>

  - **[Manual curve]**: Specify curved sewing direction line.
    "Specifying curved sewing direction line" on page 61

- **Row offset**

<table>
<thead>
<tr>
<th>Offset</th>
<th>Pattern1</th>
<th>Pattern2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smaller</td>
<td><img src="pattern1_smaller.png" alt="Pattern1" /></td>
<td><img src="pattern2_smaller.png" alt="Pattern2" /></td>
</tr>
<tr>
<td>Larger</td>
<td><img src="pattern1_larger.png" alt="Pattern1" /></td>
<td><img src="pattern2_larger.png" alt="Pattern2" /></td>
</tr>
</tbody>
</table>

- **Run pitch**

  "Motif Stitch" in the "Line sewing attributes" on page 359
Cross Stitch

<table>
<thead>
<tr>
<th>Size</th>
<th>Smaller</th>
<th>Larger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Times</td>
<td>Single</td>
<td>Triple</td>
</tr>
</tbody>
</table>

Concentric Circle Stitch, Radial Stitch and Spiral Stitch

For details on moving the center point of the concentric circle stitch and the radial stitch, refer to "Moving the center point and stitch pattern reference point" on page 58.

<table>
<thead>
<tr>
<th>Density</th>
<th>Concentric Circle Stitch Coarse</th>
<th>Concentric Circle Stitch Fine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radial Stitch Coarse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spiral Stitch Coarse</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Run pitch</th>
<th>Specify the length of one stitch.</th>
<th>Short</th>
<th>Long</th>
</tr>
</thead>
</table>

Start Point (only with Concentric Circle Stitch and Spiral Stitch)

| Start Point | Starts from the outside of the spiral. | Starts from the inside of the spiral. |

Flexible Spiral Stitch

For details on moving the center point, refer to "Moving the center point and stitch pattern reference point" on page 58.

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Narrow</th>
<th>Wide</th>
</tr>
</thead>
</table>

Run pitch "Concentric Circle Stitch, Radial Stitch and Spiral Stitch" on page 372

Start Point "Concentric Circle Stitch, Radial Stitch and Spiral Stitch" on page 372

<table>
<thead>
<tr>
<th>Direction</th>
<th>Clockwise</th>
<th>Counterclockwise</th>
</tr>
</thead>
</table>
### Stippling Stitch

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Run pitch</strong></td>
<td>Specify the length of one stitch. This cannot be specified if the motif stitch is used.</td>
</tr>
<tr>
<td>Short</td>
<td>The turns are smoother.</td>
</tr>
<tr>
<td>Long</td>
<td>The turns are more angled.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Spacing</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrow</td>
<td>The pattern is finer.</td>
</tr>
<tr>
<td>Wide</td>
<td>The pattern is coarser.</td>
</tr>
</tbody>
</table>

**Use Motif**

To use a motif stitch in the pattern, select the check box, and then specify settings for the following attributes.

**Pattern and size of the motif stitch patterns**

- **H-Arrange**
- **V-Arrange**
- **Offset**
- **Spacing**
- **Run pitch**

### Net Fill Stitch

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pattern</strong></td>
<td>Specify the pattern to be used for the net fill stitch.</td>
</tr>
<tr>
<td>Fine</td>
<td>The pattern is finer.</td>
</tr>
<tr>
<td>Coarse</td>
<td>The pattern is coarser.</td>
</tr>
</tbody>
</table>

**Spacing**

The pattern is finer. The pattern is coarser.

**Direction**

"Motif Stitch" in the "Region sewing attributes" on page 371
### Zigzag Net Fill Stitch

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Specify the pattern to be used for the zigzag net fill stitch.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Pattern Options" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Under sewing</th>
<th>To specify underlay stitching, select the check box.</th>
<th>Off</th>
<th>On</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Under sewing Options" /></td>
<td><img src="image" alt="Under sewing Options" /></td>
<td><img src="image" alt="Under sewing Options" /></td>
<td><img src="image" alt="Under sewing Options" /></td>
</tr>
</tbody>
</table>

- **Zigzag width**
  - “Zigzag Stitch” in the “Line sewing attributes” on page 358

- **Density**
  - “Zigzag Stitch” in the “Line sewing attributes” on page 358

<table>
<thead>
<tr>
<th>Spacing</th>
<th>Fine</th>
<th>Coarse</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Spacing Options" /></td>
<td><img src="image" alt="Spacing Options" /></td>
<td><img src="image" alt="Spacing Options" /></td>
</tr>
</tbody>
</table>

- The pattern is finer.
- The pattern is coarser.

- **H-Offset**
  - “Motif Stitch” in the “Region sewing attributes” on page 371

- **V-Offset**
  - “Motif Stitch” in the “Region sewing attributes” on page 371

- **Direction**
  - “Motif Stitch” in the “Region sewing attributes” on page 371
## Decorative Fill Stitch

Select a pattern for the decorative fill stitch.

Click ![icon] to display the [Browse] dialog box. Select the desired pattern from the list of patterns (.plf file) that appears.

Specify the pattern size. The pattern can be enlarged or reduced while maintaining the width-to-height proportion.

<table>
<thead>
<tr>
<th>Pattern Size</th>
<th>Smaller</th>
<th>Larger</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Pattern1]</td>
<td>![Pattern2]</td>
<td>![Pattern3]</td>
</tr>
</tbody>
</table>

1 Height (vertical length) Specify the pattern height.

1

2 Width (horizontal length) Specify the pattern width.

2

### Maintain aspect ratio

When selected, the height-to-width proportions of the pattern are maintained.

<table>
<thead>
<tr>
<th>Maintain aspect ratio</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>![On]</td>
<td>![Off]</td>
<td></td>
</tr>
</tbody>
</table>

### Minimize feed

Specify running stitches around the edges of objects.

<table>
<thead>
<tr>
<th>Minimize feed</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>![On]</td>
<td>![Off]</td>
<td></td>
</tr>
</tbody>
</table>

### Direction

<table>
<thead>
<tr>
<th>Direction</th>
<th>135°</th>
<th>90°</th>
<th>45°</th>
<th>0°</th>
<th>225°</th>
<th>270°</th>
<th>315°</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Direction]</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Run pitch

"Motif Stitch" in the "Line sewing attributes" on page 359

### Random Shift

Specify the level of breakdown in patterns.

<table>
<thead>
<tr>
<th>Random Shift</th>
<th>0%</th>
<th>50%</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Random Shift]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• If [Minimize feed] has been turned off, parts of the pattern may be lost since extremely short stitches will not be created.
## Font List

### Text

<table>
<thead>
<tr>
<th>No.</th>
<th>Font Name</th>
<th>Text Outlines</th>
<th>Min. size</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Serif 01</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>002</td>
<td>Script 01</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>003</td>
<td>Gothic 01</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>004</td>
<td>Serif 02</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>005</td>
<td>Script 02</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>006</td>
<td>Serif 03</td>
<td>ABCDE abcdde</td>
<td>8 mm (0.31&quot;)</td>
</tr>
<tr>
<td>007</td>
<td>Block 01</td>
<td>ABCDE abcdde</td>
<td>9 mm (0.35&quot;)</td>
</tr>
<tr>
<td>008</td>
<td>Block 02</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>009</td>
<td>Gothic 02</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>010</td>
<td>Block 03</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>011</td>
<td>Decorative 01</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>012</td>
<td>Block 04</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>013</td>
<td>Block 05</td>
<td>ABCDE abcdde</td>
<td>9 mm (0.35&quot;)</td>
</tr>
<tr>
<td>014</td>
<td>Script 03</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>015</td>
<td>Decorative 02</td>
<td>ABCDE abcdde</td>
<td>20 mm (0.79&quot;)</td>
</tr>
<tr>
<td>016</td>
<td>Decorative 03</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>017</td>
<td>Script 04</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>018</td>
<td>Gothic 03</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>019</td>
<td>Script 05</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>020</td>
<td>Block 06</td>
<td>ABCDE abcdde</td>
<td>9 mm (0.35&quot;)</td>
</tr>
</tbody>
</table>

### Additional Fonts

<table>
<thead>
<tr>
<th>No.</th>
<th>Font Name</th>
<th>Text Outlines</th>
<th>Min. size</th>
</tr>
</thead>
<tbody>
<tr>
<td>021</td>
<td>Gothic 04</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>022</td>
<td>Decorative 04</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>023</td>
<td>Decorative 05</td>
<td>A.B.C.D.E.</td>
<td>8 mm (0.31&quot;)</td>
</tr>
<tr>
<td>024</td>
<td>Gothic 05</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>025</td>
<td>Decorative 06</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>026</td>
<td>Gothic 06</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>027</td>
<td>Block 07</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>028</td>
<td>Gothic 07</td>
<td>ABCDE</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>029</td>
<td>Brussels Demi Outline</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>030</td>
<td>Calgary MediumItalic</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>031</td>
<td>Istanbul</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>032</td>
<td>Los Angeles</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>033</td>
<td>Saipan</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>034</td>
<td>San Diego</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>035</td>
<td>Sicilia Light Italic</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>036</td>
<td>Alaska</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>037</td>
<td>Bayern Book</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>038</td>
<td>Belgium</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>039</td>
<td>Bengal</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>040</td>
<td>Bergen</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>041</td>
<td>Berlin Regular</td>
<td>ABCDE abcdde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>No.</td>
<td>Font Name</td>
<td>Text Outlines</td>
<td>Min. size</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td>042</td>
<td>Bermuda Script</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>043</td>
<td>Blackstone</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>044</td>
<td>BR-OCRA</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>045</td>
<td>Brougham Bold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>046</td>
<td>Brougham Condensed ExtraBold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>047</td>
<td>Brunei</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>048</td>
<td>Brussels Light</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>049</td>
<td>Cairo</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>050</td>
<td>Calgary BoldItalic</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>051</td>
<td>Calgary BoldItalic LS</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>052</td>
<td>Canberra</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>053</td>
<td>Connecticut</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>054</td>
<td>Cordoba</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>055</td>
<td>Cyprus</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>056</td>
<td>Equador</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>057</td>
<td>Epsom Expanded</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>058</td>
<td>Epsom</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>059</td>
<td>Firenze Bold Expanded</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>060</td>
<td>Florida Medium</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>061</td>
<td>Frankfurt Bold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>062</td>
<td>Frankfurt Medium</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>063</td>
<td>Germany</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>064</td>
<td>BR Symbol</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>065</td>
<td>Haiti</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>066</td>
<td>Helsinki Narrow Bold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>067</td>
<td>Hungary</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>068</td>
<td>Jakarta</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>069</td>
<td>Jawa</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>070</td>
<td>Kentucky</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>071</td>
<td>Kingston Regular</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>072</td>
<td>Letter Gothic Bold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>073</td>
<td>Lillehammer</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>074</td>
<td>Liverpool Italic</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>075</td>
<td>Maryland</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>076</td>
<td>Miami Roman</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>077</td>
<td>Montreal</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>078</td>
<td>Panama Bold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>079</td>
<td>Princeton Italic</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>080</td>
<td>Riesa</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>081</td>
<td>Salamanca</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>082</td>
<td>Seattle BoldItalic</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>083</td>
<td>Sofia Bold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>084</td>
<td>Helsinki</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>085</td>
<td>Tennessee ExtraBold</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>086</td>
<td>Themes</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>087</td>
<td>Tianjin</td>
<td>ABCDE abcede</td>
<td>10 mm (0.39&quot;)</td>
</tr>
</tbody>
</table>
## Font List

<table>
<thead>
<tr>
<th>No.</th>
<th>Font Name</th>
<th>Text Outlines</th>
<th>Min. size</th>
</tr>
</thead>
<tbody>
<tr>
<td>088</td>
<td>Tirol</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>089</td>
<td>US Roman</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>090</td>
<td>Venezia</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>091</td>
<td>Vermont</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>092</td>
<td>Wellington</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>093</td>
<td>Künstlerschreibschrift</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>094</td>
<td>Toms Handwritten</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>095</td>
<td>Luedickital</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>096</td>
<td>Atranta Book</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>097</td>
<td>Atranta Demi</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>098</td>
<td>Montana</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>099</td>
<td>Base 900 Sans Heavy Italic</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>100</td>
<td>Base Monospace Wide Bold</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>101</td>
<td>Blockhead Alphabet Darkside</td>
<td>ABCDE abcde</td>
<td>15 mm (0.59&quot;)</td>
</tr>
<tr>
<td>102</td>
<td>Dalliance Roman</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>103</td>
<td>Dalliance Script</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>104</td>
<td>Dogma Script Bold</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>105</td>
<td>Elliotts Apollo Venus Dioxide</td>
<td>ABCDE abcde</td>
<td>10 mm (0.39&quot;)</td>
</tr>
<tr>
<td>106</td>
<td>Exocet Medium</td>
<td>ABCDE ABCDE</td>
<td>13 mm (0.51&quot;)</td>
</tr>
<tr>
<td>107</td>
<td>Los Feliz BoldItalic</td>
<td>ABCDE abcde</td>
<td>9 mm (0.35&quot;)</td>
</tr>
<tr>
<td>108</td>
<td>Mason Serif Bold</td>
<td>ABCDE ABCDE</td>
<td>12 mm (0.47&quot;)</td>
</tr>
<tr>
<td>109</td>
<td>Matrix Inline Extra Bold</td>
<td>ABCDE abcde</td>
<td>17 mm (0.67&quot;)</td>
</tr>
</tbody>
</table>

## Small Text

<table>
<thead>
<tr>
<th>No.</th>
<th>Font Name</th>
<th>Text Outlines</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Utah Bold S</td>
<td>ABCDE abcde</td>
<td>5-6 mm (0.20-0.24&quot;)</td>
</tr>
<tr>
<td>02</td>
<td>Belgium S</td>
<td>ABCDE abcde</td>
<td>5-6 mm (0.20-0.24&quot;)</td>
</tr>
<tr>
<td>03</td>
<td>Calgary MediumItalic S</td>
<td>ABCDE abcde</td>
<td>5-6 mm (0.20-0.24&quot;)</td>
</tr>
<tr>
<td>04</td>
<td>Utah SR</td>
<td>ABCDE abcde</td>
<td>3-4 mm (0.12-0.16&quot;)</td>
</tr>
<tr>
<td>05</td>
<td>Calgary MediumItalic SR</td>
<td>ABCDE abcde</td>
<td>3-4 mm (0.12-0.16&quot;)</td>
</tr>
<tr>
<td>06</td>
<td>Script 01 SR</td>
<td>ABCDE abcde</td>
<td>4-6 mm (0.16-0.24&quot;)</td>
</tr>
<tr>
<td>07</td>
<td>Block 03 S</td>
<td>ABCDE abcde</td>
<td>5-6 mm (0.20-0.24&quot;)</td>
</tr>
</tbody>
</table>
### Font List

<table>
<thead>
<tr>
<th>No.</th>
<th>Font Name</th>
<th>Text Outlines</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>08</td>
<td>Block 07 SR</td>
<td>ABCDE</td>
<td>4-6 mm (0.16-0.24&quot;)</td>
</tr>
<tr>
<td>09</td>
<td>Germany S</td>
<td>ABCDE abcde</td>
<td>5-6 mm (0.20-0.24&quot;)</td>
</tr>
<tr>
<td>10</td>
<td>Riesa S</td>
<td>ABCDE abcde</td>
<td>5-6 mm (0.20-0.24&quot;)</td>
</tr>
</tbody>
</table>

### Monogram

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Font Name</th>
<th>Text Outlines</th>
</tr>
</thead>
<tbody>
<tr>
<td>MG</td>
<td>Diamond</td>
<td>ABC XYZ</td>
</tr>
<tr>
<td>MG</td>
<td>Script</td>
<td>ABC XYZ</td>
</tr>
</tbody>
</table>
## Troubleshooting

If you have a problem, check the following solutions. If the solutions suggested do not correct the problem, contact your Baby Lock retailer.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Estimated Cause</th>
<th>Solution</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The software is not installed correctly.</td>
<td>An operation not described in the installation procedure was performed. (For example, Cancel was clicked or the &quot;Palette Software Key&quot; was removed before the procedure was completed.)</td>
<td>Follow the instructions as the software installs to correctly install the software.</td>
<td></td>
</tr>
<tr>
<td>The message &quot;No Palette Software Key is connected. Please connect a Palette Software Key.&quot; appeared.</td>
<td>The &quot;Palette Software Key&quot; is not connected.</td>
<td>Check that the &quot;Palette Software Key&quot; appears in the computer’s list of removable storage devices. If it does not appear, unplug the &quot;Palette Software Key&quot;, and then plug it in again.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The information on the &quot;Palette Software Key&quot; is corrupted.</td>
<td>Leave it plugged in, and uninstall, then re-install Palette Ver.11.</td>
<td></td>
</tr>
<tr>
<td>When trying to upgrade from an older version, the message &quot;Cannot connect to the Internet.&quot; or &quot;The server could not be connected to. Wait a while, and then try connecting again.&quot; appeared and &quot;Palette Software Key&quot; could not be upgraded.</td>
<td>The computer with &quot;Palette Software Key&quot; connected to its USB port could not establish a connection to the Internet.</td>
<td>To upgrade &quot;Palette Software Key&quot;, the computer with &quot;Palette Software Key&quot; connected to its USB port must connect to the Internet. If firewall software is being used, it must be temporarily disabled during the upgrade. If a connection to the Internet cannot be established, contact your Baby Lock retailer.</td>
<td></td>
</tr>
</tbody>
</table>

See "Reference Guide".
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cause</strong></td>
<td><strong>File Format</strong></td>
</tr>
<tr>
<td><strong>When opening an embroidery pattern</strong> (Application button &gt; [Open])</td>
<td>.pes</td>
</tr>
<tr>
<td></td>
<td>.phc, .phx (machine embroidery format)</td>
</tr>
<tr>
<td><strong>When importing embroidery patterns</strong> ([Home] tab &gt; [Import Patterns] &gt; [from File])</td>
<td>.pes, .phc, .phx</td>
</tr>
<tr>
<td></td>
<td>Other manufacturers’ compatible formats (.dst, .hus, .exp, .pcs, .vip, .sew, .jef, .csd, .xxx, and .shv)</td>
</tr>
<tr>
<td><strong>Incompatible formats</strong></td>
<td></td>
</tr>
<tr>
<td><strong>When opening a background image</strong> ([Image] tab &gt; [Open]) or When opening an image for Stitch Wizard (Auto Punch, Photo Stitch 1 and 2, and Cross Stitch)</td>
<td>.bmp, .tif, .jpg, .wmf, .png, .eps, and .gif</td>
</tr>
<tr>
<td></td>
<td>Images in formats other than those listed above</td>
</tr>
<tr>
<td><strong>When importing an image as an embroidery pattern</strong> ([Home] tab &gt; [Import Patterns] &gt; [from Vector Image])</td>
<td>.wmf, .emf, and .svg</td>
</tr>
<tr>
<td></td>
<td>Vector images in a format other than .wmf, .emf, or .svg</td>
</tr>
<tr>
<td></td>
<td>Raster images (.bmp, .jpg, etc.)</td>
</tr>
</tbody>
</table>
Index

A
Access key ..........................................................343
Advanced stitch wizard ........................................157
Aligning
   Embroidery patterns ........................................39
Application appearance ......................................344
Application button ............................................13
Appliqué ...........................................................55, 178
Applique Wizard .................................................178
Arc .................................................................70
Arcs .....................................................................70
Attaching stabilizer .............................................196
Attributes
   Line sewing attributes .......................................358
   Name Drop Text ..............................................138
   Region sewing attributes .................................364
   Sewing attributes ..........................................63
   Text attributes ...............................................117
Auto Hide ..........................................................343
Auto Punch function ............................................142
Auto Punch Parameters .........................................144
Auto Scroll ...........................................................89

B
Back Stitch .........................................................147
Background Fill ..................................................173
Basic color ..........................................................98
Beginner mode ....................................................63, 262
Blending ...............................................................54
Block data ...........................................................125
Block pattern .......................................................217, 316
Blocks
   Convert to Blocks ..............................................84
   Converted from text .........................................125

C
Candlewicking Stitch ...........................................351, 360
Card writer ..........................................................224, 275
Center point ..........................................................58
Centering .............................................................39
Chain Stitch .........................................................352, 362
Change Color .......................................................152, 156
Changing
   Thread color order ..........................................215
   Changing the character spacing ......................124
   Character spacing ..........................................120
   Check for Updates ............................................8
Checking
   Sewing order ....................................................91
   Stitching ..........................................................89
Circle .................................................................70
Circle copy ..........................................................42
Circles .................................................................70
Clipping Mask .....................................................159
Closed paths .......................................................73
Color button ........................................................53, 261
Color changes .....................................................98
Color Option .......................................................152, 156
Color pane ...........................................................14
Color Sort ............................................................45
Combining

D
Decorative fill .....................................................176, 302, 353, 375
Decorative fill mode ..............................................302
Decorative fill stitch .............................................353, 375
Decorative pattern .................................................45
Deleting
   Point ....................................................................76
   Sewing direction lines ......................................60
   Thread color charts .........................................213
   Thread colors from charts .................................215
   Design Center ..................................................237, 240
   Design Database ..............................................268, 269
   Design Page Property ....................................16, 20, 203, 256
   Design Page size ..............................................16, 20, 256
   Multi-position hoops ......................................203
   Design Property ...............................................14, 98
   Design Settings ................................................16, 256
Displaying
   Background images ..........................................307
   Color pane ..........................................................53
   Details ...............................................................273
   Embroidery patterns .......................................273
   Images ..............................................................164, 259
   Import pane .......................................................15
   Large Thumbnails .............................................273
   Small Thumbnails .............................................273
   Distributor dialog box .....................................228, 233
   Divide Stitches by Color ....................................84
Pattern colors ......................................................92
Concentric circle stitch ........................................353, 372
Center point ..........................................................58
Connection Points ...............................................78, 82, 126
Convert Region to Line .......................................78, 82, 126
Converting
   Embroidery pattern formats ................................282
   Region to line ....................................................52
   Shape pattern to stitch .....................................80
   Stitch to blocks ...............................................84
   Stitch to shapes ...............................................84
   Text pattern to stitch ......................................80
   Text to blocks ..................................................125
   Text to outline pattern .....................................125
   Text to stitches ...............................................125
Copy
   Arrange Copies .................................................42
   Sewing attributes .............................................63
Create new font mode .........................................328
Creating
   New folders .......................................................272
   New thread color chart ....................................213
Cross stitch ........................................................352, 372
Cross Stitch function ...........................................145
Cross Stitch parameters .......................................147
Crosshatch/stripe fill ............................................177
CSV .................................................................214
Customer Support ...............................................7
Customize ............................................................344, 345
Cutting line ............................................................56
Cutwork
   Cutting ..................................................................56
   Function .............................................................190
   Net Stitching ......................................................186
   Cutwork wizard ................................................186
# Index

<table>
<thead>
<tr>
<th>Font List .......................................................... 376</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font selector .................................................. 117</td>
</tr>
<tr>
<td><strong>G</strong></td>
</tr>
<tr>
<td>Gradation .......................................................... 54, 263</td>
</tr>
<tr>
<td>Grid .................................................................... 20, 259, 310, 337</td>
</tr>
<tr>
<td>Grouping embroidery patterns .................................. 46</td>
</tr>
<tr>
<td>Guideline .......................................................... 21, 310</td>
</tr>
<tr>
<td><strong>H</strong></td>
</tr>
<tr>
<td>H-Arrange .......................................................... 359</td>
</tr>
<tr>
<td>Help button ......................................................... 14</td>
</tr>
<tr>
<td>Hide ................................................................... 343</td>
</tr>
<tr>
<td>Hint View .......................................................... 63, 262</td>
</tr>
<tr>
<td>H-Offset ............................................................. 371</td>
</tr>
<tr>
<td>Hole sewing ........................................................ 46, 264</td>
</tr>
<tr>
<td>Appliqué ............................................................ 179</td>
</tr>
<tr>
<td>Cancel .................................................................. 47</td>
</tr>
<tr>
<td>Hoop changes ...................................................... 205</td>
</tr>
<tr>
<td>Hooping ................................................................ 197</td>
</tr>
<tr>
<td>Horizontal Alignment .......................................... 122</td>
</tr>
<tr>
<td>H-Spacing ............................................................ 371</td>
</tr>
<tr>
<td><strong>I</strong></td>
</tr>
<tr>
<td>Image to Stitch Wizard ........................................... 141, 157</td>
</tr>
<tr>
<td>Image Tune ........................................................ 158</td>
</tr>
<tr>
<td>Image Type ........................................................ 153</td>
</tr>
<tr>
<td>Images ................................................................ 153</td>
</tr>
<tr>
<td>Clipping Mask ..................................................... 159</td>
</tr>
<tr>
<td>Converting to embroidery patterns ......................... 141, 142, 157</td>
</tr>
<tr>
<td>Moving ............................................................... 164</td>
</tr>
<tr>
<td>Outputting .......................................................... 165</td>
</tr>
<tr>
<td>Resizing .............................................................. 164</td>
</tr>
<tr>
<td>Saving ................................................................. 165</td>
</tr>
<tr>
<td>Scaling .................................................................. 164</td>
</tr>
<tr>
<td>Importing ................................................................ 153</td>
</tr>
<tr>
<td>.pem files ......................................................... 251</td>
</tr>
<tr>
<td>Background images ............................................. 506</td>
</tr>
<tr>
<td>Clipboard images ................................................ 163, 251</td>
</tr>
<tr>
<td>Embroidery patterns ......................................... 15, 101, 274</td>
</tr>
<tr>
<td>From Design Center ............................................. 105</td>
</tr>
<tr>
<td>From original cards ............................................ 102, 280</td>
</tr>
<tr>
<td>Images ................................................................. 162, 251</td>
</tr>
<tr>
<td>Import pane ......................................................... 15</td>
</tr>
<tr>
<td>TWAIN images .................................................... 163</td>
</tr>
<tr>
<td><strong>J</strong></td>
</tr>
<tr>
<td>Jump frame ........................................................ 208</td>
</tr>
<tr>
<td>Jump Stitch ......................................................... 341</td>
</tr>
<tr>
<td>Jump Stitch Trimming ........................................... 18, 97, 341, 346</td>
</tr>
<tr>
<td><strong>K</strong></td>
</tr>
<tr>
<td>Kerning .............................................................. 119, 124</td>
</tr>
</tbody>
</table>

Docking ................................................................. 343
Drawing ................................................................. 69
DST ........................................................................ 282, 345
DST Settings ............................................................ 345
Duplicate ................................................................. 31

E
E/V stitch ............................................................. 351, 361
Echo fill ................................................................... 174
Edit User Thread Chart ......................................... 212
Editing ........................................................................
  Grouped objects .................................................. 46
  Name Drop ......................................................... 138
  Points ............................................................... 75, 296
  Sewing order .................................................... 94
  Template .......................................................... 112
  Thread color charts ......................................... 214
  Thread colors ................................................... 215
  Emboss .................................................................. 65, 290
  Embroidered patch wizard .................................. 183
  Embroidering ..................................................... 198, 210
  Patch ................................................................... 183
  Embroidering area .............................................. 204, 209
  Embroidery attributes for text .............................. 127, 128
Embroidery patterns ..............................................
  Adding comments ................................................ 98
  Aligning .............................................................. 39
  Centering ........................................................... 39
  Converting formats ............................................ 282
  Displaying .......................................................... 273
  Exporting ........................................................... 106
  From images ...................................................... 142, 157
  Grouping ............................................................ 46
  Importing ........................................................... 274
  Information ........................................................ 283
  Multi-position hoops ......................................... 204
  Printing ............................................................. 207
  Opening ............................................................. 274
  Organizing ........................................................ 272
EMF ......................................................................... 104
Engrave ................................................................... 65, 290
Entry/exit points ....................................................
  Moving ............................................................... 57
  Eraser ................................................................. 242
  Exclude internal patterns .................................... 176, 177
  Expert mode ....................................................... 63, 262
  Exporting ........................................................... 106
  Embroidery patterns .......................................... 106

F
Fan ......................................................................... 70
Figure Handle stage .............................................. 238
File .......................................................................... File
  New line image ................................................ 254
  Open in Layout & Editing .................................. 274
  Search .................................................................. 281
  File property ....................................................... 283
  Fill stitch .......................................................... 352, 366
  Fill/Stamp mode ................................................ 292
  Flexible spiral stitch ......................................... 353, 372
  Flip ...................................................................... 32, 41, 168, 257
  Floating ............................................................. 343
  Floral pattern ...................................................... 49
  Folders ................................................................. 272
  Font Creator ....................................................... 311, 312
  Font filter ........................................................... 118
Index

L

Large Thumbnails ................................................................. 273
Layout & Editing ............................................................. 11, 24, 100
Layout copy ........................................................................ 42
Line color button ............................................................... 54
Line Image stage ................................................................. 237
Line Interval ....................................................................... 156
Line sewing ........................................................................ 56, 261
Line sewing attributes ..................................................... 358
Line spacing ....................................................................... 120
Link Function .................................................................... 226, 280
Lock ..................................................................................... 96

M

Machine curve ............................................................... 61, 366, 370, 371
Manual punch ..................................................................... 27, 217, 316
Manual straight line ....................................................... 58, 364, 366, 370, 371
Matrix copy ......................................................................... 44
Max. Density ........................................................................ 156
Max. Number of Colors .................................................. 144, 147
Measure ............................................................................. 22, 87
Measurement units .......................................................... 22, 259
Merge .................................................................................. 44, 48
Minimize feed ................................................................... 174, 176, 375
Mirror copy ......................................................................... 42
Modify .................................................................................. 164, 259
Monograms ....................................................................... 130, 133
Motif mode .......................................................................... 298
Motif stitch .......................................................................... 352, 359, 371
Move Sections ..................................................................... 201
Moving

Center points ....................................................................... 58
Embroidery patterns to center ........................................... 39
Entry/exit points .................................................................. 57
Images ................................................................................ 164
Stitch points........................................................................ 81
Multiple Import .................................................................... 325
Multi-position hoops ......................................................... 203

N

Name Drop Feature ......................................................... 135, 138
Name Drop List ................................................................... 136, 139
Net fill stitch ....................................................................... 188, 353, 373
Network Machine Settings .................................................. 223, 277
New ..................................................................................... 100
New font mapping mode ................................................. 321
New Line Image ................................................................... 254
NOT DEFINED .................................................................... 55
Not sewn

Line .................................................................................. 56
Region ................................................................................ 56
Number of jumps ............................................................... 345

O

Offset .................................................................................. 119, 124, 359, 368
Offset line ............................................................................ 51
Online Registration ............................................................. 7
Open paths .......................................................................... 73
Opening

.pes files ........................................................................... 251
.pes file ............................................................................... 100
Background images .......................................................... 306
Clipboard images ............................................................... 251, 306
Embroidery patterns .......................................................... 105, 274
Images ............................................................................... 162, 251
Layout & Editing file .......................................................... 100
New Design Page ............................................................... 100
New figure handle images ............................................... 251
New line images ............................................................... 251, 252
New stitch pattern ............................................................. 298
Stitch patterns ................................................................. 292, 293
TWAIN images .................................................................. 163

Optimizing

Hoop changes .................................................................... 205, 208
Option

Design Property ................................................................. 206
Edit User Thread Chart ....................................................... 212
Option button ..................................................................... 13
Options ............................................................................... 344
Organizing embroidery patterns ...................................... 272
Outline ............................................................................... 10, 126
Convert to Outline ............................................................. 85
Converted from text ............................................................ 126
Text ...................................................................................... 128

Output

Template ............................................................................ 113
To Clipboard ........................................................................ 165
To File ............................................................................... 165
Oval ...................................................................................... 69
Overlap ............................................................................... 44

P

Palette Software Key ......................................................... 9
Pan ..................................................................................... 86, 242
Pattern ............................................................................... 10
Pattern information ............................................................ 98, 283
Adding comments ............................................................ 98
Multi-position hoops .......................................................... 206
Pattern Placement ............................................................. 143
Pencil .................................................................................... 73
Photo Stitch 1 ....................................................................... 149
Candidates .......................................................................... 153
Color .................................................................................... 149
Parameters .......................................................................... 152
Photo Stitch 2 ....................................................................... 154
Color .................................................................................... 156
Parameters .......................................................................... 156
Piping stitch ........................................................................ 352, 370
Points

Editing ............................................................................... 75, 296
Positioning Sheet ............................................................... 196
Positioning sticker ............................................................. 199, 200, 211
Preview window ................................................................. 308, 333
Previewing .......................................................................... 87, 283
Stitch patterns ................................................................. 307, 308
Print and Stitch ................................................................. 166
Printing

Catalogs ............................................................................ 285
Embroidery patterns .......................................................... 109
Instruction guide ............................................................... 285
Multi-position hoops ......................................................... 207
Preview ............................................................................... 109
Settings ............................................................................ 107
Programmable fill stitch .................................................... 352, 353
Programmable Stitch Creator .......................................... 287, 288
Pull Compensation ............................................................ 365
Index

Q
Quick Access Toolbar .......................................................... 13, 342, 344

R
Radial stitch ........................................................................ 353, 372
Center point ........................................................................ 58
Random shift ........................................................................ 375
Realistic View ........................................................................ 88
Settings .............................................................................. 68
Rectangle ............................................................................. 342
Redo ................................................................................. 90, 257
Reference Window ................................................................ 261
Region color button ............................................................. 261
Region sewing ....................................................................... 56, 261
Remove Overlaps .................................................................. 47
Resizing
Images .................................................................................. 164
Ribbon .................................................................................... 13
Rotate .................................................................................... 40, 41, 257
Rotate angle ........................................................................... 119
Rotating .................................................................................. 41
Round fill ................................................................................ 61
Ruler ....................................................................................... 20
Run Pitch .............................................................................. 153
Running stitch ......................................................................... 351, 358

S
Satin stitch ............................................................................. 352, 364
Saving
Different formats ..................................................................... 106
Embroidery patterns ............................................................. 106, 266
Images .................................................................................... 165
Stitch patterns ........................................................................ 308
Template ................................................................................ 114
Scaling
Images .................................................................................... 164
Scaling patterns ..................................................................... 39, 296, 301, 331
Screen Calibration .................................................................. 21
Searching ............................................................................... 281
Select Color Palette .............................................................. 216
Select from Candidates .......................................................... 153
Selecting
All embroidery patterns ......................................................... 38
Colors ...................................................................................... 80, 152, 156
Patterns ................................................................................... 38, 94
Sewing area ............................................................................ 18
Send
Link ....................................................................................... 227, 231
Send to Network Machine ..................................................... 224
Send to USB Media ............................................................... 221
Send to Your Machine ........................................................... 222
Write to Card .......................................................................... 225
Sew Page Color ...................................................................... 153
Sew Setting stage ..................................................................... 239
Sew type selector ..................................................................... 56, 261
Sewing Attribute pane .............................................................. 14
Sewing attributes .................................................................... 74
Copy ......................................................................................... 63
Setting ..................................................................................... 63, 246
Sewing Attributes bar ............................................................... 261
Sewing direction
Programmable fill stitch ......................................................... 369
Specifying .............................................................................. 58, 61
Sewing Option .......................................................................... 153, 156
Sewing order .......................................................................... 91, 265

E
Editing ..................................................................................... 94
Optimize .................................................................................. 45
Sewing Order pane ................................................................... 14
Shape patterns ......................................................................... 10
Shortcut keys .......................................................................... 345
Show grid ............................................................................... 14, 20
Single Import .......................................................................... 322
Small Text ............................................................................... 128
Snap to grid ............................................................................. 29
Solid View ............................................................................... 87
Special colors .......................................................................... 55
Spiral stitch ............................................................................. 353, 372
Split at point ............................................................................ 76, 82, 245, 297
Split embroidery designs ......................................................... 194
Split Stitch data ....................................................................... 49, 82, 83, 245
Stabilizer .................................................................................. 196
Stage
To figure handle ..................................................................... 255
To line image ........................................................................... 253
To Sew Setting ........................................................................ 260
Stamp ....................................................................................... 67, 265
Standard Character Height ..................................................... 323
Start/end point ........................................................................ 363
Startup wizard ......................................................................... 12
Status bar ................................................................................ 14
Stem Stitch .............................................................................. 351, 360
Step Pitch ................................................................................. 366, 368
Stippling fill .............................................................................. 176
Stippling stitch ......................................................................... 353, 373
Stitch patterns .......................................................................... 10
Previewing ............................................................................... 308
Saving ...................................................................................... 308
Stitch points
Deleting .................................................................................... 81
Inserting ................................................................................... 81
Moving ....................................................................................... 81
Stitch Simulator ......................................................................... 14, 89
Stitch to Block .......................................................................... 84
Stitch View ............................................................................... 87
String ......................................................................................... 70
SVG .......................................................................................... 104
System Unit ............................................................................. 22

T
Template (background) ............................................................ 306, 329
Template Wizard ..................................................................... 111
Text
Convert to blocks .................................................................... 125
Convert to Outline Object ......................................................... 126
Edit Letters .............................................................................. 116
Entering text .............................................................................. 115
Fit Text to Outline Setting ......................................................... 122
Release Text from Outline ......................................................... 123
Text Attribute Setting ............................................................... 117
TrueType Font Attribute Setting ................................................ 120
Text Attribute pane ................................................................. 14
Text menu ............................................................................... 26
Text Orientation ....................................................................... 122
Text patterns ............................................................................. 10
Text Size selector ..................................................................... 119
Thread Chart ............................................................................ 152, 156
Thread colors
Adding to charts ...................................................................... 214
Apply new color palette ......................................................... 216
Basic color .............................................................................. 98
Creating new colors ................................................................. 214
Deleting charts ......................................................................... 213
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting from charts</td>
</tr>
<tr>
<td>Editing</td>
</tr>
<tr>
<td>Editing charts</td>
</tr>
<tr>
<td>New charts</td>
</tr>
<tr>
<td>Order</td>
</tr>
<tr>
<td>Total colors</td>
</tr>
<tr>
<td>User list</td>
</tr>
<tr>
<td>Thread Colors Used</td>
</tr>
<tr>
<td>Thumbnail</td>
</tr>
<tr>
<td>Transferring</td>
</tr>
<tr>
<td>Triple stitch</td>
</tr>
<tr>
<td>TrueType Font</td>
</tr>
<tr>
<td>Under sewing</td>
</tr>
<tr>
<td>Undo</td>
</tr>
<tr>
<td>Unit</td>
</tr>
<tr>
<td>USB cable</td>
</tr>
<tr>
<td>USB media</td>
</tr>
<tr>
<td>Use smaller section sizes</td>
</tr>
<tr>
<td>User Interface Settings</td>
</tr>
<tr>
<td>User thread color list</td>
</tr>
<tr>
<td>User-mapped text</td>
</tr>
<tr>
<td>V-Arrange</td>
</tr>
<tr>
<td>Vector images</td>
</tr>
<tr>
<td>Vertical Alignment</td>
</tr>
<tr>
<td>Vertical Offset</td>
</tr>
<tr>
<td>View mode buttons</td>
</tr>
<tr>
<td>V-Offset</td>
</tr>
<tr>
<td>V-Spacing</td>
</tr>
<tr>
<td>Window</td>
</tr>
<tr>
<td>Wireless network</td>
</tr>
<tr>
<td>WMF</td>
</tr>
<tr>
<td>Zigzag net fill stitch</td>
</tr>
<tr>
<td>Zigzag stitch</td>
</tr>
<tr>
<td>Zoom</td>
</tr>
<tr>
<td>Zoom ratio</td>
</tr>
</tbody>
</table>